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Welcome to
SCO Vision97

The SCO Vision97 suite of products offers the
ultimate in Windows to UNIX integration, making
UNIX applications and data transparently accessible
directly from your Microsoft Windows desktop. SCO
Vision97 gives you a window onto your business
critical applications whatever type of application you
have - graphical X, SQL database or character
application.
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About Vision97
The Vision97 suite includes the following 32-bit products for use with Windows 95 or
Windows NT.

SCO® XVision® Eclipse provides Windows PC users with transparent access to X Window
System applications running on remote host systems, as well as to UNIX character-based
applications. It allows you to browse files on remote systems and launch applications with point
and click simplicity. File transfer, printing and advanced messaging complete this connectivity
package.

SCO® Vision Resume allows you to suspend an X session and resume it at a later time.

SCO® TermVision� gives Windows PC users transparent access to UNIX character-based
applications. This powerful set of terminal emulators gives point and click simplicity for PC users
while being highly customizable and controllable for administrators.

SCO® SQL-Retriever� allows Windows applications running on a PC to access data stored in
remote UNIX databases. It provides an Open Database Connectivity (ODBC) driver that can be
used over a wide range of network and serial connections.

SCO® SuperVision� gives System Administrators the power to remotely manage, configure and
control large groups of Windows PCs. It is specifically designed for managing software provided
in other Vision97 products. SuperVision provides facilities for: distributing data files; managing
users� desktops; creating script files to perform tasks on PCs; controlling and monitoring PCs
remotely; and remote configuration.

SCO VisionFS� is the smart way to share files and printers from UNIX servers to Windows
clients. It is the most business efficient solution for TCP/IP based connectivity in heterogeneous
environments. Its server-based approach allows total integration into users� desktops without any
additional client software. Installation on the server makes UNIX �Window Friendly�.

In addition, the Vision97 CD includes 16-bit products for Windows 3.x users. For details, see
the \Readme.txt file on the CD.

About this book
This Reference book covers all the 32-bit products in the Vision97 suite. It does not cover
VisionFS, nor 16-bit versions of other products. The book is organized in the following parts,
some of which describe common components, while others are relevant only to specific Vision97
products. In the online version of this book, only the parts relevant to the products you have
installed will be present.

Part I, Installation
Describes the procedures for installing Vision97 software on PCs and UNIX systems.
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Part II, Vision Communications Architecture
Provides details about the communications software used by Vision97 programs to connect PCs
to UNIX systems.

Part III, X Window System
This part is only relevant to XVision. It describes the X Server and the other components
relevant to the X Window System. It also describes Vision Resume, which allows you to suspend
an X session and resume it at a later time.

Part IV, Terminal Emulation
Describes the Vision97 terminal emulators and supporting programs such as the Keymap Editor.

Part V, ODBC
This part is only relevant to SQL-Retriever. It describes the Vision ODBC Driver, and supporting
applications such as SQLGold.

Part VI, Accessories
Describes the facilities provided for browsing UNIX hosts, starting UNIX programs, printing,
and messaging.

Part VII, Zones
This part is only relevant to XVision. It describes how windows can be organized into several
zones by creating a virtual desktop space.

Part VIII, Administration
This part is only relevant to SuperVision Administrator. It describes the remote administration
facilities and how to use the Administration Workbench.

Part IX, Appendices
Provides additional information relevant to the products installed.

About the documentation
Documentation for Vision97 is available online on your computer screen, accessed using the
standard Microsoft Windows Help application. Most of this information is also available in
printed form.

Online information
To access the Help system, click the Start menu, point to Vision, and then click Vision Help. For
older versions of Windows NT, double-click the Vision Help icon in the Vision group in
Program Manager. For Help on VisionFS, start the Profile Editor and choose the Help menu.
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Use the Contents tab to explore the Vision97 documentation. The information available depends
on which Vision97 products are installed on your PC. Introducing Vision97 gives basic
information about the features and facilities of your Vision97 software. For instructions about a
specific task, use the Index, or choose How To from the Contents. More detailed information of
interest to a System Administrator is contained in the Reference book. This may not be installed
for a Typical installation, so you should use Custom or Maintenance Setup if you require this
Help.

When you are using a Vision97 program, you can get Help specific to that program by choosing
Help Topics from the Help menu. You may also be able to get information about a specific
option in a window or dialog box. Click  in the title bar, then click an option.

Printed information
Introducing SCO XVision Eclipse, Introducing SCO TermVision, Introducing SCO
SQL-Retriever, Introducing SCO VisionFS   If you ordered one of these Vision97 products, the
appropriate book will be supplied.

SCO Vision97 Reference  Complete reference information about the components of Vision97,
excluding VisionFS.

Additional sources of information
For basic information about Microsoft Windows, refer to the documentation provided with your
Windows package. For technical information, refer to the Microsoft Windows Resource Kit for
your version of Windows.

For information about your host operating system, refer to the documentation provided with
your version of UNIX.

The Microsoft ODBC SDK Programmer�s Reference is the main source of documentation for
application developers writing in C. This is available on the Microsoft Developer Network CD.

For other programming languages, such as Visual Basic, see the documentation set for the
language.

Conventions used in the documentation
The following conventional terms, text formats, and symbols are used throughout the Vision97
documentation.
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Convention Meaning

[brackets] Enclose optional items in syntax statements. For example,
[password] indicates that you can choose to type a password with
the command. Type only the information within the brackets, not
the brackets themselves.

. . . (ellipsis) In syntax statements, indicates that you can repeat the previous
items. For example, filename [,...] indicates that you can specify
more than one file, putting commands between the file names.

| Stands for �or� and separates items within braces or brackets. For
example, {0 | 1} indicates that you must type 0 or 1.

Bold Indicates the actual commands, words, or characters that you type
in a dialog box or at the command prompt.

Italic Indicates a placeholder for information or parameters that you must
provide. For example, if the procedure asks you to type filename,
you must type the actual name of a file.

C:\Windows Windows file names are shown in bold type, using a mixture of
upper and lower case letters as the file name would appear in
Windows Explorer.

unixprog UNIX file names are shown in bold type, and since they are case-
sensitive they may use a mixture of upper and lower case letters.

Monospace Represents examples of screen text or entries that you might type at
the command line or in initialization files.

Windows Refers to Windows 95 or Windows NT 4.0 or later operating
systems.

Older versions of Windows NT
Refers to versions of Windows NT earlier than 4.0, which had a
different user interface.

Windows folder Refers to the Windows system folder tree. This can be C:\Windows
or whatever other folder name you specified when installing
Windows.

x86 Refers to computers based on 32-bit, x86-based microprocessors
(such as Intel® 80386 or higher) or based on Intel Pentium®

microprocessors.
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Installation

This part describes the procedures for installing Vision97 software on
PCs and UNIX systems.
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This chapter tells you how to install SCO Vision97 on your PCs and UNIX hosts.
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This chapter tells you how to install SCO Vision97 on your PCs and
UNIX hosts.
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Vision97 installation overview
Vision97 contains products with both PC parts and UNIX parts. If the UNIX software is not
installed, some Vision97 programs will work normally, but other programs will not work or have
restricted functionality. Comprehensive Setup programs for Windows and UNIX let you choose
which products to install, and lead you step-by-step through installation and essential
configuration.

For best results, we recommend you install the UNIX parts first, and let Setup make the PC parts
available using a VisionFS shared folder. In this way, everyone on your local network has instant
access to Vision97 products, and the benefits of Vision97 host components are available
immediately. Other options are to install the PC parts directly from the Vision97 CD, or to use
the Server-based Setup option to install in a shared folder.

Vision97 products are licensed on a concurrent user basis. A License Server, installed on the
UNIX host, tracks license usage. You can install products you don�t have a license for: these
products run as 30-day evaluations. The License Manager, a PC program on the Vision97 CD
and on a VisionFS share, lets a nominated License Administrator add and remove license
numbers.

Note  SuperVision Administrator should only be installed on the System Administrator�s PC.
The SuperVision Agent can be installed on any PCs you want to administer, and is automatically
included when you install any other Vision97 product.

Hardware and software requirements
This section tells you what you need to install Vision97 on PCs and UNIX servers.

PC requirements
To set up and use Vision97 software on a PC, you need:

• A computer running Microsoft Windows 95 or Windows NT.
• At least 12 Mbytes of memory if you are running Microsoft Windows on an Intel-based PC.
• A hard disk, or access to a Windows or MS-DOS network server. The amount of disk space

required depends on the options you choose at Setup time.
• A CD-ROM drive if you want to install from the Vision97 CD. Alternatively, you can install

from a VisionFS share on a UNIX server.

• A graphics monitor and adapter card supported by Microsoft Windows. A VGA is the
minimum monitor requirement.

• A mouse or equivalent pointing device.
• To use a network, you need a local area network card and networking software. Vision97

software provides support for TCP/IP and IPX/SPX (NetWare) networks. TCP/IP software
must support the 32-bit Windows Sockets interface, and you can use the Microsoft TCP/IP
supplied with the operating system. IPX/SPX provides only a terminal service.
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• For a serial connection, you can use a direct serial line or a modem. You are recommended to
configure the modem as a Windows TAPI device.

UNIX server requirements
To install and use Vision97 software on a UNIX server, you need:

• A computer running a version of UNIX for which Vision97 software is available. A full list of
supported operating systems is in the file /readme.txt on the CD.

• TCP/IP network software must be installed on the UNIX host.
• A CD-ROM drive on your UNIX server that can read ISO9660 format CDs.
• The amount of disk space required varies depending on the products installed.

Setting up Vision97 on a UNIX host
The Vision97 CD uses ISO9660 format. You can upgrade from existing versions of the software.

Note  You can install Vision97 UNIX software using a terminal emulator from a PC, but only if
the emulator does not use a USP transport.

To start Vision97 Setup from CD on UNIX

1 Log in as root on the UNIX host.
2 Mount the CD, by typing one of the following:

On this UNIX system� Type this�

Data General DG/UX (Intel) 4.11 mount -t cdrom /dev/dsk/ cddev cddir

Data General DG/UX (Motorola)
5.4.2.1; 5.4.3+ mount -t cdrom -o ro /dev/ cddev cddir

DEC Digital UNIX 3.0+ mount -t cdfs -o ro,noversion /dev/ cddev  cddir

HP-UX 9.01+ mount /dev/dsk/ cddev cddir  -r -t cdfs

HP-UX 10.01+ mount /dev/dsk/ cddev cddir  -r -F cdfs

IBM AIX 3.2.5+ mount -v cdfs -r /dev/ cddev cddir

ICL DRS/NX 6; 7 mount -F cdfs -o ro /dev/ cddev cddir

SCO OpenServer Release 5+ mount -f HS -o ro,lower /dev/ cddev cddir

SCO UnixWare 2.1+ mount -F cdfs -r /dev/cdrom/ cddev cddir

Sequent DYNIX/ptx 2.1.6 mount -r -f cdfs /dev/dsk/ cddev cddir

Siemens Sinix 5.42 mount -F cdrom -o ro /dev/ cddev cddir

Silicon Graphics IRIX 5.3 mount -t iso9660 /dev/ cddev  cddir

SPARC Solaris 2.3+ mount -F hsfs -o ro,nrr /dev/ cddev cddir

SPARC SunOS 4.1.2+ mount -t hsfs -o ro,nrr /dev/ cddev cddir
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replacing cddev with the device name of the CD drive, and cddir with the name of your CD�s
mount directory.

3 Change to the CD directory. For example, if your CD is mounted on /cdrom, type:
cd /cdrom

4 Run the setup script on the Vision97 CD. Type:
sh ./setup
Some systems (for example, HP-UX) display filenames in UPPER CASE, followed by �;1�. In
this case, type sh ./SETUP\;1

5 Follow the instructions on your screen. You�ll get to choose which products to install, and
whether to deploy these using a VisionFS shared folder (recommended). Then you can review
and change installation settings for each component, and add license numbers.

Make sure you read any README files installed in the docs subdirectory of the Vision97 shared
directory (by default, /usr/local/vision).

If you are upgrading, changes you made to configuration files may not be preserved during
installation. In this case the old configuration file is saved with the filename prefixed by �O�. For
example, if you changed the vision.conf file to set the VISION_NSGATEWAY variable, the file
will be saved as Ovision.conf. You need to reapply the edits manually after installation, and
restart the Vision Services if they are running.

If you choose to install XVision, then XRemote software will be installed if it is available for
your system (see /readme.txt on the CD). XRemote allows an X session to run over a serial line
or modem connection. The Vision97 CD also includes the standard NCD distribution of
XRemote in MS-DOS compressed file format, which supports more variations of UNIX and also
VMS (see \Misc\Xremote\Readme.txt).

Setting up Vision97 on a PC
If you�re installing only VisionFS and/or Vision Resume you can skip this section, as these
products don�t include any PC parts.

Before running the Setup program, you should ensure that the communications transport you
intend to use (network or serial line) is working correctly from Windows. You are recommended
to close any unnecessary Windows applications before starting Setup.

To start Vision97 Setup from the network in Windows 95 and NT 4.0

1 Click the Start button, point to Settings, and click Control Panel.
2 Double-click Add/Remove Programs. Click Install.
3 The Windows Install Program wizard starts and prompts you to insert a floppy disk or CD.

Click Next and then Browse to search for the Setup.exe program. Click Next.
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If you�re installing from a VisionFS share, use Setup.exe in the Vision97 folder on the
VisionFS server, which by default appears in all workgroups using the UNIX hostname. If
prompted, type your password for this VisionFS server (by default, your password on the
UNIX host).

4 Click Finish to exit the Install Program wizard. The Vision97 Setup wizard starts after a few
seconds.

5 Follow the instructions on your screen. If you choose Workstation Installation, only files
which must be private to the user will be installed on the workstation�s hard disk, and the
Vision97 programs will run from the network file server.

To start Vision97 Setup from CD in Windows 95 and NT 4.0

1 Put the Vision97 CD in a PC�s CD drive. The Vision97 AutoPlay screen appears after a few
seconds.

2 Click Install.
3 Follow the instructions on your screen.

To start Vision97 Setup in older versions of Windows NT

1 In File Manager, do one of the following:
§ To install from CD, put the Vision97 CD in a PC�s CD drive, and click the CD drive icon.
§ To install from the network, click the network drive icon and change to the folder

containing the Vision97 files.
2 Double-click Setup.exe. The Vision97 Setup wizard starts after a few seconds.
3 Follow the instructions on your screen.

Note  By default, SuperVision allows the System Administrator to browse your files, find out
which programs are running, and even see what is on your PC screen. If you do not want this
functionality, following Vision97 Setup, click the Start menu, point to Settings, click Control
Panel and then double-click Vision Services. Click the Admin tab and disable the Allow This PC
to be Administered by SuperVision option.

Server-Based Setup
Server-based Setup allows you to install Vision97 software on a network file server, and that
distribution point can then be used to install Vision97 on PC workstations. This is an alternative
to using the option to deploy the PC parts through a VisionFS shared folder when installing
Vision97 on a UNIX host. Server-based Setup is run from a PC, and allows you to use any shared
folder accessible to Windows. Workstation users can then carry out a full installation of Vision97
software, or can choose to run Vision97 programs from the network drive.

Before running Server-based Setup, make sure that you have full access privileges to the drive
and folder on the server where you want to install the Vision97 software. For example, if you
want to install on a Windows NT server, create a new folder on the server�s hard disk and make
it sharable with Full access.
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To start Server-based Setup

1 Insert the Vision97 CD in your CD-ROM drive.
If you are using Windows 95 or NT 4.0, the Vision97 AutoPlay starts after a few seconds.

2 Choose Install.
3 Choose the products you want to install.
4 Choose Network Administrator.
5 Type the UNC path of the folder where you want to install the files, or use the Browse button

to search the network for the folder you want.
6 If you want to register as a Vision97 user by email or fax, choose Yes. The registration will be

carried out following a successful installation.
7 Confirm the choices you have made.

The Server-based Setup program for the first of the selected products starts.
8 Click the Install button.

Server-based Setup copies all the files from the distribution media to the shared folder. The
process is repeated if you selected more than one product to install. After installation, set the
access privileges to read-only for the shared folder, and ensure that all users who may need to
install Vision97 software on their workstations from the network have read privileges for that
folder.

Server-based Setup does not create a working copy of Vision97 software. It copies the files off
the Vision97 CD onto the network drive, from where they can be used to set up workstations.
Follow the instructions in �Setting up Vision97 on a PC� to install Vision97 software on a
network workstation.

Automated installations
Setup script files allow hands-free installation of Vision97 software on a PC�s hard disk. Using a
script file ensures that installations are identical. Script files and executables are supplied for each
of the standard installations, for example, Xvtyp.exe executes the script file Xvtyp.shh and
installs a typical XVision with default settings.

If you chose to deploy the Vision97 software using a VisionFS shared folder, you will find
executables for the various Setup script files in the Vision97\V97-go! folder on the VisionFS
server. They can also be found on the Vision97 CD, or if you chose Server-based Setup, in the
folder in which you installed the Vision97 source files. To use one of these executables, double-
click the file�s name.

Setup script files (.shh) are text files. Hence, you can use a text editor such as VI to edit the
default settings and thereby create a Setup script file tailored to your specific requirements. For
example, you could change the default install location from C:\Program Files\Vision to
D:\Program Files\Vision. The Setup script files for the individual Vision97 products are located
with the software for that product. For example, on a VisionFS share, the Setup script files for
XVision, Xvtyp.shh and Xvcompct.shh, are located in Vision97\Pc\Win32\Xvision.
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The System Administrator can also use Server-based Setup (see �Server-based Setup�) to create a
Setup script file for a custom installation.

To create a Setup script using Server-based Setup

1 In Server-based Setup, click the Make Script button.
The Server-Based Setup Properties dialog box is displayed. The example below is for
XVision.

2 In the Script File box, enter the full UNC pathname of the script file you want to create,
which may have any name (for example, setup.shh). We recommend that you use a mapped
drive, and that all users who will use the script have the same mapping.

3 Click plus signs (+) next to the books to display further options. The example dialog box
illustrated below is for XVision.
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4 Choose the options you want, and then choose OK. The script file will be created in the
folder you specified. For Windows 95 and NT 4.0, a shortcut to the script file will be created
in the folder in which you installed the Vision97 source files.

The options available depend on the Vision97 product to be installed. Checking an option
specifies that a component should be installed, or that a Setup question should be answered
positively. Not checking such an option specifies that the component should not be installed, or
that a question should be answered negatively. For options that allow you to specify a folder
name, checking the option allows you to enter a folder name in the Settings area. Not checking
the option means that the default value used for a Typical installation will be used.

Using a Setup script created using Server-based Setup
To use a Setup script created using Server-based Setup on Windows 95 or NT 4.0, double-click
the script file�s shortcut. For older versions of Windows NT, run Setup for the Vision97 product
you wish to install, and specify the script file on the command line. You must run the product�s
Setup and not the top-level Vision97 Setup. For example, assume that the Vision97 source files
are installed on a server named NTserver and the share is Vision, and a script file for XVision
called setup.shh exists in the same folder. Display the Run dialog box from File Manager and
type \\ntserver\vision\xvision\setup \\ntserver\vision\setup.shh.
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Adding more options
When you have installed Vision97 software on your PC or workstation, you can add or remove
options at a later date by running Maintenance Setup.

To add more options in Windows 95 or NT 4.0

1 Click Start, point to Programs, point to Vision, point to Setup, and then click the Setup
command for your Vision97 product.

2 Select components to add or remove by clicking the check boxes.

To add more options in older versions of Windows NT

1 Double-click the Vision97 software Setup icon in the Vision group in Program Manager.
2 Select components to add or remove by clicking the check boxes.

You will be prompted to restart your computer if Maintenance Setup finds locked files that it
cannot delete.

When you install a component, Setup remembers where you last installed Vision97 software
from and will automatically look there for the required files. If the relevant source is not
available, then Setup prompts you to map the drive or insert the floppy disk or CD. After
copying the necessary files, the Registry is updated with the appropriate entries.

Removing Vision97 from a UNIX host
Note  Do not attempt to remove Vision97 UNIX software using a terminal emulator connected
to the host via a USP transport. You may use a Vision97 emulator, providing you select a non-
USP transport for the host.

To remove UNIX software

1 Check there are no current users of the services you are about to remove.
2 Log in as root on the UNIX system.
3 Change to the directory where the Vision97 UNIX software was installed. For example, cd /

usr/local/vision.
4 Enter the command ./v97 remove.

Follow the instructions on the screen to remove Vision97 Services.

Shared components will not be removed until the last Vision97 product has been removed.
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Removing Vision97 from a PC
Follow this procedure to remove Vision97 software from a computer running Windows 95 or
NT 4.0. There is no recommended removal procedure for older versions of Windows NT.

To remove Vision97 from Windows 95 or NT 4.0

1 Click Start, point to Settings, and click Control Panel.
2 Click Add/Remove Programs.
3 Click the name of the Vision97 product in the list and click Add/Remove.
4 Select components to remove by clicking the check boxes, or click Remove All.

All the Vision97 software files, folders, icons, and Registry entries are deleted from your hard
drive.
If any locked files are found that cannot be deleted, you will be prompted to restart your
computer.
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Communications overview
Software products in the Vision97 suite from SCO use client/server techniques to make the most
efficient use of computer resources. Most applications have a PC component and a UNIX
component. The Vision Communications Architecture provides the vital link between these
components. The key design points include the following:

• Vision Communications software forms a distinct layer which is independent of applications
using it.

• Vision97 software products that have a PC component and a UNIX component use Vision
Communications software as the communications link.

• Communications transports and available hosts are defined in Vision Communications,
together with the services available.

• The Vision Toolkit provides a well-defined interface to the communications software through
a series of Application Programming Interfaces (APIs). Other Vision97 programs use these
APIs to access the resources and services they require.

• Vision Communications Architecture supports several different transport protocols, including
TCP/IP, IPX/SPX and RS232C serial lines. The Vision97 software runs on top of existing
communications transports configured in the Windows environment. Vision Communications
Architecture does not include a protocol stack (although a separate TCP/IP stack may be
supplied with some packages).

• The way programs and users interact with applications is similar regardless of the transport
protocol being used. For example, services are requested using a standard naming convention
which is automatically translated to addresses recognized by the underlying protocol.

• Vision Communications Architecture provides its own protocol for use over serial lines,
which gives similar connectivity to a network connection. This is more efficient and easier to
install and manage than using, for example, SLIP or PPP.

• Security measures to protect both the PC and UNIX systems are an integral part of Vision
Communications Architecture.

• Vision Communications Architecture is designed for remote system management. For
example, passwords are not usually stored with the objects they protect.

• Vision Communications software is a full 32-bit implementation with high-performance
architecture.

• Vision Communications Architecture makes full use of Windows 95 and NT 4.0 capabilities
and conforms to Windows 95 and NT 4.0 conventions. Where necessary, alternatives are
provided to maintain support for older versions of Windows NT.
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Vision Communications Architecture
model
The following diagram illustrates the Vision Communications Architecture model.

Vision Applications  Applications supplied with Vision97 software packages implement
connectivity by making calls to the Vision Toolkit APIs. This makes the applications independent
of the methods used to provide the required services.

Vision Toolkit APIs  A set of high-level Application Programming Interfaces (APIs) provide
standard interfaces for Terminal, RPC, Socket, Execution, and File Access functions. Some APIs,
for example the Terminal API, support standard network services such as Rlogin, in addition to
the Vision Communications USP service. For these services, the method of providing the service
can be configured by the user or System Administrator.

Vision Service Modules (VSM)  Implement functional services using USP. They provide the
preferred method for supporting standard services for hosts on which Vision97 software is
installed. Some services are only supported using USP and the associated VSMs.
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Universal Session Protocol (USP)  Allows Vision Communications Architecture to support
multiple transport protocols, while presenting a standardized communications interface to other
software layers. USP operates directly over TCP/IP if that transport is available. If TCP/IP is not
available on the PC, a USP proxy process runs on the UNIX system to represent the PC on the
network. The proxy process uses UTP running over any available transport to communicate with
the PC.

RPC library  The USP RPC service is layered on top of Sun ONC RPC, which has itself been
modified in order to use the Vision UTP protocol as a transport. In addition, facilities for
asynchronous RPC calls have been added which are similar to those provided in ONC Transport-
independent RPC.

Transport protocols  Vision Communications Architecture supports various network and serial
line protocols. Networks supported include TCP/IP and IPX/SPX (Novell). For serial
connections, support for the RS232C protocol is built in, while other protocols can be used via
the Windows TAPI interface.

Universal Transport Protocol (UTP) is a reliable multiplexing protocol that can be used over
any communications transport. It allows Vision97 PC and UNIX software to communicate over
non-TCP/IP transports such as an RS232C serial link. For example, a notebook PC user working
away from the office could dial in using a modem, and gain full access to Vision
Communications services on the office network.

TAPI  The Microsoft Windows Telephony Application Programming Interface provides access
to a variety of telephone network services. It allows Windows applications to control voice and
data links, without including any service-specific programming code. In Windows 95 and
Windows NT, TAPI is the standard way of interfacing to modems and digital telephone services
such as ISDN.

Name Space Environment (NSE) Provides a consistent, transport-independent mechanism for
accessing Vision resources. NSE uses the Uniform Naming Convention (UNC) format for
identifying resources. This allows a client to request a service on a particular host system, using a
string that is independent of any specific form of network addressing. NSE uses a replicated
Name Space Manager (NSM) and associated Local Name Agents (LNAs) to implement a secure
but flexible framework, ideally suited to client/server architecture.

Vision Communications database  A collection of files that holds details of all configurable
elements in Vision Communications Architecture.

Authentication scheme  Designed to improve on the basic UNIX user identification
mechanism, and extend it to PC-based servers. It is the responsibility of each server program to
specify the type of authentication required for each service that it provides. A client must contact
a UNIX authentication server to obtain a token before it can access the service it wishes to use.

License management  The SCO Vision97 suite of products are licensed on a concurrent-user
basis. The License Management facilities allow the License Administrator to manage licenses
effectively.
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Changing system settings
You can configure the basic communications layer, and also the higher-level services that are
only available if Vision Services for UNIX is installed on the host.

You should not have to make any changes to the Vision Communications settings if you are
connecting over a TCP/IP network. If you use any other transport, you may need to do some
manual configuration.

Normally, the only changes you need to make to Vision Services settings are for printer
configuration.

To change system settings

1 Do one of the following:
§ Click the Start button, point to Settings, and then click Control Panel.
§ For older versions of Windows NT, open the Main group in Program Manager, then

double-click the Control Panel icon.

2 Double-click either Vision Communications or Vision Services.

You can get Help on an item by clicking  in the title bar, then clicking the item.
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Configuring transports
The Vision Communications database holds details of transports that can be used by Vision97
programs. The key points about configuring transports include the following:

• The Local transport defines a mechanism for inter-process communication on the PC. All
other transports define mechanisms for accessing a remote host. The definition includes the
protocol used to make the connection, the script used to log in and execute commands, the
authentication required, and advanced settings that specify the services available and how
they are to be provided.

• A selection of transports is created when you install Vision Communications Architecture on
your PC. Some transports such as TCP-Unix are always created, while others are only created
if the underlying transport mechanism is present on your PC.

• You will need to configure a new transport if you want to use Vision Communications
Architecture services when connected over a serial line or modem. This is because you need
to specify details of the host on which the USP proxy process runs.

• A transport can be explicitly specified as enabled or disabled, or its availability status can be
detected dynamically. To check the availability status, Vision Communications probes the
underlying transport mechanism, and determines whether the transport is Available,
Unavailable or has Unknown availability.

• Transport definitions are used by host objects to specify how the remote host should be
connected. By default, the transport is selected automatically when the connection is opened.
For this to work, it is essential that transports are configured for all types of connection that
may be used from a PC. For example, a network connection and a modem connection.

• For all transports except Local, a script written in the ComScript scripting language is used to
control various parts of the process of connecting, logging in and executing commands on the
UNIX host.

Adding a transport
The Windows Control Panel is used to add, delete or change transports.

To add a transport

1 In Windows Control Panel, double-click Vision Communications and then click the
Transports tab. The dialog box shows the configured transports.
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2 Click Add to create a new transport, or select an existing one and click Properties to modify,
or Remove to delete.

When you add a new transport you must type a description and choose the protocol to be used
(see �Specifying Communications Options� later in this chapter). You may not need to change
any of the other options, because the default values are normally suitable. Use context Help on
the Properties dialog box for information about the settings, and see later in this chapter for an
overview.

To configure transports for automatic selection

1 Specify in the properties for each transport whether or not the transport should be included
when considering transports for automatic selection.

2 Adjust the order of transports using the arrow buttons on the Transports tab. If a host is
configured to select a transport automatically, then Vision Communications Architecture will
try to connect to the host using each enabled transport in turn, starting at the top of the list.
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Specifying Communications options
The Communications tab allows you to specify a description for the transport, and the protocol
to be used. You can use the buttons to specify further details.

The Description can be any text you want to describe the transport. The Protocols available are
shown in the table below.

Option Description

None No protocol selected.
Local Specifies that a proprietary protocol should be used for inter-

process communication on the PC. The Settings and Proxy buttons
are grayed.

TCP/IP Specifies that TCP/IP protocols should be used. The Settings and
Proxy buttons are grayed.

IPX/SPX Specifies that IPX/SPX protocols should be used. The Settings and
Proxy buttons are grayed.

Serial Specifies that a serial line or a non-TAPI modem should be used to
communicate with a UNIX host. The Settings button allows you to
choose a COM port, and to enter a phone number if applicable.

Modem Specifies that a TAPI modem should be used to communicate with a
UNIX host. The Settings button allows you to choose a modem
configured as a TAPI device.
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Option Description

USP/TCP Specifies that Universal Session Protocol (USP) services should be
utilized, using TCP as the transport. The Settings and Proxy buttons
are grayed.

USP Via Proxy Specifies that Universal Session Protocol (USP) services should be
provided by a proxy running on a remote host, which you can
configure using the Proxy button. The Settings button is grayed.

Xtrace An SCO proprietary protocol that can be used for troubleshooting
problems with the X Window System when the Vision X Server is
installed.

Setting up a proxy
Choosing the Proxy button displays a dialog box that allows you to specify details of a remote
host on which the Universal Session Protocol helper process will run. The helper process acts as a
proxy for your PC on the network when you connect over a serial line, allowing you to access all
the hosts on the network and use all the Vision services. Configure the host in the same way that
you would create an ordinary host, choosing a transport that enables you to access the host, for
example Modem.

Note  Definitions of proxy hosts are not stored in the same name space as regular Vision
Communications Architecture host objects. You cannot choose a regular host as the proxy host,
because this would allow unwanted circular linkages.

Specifying Security options for a transport
The Security tab allows you to specify how passwords are obtained and stored, and allows you to
change passwords.
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If you select Authentication, you can choose from the following options:

Option Description

Password List Specifies that passwords should be stored in a Password List file.
Prompt Specifies that you should always be prompted for a password.
Permanent Specifies that the password will be stored with the object it protects.

When configuring a transport, the Default setting means use Password List. For a host, Default
indicates that the security method specified for the transport should be used.

If you select Password List or Permanent, and then choose Change, a dialog box allows you to
type in a new Username and Password for the object. If Prompt is selected, choosing Change
allows you to enter a Username and Password which will be shown as the defaults when the
prompt box is displayed.

For more information about the options, refer to �Password Storage� later in this chapter.

Specifying Script options for a transport
The Script tab allows you to specify the Vision Communications script file that will be used to
control some or all of the process of connecting to a host, logging in, and executing a command.
For USP transports, only the command execution part of the script is used.

If you select Script Options, you can choose the File Name of the script, or use the Browse
button to find the file. Script files are normally stored in C:\Program Files\Common
Files\Vision\Scripts.
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The Mode list provides the following options:

Option Description

Automatic Specifies that the script should be executed automatically.
Manual Specifies that the Connection Monitor window should be displayed

with no script loaded to allow you to control the connection
process manually.

Trace Specifies that the Connection Monitor window should be displayed
with the specified script loaded. You can then view and step
through the connection process.

The Shell option allows you to specify the shell command interpreter to be used to execute the
command execution section of the script file, which by default is the Bourne shell.

When configuring a transport, the Default setting means use a script file appropriate to the
protocol, Automatic mode, and the Bourne shell. For a host, Default indicates that the script
options specified for the transport should be used.

For further information about script files, look up �ComScript� in the Help index.

Specifying Advanced options
The Advanced tab allows you to specify the method used to provide each service available for a
transport.
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The list shows the services that are available, and the method used to provide each service. To
change a method, select a service by clicking on it in the list, then click the Change Method
button. The services and the methods available depend on the Protocol setting on the
Communications tab. In many cases, there are no alternative methods.

Choose the Settings button to display the configuration options available for the currently
selected service. The following example shows the Communications Settings for the Terminal
service for the USP/TCP Protocol. When you choose from the Category list, the options on the
right of the dialog box change. The illustration shows the Name Service Options category
selected.

Use context Help to get information about these dialog box options. Click  in the title bar,
then click an option.
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Configuring hosts
The Vision Communications database holds details of remote hosts. The key points about
configuring hosts include the following:

• If your PC is directly connected to a network, then host configuration is normally carried out
automatically by Host Finder.

• If you have a TAPI modem configured, then a host called Modem is created automatically by
Host Finder.

• If you only use a direct serial line or a non-TAPI modem, then you will need to configure at
least one host manually.

• Hosts use transport definitions which are also stored in the Vision Communications database.
A selection of transports is created when you install Vision Communications software on your
PC, but you may need to change the configuration or create new transports (see �Configuring
Transports� earlier in this chapter).

• The transport used to connect to a host can be determined automatically at connection time.
If you have a notebook PC that is connected to a network in the office, and connected via a
modem when you work from home, then Vision Communications will automatically select
the appropriate transport.

• You can choose whether a username and password should be stored with a host object, or
stored in a separate password list file. This allows you to distribute host objects to other users
without giving them your password.

Using Host Finder to configure hosts
Hosts are normally configured automatically by the Host Finder program, which runs as a
hidden background task. You can specify that the following host types should be detected:

• Vision hosts.
• XDM hosts.
• Echo hosts.
• Modem.

To detect Vision hosts, Host Finder connects to the Name Space Manager via RPC and finds out
which UNIX Local Name Agents are registered. XDM hosts are those running the X Window
System display manager daemon xdm. Echo hosts are all hosts on the local network running
TCP/IP. A Modem host will be created if a TAPI modem is configured in Windows. Non-TAPI
modems, serial lines, and hosts not running TCP/IP will not be detected by Host Finder.

Hosts entered into the Vision Communications database by Host Finder are marked as such.
Host Finder scans the network for hosts at a regular interval (the default is 30 minutes), and if it
finds that one of the hosts it originally detected is no longer present, it marks the host as
unavailable. An unavailable host is shown in Vision97 programs with a cross through its icon.
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If your PC is managed remotely by SuperVision, then Host Finder detects which host is your
administration host.

To configure Host Finder

1 In Windows Control panel, double-click Vision Services, and then click the Host Finder tab.
2 Select the options you want.

You can get Help on an item by clicking  in the title bar, then clicking the item.

Using Control Panel to configure hosts
The Windows Control Panel can be used to add, delete or change hosts.

To add a host using Control Panel

1 In Windows Control Panel, double-click Vision Communications and then click the Hosts
tab. The dialog box shows the configured hosts.
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2 Click Add to create a new host, or select an existing one and click Properties to modify, or
Remove to delete.

When you add a new host you are prompted to enter a host name. You may not need to change
any of the host properties, because the default values are normally suitable. The transport is
chosen automatically. If you do want to change the properties, click the host in the list, then
click Properties. Use context Help on the properties dialog box for information about the
settings, and see later in this chapter for an overview.

Using Unix Neighborhood to configure hosts
For Windows 95 or NT 4.0, you can use Unix Neighborhood or Host Explorer to manually add,
delete or change hosts.

To add a host using Unix Neighborhood

1 Double-click the Unix Neighborhood icon on the desktop.
You can see the hosts that Host Finder has detected, plus any others that you have previously
configured manually.
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2 Click the File menu, and then click New Host. A new host icon appears with a temporary
name.

3 Type a name for the new host, and then press ENTER.

You may not need to change any of the host properties, because the default values are normally
suitable. The transport is chosen automatically. If you do want to change the properties, click the
File menu, then click Properties. Use context Help on the properties dialog box for information
about the settings, and see later in this chapter for an overview.

To test the new host item, double-click the icon to open a connection. You will be prompted to
enter a username and password, which by default are stored in the password list, and if you log
in successfully you will not be prompted again for this information on subsequent connections.

For more information about changing or deleting hosts, click Help Topics on the Help menu.
The same information can be seen by choosing How To Use Host Explorer from the main Vision
Help Contents.

Using Host Manager to configure hosts
For Windows NT 3.51, you can use Host Manager to manually add, delete or change hosts.

To add a host using Host Manager

1 Open the Vision Group in Program Manager, then double-click the Host Manager icon.
A window shows your PC disks, any connected Windows drives, and currently configured
UNIX hosts.

2 Click the File menu, and then click New Host. A new host icon appears with a temporary
name.

3 Type a name for the new host, and then press ENTER.
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You may not need to change any of the host properties, because the default values are normally
suitable. The transport is chosen automatically. If you do want to change the properties, click the
File menu, then click Properties. Use context Help on the Properties dialog box for information
about the settings, and see later in this chapter for an overview.

To test the new host item, double-click the icon to open a connection. You will be prompted to
enter a username and password, which by default are stored in the password list, and if you log
in successfully you will not be prompted again for this information on subsequent connections.

For more information about changing or deleting hosts, click Help Topics on the Help menu.
The same information can be seen by choosing How To Use Host Manager from the main Vision
Help Contents.

Specifying Host options
The Host tab allows you to name the host, and specify the transport that will be used to connect
to it. You can also choose an icon to represent the host.

If you select Automatic in the Transport box, then the transport will be selected automatically at
connection time. Vision Communications will try to open the link to the remote host using each
transport in turn until it achieves a connection. Only those transports that have the Include This
Transport in Automatic Selection option enabled will be considered. The order of transports can
be specified in the Transports dialog box (see �Adding a Transport� earlier in this chapter).

In the Host Name box, specify the name by which you want this host to be known to Vision97
programs. Usually, this is the host�s network node name, but it can be any name.
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The Settings button can be used to supply further information about the connection. This
information varies depending on the transport. For a network transport you can enter details
such as the network node name or address. If you don�t choose the Settings button, then the
name entered in Host Name will be used as the network node name. For a serial line transport,
you can specify Telephony details that override those specified for the transport.

Specifying Security options for a host
The Security tab allows you to override the Security options specified for the transport. If you
choose Default, then the settings for the transport will be used. Choosing Authentication allows
you to specify how usernames and passwords are managed for this host.

For more information about the Security options, see �Specifying Security Options for a
Transport� earlier in this chapter.

Specifying Script options for a host
The Script tab allows you to specify the Vision Communications script file that will be used to
control some or all of the process of connecting to a host, logging in, and executing a command.
For USP transports, only the command execution part of the script is used.

For a host item, the Script tab allows you to override the Script options specified for the
transport. If you choose Default, then the settings for the transport will be used. Choosing Script
Options allows you to specify options specific to this host.

For more information about the Script options, see �Specifying Script Options for a Transport�
earlier in this chapter.
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Using a network connection
Vision Communications Architecture supports TCP/IP and IPX/SPX (Novell) networks. For
information about installing network software, look up �installing� in the index.

You can use any TCP/IP stack that supports Windows Sockets, although you may prefer to use
the Microsoft TCP/IP provided with Windows. The USP/TCP protocol provides the full range of
Vision Communications services over a TCP/IP network. There is no need to configure a USP
proxy-server to use USP services over TCP/IP.

IPX/SPX terminal connections can be made using NVT (default) or NVT2, and remote execution
is available using these terminal services. The socket library allows X clients to access your PC.
To use USP services, you need to configure a USP proxy-server, using NVT or NVT2 as the
underlying transport. The procedure for configuring a proxy-server is similar to that required
when using a serial or modem connection (see �Creating a Serial or Modem USP Transport�).

Using a serial or modem connection
Vision Communications Architecture can use a serial connection between your PC and a remote
host as the transport for carrying a range of services. If the correct host software is installed, then
the services that are available over a network connection can also be used over a serial line. The
serial connection can be provided in a number of ways, the most common being:

• A direct RS232C cable between your PC and a UNIX host.
• A modem configured as a Windows TAPI device.

The services that can be provided over a serial line are limited if host software is not installed on
the remote UNIX system. To use Vision USP services, Vision Services for UNIX must be
installed. To run X Window System clients over a serial line when the Vision X Server is
installed, you are recommended to install NCD�s XRemote (see �Using NCD XRemote� in the
�Starting X Programs� chapter if this is included in the Reference book for your Vision97
product).

The following illustration shows a VT420 terminal emulator, the Unix Neighborhood browser,
and an XRemote session with three X clients all running over a single modem connection.
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Serial protocols
If host software is not installed on the remote UNIX system, then the raw RS232C protocol is
used. Vision Communications Architecture can provide Terminal Connection and Remote
Execution services over this protocol.

If Vision Services for UNIX is installed on the remote host, then the Universal Session Protocol
(USP) can be used to provide all the USP services, including Terminal Connection, Remote
Execution, File Access, RPC and Sockets. A helper process runs on a UNIX system attached to
the network, which acts as a proxy for your PC. A proprietary multiplexing protocol called the
Universal Transport Protocol (UTP) is used to communicate over the serial line between the PC
and the proxy process. Your PC can access other networked hosts via the link to the proxy.

To run X Window System clients over a serial line when the Vision X Server is installed, you are
recommended to use NCD�s XRemote protocol. To support this protocol, you need to install
XRemote on the remote host. A helper process functions as a �proxy-server� running on the host
system, which appears to X clients to be an ordinary X server running on the UNIX system. The
helper process communicates with the PC to pass messages to and from the Vision X Server. The
XRemote protocol can be used over any underlying transport protocol, for example a simple
serial connection or a USP terminal connection.

Universal Transport Protocol
The Universal Transport Protocol (UTP) is a reliable multiplexing protocol that can be used over
any communications transport. It allows Vision97 PC and UNIX software to communicate over
non-TCP/IP transports such as an RS232C serial link. For example, a notebook PC user working
away from the office could dial in using a modem, and gain full access to Vision
Communications services on the office network.
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UTP requires support at both ends of the communications link. At the PC end, UTP support is
built into the Vision Communications software. On UNIX, a helper process called usputppxy
acts as a USP proxy for the PC on the network.

When a PC client requests a service, the request is packaged for transmission over the serial line.
When it arrives on the UNIX system, the message is unpacked by the proxy process, which then
calls the Name Space Manager nsmsrv to resolve the USP address. The mechanism used to gain
access to the server program is then the same as for a locally connected PC, with the proxy
process forwarding messages over the UTP link to the remote PC.

For servers running on a remote PC, usputppxy is responsible for registering them with the
Name Space Manager. Services are registered using the network address of the computer on
which the proxy process is running, and a unique port number. For example, the user steve has a
remote connection to a UNIX computer called scobox. If a UNIX client then asks the name
server to resolve the USP address \\steve\prtsrv, it will be supplied with the IP address of scobox,
and the port number on which usputppxy is listening for service requests.

Serial or modem configuration overview
You need to do the following to be able to access the full range of services over a serial
connection:

• Configure your modem as a TAPI device.
• Configure the Serial-Com1 or Modem transport, and optionally create a new USP transport.
• Configure one or more hosts entries in Vision Communications.
• Configure the XRemote profile if you are using the Vision X Server (see �Using NCD

XRemote� in the �Starting X Programs� chapter if this is included in the Reference book for
your Vision97 product).

Configuring a modem as a TAPI device
For Windows 95 and Windows NT, you are recommended to use Microsoft�s Telephony API
(TAPI) to integrate computers with the telephone network. TAPI provides consistent device
independent control of communication devices for operations such as dialing and answering
incoming calls.

To configure your modem as a TAPI device

1 Click Start, point to Settings and then click Control Panel.
2 Double-click Modems. If no modems are currently installed, then the Install New Modem

wizard starts.
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Follow the instructions on the screen to set up your modem.

Once your modem has been set up successfully, you can:

§ Specify where you are dialing from, and how your calls are dialed.
§ Specify connection properties, including speed, flow control, and error control.
§ Run diagnostic tests on your modem and on the COM port.

Configuring serial or modem transports
In Vision Communications Architecture, you need to configure the transports available to
connect your PC to remote computers. When you install Vision97 software, a Serial-Com1
transport and a Modem transport are created for you. The Serial-Com1 transport is intended to
be used over a direct serial line, or with a modem that has not been configured as a Windows
TAPI device. The Modem transport should be used with a modem configured as a TAPI device.

The Serial-Com1 and Modem transports can provide Terminal Connection and Remote
Execution services. If you have the Vision X Server, and XRemote is installed on the UNIX host,
then you can also run an X session over either of these transports.

If Vision Services for UNIX is installed on the remote host, then you can create a new transport
to enable you to use the full range of Universal Session Protocol (USP) services over a serial line
or modem. The transport could be named USP-Serial or USP-Modem. It will use the
multiplexing and error-correcting UTP protocol, so you can run several programs simultaneously
over a single connection. An XRemote session can also run over this transport, allowing you to
run X clients and character-based applications at the same time. Another potential benefit of
running XRemote over the USP Terminal service is that it may allow a 7-bit connection to be
used instead of the 8-bit connection normally required.
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To summarize, the procedure is:

1 Configure the Modem transport (for a TAPI modem) or the Serial-Com1 transport (for a
direct serial line or non-TAPI modem).

2 If you want to use Vision Services on the UNIX host, create a new transport called USP-Serial
or USP-Modem. Specify the host running the proxy, and choose Serial-Com1 or Modem as
the transport used to access that host.

3 Configure a host to use the appropriate transport. If a TAPI modem is installed, then a host
called Modem is added by Host Finder, which specifies the Modem transport.

Note  When you configure the proxy host, the dialog box is similar to that used to configure
hosts objects in the Vision Communications database. However, the proxy host details do not
create a host object.

Which phone number is used?
When you configure transports and hosts to use a modem, you can enter a phone number and
other details in several different locations. When deciding whether to enter a phone number,
consider the following:

• If you connect using a USP-Serial or USP-Modem transport, the phone number and other
details configured for the proxy host are always used.

• If you connect using the Serial-Com1 or Modem transport, and the host�s Transport setting is
Automatic, the phone number and other details specified in the transport are used.

• If you connect using the Serial-Com1 or Modem transport, and the host�s Transport is
explicitly set to Serial-Com1 or Modem, then if a phone number is specified in the host�s
Connection settings, that phone number will be used. If no phone number is specified for the
host, the phone number specified in the transport will be used.

Note  If Vision Communications Architecture cannot find a phone number when using
Serial-Com1, it assumes that a direct serial line is available. If you are in fact trying to connect
over a modem, then this will fail with a �Waiting for login� message. The Modem transport will
prompt you for a phone number if one is not found.

Configuring the Serial-Com1 transport
A transport called Serial-Com1 is created when you install Vision97 software on your PC. This
transport is configured to use COM1 directly, and the COM port options are set to default
values (9600 baud, 8 bit, no parity, 1 stop bit, no flow control). This transport should work
without changes on all flavors of Microsoft Windows if you have a direct serial line or a modem
attached directly to COM1, and you want to connect to a UNIX host. However, the default
settings are chosen to suit the simplest and slowest connection, and you are recommended to
reconfigure the Serial-Com1 transport.
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To configure the Serial-Com1 transport

1 In Windows Control Panel, double-click Vision Communications, and then click the
Transports tab.

2 In the Transports box, double-click Serial-Com1.
3 If you want this transport to be considered by the Automatic transport selection mechanism,

then ensure that a check mark appears against �Include This Transport in Automatic
Selection?�.

4 Click Settings. In the dialog box on Windows 95 or NT 4.0, both Country Code and Area
Code boxes are grayed. If you want to connect using a modem enter a Phone Number,
otherwise if this box is empty it will be assumed that you are using a direct serial line. If you
do enter a Phone Number, enter the complete number including the area code and any prefix
digits required, for example to gain access to an outside line if you are connected through a
switchboard. In the Connect Using box, choose Direct to Com1, or another COM port.

5 Click Configure. In the Port Settings dialog box, select the highest baud rate you can use from
the drop down list in the Speed box. (Note, if using a modem, that Vision Communications
may be able to negotiate the baud rate with your modem, so you may be able to simply
choose the highest value in the list.) The other settings in this dialog box should not normally
be altered.



Chapter 2 � Vision Communications Architecture 39

6 Click OK to return to the Transport Properties dialog box. You may need to consider
changing the script used to connect and log in to remote systems. The default script is
Unixsl.scr, which is designed to connect to a UNIX host over either a serial line or a modem.
It recognizes that a modem connection is needed if a phone number is specified for the
transport, or for a host using the transport. If you want to use a different script, for example
Unixslsc.scr for an SCO OpenServer host, click the Script tab and change the settings.

Configuring the Modem transport
A transport called Modem is created when you install Vision97 software on your PC. This
transport is configured to use the first available TAPI modem. If you have more than one TAPI
modem configured on your system, then you need to configure the transport to select the
modem you want to use.

To configure the Modem transport

1 In Windows Control Panel, double-click Vision Communications, and then click the
Transports tab.

2 In the Transports box, double-click Modem.
3 If you want this transport to be considered by the Automatic transport selection mechanism,

then ensure that a check mark appears against �Include This Transport in Automatic
Selection?�.

4 Click Settings. In the dialog box, the Country Code and the Area Code should already show
where you are dialing from. Enter the phone number of the modem attached to your UNIX
host. In the Connect Using box, choose the modem you configured as a TAPI device.
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5 Click OK to return to the Transport Properties dialog box. You may need to consider
changing the script used to connect and log in to remote systems. The default script is
Unixsl.scr, which is designed to connect to a UNIX host over either a serial line or a modem.
It recognizes that a modem connection is needed if a phone number is specified for the
transport, or for a host using the transport. If you want to use a different script, for example
Unixslsc.scr for an SCO OpenServer host, click the Script tab and change the settings.

Creating a Serial or Modem USP transport
If you want to be able to use all the facilities of the Vision97 programs, and Vision Services are
installed on your UNIX host, then you should create a new transport to run USP services via a
proxy.

Note  You do not need to create a USP transport if you only want to run X clients using
XRemote. However, running XRemote over a USP connection will allow you to run character-
terminal applications or browse UNIX file systems at the same time.

To create a USP serial or modem transport

1 In Windows Control Panel, double-click Vision Communications, and then click the
Transports tab.

2 In the Transports box, click Add.
3 In the Protocol box, choose USP via Proxy.
4 In the Description box, type either USP-Modem or USP-Serial, depending on whether you

intend to use Modem or Serial-Com1 as the underlying transport.
5 If you want this transport to be considered by the Automatic transport selection mechanism,

then ensure that a check mark appears against �Include This Transport in Automatic
Selection?�.

6 Click Proxy.
7 In the Transport box, choose either Modem (for a TAPI modem) or Serial-Com1 (for a direct

serial line or non-TAPI modem).
8 In the Host Name box, type the network node name of the UNIX host that is going to act as

your proxy on the network.
9 Click Settings.
10 In the Phone Number box, enter the phone number of the modem attached to the UNIX host

that is going to act as your proxy on the network. In the Connect Using box, choose a TAPI
modem or a COM port as appropriate.

11 Click OK to return to the Transports dialog box.
12 If you specified that this transport should be considered by the Automatic transport selection

mechanism, then you may need to adjust the order of transports using the arrow buttons.
Vision Communications will try to connect to the host using each transport in turn, starting
at the top of the list. If you have a notebook PC that you attach to the network when in the
office, and to a modem when you use it at home, then a suitable order is shown in the
illustration below.
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Configuring hosts for a serial or modem
connection
If a TAPI modem is configured in Windows, then Host Finder creates a host called Modem. This
is specified to use the Modem transport, to prompt before dialing, and to prompt for username
and password. You should be able to use the Modem host to open a connection straight away
after installation without the need for any configuration. If no TAPI modem is present, then you
need to create the first host entry manually.

If you create a USP-Modem transport (see �Creating a Serial or Modem USP Transport�), you
can change the Modem host to use it. Note that you must change the Host Name in the TCP/IP
Settings dialog box to the name of the host on which the USP Task Server will run, usually the
network node name of the host to which the remote modem is attached. For example, in the
following illustration the user has configured the USP-Modem transport to run the proxy server
on a host called �jupiter�. The user has changed the Transport used by the Modem host to
USP-Modem, then clicked the Settings button. In the TCP/IP Settings dialog box, the user typed
jupiter as the Host Name.
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If you are using a USP transport, then when you connect to the Modem host for the first time,
Host Finder will detect all the other hosts on the network running Vision Services for UNIX.

If you installed the Vision97 software when your PC was attached to a network, then all the
hosts running Vision Services for UNIX will automatically be configured for you by Host Finder.
These hosts will have the transport specified as Automatic, and will connect using a network
transport. If you then start using the USP-Modem transport, for example because you have taken
your notebook computer home, then hosts displayed in Unix Neighborhood will initially appear
with a cross through them indicating they are not available. In fact, providing the proxy host has
been configured in the USP-Modem transport, you can double-click on any host in Unix
Neighborhood and open a connection. Once the connection has been opened, the next time
Host Finder runs it will remove the crosses from all the other hosts.

Refer to �Configuring Hosts� earlier in this chapter for full details of how to configure hosts.
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Opening a modem connection from a terminal
emulator
When you start a terminal emulator and connect to the Modem host, a dialog box is displayed
before the modem dials to allow you to check the phone number, and change it if necessary. The
dialog box shown below is displayed if the modem is configured as a TAPI device. A different
dialog box is shown for a non-TAPI modem.

When you choose OK, the remote modem is dialed and the connection is opened. If you
specified a command, then you are logged in automatically and the command is executed. If no
command was specified, then the UNIX login prompt appear and you must log in manually.
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Connection Manager
The Connection Manager runs on the PC when you use the Universal Transport Protocol (UTP)
to provide a connection to a proxy host. It manages the PC end of the multiplexing link. The
Connection Manager starts automatically when the first connection is requested, and is
terminated when the last connection using the multiplexed link is closed.

The Connection Manager appears in the taskbar in Windows 95 or NT 4.0, or as an icon on the
desktop for older versions of Windows NT. You can open the Connection Manager window,
and view the total connect time. You can also click the Disconnect button to manually close the
multiplexed link to the proxy host. Do not do this unless you are sure that you want all
programs using the link to lose their connections.

You can also start Connection Manager manually from the Start Menu or Program Manager,
which would then allow programs using the link to start more quickly since the UTP connection
is already open. To run Connection Manager manually, you must previously have configured a
transport that uses the USP via Proxy protocol, and specified that the transport should be
considered for automatic selection. When you start Connection Manager, it opens a connection
to the proxy host for the first such transport it finds in the list of transports. Alternatively, if you
have more than one proxy transport, you can specify a transport name on the command line, in
which case the transport does not need to be configured for automatic selection. For example, in
the Windows Run dialog box, you could type conman USP-Modem if you have created a
transport called USP-Modem. If you try to start Connection Manager manually, when it cannot
find a proxy transport an error message will be displayed.
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Using Connection Monitor
You can use the Connection Monitor to monitor and control the connection process. To display
the Connection Monitor, hold down the SHIFT key when opening a connection.

Click Help Topics on the Help menu for full instructions. The same information can be seen by
choosing How To Use Connection Monitor from the main Vision Help Contents.
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Vision Communications database
The Vision Communications database is a collection of files that holds details of all configurable
elements in Vision Communications Architecture. The files include:

• Host definitions (*.hst)
• Transport definitions (*.vct)
• Service configurations (*.vcf)
• Authentication password list (*.vca)
• Communications definitions (*.vcc)
• ComScript script files (*.scr)
• Icon libraries (*.dll)

These files are stored in subfolders in the C:\Program files\Common files\Vision folder. Although
there are some dependencies between files, these are kept to a minimum to facilitate their
distribution using SuperVision to other PC users. For example, although a host definition may
refer to a particular transport, it would not necessarily store a username and password.

Host definitions  A Host object (*.hst) defines a host name, the transport to be used for
communicating with it, and any settings that override those specified in the transport. An
�automatic� class may be used to specify dynamic selection of the transport for a particular host,
allowing a standard configuration to be used regardless of the actual available transport
mechanisms. This scheme permits �plug and play� operation, for example a notebook PC may be
used via a LAN connection in the office, but via serial/modem connection from home.

Transport definitions  A Transport object (*.vct) provides details of communication (transport)
protocol, security, services and scripts. For each available service the file also holds details of the
method(s) selected and available.

Service configuration  A Service Configuration object (*.vcf) stores settings for a Vision USP
service. Services are configured using the Vision Services option in Windows Control Panel, and
a separate *.vcf file is provided to store the settings for each tab in the dialog box. For example,
Hostfind.vcf stores settings for the Host Finder.

There is a special instance called Launch.vcf which holds the Enabled and Show Window settings
for all services, and is read by the Vision Services program to determine which services to start.
(If a service only has these options, there is no separate *.vcf file for the service.)

Authentication password list  A password list file (*.vca) is created the first time a Windows
user accesses a Vision host. The password list stores associations between host names, and
username and password details. There will be a separate file for each user that logs in to
Windows. For example, stevel.vca.

ComScript script files  Script files written in the ComScript language are used to control all or
part of the process of connecting to a host, logging in and executing a command.

Icon libraries  A selection of icons is available in the form of Windows library (*.dll) files. You
can choose an icon using the Change Icon button in several dialog boxes.
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Configuring the Database Server
The Database Server provides access to the Vision Communications database. You can specify
whether the Database Server should be started at launch time, and whether its window should be
visible.

To configure the Database Server

1 In Windows Control panel, double-click Vision Communications, and then click the Database
tab.

2 Select the options you want.

You can get Help on an item by clicking  in the title bar, then clicking the item.



Vision97 Reference48

Vision USP services
Vision Communications Architecture provides a range of services that can be used by Vision97
programs or third-party applications. The services are feature-rich, and independent of any
specific transport or host operating system. The services are carried by the Universal Session
Protocol (USP) and are implemented on the PC by Vision Service Modules. They are made
available to programs through the Vision Toolkit APIs. The services are:

• Task service, which provides terminal connection and remote execution facilities. For more
information, see �USP Task Service� in the �Terminal Emulation� chapter.

• File Access service, which provides the ability to browse and manipulate the file store on a
remote host. It also allows files to be transferred between hosts. For more information, see
�USP File Access Service� in the �Browsing Remote Hosts� chapter

• Remote Procedure Call service, which allows a client program to call procedures in a server
program. For more information, see �USP Remote Procedure Call Service� later in this
chapter.

• Sockets service, which provides a low-level method for a client program to call procedures in
a server program. For more information, see �USP Sockets Service� later in this chapter.

The Vision Services program
The Vision Services program (Vservice.exe) directly provides many of the services on the PC,
including the Local Name Agent (LNA). Other services are provided by separate programs which
are started on demand by the LNA. A shortcut to Vision Services is placed in the Windows
StartUp folder or Program Manager group (for older versions of Windows NT) so that the
program is run when Windows starts. You can also start the program manually from Windows
Control Panel.

The Vision Services program reads the Launch.vcf file (see �Vision Communications Database�
earlier in this chapter) to determine which services should be enabled.

To start Vision Services manually

1 In Windows Control Panel, double-click Vision Services, then click the General tab.
2 Click Startup.
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Use context Help to get information about the other dialog box options. Click  in the title bar,
then click an option.

To shut down Vision Services

1 In Windows Control Panel, double-click Vision Services, then click the General tab.
2 Click Shutdown.

A warning message is displayed, and then all the server programs that were originally started by
the Vision Services program are shut down.

USP Remote Procedure Call service
A Remote Procedure Call (RPC) system allows a client program to call procedures in a server
program. The mechanism is often more convenient than the alternative low-level socket
interface, especially when the client and server programs are running on different computers on
the network. The key design points of the Vision RPC mechanism include the following:

• Vision RPC is layered on top of Sun ONC RPC, which has itself been modified in order to
use the Vision USP protocol. In addition, facilities for asynchronous RPC calls have been
added which are similar to those provided in ONC Transport-independent RPC.

• The function of the ONC portmapper in starting servers is replaced by the Vision Local
Name Agent.
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• One of the disadvantages with using Sun ONC RPC is that all RPC server program numbers
have to be registered with Sun to prevent clashes with other vendors� software. There is no
requirement to register Vision server program numbers with Sun.

• Includes RPCwiz, which runs on a PC and takes the place of ONC�s rpcgen. It can generate
client and server stubs for the PC or for UNIX, in a variety of programming languages. The
programmer typically does not need to do anything to the client stub except link it into the
client program. The server stub contains a template to which the code for the individual
procedures can be added.

• The .rpc file that is submitted to RPCwiz has a similar function to the ONC .x file, and uses a
syntax similar to Visual Basic.

• The XDR encoding/decoding mechanism is used to convert the data types in the .rpc file,
which are similar to Visual Basic data types, to language-specific data types.

USP Sockets service
Vision Communications Architecture provides a sockets mechanism for inter-process
communication that is similar to Berkeley UNIX sockets. The key design points of the Vision
sockets mechanism include the following:

• Instead of binding to an IP port, a socket is bound to a USP address.
• The Remote Sockets API supports all the standard socket calls, and provides a way of

associating a socket with a USP address.
• Sockets are only used by Vision97 software components.
• When you connect via UTP, any listening sockets on the PC are exported to the proxy

process usputppxy on UNIX. The proxy process then listens on the corresponding addresses.
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Locating Resources
Vision Communications Architecture provides a mechanism that allows client programs to locate
services and connect to server programs. The key design points are:

• Resources are identified using Universal Naming Convention (UNC) names, which provides
independence from the underlying transport protocol. It also allows requests for services
without mentioning program names, which may vary between host systems.

• The Name Space Environment (NSE) is the name space used by Vision Communications
Architecture components and implemented via the Name Space Manager (NSM) and Local
Name Agent (LNA) using UNC. It resolves UNC names to the native addresses of the
underlying transport protocol. For example, the NSE name \\sun4\prtServ would be
translated to a TCP/IP four-byte Internet Protocol (IP) address and the port number of the
Print Server.

• The Name Space Manager runs on UNIX host systems, and responds to clients requests to
locate Vision Communications Architecture services. It uses a distributed naming approach so
that if a service is not registered locally it can ask a Local Name Agent or an NSM on another
network segment to service the request. Multiple NSMs can provide network resilience.

• A Local Name Agent must be run on every computer running Vision97 software, including
PCs and UNIX hosts. It is responsible for starting server programs. On UNIX, all Vision
servers are started by the LNA. On the PC, the LNA starts servers on demand, although some
servers may be started at Windows startup time.

Name Space Environment
The Name Space Environment (NSE) provides a consistent, transport-independent mechanism
for accessing Vision resources. NSE uses the Uniform Naming Convention (UNC) format for
identifying resources. This allows a client to request a service on a particular host system, using a
string that is independent of any specific form of network addressing.

NSE is implemented via the Name Space Manager (NSM) and Local Name Agent (LNA) which
resolve UNC names to the native addresses of the underlying transport protocol.

Uniform Naming Convention
The Uniform Naming Convention is used by the Universal Session Protocol (USP) to identify
resources. The format is:

\\hostname\service

where hostname is the Vision Communications Architecture host name, service is the service
name, and parameters are server-specific parameters. The UNC-format names are resolved to
network addresses and port numbers by the Name Space Environment.
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Name Space Manager
The Name Space Manager (NSM) provides a fault tolerant, replicated naming service. One or
more host (UNIX) systems are nominated as NSM hosts, on which NSM processes called nsmsrv
are started automatically. An NSM process runs in either a master or backup mode. Only one
NSM process can be the master NSM on a subnetwork at any one time, but there may be a
number of concurrent backup NSM processes. The backup NSMs poll the master occasionally
for updates. The master NSM is selected via an election, which may occur whenever a new NSM
comes on line, or when a client seeks to locate an NSM manager. NSM election is determined by
the result of a voting mechanism, on the basis of longevity, by NSM processes.

When any Vision server process starts, it registers with the NSM. This applies equally to servers
on PCs as well as on UNIX hosts. The server registers its USP address, and the actual network
address and port number that it is listening on. It also registers other information, such as the
type of authentication it requires.

There is an RPC server called nsmrpcsrv that acts as an RPC interface to the Name Space
Manager.

You can specify which host the master NSM is running on, and the port on which the server
process is listening.

Specifying the master NSM on UNIX.  When you install Vision97 software on a UNIX host,
you are asked whether you want to run an NSM on that host, and if you want to nominate a
master NSM (which may be on a different host). The host you specify as the master is recorded
in the VISION_NAMESVC entry in the vision.conf file. The format of the entry is:

VISION_NAMESVC=host . port_number

where host is the name of the UNIX host running the master NSM and may be specified as a
host name, full domain name or IP address, and port_number is the IP port number on which the
server listens. For example:

VISION_NAMESVC=jupiter.16024

Note  If you want to nominate a master NSM, don�t nominate different master NSMs on the
same subnetwork. For example, if you install Vision97 software on more than one host,
nominate the host you want in the first installation and then accept the default answer for each
subsequent installation. If you have nominated different NSMs, you need to edit (as root) the
VISION_NAMESVC entry in vision.conf to be:

VISION_NAMESVC=*.16024

Then use v97 to restart Vision97 services. Do this on every host nominated as a master NSM
other than the host you want.

Specifying the master NSM on a PC.  A PC client normally accesses the NSM by broadcasting
on the LAN, but you can specify an NSM when configuring a USP transport.
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To specify the NSM on a PC

1 In Windows Control Panel, double-click Vision Communications, then click the Transports
tab.

2 Double-click a Transport in the list of transports.
3 Click the Advanced tab, then click Settings.

It does not matter which Service is currently selected.
4 In the Category list, click Name Service Options.

5 Click Specify Name Service.
6 Type the name of the UNIX host running the master name server.
If you click Default, the PC will broadcast for the NSM.

If an NSM is specified, but is found to be unavailable when the client tries to access it, the client
will then broadcast to ask for the master NSM. If the client receives a reply from the master
NSM, then it can continue. If no reply is received, an election is initiated to choose a new master
NSM, and this will then reply to the client.

Note  If you just want to change the Name Service Port Number without changing the host, type
asterisk (*) in the Name Service Host box.

Registering administered PCs
In addition to registering services, the NSM also registers PCs if SuperVision is in use. A program
called pclist is run on the administration host at the start of a session that registers all the PCs
administered by that host with the NSM. The list is then automatically updated for any
subsequent changes. The NSM is therefore able to tell a client which host is acting as the
administration host for a particular PC.
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Local Name Agent
A Local Name Agent (LNA) is present on every UNIX and PC system. The LNA acts on behalf of
the Name Space Manager (NSM) in carrying out tasks within its local domain.

The main task of the LNA is to start server programs (see �Starting Server Programs� later in this
chapter). In this respect, its function is similar to a portmapper in a Sun ONC RPC system. Some
servers are started immediately after the LNA has been run, while other servers are started in
response to client requests.

Starting and configuring the LNA
The Local Name Agent (LNA) is responsible for starting all other Vision servers. The LNA must
be started at the beginning of a session on any computer running Vision97 software, including
PCs and UNIX systems.

To start the LNA on UNIX

4 The LNA should be started automatically at system boot time, by including the following
command in a system startup file:
nohup /usr/local/vision/bin/lna -b &

The -b option forces the LNA to start the boot-time servers configured in the servers
database.

To start the LNA on a PC

4 The Local Name Agent is built into the Vision Services program (Vservice.exe) on the PC,
which is normally started automatically when Windows starts.

To configure the LNA on a PC

1 In Windows Control panel, double-click Vision Services, and then click the LNA tab.
2 Select the options you want.
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You can get Help on an item by clicking  in the title bar, then clicking the item.

Server configuration
On UNIX, servers are configured in the servers database. For further information, look up
�servers file� in the Help index.

On a PC, the Local Name Agent (LNA) references entries in the
HKEY_LOCAL_MACHINE\Software\SCO\Lna\Servers section of the Windows Registry. The
format is:

multiple|single  server

where server is the server program name which may be a full or partial pathname, multiple
means multiple clients, and single means single client. For example:

single,C:\PROGRA~1\COMMON~1\SYSTEM\VISION\infosrv.exe

The multiple option means that one instance can handle multiple clients. When this type of
server is started it remains running for the remainder of the session.

The single option means run a separate instance for each client, and terminate the process when
the conversation with that client ends.
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Starting server programs
Server programs must be running in order to handle requests from client applications. Some
servers which are frequently used, such as the Task Server, are normally started at the beginning
of a session and then continue running. Less frequently used servers are started only when a
client requests a service. On UNIX, all servers are started by the Local Name Agent (LNA), either
at the beginning of a session, or on demand. On the PC, the Vision Services program
(Vservice.exe) starts some servers when Windows is started, and others are started on demand by
the LNA (see �The Vision Services Program�).

When a client wishes to use a service, it contacts the Name Space Manager (NSM), passing it a
USP address that contains a host name and the service name. If the service is registered, this
indicates that the server should currently be running, and the NSM returns the IP address of the
server, and details of any authentication required by the server. The client carries out any steps
required to obtain authority to access the server (see �Authentication� later in this chapter), and
then tries to connect to the server using a TCP operation. If this is successful, then the client and
server can conduct their conversation.

If the service is not registered with the NSM, the NSM determines the Local Name Agent (LNA)
for the requested service from the host name part of the request. For example, if the service
requested was \\jupiter\prtServ, then it looks for an LNA registered as \\jupiter\. If the LNA is not
registered with the NSM, an error is returned to the client. If the LNA is registered, the NSM
passes the service request to it.

When the LNA receives a request from the NSM to start a server, it looks in the servers database
on UNIX, or the Registry on the PC. If the service is not configured, it returns an error to the
NSM, which returns an error to the client. If the service is configured, the LNA starts the
associated server program. The LNA also notifies the NSM of the name of the server process,
which depends on whether the server handles single or multiple clients. When the server
program starts, it registers itself with the NSM, which then returns the address details to the
client.

If the client tries to connect to a server using an IP address supplied by the NSM, the connection
may fail, for example because the server process has been killed. In this case, another request is
sent to the NSM, including a flag to indicate this has happened. The NSM then asks the LNA to
restart the server.
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Locating resources on another network
A client can only broadcast on the local subnetwork, but the Name Space Manager (NSM) may
act as a gateway to another LAN. If the VISION_NSGATEWAY entry exists in the vision.conf
configuration file, it indicates the addresses of NSMs on other subnetworks. The local NSM will
periodically inform these remote NSMs of the hosts for which it has services currently registered.
If the local NSM receives a request for a service on a host that it knows is on another
subnetwork, it redirects the request to the remote NSM.

The format of the VISION_NSGATEWAY entry is:

hostname.port-number [: ... ]

where hostname is the host on which the master NSM for the remote subnetwork is running and
may be specified as a full domain name. The port-number is the port number on which the NSM
listens for requests. For example, jupiter.sco.com.16024.

You should specify the host that normally runs the master NSM on the remote subnetwork. It is
possible that at run time another host may take over as master NSM, in which case gateway
messages will be forwarded to the master providing an NSM (backup) is running on the host you
specified.

Gateway messages will be propagated through a chain of gateways, for example from
subnetwork A to subnetwork B, and then from subnetwork B to subnetwork C.
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Authentication
The Vision Communications security scheme is designed to improve on the basic UNIX user
identification mechanism, and extend it to PC-based servers. The key design points include the
following:

• Each service specifies the type of authentication that clients must perform before they are
allowed access.

• If authorization is necessary to use a service, a client must access a UNIX-based
Authentication Server to gain authority.

• All messages passed between the Authentication Server and its clients are encrypted.
Passwords are never sent across the communications link as plain text.

• Although the Authentication Server requires Superuser privilege to allow it to access the file
containing encrypted passwords, other servers do not need to access this file and so may not
need Superuser privilege.

• A UNIX RPC client can be started from the PC by an authenticated user and does not need to
prompt for username and password.

• A PC-based server can specify that clients should be authenticated with the administration
host before being allowed access.

• A set of permissions can be assigned to each user, allowing access to some services but not to
others. For example, some services can only be used by the System Administrator.

Authentication types
There are three types of authentication that a service may request:

• No authentication.
• Direct authentication.
• Indirect authentication.

If a service may be used by anyone, for example the Print service, then the server specifies no
authentication. For a UNIX service with restricted access, such as the Task service, Direct
authentication is specified. A PC server can not request Direct authentication because there is no
local Authentication Server, so it may request Indirect authentication. This means that the client
must access the Authentication Server on the UNIX administration host to obtain authority,
before accessing the PC-based server.

When a server registers a service with the Name Space Manager (NSM), the type of
authentication required is stored, and a client receives this information when it asks the NSM to
locate the service.
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Authentication Server
An Authentication Server called authsrv must be run on every host that runs Vision Services for
UNIX. When this program starts, it reads the visionpriv database of user names and permissions
and stores this information in an internal cache. It then listens for requests from client programs.

Client authentication
The way authentication works is slightly different for PC-based clients and for UNIX-based
clients. Once a PC-based client has obtained the username and password required to access the
host, it always has access to that information and can supply it to servers as required. However, a
UNIX-based client does not have the same access to the username and password.

Note  Vision security relies on the access permissions of system files remaining at least as
restrictive as the permissions with which they are installed.

PC client authentication
A UNIX-based server may specify Direct authentication when it registers a service with the Name
Space Manager (NSM). A PC client must then obtain authority from the Authentication Server
on the same host before accessing the server. The client passes a request containing a username,
password, host name and service name. The Authentication Server checks the username and
password against /etc/passwd (or /etc/shadow). If valid, the Authentication Server generates and
saves a token, which it returns to the client. Otherwise, the Authentication Server returns an
error status. The token specifies the service the client is authorized to use, and contains the user
permissions.

A PC-based server may specify Indirect authentication when it registers a service with the NSM.
The NSM then identifies the administration host for that PC. When a client asks the NSM for
the service, it is told to authenticate itself with the administration host before accessing the
server.

When an authorized client contacts a server, it passes the token obtained from the
Authentication Server. The server makes a call to the Authentication Server to validate the token.
If the token is valid, and the user has the correct permissions, then the client is given access to
the service. Because the token has a limited lifetime, the client may need to contact the
Authentication Server again if the client/server conversation continues for any length of time.
However, it will not be necessary for the client to send the username and password each time
because a token can be �refreshed� and used for up to eight hours. After that time the token
becomes invalid and the client must obtain a new one.

All messages passed between the Authentication Server and its clients are encrypted using a
proprietary algorithm, so passwords never have to be sent in clear text across the
communications link.
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UNIX client authentication
A UNIX client does not have access to the password, because it is not stored anywhere on the
UNIX system when you log in. It is not acceptable to prompt the user when the client starts, so
an alternative method of validating the client with the Authentication Server is required.

A UNIX client first creates a file with unique characteristics that contains a key. It then passes a
request to the Authentication Server containing the filename, the key, the client�s UID, host
name and service name. The Authentication Server carries out several checks to ensure that these
details match the authentication file, and if so it issues the client with a token. Otherwise, the
Authentication Server returns an error status. The authentication file is deleted by the
Authentication Server, or by the client in the event of the server failing to do so.

The interaction between the client and the server is now similar to that described for the PC-
based client.

Password storage
Vision Communications Architecture handles password storage in a similar way to Windows 95.
Certain objects can be protected by a password, for example hosts. You can specify that the
password should be:

• Prompted for when the object is accessed.
• Stored permanently with the object.
• Stored in a password-list file (default).

A password-list file contains a list of objects and associated usernames and passwords. If you
choose to use a password-list file, then a file will be created if one does not already exist for you
on this PC.

If you try to use a protected object that does not have an entry in the password list, then you are
prompted to enter a username and password, which are then stored. If you try to access that
object in the future, then Vision Communications attempts the operation using the stored
password. If the password is no longer valid, then you are prompted to update the password-list
file with the current password.
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Logging events and errors
Vision97 programs on the PC and on UNIX can write debug messages to log files to assist with
troubleshooting or monitoring network performance. These messages are likely to be meaningful
only to SCO Technical Support, and normally you would only enable debug logging if asked to
do so by a support technician. On UNIX, a higher level of event logging is provided, which is
enabled by default and which may be of use to the System Administrator.

Note  Debug logs can become very large and use up disk space. Logging can also seriously affect
the performance of your Vision97 software, so do not enable debug logging except for short
periods when trying to solve specific problems.

Logging on the PC
The Windows Control Panel is used to enable or disable debug logging.

To enable debug

1 In Windows Control Panel, double-click Vision Communications and then click the
Diagnostics tab.

2 Click the Debug On box so that a check mark appears.
3 Click the boxes to choose specific types of debug information, or click Set All.
4 Click Apply or OK.
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The debug information is written to a file called C:\Vwcomms.txt. The format of entries is:

tick_count  :  component  :  description

A sample is shown below.

18144850 : NMUSPT32 : findNS(bcast = 0)
18144850 : NMUSPT32 : presetNS(10252592, 0)
18144904 : NMUSPT32 : usptcp_GetNSCache(192.86.169.164,16024)
18144904 : NMUSPT32 : presetNS: calling GetInetAddr(192.86.169.164)
18144904 : NMUSPT32 : presetNS: returning 192.86.169.164 (16024)
18144957 : NMUSPT32 : UspMapIO: nl_connect(192.86.169.164 (16024)) errno 35
18144957 : NMUSPT32 : UspMapIO: awaiting connection completion
18145149 : VWC32 : NlTerminate : Called for protocol 1
18145149 : VWC32 : Free stack for 1 ref 61

Logging on UNIX
Logging services on UNIX are provided by the logsrv server. This can write two types of
information to separate files:

• System events.
• Debug messages.

Logging events
Important system events are normally logged to a file called vweventlog, and the System
Administrator may wish to view this file using a text editor. Unless SuperVision is in use, only
errors will be logged. For further information, look up �vweventlog file� in the Help index.

Event logging can be enabled or disabled using the VISION_EVENTLEVEL variable, configured
in the /etc/vision.conf file, which can be set to 0 (disabled) or 1 (enabled).

Logging debug information
Debug information is useful to Product Support technicians, and you should not normally enable
it unless asked to do so. Debug can be enabled for many Vision97 programs using the v97 debug
command. For further information, look up �v97, debug option� in the Help index.

The vwdebuglog file is used to log debug messages. For further information, look up
�vweventlog file� in the Help index.



3License Management

This chapter covers the management of SCO Vision97 license
agreements.
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License management overview
When software products are used on a large number of clients on a distributed network, it can be
a difficult task keeping track of what software is installed. Vision97 products are therefore
licensed on a concurrent user basis, not on the basis of the number of computers the software is
installed on. For example, you might purchase a 100 user TermVision for Windows license,
which means that up to 100 people may use TermVision software at any one time. If the
software is installed on more than 100 PCs, then it is the responsibility of the customer to ensure
that no more than 100 people actually use the software concurrently.

The License Administrator is the person responsible for policing license agreements, and License
Manager and the licadmin UNIX utility are designed to assist in the task of managing Vision97
software licenses. The key design points include the following:

• License Manager and licadmin are programs to be used by the License Administrator. We
recommend that you use License Manager.

• A License Number should normally be entered when you install Vision97 software, unless a
valid license already exists on the system. If you do not enter a License Number and do not
have an existing license, an evaluation copy of the software is installed which you can use for
a limited period of time.

• A UNIX-based License Server issues tokens to allow Vision97 programs to run.
• If the License Server is not running on the subnetwork then no licensing restrictions are

imposed by the software. The License Administrator must use other means to ensure that the
license agreement is not breached, for example by ensuring that Vision97 software is not
installed on more clients than the number of users specified in the concurrent user license.

• A subnetwork can be divided into domains for the purposes of license management.
• A Vision97 software product is defined as containing one or more licensed components. Each

component may be used by the number of users specified in your license agreement.
• Soft licensing is enabled by default. Even if a license request exceeds the number of users

specified in your license agreement, a license token is awarded. The License Administrator
can use License Manager to enable or disable soft licensing.

• A shell script is executed on the UNIX host when a Vision97 program fails to obtain a license
token, which the License Administrator can tailor to manage license failure events. The
License Administrator can also use License Manager to send an email message when all
licenses are in use.

• Software theft is a serious offense, and license agreements should be carefully monitored and
fully implemented.
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License Manager
License Manager is a SCO Vision97 license management program that runs on a PC. To use
License Manager, you must be the License Administrator or have Superuser (root) privileges.

To start License Manager

Do one of the following:
§ For Windows 95 or NT 4.0, insert the Vision97 CD in a PC�s CD-ROM drive, and, when

the Setup wizard starts, choose Browse. Open the Licmgr folder, and then double-click
Licmgr.exe.

§ For older versions of Windows NT, insert the Vision97 CD in a PC�s CD-ROM drive, and
use File Manager to open the Licmgr folder. Double-click Licmgr.exe.

§ If VisionFS is installed, double-click the Vision97 UNIX host in your Network
Neighborhood, and open the Visiontools share. Open the Licmgr folder, and then double-
click Licmgr.exe.

Click Help Topics on the Help menu for full instructions.

licadmin UNIX utility
The licadmin UNIX utility can be used as an alternative to License Manager to perform license
administration tasks. The License Administrator can use licadmin to:

• View licensing information
• Enter new licenses
• Delete licenses

Refer to �licadmin� in the UNIX Commands Appendix for information on how to use licadmin.

Organizing users into domains
The total number of licenses available on a subnetwork may be divided into logical domains. For
example, a company-wide subnetwork could be divided into Sales, Manufacturing, Accounts and
so on. There are at least two reasons why a License Administrator may choose to set up a domain
structure:

• A department may be operating as a self-contained business unit, responsible for purchasing
and administering its own computer resources. In this case the License Administrator must
obtain the machine names of all users in the department, and edit the domain database file
domain.dat to create a new domain. For further information, look up �domain.dat file� in
the Help index.

• It may be desirable to ensure that some users always have access to licenses, irrespective of
usage in the general �pool� of licenses. This is done by creating a domain with these users
specifically named.
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License Numbers
A License Number will be supplied to you when you obtain a Vision97 product. This License
Number must normally be entered when you install Vision97 software on a PC or on a UNIX
system.

On a PC, the License Number is used by the Setup program to determine Right to Use
information for all the components that make up the product. A component may be fully
licensed, or have rights that allow it to be used for evaluation purposes for a limited period of
time. This information is stored in the Windows Registry.

On a UNIX system, the License Number is used to determine the maximum number of
concurrent users of each component included in the product.

Once Vision97 software is installed, License Administrators can use License Manager or the
licadmin UNIX utility to view license usage and add new license numbers.

Products and components
Most Vision97 software products include several components, and it is these components whose
usage is actually monitored by the license management mechanism. The products and the
�license-aware� components within them are defined in the product information database
prodinfo.dat. For example, XVision includes, among other programs, an X Server and a VT420
Emulator, both of which are license-aware. The use of license-aware programs is controlled by
the issuing of tokens issued by a UNIX-based License Server.

License Server
A License Server called licsrv  is started automatically on the host on which the master Name
Space Manager (NSM) is running. Only one License Server may run on a subnetwork, and if the
NSM on another host takes over as the master, the License Server is started on that host and the
License Server on the original host is shut down.

When started, licsrv initializes its license cache by reading the following files:

licsrv.dat This file holds details of license availability and currently issued tokens.
ln.dat The license database, which holds the license numbers.
prodinfo.dat The product information database, which defines Vision97 software products

and the components that make up those products.
domain.dat The license domain database, which defines licensing domains, and specifies

for each domain the maximum numbers of users licensed to use each
product.

These files are periodically copied to all other hosts running backup NSMs.
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The License Server then listens for requests from Local Name Agents. The License Server
maintains a list of all LNAs which have registered with it. The LNAs issue requests for new
tokens in response to demands from programs. The LNAs also re-send their token lists at
intervals, when they are time-stamped by the License Server. The License Server periodically
(every 12 minutes by default) checks its record of these token lists. If any are out of date, the
License Server releases the tokens.

The file licsrv.rc can be used to configure the behavior of the License Server, although we
recommend that you use License Manager to do this.

Client authorization
The Local Name Agent (LNA) is responsible for implementing license management on the client.
Only the LNA contacts the License Server directly; other programs make requests via the LNA.

When the LNA starts, it tries to connect to the License Server, using the usual USP addressing
method. If it connects, it registers the client with the License Server. If it fails to connect,
programs will run in �open� mode, which means that they will not be subject to any licensing
restrictions. If the LNA is not running in open mode, then when it terminates it connects again
to the License Server to unregister the client (and release all tokens which have been issued to
that client).

A �license-aware� program sends a request to the local LNA asking for permission to use that
component. The LNA first checks for Right to Use information for the component. If a
component can only be used with evaluation rights, then no further license checking occurs and
the program can run without restriction providing the evaluation period has not expired. If the
component has full Right to Use permissions, then the LNA proceeds to try to obtain a license
token for the program.

The LNA checks its local cache to see if the client has already been granted a license token for
this component (it only needs one to cover any number of instances of the same component). If
it finds a token locally, it responds directly to the program without involving the License Server.
If it does not find a token, it asks the License Server for one, and then responds to the requesting
program when (or if) the token is received.

When a license-aware program terminates, it requests the LNA to release its token.

The LNA maintains a count of how many programs have a �share� in each issued token. When a
count goes back to zero, the LNA instructs the License Server to release the token.

The LNA maintains a list of all the process ids of the token-requesting programs. Every 5
minutes, it checks whether these process ids are still active. Any which are no longer running are
removed from the LNA�s list; this is intended to cope with programs that do not terminate
cleanly.

The LNA periodically connects to the License Server and sends its list of tokens. This enables the
License Server to check that the client is still active, and also ensures that if the License Server is
restarted, its token list will be repopulated from the active clients.
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Soft licensing
Soft licensing is where a user is permitted to use a software component even though the license
request exceeds the number of users specified in a license agreement. Soft licensing is the default
licensing behavior for Vision97 products. When all licenses are in use, additional programs are
allowed to run but they display warning messages. The License Administrator can use License
Manager to enable or disable soft licensing, and to send an email message when all licenses are in
use.

Managing license request failure events
If a client requests a license token and is refused, the shell script
$VISION_ETCDIR/license_event is executed on the UNIX host on which the License Server is
running. As initially installed, the script does nothing. The License Administrator may wish to
modify the script to take some action in the event of license request failure, for example to write
a message to the console.

The License Administrator can also use License Manager to send an email message when all
licenses are in use.

Managing licenses across subnetworks
Vision97 licensing allows license requests on more than one subnetwork to be managed. License
information is synchronized between License Servers running on different subnetworks using the
NSM gateway mechanism.

Specifying the master NSM on UNIX.  You need to have nominated one master NSM host on
each subnetwork. The opportunity to do this is provided when you install the Vision97 UNIX
software. If you didn�t nominate a master NSM host during Setup, refer to the following
instructions. Otherwise, skip this section.

To specify the master NSM on UNIX

1 On the host you want to be the master NSM, open vision.conf in a text editor.
vision.conf is located in the /etc directory. You can edit the file providing you have Superuser
(root) privilege.

2 Change the VISION_NAMESVC entry to be:
VISION_NAMESVC=hostname . port_number

where hostname is the name of this host and may be specified as a host name, full domain
name or IP address and port_number is the IP port number on which the server listens. For
example:
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VISION_NAMESVC=jupiter.16024

3 Still as root, type the following at the command prompt to restart Vision97 services. Replace
vision_dir with the name of the Vision97 shared directory, by default /usr/local/vision.
vision_dir /v97 stop
vision_dir /v97 start

You need to repeat this procedure on each subnetwork.

Propagating license information across subnetworks.  When license information changes on
the local subnetwork, the change is propagated to each remote NSM host specified in the
VISION_NSGATEWAY entry in vision.conf.

To enable license information to be propagated across subnetworks

1 On the master NSM host running on the local subnetwork, open vision.conf in a text editor.
vision.conf is located in the /etc directory. You can edit the file providing you have Superuser
(root) privilege.

2 Add the following line to the file:
VISION_NSGATEWAY=hostname . port-number

where hostname is the host on which the master NSM for the remote subnetwork is running
and may be specified as a full domain name. The port-number is the port number on which
the NSM listens for requests. For example:
VISION_NSGATEWAY=saturn.research.sco.com.16024

You need to specify the master NSM running on each remote subnetwork in this entry.
Separate multiple NSMs with a colon (:).

3 Still as root, type the following at the command prompt to restart Vision97 services. Replace
vision_dir with the name of the Vision97 shared directory, by default /usr/local/vision.
vision_dir /v97 stop
vision_dir /v97 start

You need to repeat this procedure on each subnetwork.

For example, an organization has two subnetworks; the domain names of subnetwork A and B
are dev.sco.com and research.sco.com respectively. The master NSM host on A is jupiter, the
master NSM host on B is saturn. vision.conf on jupiter will contain the following entries to
enable license information to be propagated across the subnetworks:

VISION_NAMESVC=jupiter.16024
VISION_NSGATEWAY=saturn.research.sco.com.16024

vision.conf on saturn will contain:

VISION_NAMESVC=saturn.16024
VISION_NSGATEWAY=jupiter.dev.sco.com.16024

Note  If the master NSM host goes down on a subnetwork, you need to nominate another
master NSM and specify the new master NSM in the remote VISION_NSGATEWAY entries to
re-enable cross-subnetwork licensing.
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License data synchronization.  A change in any of the following files triggers a
synchronization: licsrv.dat, ln.dat, prodinfo.dat. The licsrv.dat file (used by the License Server to
monitor license usage) is updated periodically, the default interval being 12 minutes. It is possible
therefore that cross-subnetwork license usage totals may not completely reflect actual usage in
the period between updates. In fact, cross-subnetwork license usage could exceed that permitted
by your license agreement, with tokens continuing to be issued even with hard licensing enabled.
However, when licsrv.dat is next updated, no more new tokens will be issued.
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X Server overview
The X Server is an X Window System server that runs under Microsoft Windows or a
compatible operating environment. The main features are described briefly below.

• Based on the X version 11, release 6 sample server, with parts rewritten to obtain optimum
performance in the Microsoft Windows environment.

• The server is a 32-bit application designed to run on Windows 95 or NT.
• X clients and Microsoft Windows applications can appear simultaneously on the same screen.
• The X Server is an intelligent server. For example, it is automatically configured for your

system; it chooses the best method of starting clients; it can substitute fonts; it can display
inactive X clients in their correct colors; it provides Help if a client fails.

• You can create profiles which contain information about configuring and running the server.
You can set up as many profiles as you like and run more than one at a time. This enables you
to run several X sessions concurrently.

• The server can be used in either multiple-windows mode, or in single-window mode. In
multiple-windows mode, each X client runs within its own Microsoft window and the X root
window is optionally displayed as the Microsoft Windows background. This mode provides
the look and feel of Microsoft Windows for X applications. In single-window mode, the X
Server window contains the X root window which is always visible. All X clients appear in
child windows within the server window. This mode provides the look and feel of a standard
X display. The server window can share the screen with other Microsoft Windows
applications and can be moved, resized or minimized in the normal manner.

• In multiple-windows mode, window management for X clients is performed locally using the
built-in VWM window manager, which is ICCCM compliant. When the server is in single-
window mode, you can use the local Motif window manager provided, or a host-based X
window manager of your choice. Local window management improves performance by
reducing network traffic and the load on the host processor.

• The server can run transparently, or hidden, when in multiple-windows mode. When running
transparently, the X Server will be started automatically at the beginning of each Windows
session.

• Panning and scrolling mechanisms allow you to use clients that require a display larger than
the PC screen.

• You can copy and paste text or graphics between X clients and Microsoft Windows
applications.

• Server extensions SHAPE, XTEST, XIE, DBE, SYNC, BIG-REQUESTS, and XC-MISC
provide support for non-rectangular windows, the X Test Suite, the X Image Extension, a
double buffering API, client synchronization, 32-bit protocol requests, and querying for and
making use of available resource IDs.
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• The server extension GLX allows you to display OpenGL applications.
• A proprietary server extension provides support for Vision Resume, which allows you to

suspend an X session and resume it at a later time.
• The X Server can display X fonts that have been compiled to Microsoft Windows .fon

format, and also fonts in the X .pcf format. The standard X Window System fonts are
supplied in compiled form, and a Font Compiler is supplied to allow third-party fonts to be
compiled. The server can also make regular Microsoft Windows fonts available to X
applications.

• The X Font Server Protocol is supported, so allowing fonts to be stored on a central font
server instead of on individual PCs. Available font servers can be detected automatically.

• Deferred glyph loading is supported for font server fonts, so providing improved
performance with large, sparsely used Asian fonts.

• A font substitution mechanism can supply an alternative font if a font requested by a client is
not available.

• The X Server provides the functionality of a three-button mouse when using a two-button
mouse.

• Local backing store is provided for faster screen updates, with a special option to provide fast
text scrolling when backing store is enabled.

• A unique Graphics Speed Optimization feature tunes the server for maximum speed on your
display hardware.

• Security is provided by support for Host Access Control and User Access Control.
• Supports XDMCP, including MIT-MAGIC-COOKIE and XDM-AUTHORIZATION-1 security modes.
• The X Server can use any graphics display supported by Windows.
• Support for many languages and keyboard types.
• Clients can access the server over a network or serial line. NCD�s XRemote protocol is used

to support serial lines.
• Online Help is provided using the standard Microsoft Windows mechanism.
• Helpful Interactive Support (HINTS) provides assistance when a client starts but then

terminates with an error.

Restrictions
The X Server is a comprehensive implementation of the X11R6 sample server distributed by the
X Consortium. However, there are a few restrictions of which you should be aware. Most of
these are described below.

The restrictions are:

• PEX is not supported.
• X Input Device Extension is not supported.
• The authorization service SUN-DES-1 is not supported.
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• Cursor size is restricted to 32x32, because this is a Microsoft Windows limitation.
• You cannot set keyboard click, autorepeat, LEDs and bell volume and pitch.
• In multiple-windows mode, keyboard input to the root window is disabled.

Starting the X Server
The X Server is normally started automatically when Windows starts. If you do not want the
server to start automatically, then in Windows Control Panel, double-click XVision Profiles,
click the Global Settings tab, and disable the Load XVision At Windows Startup option. The
server may also start automatically if it is not running when you use the Program Starter to run
an X client.

To start the X Server manually

Do one of the following:

§ Click the Start button, point to Programs, point to Vision, and click XVision Server.
§ For older versions of Windows NT, open the Vision group in Program Manager and double-

click the XVision Server icon.

The server starts, and if it is configured to run hidden, then an indicator appears in the
notification area of the taskbar in Windows 95 or NT 4.0.

If you have changed the configuration, then the server may appear as an icon on the taskbar or as
a window.

It is possible to run more than one instance of the server at any one time, by setting up and
running profiles. For more information on profiles, see �Server Profiles� later in this chapter.
Note that only one server can run in multiple-windows mode, and that each server running must
have a unique X Display number. The Display number can be changed in the Server Properties
dialog box.

Closing the server manually
To close down the X Server manually, follow the instructions below.

To close the X Server

1 Close down all X clients, using the recommended exit procedure for each application.
2 Do one of the following:
§ If the server is running hidden, then click the X Server icon in the notification area of the

taskbar with the right mouse button and click Close. (For older versions of Windows NT,
display the root menu and then click Close.)
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§ If the server is not hidden, click the X Server icon on the taskbar with the right mouse
button and click Close.

§ If the server is running in single-window mode, click the Control menu and then click
Close. If the server is in full-screen mode, press ALT+SPACE to display the Control menu.

3 Confirm that you wish to end the session.
Any remaining X clients will be terminated automatically and without further warning.

When the program finishes, the X Server window will be removed from the screen.

Closing xdm�s main program
If you are using the xdm display manager, then closing the �main program� causes all other
clients to be terminated. You will be logged out, and the connection to xdm will be closed. If
XDMCP is in use and the One Session option is enabled, then the X Server will be terminated.
Otherwise, the server will attempt to start a new session according to the current XDMCP Mode
setting.

Configuring the server
The X Window System was designed to be as flexible as possible to encourage its use on a wide
range of computers of different sizes and architectures. The X Server must therefore be able to
accommodate many different ways of using X, and must also ensure that the best possible use is
made of the functionality provided by Microsoft Windows.

There are many options for configuring the X Server, and the Setup program chooses
appropriate settings for your PC at installation time. You may find that you do not need to make
any changes to these default settings. If you do want to change the options, you can do so from a
running server or by configuring profiles in the Windows Control Panel. See �Server Profiles�
later in this chapter for more information.

To configure an active server

Do one of the following:
§ If the server is running hidden, click the X Server icon in the notification area of the taskbar

with the right mouse button, and then click Properties. (For older versions of Windows NT,
display the root menu and then click Properties.)

§ If the server is not hidden, click the X Server on the taskbar with the right mouse button and
click Properties.

§ If the server is running in single window mode, click the Control menu and then click
Properties. If the server is in full-screen mode, press ALT+SPACE to display the Control menu.

A dialog box appears, with the name of the current profile displayed in the title bar. Use the tabs
to switch between the various server properties. To save changes and close the properties dialog
box, click OK. For changes to take effect before you close a properties dialog box, click Apply.
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Some options only become applicable when you choose another option. When options are not
applicable, they appear grayed in the dialog boxes. If grayed options become available again,
they show the built-in default settings.

Most changes you make take effect immediately, but others (such as changing the display mode
or changing transports) require you to restart the X Server. If this is necessary, a dialog box is
displayed asking whether you wish to restart the server now. If this is a convenient time to restart
the server, choose the Yes button. If you have active clients, you may prefer to choose No, close
down your clients, and then restart the server.

To restart the server

Do one of the following:
§ If the server is running hidden, click the X Server icon in the notification area of the taskbar

with the right mouse button, and then click Restart. (For older versions of Windows NT,
display the root menu and then click Restart.)

§ If the server is not hidden, click the X Server on the taskbar with the right mouse button and
click Restart.

§ If the server is running in single window mode, click the Control menu and then click
Restart. If the server is in full-screen mode, press ALT+SPACE to display the Control menu.

Server profiles
A profile is a set of configuration options used by the X Server that contains information about
how X clients appear and how the server is to run and behave. Whenever the server is started it
will always run a profile, either automatically or after prompting the user for one. Depending on
whether the Network X Server and/or the Serial Line X Server are installed, the default profile is
either called XVision or XRemote.

Server profiles give you the ability to save different server configurations and run several
concurrently. Profiles are saved as hidden files with the extension .xfg, and are located in the
.\Vision\User\Profiles folder.

You can add, remove and configure profiles using the General tab on the XVision Profiles dialog
box.

To create a profile

1 Do one of the following:
§ Click the Start button, point to Settings, and click Control Panel.
§ For older versions of Windows NT, open the Main group in Program Manager, and

double-click the Control Panel icon.
2 Double-click XVision Profiles.
3 Click Add and type a name in the space provided.
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4 To configure the profile, select the profile from the list and click Properties.
Information you can specify includes whether clients appear in multiple Microsoft windows
or a single window, options that govern the performance and appearance of X clients, such as
server extensions, resource optimization, transports, security mechanisms, and Clipboard
options. Set all the options you want and click OK.

The server can be configured to always run a particular profile when it starts. In the General tab
in the XVision Profiles dialog box, click Always Use This Profile, and select the appropriate
profile name from the drop-down list. If you wish the server to prompt you for a profile to run
when it starts, click Prompt For a Profile To Be Used.

Note  If you wish to run two server sessions concurrently, then you need to create two different
profiles, each with different X Display numbers. You may run only one server in multiple-
windows mode, but any number of single-window mode servers.

Global Settings
In addition to properties that can be set as part of profiles, there are global settings that will
apply to all profiles. These include specifying that the X Server starts automatically when you
start Windows, changing the name of the color database file, and setting basic options for
XDMCP security and Host Access Control security.

Choosing a display mode
The X Server can operate in two modes. In the default multiple-windows mode, each X client
appears in its own Microsoft window, and the Vision Window Manager built into the server is
used to manage windows. This gives X clients the look and feel of Microsoft Windows.
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If you prefer the style defined by another window manager, such as the OPEN LOOK or the
DECwindows window manager, then you may prefer to use the X Server in single-window
mode. In this mode, your PC resembles a standard X display and all X clients appear within the
main server window. The window manager runs as a separate X client as is normally the case in
the X Window System. Use the Display Properties dialog box to change the display mode.

Window management
If you want X clients to have the look and feel of Microsoft Windows, then use the Vision
Window Manager (VWM) which is built into the X Server and operates when the server is in
multiple-windows mode. VWM is compatible with the Motif window manager MWM, which
was itself designed to provide X clients with the look and feel of Microsoft Windows.

If you want to use a real MWM window manager, then the local Motif window manager can be
used when the server is in single-window mode. This uses a special local transport to carry
messages between the window manager and the server so that TCP/IP does not need to be
installed on the PC. A host-based window manager such as the OPEN LOOK window manager
OLWM can also be used.

Refer to the �X Window Management� chapter for details.
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Selecting the active transport
The X Server can communicate with a remote host system over a network using TCP/IP or
IPX/SPX protocols, and over a serial line using NCD�s XRemote. A different server program is
used for a network or a serial transport, so you must specify which server is to be used when
configuring an X Server profile.

Note  The Serial-Line X Server can only be installed using Custom Setup. If only one of the X
Servers was installed, then the option to select the transport is not available.

To select the active transport

1 In the X Server properties dialog box, click the Transports tab.
2 To use the X Server over a network, make sure that Use XVision on the Network is checked.

- or -
To use the X Server over a serial line or modem, click Use XVision With a Serial Line.
Specify the name of the UNIX host running the XRemote proxy-server in the space provided.

Optimizing performance
The X Server aims to produce fast performance on a suitably configured Microsoft Windows
computer. To achieve this, parts of the X Consortium�s sample server, on which the X Server is
based, have been rewritten to achieve the fastest operation under Windows, and to take
advantage of PC graphics display hardware. You can use the following features to ensure optimal
graphics performance:

• Graphics Speed Optimizer
• Graphics Cache

Graphics Speed Optimizer
The X Server translates X drawing operations into equivalent Microsoft Windows functions.
Sometimes there is an exact correlation between the two, but for some operations an X function
has no direct equivalent, or the Microsoft Windows equivalent does not match the X
specification. In these cases the server can be configured to use the nearest equivalent Microsoft
Windows function (Windows mode), or to use the X routines (Correct mode) or can use Custom
mode which aims to produce the fastest performance. Custom mode, however, may not in fact
produce the fastest operation on your specific display hardware.
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If it is important to always produce a pixel-perfect image, then you should configure the server
to use Correct mode. If you want to ensure the fastest performance, then you can run the
Graphics Speed Optimizer (GSO) to tune the server to produce the fastest performance on your
individual display. This runs a series of tests to determine which of the three drawing modes is
fastest on your display for several types of drawing operation. The GSO is normally run as part
of Setup, however it can also be run manually if required. If you have changed the configuration
of your PC, you should run the GSO to ensure the X Server is giving optimum performance. The
GSO can be run on individual drawing operations or on all operations, which will take several
minutes.

To run the Graphics Speed Optimizer

1 In the X Server properties dialog box, click the Graphics tab.

2 Click Optimize Now to optimize all drawing operations.
3 To optimize individual drawing operations, click Let Me Specify the Drawing Operation

Settings and click Customize.
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4 Select the operation you want to optimize from the drop-down list and then click Optimize.
The X Server chooses the fastest mode for the selected operation.
The dialog box is extended to include a benchmarking display where the operation being
optimized is tested in each of the three modes. If you chose Optimize Now, the Server
Optimization dialog box appears showing the results of the drawing operations as they are
optimized. The longer the bar, the faster the operation. If you want to abort the optimization
process, press ESCAPE.

Click Close to restore the normal appearance of the dialog box when you have viewed the
results.

Graphics cache
The X Server uses a graphics cache to store resources such as brushes, pens and bitmaps. This
reduces the frequency with which resources need to be created and destroyed. It also encourages
resource sharing, which is important under Microsoft Windows because there is a system-wide
limit on the number of these resources.

To change the amount of Windows resources used for the graphics cache

1 In the X Server properties dialog box, click the Graphics tab.
2 Under Graphics Cache, drag the slider.

Choosing a large value may not improve the performance of the X Server, since the performance
of Windows may decline as a result.

The About XVision dialog box shows you the percentage of system resources which are currently
being used by the X Server.
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Security
In the X model, a connection between a client and a server is initiated by the client. It may be
desirable to restrict access to your server, to prevent unwanted clients from appearing on your
screen. Several ways of controlling access to a display server are provided by the X Window
System. The Host Access Control method restricts access to clients running on specified hosts. If
Host Access Control is disabled, any client will be able to display on your PC. User Access
Control is more secure as it uses an authorization code which must be known to both server and
client before the client is allowed to run. User Access Control is most commonly used when
XDMCP is in use, however a local authorization file can also be used.

Using Host Access Control
The Host Access Control method restricts access to your display to clients running on hosts
specified in a list of authorized hosts. This list of authorized hosts is created when the X Server
starts and is stored in a file on the PC called, by default, Xhosts.txt. You can view and modify
the list of authorized hosts in the Global Settings tab in the XVision Profiles dialog box.

To view the list of authorized hosts

1 Do one of the following:
§ Click the Start button, point to Settings, and click Control Panel.
§ For older versions of Windows NT, open the Main group in Program Manager, and

double-click the Control Panel icon.
2 Double-click XVision Profiles.
3 Click Global Settings. Authorized hosts are listed under Host Access Control. You can use

Add and Remove to add and remove hosts from the list.

You enable Host Access Control in the X Server properties dialog box. When you enable Host
Access Control, you can also specify a special host. A special host is treated as having the same
privileges as the local host (your PC) for access control purposes only. These privileges enable it
to alter the list of authorized hosts, and it may be desirable to nominate a computer on which an
X session manager is running.

To enable Host Access Control

1 In the X Server properties dialog box, click the Security tab.
2 Click Host Access Control.
3 To add a special host, type in a host name in the space provided, or choose a host from the

drop-down list.

If XDMCP or Local Authorization File are also enabled, then any client which supplies a correct
authorization code will be allowed to run, irrespective of whether the host it is executing on is
included in the list of authorized hosts.
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Using XDMCP security
The X Server supports the X Display Management Control Protocol (XDMCP) which defines
the interaction between a server and a display manager. If XDMCP is enabled, then a display
manager such as xdm can be used to start an X session. Look up �X Display Manager, using� in
the Help index for further information.

When XDMCP is in use, the User Access Control method can be used to restrict access by clients
to your server. After you log in, the server is given an authorization code. When any client which
is part of that display management session subsequently contacts the server, it passes the same
code and so is allowed to run. Any client which does not supply the authorization code is not
allowed to run. The host on which an authorized client is running is not relevant. Note that
applications must have been compiled to use the authorization codes (ask your application
supplier). Applications not compiled with the correct X11R4 or later libraries will not run.

Two levels of User Access Control are supported: MIT-MAGIC-COOKIE-1 and
XDM-AUTHORIZATION-1. When using MIT-MAGIC-COOKIE-1 security, the authorization code
(�magic cookie�) is passed between the server and the client as a straightforward character string.
Thus, it is possible for a snooper program to read the authorization code. The
XDM-AUTHORIZATION-1 mechanism is more secure as it encrypts the authorization code before it
is transmitted. The encryption and decryption is performed using the values of Display Id and
Key in the Global Settings tab of the XVision Profiles dialog box. These values must also be
registered in the host file xdm-keys, which is normally located in /usr/lib/X11/xdm.
XDM-AUTHORIZATION-1 is only available for X11R5 or later. If you attempt to use this security
mechanism with pre-X11R5 clients then MIT-MAGIC-COOKIE-1 security will be silently used
instead.

Note that for User Access Control to work, Host Access Control must also be enabled. Hosts
included in the Valid Hosts list will be allowed to start any client on your server, so to restrict
access to clients that supply an authorization code you should enable Host Access Control but
not include any hosts in the list except your PC. If Host Access Control is disabled, then any host
can display any client. Note that to run an X11R3 client when XDMCP is enabled, you must
include the host it runs on in the list of Valid Hosts.

If XDMCP is not enabled, then you can still use User Access Control by creating a local
authorization file as described in the following section. However, you should not use both
methods simultaneously as they both rely on the presence of a .Xauthority file on the host. See
�Using a Local Authorization File� later in this chapter for details.

To enable XDMCP-based security

1 In the X Server properties dialog box, click the Security tab.
2 Make sure that XDMCP is enabled in the check box.
3 Under XDMCP, click the required mode. Click with the right mouse button and then click

What�s This? for more information about the modes.
If you are using Direct or Indirect mode, type the name of the host to be used in the Hosts
box, or choose one from the drop-down list.
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4 If you wish to use the XDM-AUTHORIZATION-1 security mechanism, you must enter your key in
the Key box in the Global Settings tab of the XVision Profiles dialog box.
The value of the key option should be obtained from your System Administrator, who will
also require the value of Display Id. These values must not be changed once they have been
registered. If the Key box is left empty, the MIT-MAGIC-COOKIE-1 security mechanism will be
used.

5 Click Advanced to specify any further options required.

Using a local authorization file
If XDMCP is disabled, you can still use User Access Control if you set up a local authorization
file on the host system and on the PC. The file contains the authorization codes necessary to
allow X11R4 or later clients to run on the server.

To create an authorization file on the host system, use the xauth program which is part of the
X11R4 or later distribution. By default, the file is called .Xauthority in the user�s /home
directory. Use Unix Neighborhood to transfer this file to the PC, renaming it to conform to short
file name conventions if necessary. If a client passes a code which is included in the file, then it
will always have access to the server, even when not part of a current display manager session.

If you want to make certain that only clients which present a valid authorization code have
access to the server, when you enable the local authorization file you should also enable Host
Access Control and ensure that the list of authorized hosts only includes the local host (your PC).
See �Using Host Access Control� earlier in this chapter for details.

XDMCP security and a Local Authorization File should not be used at the same time. XDMCP
uses a temporary .Xauthority file on the host. This is created dynamically when clients using
XDMCP are run. This file will over-write the manually created .Xauthority file, and so the
values in the PC and host files will no longer match and clients will not run.

To enable a Local Authorization File

1 In the X Server properties dialog box, click the Security tab.
2 Click Local Authorization File.
3 Type the name of the authorization file in the Authorization File text box.

If the file is in a folder which is not in your MS-DOS path, then you should include the full
folder specification.
If you do not know the location of your authorization file, click Browse to display the
Authorization File dialog box to enable you to find the file.
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Keyboard input in X
In the X Window System, a key on the keyboard is identified by a number in the range 8-254,
called a keycode. The way keycodes are assigned to physical keys is arbitrary, and depends on the
type of keyboard. X provides a mechanism to translate the keycodes to logical key values called
keysyms, which are values corresponding to the symbols engraved on keyboard keys. In
principle, there is a keysym for every symbol engraved on any key. A particular keyboard
intended for a specific language will have an appropriate set of keys and matching keysyms.

Many keys must produce a different value depending on the state of one or more modifier keys,
such as the SHIFT key. To cope with this, X allows a single keycode to be associated with more
than one keysym. Keysyms can correspond to the unshifted key, the shifted key, the key when
the Mod2 modifier (Mode Switch) is down, and the key when both the SHIFT and Mod2 keys are
down.

When a key is pressed or released, a client usually receives a keyboard event that identifies the
keycode of the key, and the state of the modifier keys. To enable it to translate this information
to the corresponding X keysym, the client uses the keyboard map supplied by the X Server
during the connection startup phase.

X Server keyboard input
The X Server uses a keyboard map (.xkg) that defines the keysyms associated with each key on
the keyboard. Keyboard maps are provided for all the standard Windows keyboard layouts:

Belgian Latin American
British Norwegian
Canadian Multilingual Portuguese
Danish Spanish
Dutch Swedish
Finnish Swiss-French
French Swiss-German
French-Canadian US
German US-Dvorak
Icelandic US-International
Italian

For each layout, there is a keyboard map for the standard IBM PC Extended keyboard, and there
may be additional keymaps for vendor-specific keyboards, for example the Digital LK250. The
name of the current keyboard map is specified in the Devices Properties dialog box. The correct
keyboard map for your Windows system is selected automatically at Setup time. Keyboard maps
are stored in the \Program Files\Vision\System\Keymap folder.
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Note  For keyboard mapping to work correctly, it is essential that the correct keyboard layout
and country was specified when Microsoft Windows was installed. Mappings depend on the
keyboard in use and the Windows country setting. If you are using a non-standard keyboard, you
may need to use a modified keyboard map.

Configuring X keymaps
You can create a new keyboard map by using the Devices Properties dialog box. The new
keyboard map is displayed in the X Keymap Editor and initially contains the same mapping as
the default keyboard map.

If you want to modify one of the standard keymap files, then save the file with a different name,
and use that as the basis for your new keymap. Do not overwrite the standard keymap with your
changes. Remember to change the description line when you save the keymap, since this will
appear in the Keymap list in the Devices Properties dialog box.

You can modify a keymap to alter the keysyms associated with any key, and add keysyms for any
extra keys if you are using an application designed to use a non-standard keyboard. For example,
there are several keys on a Sun workstation keyboard that you might want to map. You can also
change the keys that are used as modifier keys. Click Help Topics on the Help menu for full
instructions. The same information can be seen by choosing How To Use X Keymap Editor from
the main Vision Help Contents. Look up �keysyms� in the index for a list of the standard X
keysyms. (The Sun keysyms are in the XKeysymDB character set.)

The X Keymap Editor can also be run as a stand-alone program. Click the Start button, point to
Programs, point to Vision, point to Accessories, and then click X Keymap Editor.
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X Server and Xmodmap
The X Server generates a unique X keycode for each key, and it is this value that is sent to the
client. The keycodes are assigned to keys in an arbitrary way and are not associated with a
specific physical key. For this reason, you should not use the xmodmap client to directly modify
the associations between keycodes and keysyms in the keyboard map. You may use xmodmap to
modify the keyboard map providing you use only keysyms in the expression list.

Shortcut keys
Microsoft Windows applications normally use ALT+key keyboard sequences (�shortcut keys�) to
provide a quick method of control. When these keys are pressed, they are normally dealt with by
Microsoft Windows, and are not seen by the application program.

You may prefer to pass the shortcut keys to the X Window System, instead of to Microsoft
Windows. For example, the OSF/Motif window manager uses ALT+key shortcut keys in a similar
way to Microsoft Windows. The Devices Properties dialog box contains the Shortcut Keys check
box. If this box contains a check mark, then Microsoft Windows will receive the shortcut keys.
The X Window System will not receive these keys. If the Shortcut Keys box is clear, then the
shortcut keys will be passed to the X Window System in the same way as all other keyboard
input.

The keys that are treated as shortcut keys are defined in the keyboard map. They normally
include the following:

ALT+ESCAPE ALT+F6

ALT+TAB ALT+F7

ALT+SPACEBAR ALT+F8

ALT+F4 ALT+F9

ALT+F5 ALT+F10

Modifier keys
Modifier keys are so called because they modify the action of other keys. For example, most
keyboard users are familiar with the action of the SHIFT and CONTROL keys. To make X
independent from any specific keyboard layout it uses the concept of �logical� modifier keys,
which can be mapped to any physical key on the keyboard. The logical modifier keys are:

Shift Mod2
Lock Mod3
Control Mod4
Mod1 Mod5

The X Server allows up to three physical keys to be associated with each modifier key.

The auto-repeat function is automatically disabled for modifier keys.
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The Mod2 modifier has an additional meaning as the Mode Switch for the main keymap. With a
standard IBM PC Extended keyboard, the X Server uses the ALT GR key as the Mode Switch.
Under Microsoft Windows, this key generates a VK_CONTROL key event, immediately followed
by a VK_MENU event. The server detects this occurrence, and generates a different, single virtual-
key code instead. It is this new virtual-key code that is used in the X Server keyboard map. If you
do not have an ALT GR key, then you may want to map the left-hand ALT key to Mode Switch
and Mod2. When you save a keymap, the X Keymap Editor looks for an existing mapping for
the Mode_switch keysym and if not found it inserts one.

Num Lock management
The value generated when you press a key on the numeric keypad normally depends on the state
of the Num Lock toggle switch. If Num Lock is ON, then the number keys generate keypad
numbers. If Num Lock is OFF, the same keys generate HOME, END and so on.

There is an option in the Devices Properties dialog box which enables you to disable local Num
Lock management. If you clear the Local NumLock Management check box, then the keypad
number keys will always generate numbers and keyboard events will be sent to the client when
the NUM LOCK key is pressed. NUM LOCK keyboard events are not sent when Local NumLock
Management is enabled.

Using the mouse
The X Window System is designed to be used with a three-button mouse. Most PC mice have
only two buttons, but fortunately Microsoft Windows understands about a middle button and
the X Server provides a way to emulate this feature.

To emulate clicking the middle mouse button

1 Press both the left and right mouse buttons down together.
2 Release both buttons.

For the X Server to recognize pressing both buttons to indicate the middle button, you must get
both buttons down within a short period of time. This interval can be altered in the Devices
Properties dialog box (look up �middle mouse button, emulation� in the Help index). If the
interval between pressing the first button and pressing the other button exceeds this time, the
action is taken as two separate mouse actions, for example a left button click followed by a right
button click.

To drag with the middle button

1 Press both the left and right mouse buttons down together.
2 You may now release one of the buttons.
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The �middle button� remains down while either or both of the buttons used to initiate the
action remains depressed.

3 Move the mouse while holding down the button.
4 When you have finished dragging, release the button which is holding the middle button

action.

You can combine pressing the �middle button� with other mouse buttons and/or key depressions.
For example, if your X application instructs you to drag while holding down the left and middle
buttons, then you would press both buttons down together, and release the left button while
holding down the right button. Then you would press down the left button again and drag the
mouse to the new location before releasing both mouse buttons.

If you have a three-button mouse attached to your PC, you can disable the middle button
emulation facility, so that when the left and right buttons are pressed down together, the
operation produces separate mouse actions.

Fonts in X
The X protocol allows a font to be specified by supplying a string of characters, which may
include wildcard characters. However, the protocol does not define the contents of the string.
For X11R2, the string was normally used to contain a font file name.

With X11R3, a convention was introduced which uses the string to hold a complete description
of all the characteristics of the font. The string is known as the X logical font description (XLFD)
and X clients compatible with X11R3 or later will use such a string to request a particular font
from the server. The elements in the X logical font description are, from left to right: foundry,
font family, weight, slant, set width, additional style, pixel size, point size (in tenths of a point),
horizontal resolution (in dots per inch), vertical resolution (in dots per inch), spacing, average
character width (in tenths of a pixel), character set registry, and character set encoding. The
elements are separated with hyphens. For example, the following specifies a Courier 10pt font:

-Adobe-Courier-Medium-R-Normal—10-100-75-75-M-60-ISO8859-1

The asterisk character (*) can be used as a wildcard in any element. For example, the following
would also specify Courier 10pt:

*-Courier-*-R-*-100-*

X11R5 introduced the concept of scaleable fonts to X. If the server reports to a client that it can
provide a scaleable font, the client can then request the font at any point size. A scaleable font is
indicated in the XLFD by zeros in the point size and pitch values.

Font technology has evolved in X11R6. One of the new features is the Matrix XLFD
Enhancement. It is now possible to generate transformations of existing bitmaps and scaleable
fonts through using transformation matrices. These enable applications to create font variations
(widening and narrowing ) or generate special effects (mirroring and rotation). Matrices can be
specified in the pointsize and pixelsize fields, as shown in the following example:

-Adobe-New Century Schoolbook-Medium-R-Normal—0-[12 0 0 12]-100-100-P-0-ISO8859-1
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The Matrix XLFD Enhancement can only be applied when the font is opened, which means that
for clients generating special effects a different font must be opened for every character. To
speed up the process of opening up a large number of fonts, character subsetting is supported.
This is the ability to hint, through the font name, which characters are of interest. The charset
subset specification can be appended at the end of the XLFD name in the form
=value[:value][+value], where value is an ASCII character value. Two values separated by a
colon (:) specify a range and ranges are separated by a plus (+). For example:

-Adobe-Utopia-Medium-R-Normal—0-120-0-0-P-0-ISO8859-1=65:67+118:120+32

A system of font aliasing is also available. An alias is a short name which can be used to identify
the font as an alternative to using the X logical font description. In the X Server, font name
aliases are defined in the Fonts.ali file. See �The Fonts.ali File� later in this chapter for further
details.

Fonts and the X Server
X applications and Windows applications use different formats for their font files. X applications
use a variety of different font formats, two of the most common being Bitmap Distribution
Format (.bdf) and Portable Compiled Format (.pcf). Microsoft Windows applications, on the
other hand, use the Windows .fon format. The X Server can use fonts which are in either .fon or
.pcf format.

All the standard X Window System fonts are distributed with the X Server, compiled for use
under Microsoft Windows. A font compiler is also provided which will convert .bdf and .pcf
font files into .fon files so that you can make additional X fonts available to the X Server. The
font compiler can also convert .bdf files into .pcf fonts. This is useful for fonts which are too
large to be converted to .fon format. Once in .fon format, the X fonts can be used with other
Windows applications if desired.

A remote font server can also be used to provide fonts for the server. The fonts used by X clients
can use a significant amount of the disk space on an average PC. The use of a font server means
that most fonts can be stored remotely. For details on the use of a font server with the X Server,
see �Font Servers� later in this chapter.

Some of the font transformation features are only available for .pcf fonts, for example, scaleable
fonts and the Matrix XLFD Enhancement.

The X Server also has a font substitution mechanism which can be used to provide alternative
fonts if a font requested by an X client is unavailable. This can be done either interactively, with
the user selecting the fonts to be used, or automatically. See �Font Substitution� later in this
chapter for details.

The X Server can also make Microsoft Windows fonts available to X clients. For details, see
�Using Windows Fonts with X Clients� later in this chapter.
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Standard X fonts
The standard X Window System fonts are distributed in compiled form, together with some
additional fonts required by different UNIX systems. The fonts are placed in subfolders in
.\Vision\Fonts, as follows:

Folder Fonts

Misc Fixed-pitch fonts; cursor fonts; fonts for compatibility with older
versions of X. This font set is always installed.

75dpi Variable-pitch 75 d.p.i. fonts
100dpi Variable-pitch 100 d.p.i. fonts
Oriental Kanji and other oriental fonts. Due to the large size of these font

files, they are supplied as .pcf files rather than .fon files.
Andrew Fonts from the Andrew toolkit, required by some IBM applications.
ICL Fonts required by some ICL applications. These include fonts from

a previous version of OPEN LOOK, plus fonts for the ICL VT
terminal emulator.

HP Fonts required by some Hewlett-Packard applications.

The 75 d.p.i. and 100 d.p.i. font collections include a variety of different typefaces in different
sizes, with normal, bold and italic versions of each font. These are high quality fonts, including
fonts from Adobe Systems, Inc. and Bitstream, Inc.

When you use the Express option in Setup, the Misc fonts and either the 75DPI fonts or the
100DPI fonts, as appropriate for your display hardware, are installed. Oriental, Andrew, ICL,
and HP fonts are not installed. If you use Custom Setup, you can choose which font sets to
install.

Font path items
A list of font path items must be specified in the Fonts Properties dialog box, to tell the server
where X fonts may be found. The initial font path will depend on the options selected during
Setup. It will typically include a number of folders containing X fonts and may also include a
font server. Windows fonts can also be included as fonts path items. There is also a font path
item called �Global Aliases.� This must be in the list for permanent font substitution to be used.
All the item types can be configured using command buttons in the Fonts Properties dialog box.
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If you add new fonts, for example those supplied with an application, the appropriate item must
be added to the font path. The fonts become available to X clients as soon as the font path is
changed.

Changing the order of font path items
When searching for a particular font the X Server will look in the various font path items in the
order in which they occur in the font path items list box. The arrow buttons can be used to order
the items in the most efficient manner. The Global Aliases item should always be at the bottom
of the list so that wherever possible the requested font will be located before an alias.

To change the order of font path items

1 In the X Server properties dialog box, click the Fonts tab.

2 Select an item in the Font Path Items list box.
3 Use the arrows to move it to a new position in the list.

The item will be moved up or down in the list.
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Installing additional fonts on your PC
If your X application is supplied with special fonts, then you need to copy them from the
distribution medium to your PC.

To install additional fonts

1 Use My Computer or File Manager to create a new folder within the X Server fonts folder.
By default, on Windows 95 this is C:\Program Files\Vision\Fonts.

2 Use Unix Neighborhood to copy the font files from the host system to the new folder on the
PC.

3 Do one of the following to start X Font Compiler:
§ Click the Start button, point to Programs, point to Vision, point to Accessories, and then

click Font Compiler.
§ For older versions of Windows NT, open the Vision group in Program Manager, and then

double-click the Font Compiler icon.

Compiling fonts
If fonts are in .bdf format, then they must be compiled for use with the X Server. If they are in
.pcf format, then you do not need to compile them, but you may find compilation improves
performance. Some fonts may be too large to compile, for example, Kanji fonts. In all cases you
must create a Fonts.dir index file and add the folder to the font path.

To compile fonts

1 In XVision Font Compiler, click the File menu, and click Preferences. Make sure that the
Automatically Update the Fonts Index and Automatically Update XVision Font Path options
are enabled otherwise you will need to carry out these steps separately.

2 On the File menu, click Select Font Files and choose the new fonts folder.
3 Click Compile All.

The process of adding the new fonts is complete.

Creating a fonts index
If you did not compile the new fonts, then you need to create an index file (Fonts.dir) which lists
each font file and its associated X logical font description. You can use the Make Font Index
command to create a new Fonts.dir file for all .fon files containing X properties. pcf fonts (which
can be read directly by the X Server) are also included in the Fonts.dir file. The Fonts.dir file
should not be edited manually.

To create a font index file

1 In XVision Font Compiler, click the File menu, and then click Make Fonts Index.
2 Change to the drive and folder containing the .fon or .pcf format font files and click OK.

A dialog box is displayed to show the progress of the indexing.
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When the font index has been created, a message is displayed. If the Automatically Update
XVision Font Path option is enabled, then the font path will be updated to include the new
folder.

Adding a folder to the font path
To make the new fonts accessible to the X Server, you must ensure that the folder where you
installed them is in the X Server font path. XVision Font Compiler will have done this for you
automatically if you chose the option in the Preferences dialog box. Otherwise you need to
display the X Server�s Fonts Properties dialog box, and add a new Fonts Folder item to the font
path. See �Fonts Folder Items� if you need to add the folder manually.

Creating font aliases
Follow any instructions provided by the X application supplier about setting up aliases for fonts.
You can use the Font Folder Editor dialog box to create or modify a Fonts.ali file in the folder.
In the server�s Fonts Properties dialog box, select the relevant Fonts Folder item and choose the
Properties button.

Fonts Folder items
Any folder containing a Fonts.dir file can be added to the X Server font path as a Fonts Folder
item. A fonts folder may also contain a file called Fonts.ali, which contains aliases for the logical
font descriptions in the Fonts.dir file.

To add a folder to the font path

1 In the X Server properties dialog box, click the Fonts tab.
2 Click Add.
3 Click Fonts Folder and click Add.
4 Browse through drives and files to find the Fonts.dir file you require.

The Fonts.dir file must be present in a folder before that folder can be added to the Font Path
items list. If you attempt to add a folder without a valid Fonts.dir file, then an error message
is issued stating that the Fonts.dir file cannot be found. When X fonts are compiled into .fon
or .pcf format using the XVision Font Compiler, a Fonts.dir file can be created automatically.

The new item appears as a path name in the list of Font Path items in the Fonts Properties dialog
box. Once you have created a Fonts Folder item, the path name of the folder cannot be changed.

Configuring a Fonts Folder item
You can configure an existing Fonts Folder item to set up aliases by clicking the item in the list of
font path items, and then clicking Properties. The Font Folder Editor dialog box appears, with
the Aliases tab visible showing existing aliases. If a Fonts.ali file did not previously exist in the
folder, one is created.
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Each alias is associated in the Fonts.ali file with an X logical font description, which in turn is
associated with a font file in the Fonts.dir file. When you click on an alias in the list, the
associated logical font description and font file are shown. You can add new aliases or remove
aliases.

An alternative view is provided by the Fonts tab, which lists the fonts in the Fonts.dir file.
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You can click on a font to see any associated aliases, and also add or remove aliases.

The Fonts.dir file always has a one-to-one correlation between a logical font description and a
font file, whereas the Fonts.ali file can define multiple aliases for a logical font description. The
Fonts.ali file can also be used to alias one logical font description to another. This provides one
mechanism for substituting one font for another. This can also be achieved in a more flexible
way using the X Server�s font substitution mechanism as described later in this chapter.

The Fonts.dir file
The Fonts.dir file lists all fonts in a folder. Each font is listed on a separate line, which has the
form:

filename   logical-name

where filename is the name of the file holding the font and logical-name is the X logical font
description. For example:

COURBO10.fon  -Adobe-Courier-Bold-O-Normal—10-100-75-75-M-60-ISO8859-1

The Fonts.ali file
A file called Fonts.ali may be placed in each font folder to specify aliases for the fonts. An entry
in this file has the format:

alias   logical-name

where alias is an alternative name to be used for the font and logical-name is the X logical font
description. For example:

variable  *-helvetica-bold-r-normal-*-*-140-*

Font alias files can be nested, simply by placing the name of another alias file on a separate line
within Fonts.ali.

Font servers
A font server is a program running on a remote UNIX host which can make fonts stored on that
host available to an X Server. This makes font administration much easier as it means that fonts
do not have to be installed on each PC on which the X Server is used and you always have access
to fonts when using different PCs. It also results in a saving in the disk space required to run the
server.

The fonts accessed through a font server may be grouped into named sets called catalogs. The
catalogs equate to the different directories in which the font files are located.

The fonts server program on a UNIX system is typically called fs and is usually installed in /usr/
bin/X11. For details of font servers available on your system, consult your System Administrator.
The client application fsinfo can be used to obtain details about a font server, including the
available catalogs.

The server fonts can be listed using the X client fslsfonts.
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Fonts supplied by a font server are in a consistent binary format that is independent of the file
format used to store the font.

The X Server supports deferred glyph loading for font server fonts. This provides improved
performance with generation of fonts, particularly large Asian fonts, by deferring creation of
characters that may not be needed.

A font server can be created as font path item using the Fonts Properties dialog box.

To configure the X Server to use a font server

1 In the X Server properties dialog box, click the Fonts tab.
2 Click Add.
3 Click Font Server Fonts and click Add.
4 Set any options you require. You can use Auto Detect to automatically detect available font

servers.
5 To enable deferred glyph loading for font server fonts, click Defer Font Server Glyphs, and

click either 16-bit or All.

If the X Server detects that a connection to a font server has been lost, it displays a message
asking if you want to try and reconnect. If you choose Yes, it will try to reopen the connection. If
you choose No, you will not be reconnected to the font server until the server is restarted. If the
font server is no longer running on the remote system, attempts to reconnect will fail and there
will be a timeout delay.

Using Windows fonts with X clients
You can choose to make Microsoft Windows fonts installed on your PC available to X clients by
adding a Windows Fonts item to the font path. The X Server adds X logical font descriptions for
Windows fonts to its internal table of fonts, supplementing those read in from Fonts.dir files in
the X font folders.

To use Windows fonts with X clients

1 In the X Server properties dialog box, click the Fonts tab.
2 Click Add.
3 Click Windows Fonts and click Add.
4 Set any options you require.

When the X Server adds an X logical font description, it uses a foundry name of �microsoft
windows.� For example:

-microsoft windows-Courier-Bold-O-Normal10-100-75-75-M-60-ISO8859-1
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You can set up aliases for Microsoft Windows fonts (see �The Fonts.ali File� earlier in the
chapter). The alternative names for the fonts can be added to any Fonts.ali file, although the
Fonts.ali file must be in a folder which contains a Fonts.dir file. You are recommended to use a
Fonts.ali file in the .\Misc fonts folder.

Using TrueType fonts
If you have TrueType fonts installed and enabled in Microsoft Windows, then you can make
them available to X as scaleable fonts.

To use TrueType fonts

1 Open the Windows Fonts dialog box.
2 Click the Plotter and Scale boxes so that check marks appear.
3 If required, click the Bold and/or Italic boxes so that check marks appear.
4 Specify the Max Size and Min Size values. These constrain the range of point sizes for which

logical font descriptions will be added. A logical font description is also added to allow the
font to be used as a scaleable font.

Any installed TrueType fonts will be added to the X Server�s internal table of fonts. For each
font, logical font descriptions will be added for the font as a scaleable font, and also for a range
of specific point sizes, constrained by the Min Size and Max Size values in the dialog box.

Using X fonts with other Windows applications
X fonts which have converted into .fon format with the font compiler can be used with other
Microsoft Windows applications. To make the fonts available to other applications, you need to
add them to the list of available Windows fonts using the Windows Control Panel. Refer to the
Microsoft Windows documentation for details about adding fonts with the Control Panel.

Note  It is not necessary to add the X fonts to Microsoft Windows, if you only want to use them
with X clients.

Using font substitution
Many X applications request particular fonts and if these are not available the client will fail to
run. The X Server avoids this problem by using font substitution. This can be done either
automatically or interactively. The font substitution mechanism should be used with care,
however, since some applications are capable of doing their own substitutions and may select
better fonts than the X Server. Use font substitution in conjunction with HINTS (see �Helpful
Interactive Support�), and enable it only when HINTS informs you that the reason for a client
terminating is that it cannot find a font.
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To enable font substitution

1 In the X Server properties dialog box, click the Fonts tab.
2 Click Allow Font Substitution and then click either Interactive or Automatic.
3 If permanent font substitution is to be used, add the Global Aliases item to the Font Path

Items list.

The dialog box is removed and the new font substitution mode takes effect immediately.

Automatic aliasing
If automatic font substitution is enabled and a font requested by a client cannot be located, the X
Server will silently provide a suitable alternative. Font aliases used for automatic font substitution
last for the current session only. You should only consider using Automatic mode if you have a
minimum system with very few fonts available.

Interactive aliasing
If the correct font cannot be found when using interactive font substitution, a dialog box is
displayed to allow the user to select an alternative font. Interactive font substitution can be for a
single request, for all requests in a session, or permanent. In order for permanent font
substitution to be used the Global Aliases item must be in the Font Path Items list.

To select a substitute font

1 The Font Substitution dialog box will be automatically displayed with the X Server�s
suggestion for an alternative font in the Substitute For box.
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2 Click the Substitution mode from the drop-down list box.
3 If the X Server�s initial suggestion is not suitable, click a substitute font from the Suggestions

list box or type the alias or logical font description of the required font into the Substitute
For box.

4 Click Substitute.
5 Repeat these steps for each font, or enable the Continue With Automatic Aliasing for This

Client option.

If the initial font suggestions list does not contain a suitable font, then a manual search of all
available fonts can be carried out.

To search the available fonts

1 The Font Substitution dialog box must be displayed.
2 Enter the search pattern in the Pattern box.

The asterisk character (*) can be used as a wildcard to replace any element in the logical font
description. If only an * is used, all available fonts will be displayed, up to the maximum
number of suggestions.
You could copy part of the logical font description from the Font Not Found box to the
Pattern box using standard Windows copy and paste techniques. Select the text you want to
copy, then press CONTROL+INSERT. Select the destination, then press SHIFT+INSERT.

3 Enter the maximum number of suggestions that you want to see in the Max. Suggestions box.
It is recommended that you set this number to a moderate value, as the number of available
fonts can be very large, particularly if Microsoft Windows fonts are enabled.

4 Click Suggest.

The fonts which match the pattern appear in the list box.

Color in X
Most color displays use the RGB model, in which the screen is divided into many pixels (picture
elements), each containing a red, a green and a blue dot of phosphor. The different colored
phosphors respond to separate electron beams, and by varying the intensity with which each
colored phosphor is made to glow, the visible color of the pixel can be varied.

Each pixel has a number of bits available in video memory to store color information. The
number of bits is also referred to as the number of planes. Normally, these bits are used to store
a value which acts as an index into a �colormap.� The colormap contains �colorcells� which
specify an RGB value. For example, if the pixel value is 12, the twelfth entry in the colormap is
accessed and the RGB values stored in that colorcell are used to set the intensity of the red, green
and blue phosphors in that pixel on the screen. The number of bits available per pixel determines
the number of entries available in the colormap, and so the number of colors which may be
displayed simultaneously.
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For some high-performance color displays, instead of the colormap consisting of colorcells which
contain RGB values, the colormap contains three separate indices, one for each primary color.
The available bits per pixel are divided up to access each color index separately. For example,
with a 24-bit color display, the first 8 bits may be used to index the red, the next 8 bits the green
and the final 8 bits may index the blue value. This makes the task of managing the large number
of available colors easier.

X uses a structure called a �visual� to describe the color capabilities of a display. This includes
information about the number of colorcells in the colormap (or the size of the largest submap if
the colormap has separate indices for the primary colors). It also contains the visual �class.�
There are six visual classes, corresponding to different types of display hardware: StaticGray,
GrayScale, StaticColor, PseudoColor, TrueColor and DirectColor.

Since a visual really describes a way of using a particular display, several different visuals may be
available for a single screen. For example, it is usually possible to treat a color display as a
monochrome or gray scale device. The X Server specifies which visual classes are currently
available, and defines a default class.

Static gray, static color and true color visuals have colormaps which cannot be changed. Gray
scale, pseudo color and direct color visuals have changeable colormaps, which allows an
application to add colors, or to install its own colormap. Note that colorcells in a changeable
colormap may be read-only, or read/write.

Since most displays have only one hardware colormap, X implements multiple virtual colormaps.
It is then able to swap virtual colormaps in and out of the hardware colormap. When the server
initializes, it creates one virtual colormap called the �default colormap,� which it initially installs
in the hardware colormap.

Color and the X Server
Depending on the type of display in your PC, the X Server makes as many color visuals as
possible available to X clients. The X Server can automatically select a suitable default visual, or
you can specify a different default visual using the Color Properties dialog box.

The X Server divides PC displays into four categories:

Category PC Display

Monochrome Hercules, EGA mono, VGA mono, etc.
Non-changeable color CGA, etc.
Changeable color EGA, VGA, Super-VGA, XGA, 8514/A, etc.

True color Displays with more than 256 colors.

How the X Server behaves with each of these categories of display is described in the following
sections.
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Monochrome display
For monochrome displays, the X Server offers a static gray visual with a colormap containing
two colors: black and white. For an EGA or VGA display to be treated as a monochrome device,
it must be configured as such using the Windows Setup procedure.

Non-Changeable color display
For a color display with a hardware colormap which cannot be changed by the X Server, a static
color visual is offered. The colormap contains the standard Windows colors.

Changeable color display
If a color display allows the X Server to change the colors in the hardware colormap, then the
server can offer all six visuals. For an EGA or VGA display, the server modifies the colormap
directly. For other displays, the server uses the Microsoft Windows Palette Manager to change
the colormap.

The factory-set default visual is pseudo color, but this can be changed using the Color dialog
box.

If a static gray visual is selected, the colormap contains black and white, and a range of gray
values produced by setting the red, green and blue components of each colorcell�s RGB value to
be equal.

For a gray scale visual, the default colormap contains only black and white, with the remaining
colorcells unallocated. If the Empty Private Colormaps option is enabled, then although the
colorcells containing black and white cannot be changed, the colormap will appear empty to a
client. If a client allocates additional colors, they will be grays, with the red, green and blue
components of each RGB value equal.

When a static color visual is selected, then if the Windows System Colors option in the Color
properties dialog box is disabled, the colormap contains black and white, and an even spread of
other colors. If the Windows System Colors option is enabled, then the colormap contains the
standard Microsoft Windows system colors, and an even spread of other colors in any additional
colorcells.

The pseudo color visual provides a default colormap which, if the Windows System Colors
option is disabled, contains only black and white, with the remaining colorcells unallocated. If
the Empty Private Colormaps option is enabled, then although the colorcells containing black
and white cannot be changed, the colormap will appear empty to a client. When Windows
System Colors is enabled, the default colormap contains the standard Windows colors in read-
only colorcells, with any remaining colorcells unallocated. Clients can add colors to the default
colormap if there are any unallocated colorcells, or create their own alternative virtual
colormaps.

True color and direct color visuals are not useful on a display with less than 8 planes because it
offers too few colors.
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Note that a 4-bit EGA or VGA display can support a colormap with only 16 colorcells. The
Windows System Colors option therefore provides 16 colors in a static color or pseudo color
colormap, compared to 20 colors when more colorcells are available. Also, if the Windows
System Colors option is enabled with a pseudo color visual, there will be no unallocated
colorcells. Some clients, such as the MWM window manager, will complain if they cannot add
colors to the colormap.

True color display
For a color display with more than 8 planes (more than 256 colors), the server offers a true color
visual and a pseudo color visual. When using a true color visual, an RGB value specified by an X
client is passed directly to Microsoft Windows. The pseudo color visual is made available to
allow clients which expect a pseudo color visual to work on a true color display.

Colormap management
Because the hardware colormap is shared by all clients, the X model has a potential problem if
clients modify the default colormap, or worse, swap out the default colormap and install their
own colormap. Any clients which used the old colormap will be displayed in false colors when a
new colormap is installed. For this reason, X colormap swapping should be left to the window
manager. Because each window can have a colormap specified as a window property, the policy
usually adopted by window managers is to install the colormap associated with the window
which currently has the input focus. The Vision Window Manager (VWM) follows this
convention by installing the colormap associated with the window when an X client becomes the
active window. Refer to Vision Window Manager in the �Window Management� chapter for
more information about VWM.

The situation is complicated for the X Server by the simultaneous presence on the screen of
other Microsoft Windows applications. If the input focus does not belong to the server or an X
client, then no X colormap is installed. The screen colors in this case will be the standard
Windows colors, or those determined by another active Windows application. If the installation
of an X colormap requires that the standard Windows colors are not available, then if the Fast
Color Changes option is disabled, the server changes the colors used for things such as window
frames, scroll bars, title bars and so on to be black and white. These are colors which are always
available, and so these items will always be visible.

Note that with certain display types and visual classes, the default colormap contains only black
and white. Therefore, if the X Server is started in single-window mode, the screen colors will
initially change to black and white (because the X Server window has the focus). Likewise, in
multiple-windows mode, when the first X client is started, the screen colors will change when
the client�s window gets the focus. Making a Microsoft Windows application active restores the
Windows colors.

Starting an X client which adds colors to the default X colormap makes those colors available to
the whole display. However, if the standard Microsoft Windows colors are not also present in
the default colormap, the effect is to make other Windows applications display in false colors.
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When the X client is terminated, the colors which it added to the colormap remain available, but
the colorcells are marked as unallocated. Therefore, if another client is started which adds colors
to the default colormap, those colors will replace the previous colors.

The Intelligent Color Matching option which is available in the Color properties dialog box
allows X clients to be displayed using colors that approximate to their own colors when a
Microsoft Windows application has the input focus. This avoids the unsightly display of X
clients in false colors, but you may prefer to disable this option to improve speed if you
frequently switch between Microsoft Windows applications and X clients.

Color name database
To enable X clients to request a color by name, X provides a color name database which contains
a lookup table of color names against RGB values.

The X Server will use the color name database to translate a client�s request for a named color
into an RGB value. It then finds the nearest matching RGB value in the current colormap, and
asks Microsoft Windows for that color. When the X Server is running the color name database is
stored in memory for fast access.

The color database is contained in an ASCII text file, normally called Rgb.txt, which the Setup
program placed in the folder where you installed the X Server. This file is part of the standard X
Window System distribution, and has not been altered by SCO. You can view the color database
file by choosing the Edit button in the Color Properties dialog box. The current color database
file will be opened in Windows Notepad.
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Each line in the file specifies a color. The numbers are values in the range 0 to 255 and indicate,
from left to right, the strength of the red, green and blue components of the color. The name is
the color name and is used by X applications to refer to the color.

Copying and pasting
The X Server supports the standard methods of copying and pasting information between X
applications. In addition, it allows data to be copied between X clients, character-terminal
applications and Microsoft Windows applications.

Copying and pasting in X
The X Window System provides methods for transferring information between clients, which
can be used for copying and pasting between windows. The principal method is called the
selection mechanism, which allows data to be associated with global named memory objects, or
�atoms.� A selection has an �owner,� and a client wishing to receive the information is called a
�requester.� This is an interactive mechanism, with responsibilities placed on owner and
requester to ensure the smooth transfer of information.

The other method of transferring information, called cut-buffers, is much simpler. It is a passive
operation, in which a client associates data with an atom, which can later be retrieved by another
client. There are eight pre-defined cut-buffer atoms, implemented as properties of the root
window.

The X Server supports both the selection mechanism and cut-buffers as a means of transferring
information between X clients. It also enables the data associated with an X selection or cut-
buffer atom to be mirrored on the Microsoft Windows Clipboard. This enables data to be copied
between X clients and Microsoft Windows applications. You can use the Clipboard Properties
dialog box to choose either a selection atom or a cut buffer to be associated with the Windows
Clipboard.

Note  Most X clients use the PRIMARY selection by default, and this buffer is the one associated
with the Windows Clipboard when you first install the X Server. Note that some OPEN LOOK
applications, such as cmdtool, shelltool, textedit and mailtool, use the CLIPBOARD selection.

Copying between Windows and X
Data can be transferred between the X selection and the Windows Clipboard automatically, or
manually using commands on the Edit sub-menu on the Control menu. The Setup program
initially selects Automatic mode, and the menu commands are grayed. To switch to Manual
mode, choose the Clipboard tab in the X Server�s Properties dialog box and click Manual in the
Cut and Paste area.
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Selections in Automatic mode
If the selection is not owned by the X Server, then the data is requested from the selection owner
and copied to the Windows Clipboard when required.

The X Server takes ownership of the selection on behalf of the Windows Clipboard when the
Windows Clipboard is changed. Future requests for the selection from X clients are fielded by
the X Server which returns the current values of the Windows Clipboard.

Cut buffers in Automatic mode
If the specified cut-buffer is set to a new value by an X client, then the Windows Clipboard is
changed to reflect the new value.

The cut-buffer is updated with the value of the Windows Clipboard when necessary.

Selections in Manual mode
When the Copy from X Selection menu command is chosen, then if the selection is not owned
by the X Server then the data is requested from the selection owner and copied to the Windows
Clipboard.

When the Paste to X Selection menu command is chosen, the X Server becomes the selection
owner. Future requests for the selection from X clients are fielded by the X Server which returns
the current values of the Windows Clipboard.

Cut buffers in Manual mode
Choosing menu commands to copy data between the Windows Clipboard and the X selection
causes the requested action to be carried out.

Copying graphics
Graphics can be copied and pasted between X applications using the selection mechanism (not
cut buffers). To copy graphics between X clients and Microsoft Windows applications you can
use the mechanism that allows the X selection to be mirrored on the Windows Clipboard. You
must specify a suitable graphical Clipboard target format (or MULTIPLE) in the Clipboard
Properties dialog box. Note that the default target format is STRING, which means that graphics
will not be copied.

There is a simple alternative method for copying graphics from an X window to a Microsoft
Windows application. The Copy Area command appears on the Control menu of the server and
in client windows.

To copy using Copy Area

1 On the Control menu in any X window or the X Server window, point to Edit and then click
Copy Area.
The mouse pointer changes shape.
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2 Point to the top-left corner of the screen area to be copied.
3 Press the mouse button and drag so that the outline contains all the graphic information to be

copied.
4 Release the mouse button.

The area within the outline is copied to the Clipboard, and can be pasted into a Windows
application able to accept graphics information, such as Windows Paint.

Working with sound
The Audio Server is a Network Audio System (NetworkAudio) server that runs under Microsoft
Windows or compatible environments. The Audio Server was based on the Network Audio
System Release 12 P1 sample server.

The Audio Server can be installed by choosing Custom Setup when installing Vision97 software
on your PC and choosing the Audio Server option from the Select X Components dialog box. If
you want to add the Audio Server to an existing installation, you can do so using Maintenance
Setup.

The NetworkAudio service provides applications with the ability to send and receive audio data
such as voice, sound effects, and music in a network environment. It uses the client/server model
to separate applications from the specific drivers that control audio input and output devices.
The Audio Server controls the various input and output devices on the PC in response to
messages sent from client programs running on other hosts.

The Audio Server supports the following formats for the play-back and recording of audio data:

11025 kHz, Mono, 8-bit 11025 kHz, Stereo, 8-bit
11025 kHz, Mono, 16-bit 11025 kHz, Stereo, 16-bit
22050 kHz, Mono, 8-bit 22050 kHz, Stereo, 8-bit
22050 kHz, Mono, 16-bit 22050 kHz, Stereo, 16-bit
44100 kHz, Mono, 8-bit 44100 kHz, Stereo, 8-bit
44100 kHz, Mono, 16-bit 44100 kHz, Stereo, 16-bit

Note  NetworkAudio assumes that if an audio server supports both input and output, then both
operations can be performed concurrently. However, most PC sound cards cannot do this and
the Vision Audio Server therefore does not implement this functionality. Audio input and output
can be done sequentially.

To start the Audio Server

Do one of the following:

§ Click the Start button, point to Programs, point to Vision, point to Accessories, and then click
Audio Server.

§ For older versions of Windows NT, open the Vision group in Program Manager, then
double-click the Audio Server icon.
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The Audio Server starts as an icon on the taskbar. You cannot turn the icon into a window, but
you can display its Control menu by clicking on the icon with the right mouse button (the left
mouse button on older versions of Windows NT), or by using ALT+TAB to choose the active
application then ALT+SPACEBAR.

When the Audio Server starts, it detects which audio formats any input or output device drivers
are capable of supporting and by default will use the lowest applicable format for the first device
driver detected. If you want to select a different audio format or device driver, you need to
configure the Audio Server.

To configure the Audio Server

1 On the Control menu, click Configure.
2 Make any changes you want to the options, then click OK.

If you have any active clients, then any changes you make that require the server to be restarted
will cause a message box to be displayed. Choosing OK will restart the server and disconnect any
active clients.

Helpful Interactive Support
The Helpful Interactive Support (HINTS) mechanism provides assistance when an X client starts,
but terminates with an error, for example because it cannot find the correct font. A dialog box is
displayed showing the type of error and the protocol request that was being processed when the
error occurred.

Click Information for Help on the likely cause of the error, and how to correct the problem.

The HINTS mechanism is enabled in the X Server.
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To enable HINTS

1 In the X Server properties dialog box, click the Diagnostics tab.

2 Under Options, make sure that Helpful Interactive Support (HINTS) is checked.

Logging X errors
A log file which by default is called Xlog.txt is created when the X Server starts. Minimal
information is written to this file unless you enable some of the options on the Diagnostics tab of
the X Server Properties dialog box. By default the file is created in C:\Program Files\Vision\User,
or C:\Vision\User on older versions Windows NT, although you can change this in the dialog
box. Use the View button in the dialog box to see the contents of this ASCII text file.

Getting information about the X Server
You can find out the version number of the X Server, details of memory usage, and information
about the number of X clients using the server.
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To get information about the X Server

1 Do one of the following:
§ Click the X Server icon in the taskbar, or in the notification area, with the right mouse

button, and click Help About XVision.
§ For older versions of Windows NT, click Help About XVision from the root menu, if the

server is running transparently. If the server�s Control menu is accessible, click Help About
XVision from the Control menu.

2 Click OK when you have read the information.
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Management

This chapter describes the window management options available
when using the X Server.
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Window management overview
The X Window System model specifies that the look and feel of X clients top-level windows
should be defined by a window manager. Normally the window manager runs as a separate
program that interacts with the server and other clients.

The Vision X Server provides a choice of window management policy. The server contains a
built-in Vision Window Manager (VWM) which operates when the server is in �multiple-
windows mode� (see �Choosing a Display Mode� in the �Using the X Server� chapter). Each X
client appears in a separate Microsoft window, and the window decoration is the same as for any
other Microsoft Windows application.

If the server is configured in �single-window mode�, then VWM is not used and a separate
window manager should be run. X clients appear as windows within a single Microsoft window,
and the decoration of the X windows and user input to them is defined by the window manager.
The window manager can run on the PC or on a UNIX host. Examples of window managers are
TWM (which is part of the standard X11R6 distribution), or the Motif window manager MWM,
or the UI OpenLook window manager OLWM.

A Motif window manager is provided with your Vision X Server package that can be used when
the server is in single-window mode. This allows you to create the look and feel of a standard X
display running Motif, without the overhead of running a host-based window manager.

Vision Window Manager
The Vision Window Manager (VWM) is built into the X Server, and is enabled when the server
is used in multiple-windows mode.

VWM conforms to the Inter-Client Communications Conventions Manual (ICCCM) published
by the X Consortium, which defines how clients and a window manager should interact. It is
also designed to be compatible with Motif, through the support of some additional Motif
functionality.

VWM has many options which can be set using the Multiple-Windows Mode dialog box.
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Note  If you know how to use Microsoft Windows, then you already know how to use VWM to
carry out most window management tasks. For example, the way you move, resize, and close a
window is the same, as are most of the commands on the Control menu. Refer to the Microsoft
Windows documentation for more information.

Initialization
When the X Server is started in multiple-windows mode, then following initialization of the
server, VWM is initialized. The window manager effectively becomes the first client. Note that
VWM does not actually use any client resources, and so is not included in the count of clients in
the About dialog box.

The initialization routine for VWM performs similar operations to those carried out by a host-
based window manager when it starts. For example, it sets WM_ICON_SIZE and _MOTIF_WM_INFO
properties on the root window. It also obtains redirection of certain requests which concern top-
level windows, to enable it to start managing client windows. No other well-behaved window
manager will be allowed to start once VWM is running.



Vision97 Reference116

Mapping client windows
A client may create one or more top-level windows. A top-level window is not visible, and the
window manager is not involved with it, until the client asks for the window to be �mapped.�

When a client requests that a top-level window should be mapped, VWM examines any ICCCM
or Motif �hints� which specify the desired title, icon and so on. VWM then creates a Microsoft
window to contain the X window, using as many of the hints supplied by the client as possible.

Window decoration
For a normal top-level window, the full Windows decoration of resize-borders, title bar, size
buttons, and Control menu will be provided, and the corresponding X borders are turned off.

If the top-level window has the WM_TRANSIENT_FOR property set, then VWM will create a
window with resize-borders, a title bar and a Control menu. The corresponding X borders are
turned off. VWM will ensure that the window always remains above its parent window in the
stack of windows on the screen. This type of window is often used for dialog boxes.

A top-level window with the override_redirect attribute set will be created without any
decoration at all being added by VWM. The X borders are not altered.

Size and position
VWM tries to display a new Microsoft window on the PC screen, using the size and position
specified by the client. The X Window System uses a pixel coordinate system, with the origin in
the top left corner of the screen.

If the client specifies a position which is not within the screen area, the origin for the new
window will be adjusted to show as much of the window as possible. VWM also ensures that a
portion of the Microsoft window�s title bar is visible, repositioning the X client if necessary to
achieve this.

If the client does not specify an initial position, then if the Auto Placement option in the
Multiple-Windows Mode dialog box is enabled, VWM provides a default initial placement.

If the size requested is larger than the PC screen area, then if the Windows > Display option is
enabled in the Multiple-Windows Mode dialog box, the window is created at the desired size
and the panning facility must be used to move the visible area. If the Windows > Display option
is disabled, then the window will be made as large as possible to fit within the screen and the
client will be sent a resize notification. It is up to the client how it responds to this, and it may
object if the window is smaller than its specified minimum size.

The client may specify the maximum and minimum sizes allowed for the window. The user will
not be allowed to resize the window beyond these limits. VWM will recognize the desired
increments for resizing a window, when these are specified by a client.
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Title and icon
The client can specify the window�s name, which will be used as the caption title for the
Microsoft window. It can also specify a separate icon name which will be used when the window
is minimized. If an icon name is not specified, the window name will be used as the icon title.
The icon pixmap to be used can also be specified by the client, although VWM will provide a
default icon if none is specified. Icon windows are also supported in Windows NT 3.51.

Initial state
The client may request that the window should initially be minimized (displayed as an icon).

Motif hints
For VWM to recognize Motif hints, the Motif Hints option in the Multiple-Windows Mode
dialog box must be enabled. The Motif hints specify what decoration should be applied to the
window frame, which Motif window manager functions should apply to the window, and the
input focus constraints imposed by the client window. Refer to �Motif Compatibility� later in
this chapter for further details.

Motif menus
If Motif hints are enabled, VWM will recognize the _MOTIF_WM_MENU property which is used by
Motif clients to customize the Control menu of the top-level window.

Focus policy
The window that receives keyboard input is said to have the input focus. An X window manager
can use either of two methods of giving a window the focus. With explicit focus policy, a
window is given the focus when the user clicks inside the window with the mouse. With pointer
focus policy (also called �real estate� policy), a window gets the focus as soon as the mouse
pointer is moved into the window, without clicking. VWM uses explicit focus policy.

Within a client�s top-level window, the policy on giving the focus to child windows is
determined by the X toolkit used by the application. This may well operate using a different
principle to that specified by the window manager.

You can specify whether a window should be given the focus automatically when it is mapped,
and also when it is raised to the top of the stack.

Colormap management
When an X client obtains the focus, VWM normally installs the colormap associated with the
client�s top-level window. However, a top-level window may have the WM_COLORMAP_WINDOWS
property set to specify that child windows require different colormaps to that of their parent. If
the Color Follows Mouse option in the Multiple-Windows Mode dialog box is enabled, then
when a child window with its own colormap gets the focus, its colormap is installed. If the
option is disabled, VWM does not install colormaps for child windows.
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Closing clients
When VWM provides a client�s top-level window with a Control menu, you can choose the
Close command or double-click on the Control-menu box in the normal Microsoft Windows
manner.

Note  If the top-level window is the main client window, then if the client has a proper exit
facility, you should use that to terminate the application.

If the Close Warning option in the Multiple-Windows Mode dialog box is enabled, then when
you choose Control Close, a message box is displayed asking you to confirm the action.

When you confirm that the window should be closed, then if the window has the
WM_DELETE_WINDOW protocol enabled, VWM does not in fact close the window. Instead, it
sends a message to the client, which may then ask for the window to be removed.

If the WM_SAVE_YOURSELF protocol is enabled, VWM sends a message to the client informing it
that it is about to be terminated. The client should then tidy up, and send a message back to the
window manager when it has done so. VWM will then close the client connection. If the client
does not respond within the time specified in the Multiple-Windows Mode dialog box, VWM
closes the client anyway.

When the client connection is closed, all the resources allocated by the server to the client are
freed.

Motif compatibility
Because the Motif window manager MWM provides the same look and feel as Microsoft
Windows, it offers a good model for the Vision Window Manager VWM. Like MWM, the
VWM window manager obeys the ICCCM rules and so is not restricted to use with Motif
clients. However, specific Motif features are incorporated to enable VWM to provide better
support for clients written specifically for the Motif environment. Support for Motif Hints can
be enabled or disabled in the Multiple-Windows Mode dialog box.

The MWM functions supported by VWM, and the Motif window properties, are listed later in
this chapter.

Note that VWM does not process resource files or resource manager properties.
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The Lower command
There is an option in the Multiple-Windows Mode dialog box to add the Lower command to the
Control menus of clients� windows. Choosing Control Lower places the window at the bottom
of the stack of windows on the screen.

Window properties
The window properties which are used by the VWM window manager can be divided into two
types:

• Properties set by clients
• Properties set by the window manager

Some properties are supported for compatibility with the Motif window manager MWM. It is
possible to prevent VWM recognizing these properties by disabling the Motif Hints option in the
Multiple Windows Mode dialog box, although normally this is not necessary when running non-
Motif clients.

The xprop utility returns details of the properties set for an X window. The program is run from
an xterm window, and then the user must click in the X window for which the properties should
be returned. With the X Server, if you click outside an X client window, the properties of the X
root window will be returned. In multiple-windows display mode, the Microsoft window
decoration (title bar, borders and so on) is not considered to be part of a client�s top level
window.

Properties set by clients
The following window properties are set by clients, and recognized by VWM.

WM_NAME
The window name is used for the caption title of the Microsoft window.

WM_ICON_NAME
The icon name is used for the icon title when the window is minimized.

WM_NORMAL_HINTS
This property provides size hints which inform the window manager of the range of sizes that
are preferable for a top-level client window. For X11R2 or earlier clients, VWM also recognizes
hints which indicate the desired initial position of the window. For X11R3 and later clients,
these position hints are ignored and the information given in the create or configure window
request is used instead.

The fields recognized are:
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Field Meaning

x Initial position x coordinate (X11R2 clients only).
y Initial position y coordinate (X11R2 clients only).
width Initial width (X11R2 clients only).
height Initial height (X11R2 clients only).
min_width Minimum width allowed.
min_height Minimum height allowed.
max_width Maximum width allowed.
max_height Maximum height allowed.
width_inc Width increment.
height_inc Height increment.
base_width Base width.

base_height Base height.

WM_HINTS
This property stores additional window manager hints, which are optional. If the client does not
supply an icon pixmap, a built-in default icon will be used by VWM.

The fields recognized are:

Field Meaning

input A boolean value which specifies the keyboard focus model used by the
application.

initial_state Specifies the preferred initial state of the window when it is mapped.
icon_pixmap Specifies the icon pixmap to be used when the window is minimized.
icon_window Specifies a window to be used as the icon when the window is minimized.

_MOTIF_WM_HINTS
This property is used by Motif clients to communicate certain preferences to the window
manager.

The fields recognized are:

Field Meaning

flags This field indicates which of the other fields in the property contain data.
decorations Specifies how the window frame should be decorated.
functions Specifies which window manager functions should apply to the client

window.
input_mode Indicates the input focus constraints that are imposed by the client window.
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Note that if a client turns off the MWM_DECOR_RESIZEH decoration and the MWM_FUNC_RESIZE
function, then the Microsoft Windows border on the client�s top-level window will be turned
off. If the MWM_DECOR_BORDER decoration is turned on, then the X border will be shown,
potentially in addition to the Microsoft Windows border.

The window manager gives precedence to functions over decorations. So, for example, if the
maximize or minimize function is on, the corresponding decoration will be forced on.

WM_TRANSIENT_FOR
If the client sets this property, then the window manager will create a window with resize-
borders, a title bar with caption, and a Control menu.

A window with the override_redirect attribute set will be created with no decoration added by
VWM.

_MOTIF_WM_MESSAGES
This property is used by Motif clients to indicate to the window manager which messages sent by
the window manager are currently being handled by the client. The _MOTIF_WM_MESSAGES atom
must be included in the WM_PROTOCOLS property for the window manager to track the
_MOTIF_WM_MESSAGES property.

WM_PROTOCOLS
This property is a list of atoms, each of which identifies a communications protocol between the
client and the window manager in which the client is willing to participate. The protocols are
shown in the table below, together with the effect on the client when the protocol is enabled.

Protocol Effect

WM_TAKE_FOCUS The client receives a message at set focus time.
WM_SAVE_YOURSELF The client receives a message when the window manager tries to

close the window. The client is expected to tidy up, and send a
message to the window manager when it has done so. The window
manager will then terminate the client. If the client does not
respond within a certain time, the client will be terminated anyway.

WM_DELETE_WINDOW The window will never be removed by the window manager.
Instead, when the user tries to close the window, a message is sent
to the client.

_MOTIF_WM_MESSAGES The window manager monitors the _MOTIF_WM_MESSAGES property
on the client window, which specifies which messages sent by the
window manager are currently being handled by the client.

_MOTIF_WM_MENU
This property is used by Motif clients to customize the Control menu of the top-level window.
New menu items are added to the end of the menu.
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WM_COLORMAP_WINDOWS
This property is a list of the IDs of windows that may need colormaps installed that differ from
the colormap of the client�s top-level window. The window manager will watch this list of
windows for changes in their colormap attributes.

_SUN_DRAGDROP_INTEREST
VWM looks for this property on any top-level window, and sets a corresponding SITE_FORWARD
property on any associated icon window to allow Open Windows drag and drop to VWM icons.

Properties set by the window manager
The following properties are set and maintained by VWM, and are available for reference by
clients.

WM_ICON_SIZE
If the Motif Hints option is enabled, VWM sets this property on the X root window, and clients
should read this property and provide an icon pixmap of an appropriate size as part of the
WM_HINTS property described above. Icons of a larger size will be truncated.

_MOTIF_WM_INFO
If the Motif Hints option is enabled, VWM sets this property on the X root window, which
provides MWM-specific information to Motif clients. The property contains a flags field and a
window ID. The Vision Window Manager sets the MWM_INFO_STARTUP_STANDARD value in the
flags, and specifies the ID of the root window.

WM_STATE
This property is maintained by the window manager for top-level client windows. It specifies the
current state of the window, and is intended for communication between the window manager
and a session manager.

VWM functions
The functions supported by the VWM window manager are shown in the following table. These
are a subset of the functions provided by the Motif window manager MWM. Refer to the Motif
Programmer�s Guide - MWM for more details.

Function Description

f.beep Causes a beep to sound.
f.circle_down Puts a window on the bottom of the stack.
f.circle_up Puts a window on top of the stack.
f.kill Terminates a client.
f.lower Lowers a window to the bottom of the stack.
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Function Description

f.maximize Enlarges a window to its maximum size.
f.minimize Changes a window into an icon.
f.move Enables the interactive moving of a window.
f.next_cmap Installs the next colormap in the window with the colormap focus.
f.nop No operation performed.
f.normalize Displays a window in normal size.
f.prev_cmap Installs the previous colormap in the window with the colormap focus.
f.raise Lifts a window to the top of the stack.
f.raise_lower Raises a partially concealed window; lowers an unconcealed window.
f.refresh Redraws all windows.
f.refresh_win Redraws a client window.
f.resize Enables the interactive resizing of windows.
f.separator Draws a line between menu commands.

f.title Inserts a command into a menu at a specified position.

Using Motif
The Motif GUI was developed by the Open Software Foundation (OSF) and has been
implemented by a number of companies on a range of hardware and operating systems. A Motif
Window Manager (MWM) that runs on the PC is supplied with the Vision X Server.
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Motif and the X Server
Motif applications can be displayed on a PC using the X Server in either multiple-windows mode
or single-window mode.

In multiple-windows mode, the client windows are managed by the Vision Window Manager
(VWM) and have a Microsoft Windows look and feel. (See �Vision Window Manager� earlier in
this chapter for details.) VWM and MWM have a very similar look and feel and VWM has a
number of features specifically for Motif compatibility, for example the Lower command and the
recognition of Motif Hints. Consequently, the use of VWM does not greatly affect the
appearance of applications to a user familiar with the Motif Window Manager. The main
difference is that VWM does not process resource files or RESOURCE_MANAGER properties.

If you want a Motif environment that is the same as a workstation, then you should use the X
Server in single-window mode and run the Motif Window Manager (MWM). A local MWM
that runs on the PC is supplied with the Vision X Server, and normally you would use this.
However, you may use a host-based MWM instead if you wish.

About local MWM
The local MWM is not installed if you choose Typical Setup. Either choose Custom Setup at
installation time, or add local MWM later using Maintenance Setup.

To improve performance and to allow the local MWM to be used without TCP/IP installed, a
special Local transport is used to communicate between MWM and the X Server.

The following changes from the standard configuration have been made to the mwmrc.txt
configuration file (see �Configuring MWM�). Changes to keyboard shortcuts have been made
because Microsoft Windows will by default obtain the input from many of the Motif shortcuts.

Default window menu
The CTRL modifier has been added to accelerators so that anything that was previously
ALT+�key� is now CTRL+ALT+�key�.

Resource changes
Opaque move is turned on by default to improve performance.

Default key bindings
ALT+SPACEBAR is now CTRL+ALT+SPACEBAR

ALT+TAB is now CTRL+ALT+TAB

ALT+SHIFT+TAB is now CTRL+ALT SHIFT+TAB

ALT+ESC is now CTRL+ALT+n

ALT+SHIFT+ESC is now CTRL+ALT+p
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ALT+F6 is now CTRL+ALT+F6

ALT+SHIFT+F6 is now CTRL+ALT+SHIFT+F6

ALT+SHIFT+Delete is now CTRL+ALT+SHIFT+d

Starting the local MWM
If you want to use the local MWM, then you should configure the X Server in single-window
mode. In the Advanced Single-Window Mode dialog box, you can enable Launch Local Motif
Window Manager at Startup so that the local MWM is started when the X Server starts. You can
also start the local MWM manually.

To start the local MWM manually

4 When the server is running in single-window mode, click the Control menu and then click
Close. If the server is in full-screen mode, press ALT+SPACE to display the Control menu.

If a window manager is already running, the Start Local MWM command will be grayed.

Starting a host-based MWM
If you want to use a host-based MWM, then you should configure the X Server in single-window
mode.

The simplest way to start MWM is from an xterm window. You can use Remote Program Starter
to start an xterm. Then when the xterm window appears inside the X Server window, type the
command to start the window manager at the system prompt:

mwm &

Do not attempt to start MWM when the X Server is in multiple-windows mode, since a window
manager is already running.

Quitting a Motif Session
Normally MWM is terminated when the X Server is closed. You can terminate the window
manager manually by choosing Quit from the root menu. (Note that the contents of the root
menu are configurable, so Quit may not be available at your site.) Quitting MWM will not close
down any other applications so these should be closed before terminating the window manager.

Configuring MWM
MWM is configured from its resource database, which is built from various sources. They are
listed in order of precedence, low to high, with the local MWM file first, followed by the UNIX
equivalent in brackets.
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RESOURCE_MANAGER root window property

\Program files\Vision\User\Xdefault.txt ($HOME/.Xdefaults)

\Program files\Vision\User\Xdef-lcl.txt ($XENVIRONMENT or $HOME/.Xdefaults-host)

mwm command line options

The pathnames shown represent the customary locations for these files on Windows 95 or NT
4.0.

Entries in the resource database may refer to other resource files for specific types of resource.
For local MWM, the file \Program files\Vision\User\Mwmrc.txt ($HOME/.mwmrc on UNIX)
contains menu definitions and key bindings.

Using OPEN LOOK
The OPEN LOOK UI is not a piece of software. Rather it is a specification for the look and feel
of a windowing environment for a multi-tasking computer system. OPEN LOOK has been
implemented by a number of companies on a range of hardware and operating systems, for
example, OpenWindows from SunSoft, Inc. and the AT&T OPEN LOOK Graphical User
Interface. The illustrations and examples in this section feature OpenWindows Version 3.4.

OPEN LOOK and the X Server
OPEN LOOK applications can be displayed on a PC using the X Server in either multiple-
windows mode or single-window mode.

In multiple-windows mode, the client windows are managed by the Vision Window Manager
(VWM) and have a Microsoft Windows look and feel. Many users prefer multiple-windows
mode, since using local window management improves performance.

If you want an OPEN LOOK environment that is the same as a workstation, then you should use
the X Server in single-window mode and run the OPEN LOOK Window Manager (OLWM).

The OPEN LOOK File Manager application can be used to provide a graphical display of the
UNIX file system. Files and directories are represented as icons. File Manager can be used for all
standard file manipulation procedures, including the opening, moving, copying and deleting of
files. Applications can be started from File Manager.

Limitations
When using OpenWindows it is not possible to access the Help handbooks as these require
display of PostScript. The man pages can be used as an alternative. In order to access these you
must ensure that the MANPATH environment variable includes the $OPENWINHOME/man
directory.
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Configuring the X Server for using OLWM
In order to use the OPEN LOOK Window Manager with the X Server you must make a number
of changes to the default server configuration.

To configure XVision for using OLWM

1 Set the X Server to single-window mode.
2 If you are using a VGA display, turn off Windows System Colors.
3 Most OPEN LOOK applications expect a three-button mouse whereas most PCs are fitted

with a two-button mouse. If you need to use the ADJUST mouse button, you must ensure
that Middle Button Emulation is turned on.
If your mouse buttons have been remapped within the OPEN LOOK system, then the middle
button emulation will reflect this mapping.

4 If your OPEN LOOK applications do not display completely within your server window, you
should set the size of the Virtual Root to match that of your workstation monitor and enable
Scroll Bars so that the visible area of the workspace can be moved.

5 If you wish to mimic the special keys found on certain workstation keyboards, for example
the Front or Open keys on a Sun keyboard, you will need to create a new keymap.
For details of how to create a new keymap file look up �X keymaps, creating� in the Help
index.

6 Make sure that your host on which you want to run OLWM is visible within Host Explorer.
Note that the command for starting the OPEN LOOK Window Manager is normally olwm,
although this may be different for the specific implementation you are using. Consult the
documentation for the specific version of OPEN LOOK if you require further information.

For more information on configuring hosts, look up �hosts, configuring� in the Help index.

Configuring your host environment
The host configuration required to run OPEN LOOK will depend on the particular version in
use at your site. Typically you will need to set one or more environment variables and ensure
that the directories which contain the OPEN LOOK files are in your path. For example, when
using OpenWindows you should set the environment variable OPENWINHOME to point to
your main OpenWindows directory and this directory and the corresponding /bin subdirectory
should be included in your PATH variable.

For details for your specific version of OPEN LOOK, see your System Administrator.

Starting the OPEN LOOK Window Manager
If you want to use the OPEN LOOK Window Manager, then you should configure the X Server
in single-window mode, as described in �Configuring the X Server for Using OLWM.�
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The simplest way to start OLWM is from an xterm window. You can use Remote Program
Starter to start an xterm. Then when the xterm window appears inside the server window, type
the command to start the window manager at the system prompt:

olwm &

Do not attempt to start OLWM when the X Server is in multiple-windows mode, since a
window manager is already running.



6Starting X Programs

This chapter discusses the various methods of starting X applications.
It includes details of how to start an X session over a serial line or
modem.
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Starting X programs overview
There are several different ways of starting X applications that run on a UNIX system and
display on your PC. If you are using a network transport, then you can use the Unix Application
Wizard to set up a document that contains all the settings required to open the application.
Alternatively, you can use the Remote Program Starter to run an X client, or you can start a
client from a terminal emulator.

There are ways of starting an X session that runs a pre-configured selection of X applications.
You can place Remote Program Starter settings files in the Windows StartUp folder, or in a
Zones StartUp folder. For a network connection, you can use the standard xdm display manager
to start a session. If you are using a serial transport, the only way of running the first X client is
to start an XRemote session. If Vision Resume is in use at your site, you can suspend an X
session and clients will be restarted automatically when the session is resumed.

Using the Unix Application Wizard
The Unix Application Wizard can be used to create a settings document that allows you to start a
UNIX application. The following types of document can be created if the necessary Vision97
components are installed:

• A Remote Program Starter document for an X application.
• A terminal emulator document for a character-based application (VT420, ANSI or Wyse 60).
• A Remote Program Starter document for a UNIX application that does not require a user

interface, such as a server program or network daemon.

For Windows 95 and NT 4.0, the wizard will either add the application to the Unix Programs
menu on the Start menu, or create a new item on the desktop or in a folder, depending on how
you started the wizard. You can also include Remote Program Starter documents in your Web
pages and thereby start X applications directly from a Web browser (see �Remote Program
Starter documents� in the Executing Remote Programs chapter).

To create a new settings document

1 Do one of the following:
§ If you want the application to appear on the Start menu, click the Start button, and then

click New Unix Program.

§ If you want the application to appear on the desktop or in a folder, click with the right
mouse button where you want the item to appear, click New, and then click Unix
Program.

§ For older versions of Windows NT, open the Vision group in Program Manager and
double-click the New Unix Program icon.
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2 Follow the wizard�s instructions, choosing the host and the command to be executed. You
can use the Browse button to find the executable file you want.
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3 You are asked to choose the type of program. �Other� means a UNIX program that does not
require a user interface.

4 The wizard asks if you want to test the application. Be sure that the command will not make
unwanted changes on the host system before you execute it.
If the application is an X client or �other�, then the Host Replies window is displayed to
show status messages including any error messages produced by the host operating system.
The X client should then appear.
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5 If the command produces an error, it will be displayed by the wizard. For most common
errors you can select the error in the list box and click the Help button for assistance with
that specific problem. You can click the Back button to return to previous settings, and then
try executing the program again.

6 The wizard prompts you for an application name, which is used as the name of the settings
file.

The Unix Application Wizard creates either a Remote Program Starter document (.rps) or a
terminal emulator document (.v42, .ans, .w60). If you ran the wizard from the Start menu, then
the application is added to the list of UNIX programs on the Start menu. If you ran the wizard
from the desktop, then a new icon appears. If you ran the wizard from inside a folder, then the
settings document appears in the folder.

Using Remote Program Starter
The Remote Program Starter can be used to start X applications (see the �Executing Remote
Programs� chapter). The Remote Program Starter can be started from the Start menu or Program
Manager, or settings documents can be created and used in your Web pages or placed as icons on
the Windows desktop or in a Program Manager group.
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To start an X application from Remote Program Starter

1 Do one of the following:
§ Click the Start button, and then click Run Unix Program.
§ Click the Start button, point to Programs, point to Vision, point to Accessories, and then

click Program Starter.
§ For older versions of Windows NT, when the X Server is in single-window mode, click

Run on the Control menu.
§ For older versions of Windows NT, open the Vision group in Program Manager, then

double-click the Program Starter icon.
A new Remote Program Starter window appears.

2 In the Host box, type a host name or choose a host from the drop-down list.
3 In the Command box, enter the command to be executed on the host system. The drop-down

list allows you to choose from the last five previously-used commands.
For a UNIX system the command syntax is similar to what you would type at the system
prompt on the remote system, except that you do not type an ampersand (&) to indicate that
the process should run detached from a terminal. For an X application you do not need to
type -display since by default the DISPLAY environment variable is set automatically.
Alternatively, click the Browse button. If the Host box is empty, all the configured hosts will
be displayed. If you specified a host in the Host box, then the contents of your home
directory on that host will be displayed. Browse the host until you find the program or shell
script you want to execute.

4 If you want to change other settings, choose a command from the Properties menu. The
Display, Size and Color properties are not relevant unless you are running an X application.

5 Click Run.

The X application will start in a few seconds. If you enabled the Start XVision option, then the
X Server will be started automatically if necessary and will run in either a specified profile or
start the first one it encounters. For further information on profiles, look up �server profiles� in
the Help index.
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For full instructions on using Remote Program Starter, click Help Topics on the Help menu. The
same information can be seen by choosing How To Use Remote Program Starter from the main
Vision Help Contents.

Using a terminal emulator to start X
clients
The most reliable method of starting an X client on a server is to log in to the host operating
system from an ordinary terminal or a terminal emulator and then run the client from the system
prompt.

To start an X client from a terminal emulator

1 Do one of the following:
§ Click the Start button, point to Programs, point to Vision, and then click either ANSI

Emulator, VT420 Emulator, or Wyse 60 Emulator.
§ For older versions of Windows NT, open the Vision group in Program Manager, then

double-click either the ANSI Emulator, VT420 Emulator, or Wyse 60 Emulator icon.
2 On the Session menu, click Connect.
3 In the Host box, type a host name or choose a host from the drop-down list.
4 In the Command Line box, enter the command required to start a UNIX shell, for example

csh.
The connection process begins, and if this is the first time you have connected to the host you
will be prompted to enter a username and password. A dialog box shows status messages
during the connection process, and then the UNIX system prompt appears in the window. If
the automatic connection mechanism does not work, try again without entering anything in
the Command Line box. This inhibits automatic login, and after the connection has been
opened the UNIX login program will be run, which will prompt you for username and
password before starting your default login shell.

5 When the system prompt appears, type the command required to run the X client on your
display (see �Starting Clients from the UNIX System Prompt�). If the DISPLAY environment
variable has not been configured on the host, then be sure to add the -display switch. For
example, nohup xterm -display stevel:0 &.

The X client should appear on your PC screen.
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Alternatively, you enter the command required to start the X client directly into the terminal
emulator�s Command Line box when opening the connection.

If you are unable to connect using the terminal emulator, look up �troubleshooting� in the Help
index.

Note  The X Server on your PC must be running before starting any X clients. If the server is
not running, click the Start menu, point to Programs, point to Vision and then click XVision
Server. For older versions of Windows NT, double-click the XVision Server icon in the Vision
group in Program Manager.

Starting clients from the UNIX system prompt
If the directory containing X clients is not in your PATH environment variable, you need to
specify the full pathname when typing commands. Depending on the version of UNIX, you may
need to use the nohup command to prevent clients being killed if you close the terminal
emulator connection.

There are two ways in which you can direct a client to use your PC as the X display device. You
can set the DISPLAY environment variable, or use the -display option.

By setting the DISPLAY environment variable you ensure that all clients will display on the
specified device. If you are using TCP/IP and use the C shell as your login shell, then the
command to do this is:
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setenv DISPLAY nodename:0

where nodename is the network node name of your PC as defined in the host names file (usually
/etc/hosts). For example:

setenv DISPLAY stevel:0

If you use the Bourne shell, then the commands are:

DISPLAY=nodename:0
export DISPLAY

You could include these commands in your login startup file, or enter them in the terminal
emulator window, as shown in the example below:

DISPLAY=stevel:0
export DISPLAY

When the DISPLAY variable has been set, you can run an X client simply by typing nohup
followed by the program name, followed by the ampersand character to force it to execute in the
background. For example:

nohup xclock &

Note  You must specify the pathname of the directory containing the clients if it is not specified
in the PATH environment variable.

An alternative to setting the DISPLAY variable is to use the -display option on the command line
when running an X client. Most clients accept this parameter, so that you could type a command
such as:

nohup xterm -display nodename:0 &

where nodename is the network node name of your PC. The -display nodename:0 parameter
specifies that the client should display on server zero of the nodename display. The ampersand
character forces the program to execute in the background. For example, to display on the PC
whose network node name is �stevel�:

nohup xterm -display stevel:0 &

When the xterm window appears on your PC, you can use it to start other clients.

Using X Display Manager
A display manager called xdm is supplied with the X Window System to provide a standard way
for users to log in to a UNIX system and start an X session. If you are using a different
proprietary display manager, see the documentation provided with your operating system.

xdm normally runs as a daemon on a UNIX system, and uses the X Display Management
Control Protocol (XDMCP) to interact with remote servers. Its purpose is to prompt the user to
log in, validate the username and password, and then start an X �session.� One of the clients
started for the session is treated as a session manager, and the session lasts until this process
terminates. xdm then closes any remaining X clients and either resets or terminates the server.
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X Server and XDMCP
The X Server supports XDMCP, but whether or not you can use it depends on the type of
network you are using. The network must support the User Datagram Protocol (UDP) and the
Broadcast service. This restricts it to TCP/IP networks.

If you want to use XDMCP, then it must be enabled in the server (see �Configuring the X Server
for X Display Manager� later in this section).

In addition to defining the interaction between a server and a display manager, XDMCP
implements the User Access Control method of controlling what clients are allowed access to the
display. Refer to �Using XDMCP Security� in the �Using the X Server� chapter for details.

Configuring the X Server for X Display Manager
When you install the X Server using Custom Setup, you are prompted whether XDMCP
Broadcast should be enabled. This prompt is not displayed by Typical Setup and the default is for
XDMCP to be disabled. To use X Display Manager, you need to enable XDMCP in the server
profile.

To enable XDMCP

1 Click the Server icon with the right mouse button, and then click Properties.
2 Click the Security tab.
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3 Click XDMCP so that a check mark appears.
4 Under XDMCP, click the required mode.

If you are using Direct or Indirect mode, type the name of the host to be used in the Hosts
box, or choose one from the drop-down list.

5 If you wish to use the XDM-AUTHORIZATION-1 security mechanism, then you should have
entered your key in the Key box in the Global Settings tab in the XVision Profiles dialog box.

The value of the key option should be obtained from your System Administrator, who will
also require the value of Display Id. These values must not be changed once they have been
registered. If the Key box is left empty, the MIT-MAGIC-COOKIE-1 security mechanism will be
used. Refer to �Using XDMCP Security� in the �Using the X Server� chapter for details.

6 Click Advanced to specify any further options required.

Configuring X Display Manager on UNIX
If xdm is in regular use at your site, then the System Manager for your UNIX system will
normally ensure that the program is started at system boot time. By default, xdm runs as a
daemon in the background.

The operation of xdm can be configured by specifying resources in the
/usr/lib/X11/xdm/xdm-config file. Some of these resources specify other control files, such as the
access control file and the resource database mentioned in �Starting an X Display Manager
Session.� The System Manager for your UNIX system may wish to change these files.
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You may like to look at the file /usr/lib/X11/xdm/Xsession which is the default session program.
This script will be executed for each user after a successful login. Only the System Manager
should change this file. To allow each user to have a different session, the Xsession script
normally executes /home/.xsession if that file exists. If that file does not exist, Xsession should
start a default session which usually consists of the twm window manager and an xterm.

Creating .xsession
Create a .xsession file in your home directory using a text editor. The file should contain
commands to start clients, using the same syntax that you would use to start clients from a shell.
You should run all clients except the last in the background. The last client listed should be the
program you want to use as the session manager, and this should be run in the foreground.
When this client exits, the xdm session is terminated.

If you are using the X Server in multiple-windows mode, your session file must not attempt to
start a window manager as the session manager. If you tried to do this, the window manager
would not be allowed to run and so the session would be terminated. If you want to run a host-
based window manager, set the X Server into single-window mode.

The sample session file below starts three clients. Note that the DISPLAY environment variable
is automatically set by xdm to pc-name:0.0 where pc-name is the network address of your PC.

#!/bin/csh
# SCO XVision
# Sample session file for use with X Display Manager
# or with NCD XRemote.
# Author: Steve Lewis  Date: 1-Jul-1993
#
# Use this file to start clients at the start of an xdm
# or Xremote session.
# All clients except the last should be run in the background.
# The last client started is the "session manager" and must run
# in the foreground.
# Note that the DISPLAY variable is set by xdm or Xremote.
#
xclock -g =80x80-0+0 -display $DISPLAY &
xbiff -g 40x40-100+150 -display $DISPLAY &
# This xterm runs in the foreground and the session
# terminates when you close it.
xterm -display $DISPLAY -ls

Hint  To use this file, display this page in Help, choose Edit Copy from the Help window, copy
the text to a Notepad file, then File Transfer the file to your UNIX system.

If you also use XRemote to log in and start an X session (see �Using NCD XRemote�), then you
can make the XRemote environment identical to the xdm environment by copying your
.xsession file to .xinitremoterc (the startup file for XRemote), or by setting the XINITRC
variable to point to the .xsession file.

Note  The .xsession file must be made executable. For example:

chmod +x .xsession
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Xdm ping interval
xdm pings the server at regular intervals, to ensure that it is still accessible. If the server does not
respond, xdm declares the session terminated. This may cause a problem if you are using a
MS-DOS compatibility window, or if the server is very busy. The UNIX System Manager can
prevent xdm from pinging the server by setting the DisplayManager.DISPLAY.pingInterval
resource to 0.

xdm Log Files
By default, the xdm program and the various scripts and programs run during the session write
error messages to the system console. However, there may be an entry in the xdm-config file to
set the DisplayManager.errorLogFile resource. Typically, this is set so that errors are written to
the file /usr/lib/X11/xdm/xdm-errors.

It is possible that the Xsession script may redirect errors that occur while starting the session to a
file in the user�s home directory, for example /home/.xsession-errors.

Starting an X Display Manager Session
When XDMCP is enabled, the X Server will place a message on the network when it starts or is
reset. The type of message is either Direct, Indirect or Broadcast, as specified in the Security
Properties dialog box. The way xdm responds depends on the type of message, as described in
the following sections.

Checking access authority
When the X Server makes an XDMCP request, the response is determined by the XDMCP
access control file on the host, normally called /usr/lib/X11/xdm/Xaccess. For a Direct or
Broadcast query, xdm checks whether the PC is allowed access to this machine. It looks at the
Direct/Broadcast type entries in the Xaccess file (which may contain wildcards for pattern
matching) and the first entry matching your PC�s network node name determines the response. A
matching entry may allow or disallow access, and access is not allowed if no match is found.

For an Indirect query, your PC�s network node name must match an Indirect type entry in the
Xaccess file (which may include a pattern). An Indirect type entry may specify a single host, or a
list of hosts from which display management services are requested. Alternatively, Indirect
entries may specify that xdm should run chooser to offer a menu of hosts to connect to (see
�Choosing a Willing Display Manager�). An entry that specifies chooser may include a list of
hosts, or it may tell chooser to broadcast to find willing display managers.

Choosing a willing display manager
For a Broadcast query, xdm responds with a message saying it is willing to manage the display. If
the Select First Manager option in the XDMCP Advanced Settings dialog box is enabled, then
the first manager to respond will be asked to manage the display. Otherwise, the X Server
displays the Display Manager Selection dialog box to allow you to choose from a list of willing
display managers.
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For an Indirect query, if the chooser is specified in the Xaccess file (see �Checking Access
Authority�), then you should enable the Select First Manager option in the XDMCP Advanced
Settings dialog box so that the Display Manager Selection dialog box does not appear. The
chooser will display its own list of willing display managers, and you should select one and
choose the Accept button. (To have both the X Server�s Display Manager Selection dialog box
and the chooser window displayed is rather confusing.)

If chooser is not used for Indirect queries, then you should disable the Select First Manager
option so that the X Server�s Display Manager Selection dialog box will be displayed to allow
you to choose a display manager.

The appearance of the chooser window can be controlled by resources in a file which by
convention is named /usr/lib/X11/xdm/Xresources. For example, it may be necessary to specify a
smaller initial window size and smaller fonts if you are using a VGA display. Only the UNIX
System Manager should change this file.
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Logging in
When xdm is ready for you to log in, it displays a dialog box for you to enter your username and
password.

Note  The xdm login box is an X client, not a Windows dialog box. Therefore, you must press
ENTER to move between fields, not TAB as you would expect for a Microsoft Windows
application.

The appearance of the login dialog box can be controlled by resources in a file which by
convention is named /usr/lib/X11/xdm/Xresources. Only the UNIX System Manager should
change this file.

Starting the session
When xdm has authenticated your login, it may then run a startup program which is typically a
shell script, for example to mount remote file systems or display the message of the day. The
default is not to run a startup program.

Next, a program is run to start your X session. By default this is a script called
/usr/lib/X11/xdm/Xsession. Normally, this script will look in your home directory for a file
called .xsession which contains the programs you want to run for the session (see �Configuring
X Display Manager on UNIX� later in this chapter). If there is no .xsession file, then the
.xsession script should start a system default session, which may for example include a window
manager and a single xterm.

Window management
In multiple-windows display mode, the X clients appear within their own Microsoft windows,
and are managed by the local window manager VWM.
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If you are using the XVision Server in single-window display mode, then clients appear within
the XVision Server window. You need to run a window manager to allow you to move and
resize windows. You could use the local Motif window manager, or run a window manager on
the UNIX host system. If you regularly intend to run a host-based window manager, place the
relevant command in the .xsession file.

Quitting an X Display Manager session
An X Display Manager session ends when the session manager program is closed (see �X Display
Manager overview� earlier in this chapter). Any X clients still running on your display will be
terminated. Since any program can be designated as the session manager in the .xsession file, you
must remember which program has that function and be careful not to close it until you really
want the session to end.

If the One Session option in the XDMCP Advanced Settings dialog box is enabled, then the X
Server will be terminated. If this option is disabled, then the server will try to start a new session
using XDMCP.

Additional Sources of Information
X Window System User�s Guide for X11 Release 5 by Valerie Quercia and Tim O�Reilly, pub.
O�Reilly & Associates, Inc., 1993.

Using NCD XRemote
NCD XRemote allows you to run X clients on your PC over a serial line or modem connection.

XRemote requires a PC part and a UNIX part. The PC part is provided within a special X server
called the Serial Line X Server, and by elements of Vision Communications Architecture. The
UNIX part is provided within the X Services module of the Vision97 UNIX software, or may be
provided by a separate installation of NCD XRemote on the UNIX host.

The UNIX software includes a �proxy-server� called Xremote that appears to X clients to be an
ordinary X server running on the UNIX system; in fact it communicates with software on the PC
to pass messages to and from the X Server.

The UNIX software also includes a program called xinitremote that is used to start an XRemote
session (see �Starting an XRemote Session�). This program starts the XRemote proxy-server, and
then executes clients listed in a session file.

One of the clients started for the session is treated as a session manager, and the session lasts
until this process terminates. XRemote then closes any remaining X clients and closes the
connection.
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X Server and XRemote
The Serial Line X Server that contains support for XRemote can be installed by choosing Custom
Setup when installing Vision97 software on your PC and choosing the Serial Line X Server
(XRemote) option from the Select X Components dialog box. (The Typical Setup installs the
Network X Server.) If you want to add the Serial Line X Server to an existing installation, you
can do so using Maintenance Setup.

When you install the Serial Line X Server, a profile called XRemote is created. This contains the
setting Use XVision With a Serial Line in the Transport tab. It is possible to run the Serial Line X
Server and the Network X Server at the same time if necessary.

XRemote is intended for use over a direct RS232C serial line between your PC and a remote
host, or over a modem link. The Vision97 implementation can in fact be used over any transport
supported by Vision Communications Architecture, and so it could be used over a network. Note
the following considerations regarding the use of XRemote:

• The connection should normally be a full 8-bit connection. If you cannot provide an 8-bit
path, then installing Vision Services for UNIX on the host may allow a 7-bit connection to be
used.

• The telnet service is not suitable.
• XRemote sets the DISPLAY environment variable. Do not set DISPLAY explicitly in your

.cshrc file.

Refer to the chapter about setting up your Vision97 product on a PC for guidance about
choosing and setting up a modem for use with XRemote.

If Vision Resume is in use at your site, and you want to run a Resume session over XRemote,
refer to the �Suspending and Resuming a Session� chapter.

Configuring XRemote on the PC
After installing the Serial Line X Server, you may configure the XRemote profile to choose the
host on which the XRemote proxy-server will run. This host must previously have been
configured in the Vision Communications database (see �Configuring Hosts� in the �Vision
Communications Architecture� chapter). If you do not enter a host name, then you will be
prompted for a host when you start an XRemote session.
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Normally, you will be using XRemote to access a host over a serial line or modem, so you must
configure the serial transports and the host as described in �Using a Serial or Modem
Connection� in the �Vision Communications Architecture� chapter.

Note that by configuring the host to use Automatic transport selection, a mobile user could
obtain a consistent X environment by connecting to the host over a network while in the office,
or using a serial line while on the road. In both cases, XRemote would be used to provide the X
session, with the XRemote protocol running over the terminal connection provided by the
underlying transport. You would need to enable the Include this Transport in Automatic
Selection option in the properties dialog box for either the Modem or Serial-Com1 transport.

Installing XRemote on UNIX
The XRemote host software is available for a wide range of UNIX systems. It will be installed as
part of the X Services for UNIX module if it is available for your platform. Refer to the
/readme.txt file on the CD to find out whether XRemote is installed with X Services.

If the X Services module is not available for your platform, you may still be able to install
XRemote from the Vision97 CD. The Xremote directory on the CD contains files in an MS-DOS
compressed file format, with one file for each supported platform. The file
\Misc\Xremote\Readme.txt contains the file names along with the host computer and operating
system they support.
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To install XRemote separately from X Services

1 Using My Computer or File Manager, copy the XRemote file for your host from the
\Misc\Xremote folder on the CD to an empty folder on your PC.

2 Double-click the file name.
3 Using Unix Neighborhood, or another method of copying files, move the extracted file(s) to a

directory on the host computer. Be sure to use a binary copying method.
4 Remove the files from the tar file with the following UNIX command:

tar -xvf filename

5 Place the files extracted from the tar file (Xremote, xinitremote) in a suitable directory for
end users to access such as /usr/local/bin.
Note that superuser privilege may be required.

6 Change the permissions on the Xremote and xinitremote files. Provide execute permission for
the group or others as you desire. For example, to allow XRemote use by anyone on your
system, type:
chmod 0555 Xremote xinitremote

The installation of XRemote is now complete. There is no need to start xinitremote or the
Xremote program. These programs are started automatically by Vision Communications when an
XRemote connection is opened.

Configuring XRemote on UNIX
Each XRemote user on UNIX should check that the XRemote files are accessible from their
environment, and set up a .xinitremoterc startup file.

The search path
The directory containing xinitremote should be included in the PATH environment variable.
The UNIX System Manager should have placed the files in a directory that is normally in the
PATH. If you want to check, type �env | more� at the UNIX system prompt, and look for the
PATH variable. Ask your UNIX System Manager to configure your PATH if necessary.

Creating .xinitremoterc
When an XRemote session starts, xinitremote looks for a file called .xinitremoterc (note the dot)
to run as a shell script to start up client programs. If no such file exists, xinitremote will use the
following as a default:

xterm -geometry +1+1 -n login

Your UNIX System Manager may choose to create a global session file for use by all XRemote
users (see example file below). The file should be called .xinitremoterc and should be placed in
the same directory as xinitremote. Each user required to use this file should have the XINITRC
environment variable set up to point to the global file. By default, if XINITRC is not specified in
the user environment, .xinitremoterc in the home directory will be used.
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If you want to create a .xinitremoterc file in your home directory, use an ASCII text editor. The
file should contain commands to start clients, using the same syntax that you would use to start
clients from a shell. Do not include too many clients, so that you get a fast start up. You should
run all clients except the last in the background. The last client listed should be the program you
want to use as the session manager, and this should be run in the foreground. When this client
exits, the XRemote session is terminated.

If you are using the X Server in multiple-windows mode, your session file must not attempt to
start a window manager as the session manager. If you tried to do this, the window manager
would not be allowed to run and so the session would be terminated. If you want to run a host-
based window manager, set the server into single-window mode.

Note that if you run a session manager, and the session manager itself starts a large number of
clients, your XRemote session may take a long time to start.

The sample session file below starts three clients. Note that the DISPLAY environment variable
is automatically set by xinitremote to net:1 where net is the network address of the host on
which the helper process is running. You must not explicitly set the DISPLAY variable in your
.cshrc file.

#!/bin/csh
# SCO XVision
# Sample session file for use with X Display Manager
# or with NCD XRemote.
# Author: Steve Lewis  Date: 1-Jul-1993
#
# Use this file to start clients at the start of an xdm
# or Xremote session.
# All clients except the last should be run in the background.
# The last client started is the "session manager" and must run
# in the foreground.
# Note that the DISPLAY variable is set by xdm or Xremote.
#
xclock -g =80x80-0+0 -display $DISPLAY &
xbiff -g 40x40-100+150 -display $DISPLAY &
# This xterm runs in the foreground and the session
# terminates when you close it.
xterm -display $DISPLAY -ls

Hint  To use this file, display this page in Help, choose the Copy command (Edit menu) from
the Help window, copy the text to a Notepad file, then use Unix Neighborhood to copy the file
to your UNIX system.

If you normally log in to the same host locally using Ethernet, and you use xdm display manager
(see �X Display Manager overview� earlier in this chapter), then you can make the remote
environment identical to the local environment by copying your .xsession file as the startup file
for XRemote, or by setting the XINITRC variable to point to the .xsession file.

Note  The .xinitremoterc file must be made executable. For example:

chmod +x .xinitremoterc
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XRemote log file on UNIX
The XREMOTETMPDIR variable can be set to the directory for the log file for all stdio library
output from the XRemote helper and all the clients run by the .xinitremoterc script. The log file
is called Xremote<n> where <n> is the display number.

If there is no XREMOTETMPDIR variable, the TMPDIR variable is consulted for the name of
the directory in which to create the log file. If neither variable is present, the log file is created in
the /usr/tmp directory.

Version numbers
To display the version number of the host-resident helper program and the startup program, use
the what command. For example, on SunOS it looks like:

% what Xremote xinitremote
Xremote:
        Copyright 1993 Network Computing Devices, Inc.  All rights reserved.
        NCDware version 4.0.115 Xremote
        main.c,v 15.20.8.2.6.1 1994/12/22 02:17:18 dct Exp $
        compress_lzw.c,v 14.13.12.1 1994/08/03 00:38:28 mse Exp $
        bytestream.c,v 15.22.8.1.6.1.2.1 1995/01/20 22:29:54 mse Exp $
xinitremote:
        Copyright 1993 Network Computing Devices, Inc.  All rights reserved.
        NCDware version 4.0.115 xinitremote
        xinitremote.c,v 15.13.16.1 1995/02/10 18:57:35 jag Exp $
%

Starting an XRemote session

To start an XRemote session

1 Run the X Server and specify the XRemote profile.
If you installed only the Serial Line X Server, then the XRemote profile is the default profile
chosen when you start the X Server. If you installed the Serial Line X Server alongside the
Network X Server, then you can enable the Prompt For a Profile to be Used option in the
General tab of the XVision Profiles dialog box. When you start the X Server, choose
XRemote from the list of available profiles.
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2 If an XRemote Host has not been specified in the X Server profile, then you will be prompted
to choose one. If the profile specifies the XRemote host, then you will not see this dialog box.

If you want to set this XRemote Host name in the X Server profile, click the check box.
3 If you are connecting using the Modem transport, then you will always be asked to enter a

username and password. The Modem transport does not allow usernames and passwords to
be stored.

4 If you are using the Modem transport, then you will be prompted for a phone number. Any
phone number specified  for the transport or host will be displayed as a default.

A connection is opened to the UNIX host, using the transport specified for that host in the
Vision Communications Database. After logging in, the XRemote startup program called
xinitremote is run. This starts the Xremote helper process, and then tries to execute a session file
that specifies the X clients to be run. It looks first for a file referenced by the XINITRC
environment variable. If this is not found, it looks for a file in the user�s home directory called
.xinitremoterc, and then, if this is not found, it looks for a file called .xinitrc (compatible with
older versions of XRemote). If none of these exists, a single xterm is started using the command:

xterm -geometry +1 +1 -n login
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If the XRemote session fails to start, then, for a serial connection, use the Connection Monitor
window to view the process of establishing the connection, logging in, and running the startup
program. Look up �troubleshooting� in the Help index for details.

Quitting an XRemote session
If you have set up a session file like that described in �Creating .xinitremoterc�, you can quit
XRemote by quitting or killing the last client listed in the session file. If you did not set up a
session file, then closing the first xterm displayed by XRemote will kill any other clients and end
the session.
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This chapter describes Vision Resume which allows you to suspend an
X session and resume it at a later time.
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Vision Resume overview
Vision Resume allows you to suspend an X session and resume it at a later time. The main
features are:

• X clients that are part of a Resume session actually run via a �proxy-server� on a UNIX host.
• The proxy-server communicates with an X display to show output and receive user input.
• A session can be suspended at any time either by user action, or through an unscheduled

event such as communications failure. The X clients that are part of the session continue to
run on the proxy-server.

• When a session is resumed, the X clients that were previously running reappear on the X
display and you can continue to work with them.

• There is only one Resume session for a UNIX user, so a session can be resumed on the same
display or a different display.

• An X session can be relocated to a different display at any time.
• You can use Vision Resume with a network connection or with a serial or modem connection.

For a serial or modem connection, Vision Resume may be run over an XRemote transport.

How Vision Resume works
Vision Resume software for UNIX includes a �proxy-server� which consists of two programs
called tpproxy and tpwatch. The proxy-server appears to X clients to be an ordinary X server
running on the UNIX system; in fact it communicates with an X display to show output and
receive user input. The standard X protocol is used between the proxy-server and the X display,
but the X server running on the display must include a proprietary X extension to support
Resume.

The UNIX software also includes a program called xresume that is used to control a Vision
Resume session (see �UNIX Commands� in the Appendices). A graphical user interface to this
program is supplied which allows you to carry out the basic functions of starting, stopping,
suspending, resuming or relocating a session (see �Controlling a Vision Resume Session�).

When a Vision Resume session starts, clients listed in a session file are executed. Further clients
can be started through the graphical user interface, or directly from an xterm started as part of
the session.

The Resume session lasts until it is terminated by user action.
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Configuring Vision Resume in XVision
Eclipse
For XVision Eclipse, Vision Resume is configured by changing the properties for an X Server
profile. You can display properties either using Windows Control Panel, or for the current X
session by using the X Server�s Control menu. By default the option to use Vision Resume is
disabled.

To configure Vision Resume in an X Server profile

1 In the X Server properties dialog box, click the Vision Resume tab.

2 Choose the Use Vision Resume option.
3 In the Resume Host box, choose the host on which the Vision Resume proxy-server will run.

If you leave this box empty, then you will be prompted for a host when you start a Resume
session.

4 Choose the Let XVision Automatically Manage My Resume Session option if you want a
Resume session to be started automatically when the X Server starts.

5 Click OK or Apply. If Let XVision Automatically Manage My Resume Session is enabled,
then a Resume session is started.
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Configuring Vision Resume on UNIX
It may be necessary to configure environment variables so that the Vision Resume files are
accessible on UNIX. Vision Resume uses a session file to automatically start clients at the
beginning of a new session, and the System Administrator may want to set up a global session file
or allow each user to create their own.

Configuring the environment
The directory containing xresume should be included in the PATH environment variable. The
installation process may already have ensured this by placing a link to this program in a location
such as /usr/bin. Alternatively, the directory containing xresume, for example /usr/local/vision/
bin, may be added to the user�s PATH. Other Vision Resume executables are started by xresume,
which looks for them in the directory specified by VISION_BINDIR, configured in
/etc/vision.conf.

If the C shell is used as the login shell, then environment variables should be set up in
$HOME/.cshrc for each user.

Note  Vision Resume sets the DISPLAY environment variable. Do not set DISPLAY explicitly in
your .cshrc file.

Vision Resume session file
When a Vision Resume session starts, xresume looks for a file called $HOME/.tpsession (note
the dot) to run as a shell script to start up client programs. If no such file exists, it looks for a
global session file called $VISION_ETCDIR/default.tpsession. (The value of VISION_ETCDIR
is defined in the /etc/vision.conf file, normally as /usr/local/vision/etc.) If no session file is found
then no clients will be started automatically.

The default.tpsession file installed with the Vision97 software contains instructions to start an
xterm, which contains a login shell with the DISPLAY variable set to the proxy-server display so
that all clients launched from that xterm will also default to running on the proxy-server. The
System Administrator can edit default.tpsession to start other clients, giving all users of the
UNIX host the same default X session. The commands used to start clients should use the same
syntax that you would use to start clients from a shell. Do not include too many clients, so that
you get a fast start up. You should run all clients in the background, which means that there must
be an ampersand (&) at the end of each command line.

If you want to create a .tpsession file in your home directory, copy default.tpsession and rename
it, then use an ASCII text editor to edit the file.

Note  The default.tpsession and .tpsession files must have execute permission. For example, to
give a file execute permission you would type chmod a+x $HOME/.tpsession.

In some versions of UNIX, for example SCO OpenServer Release 5, the PATH variable may not
be set up to include X client directories. You may need to include full pathnames in the session
file, for example /usr/bin/X11/xterm.
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Vision Resume Domain Name Usage
Vision Resume stores the display name of the proxy server in a local temporary file. The format
of this name can be determined by the user by setting the environment variable
RESUME_HOST_FORMAT to one of three values

Option Meaning

- f(ull) The fully qualified name is used e.g. bucks.sco.com:1. This is the default
option.

- s(hort) A non-qualified name is used e.g. bucks:1
- n(umeric) An IP code is used e.g. 192.102.82.120:1

For well-behaved systems the fully qualified name is the most appropriate. Unfortunately some
systems have problems with resolving these names (for example SunOS 4.1.3 systems have
known problems in this area) and this can mean that attempting to start a client displaying to the
proxy server will cause an error saying it cannot find the proxy display. In this case use of the
short form may well solve the problem as long as the client is running on the same local network
as the proxy server. If, however, it is on a remote network then the best fallback is the numeric
form that will always work but is not as informative to the user.

Vision Resume log files
The proxy-server programs tpproxy and tpwatch generate log files called $HOME/.tpproxylog
and $HOME/.tpwatchlog respectively. If the RESUME_DEBUG environment variable is set
( =1 ) in the environment within which the xresume command is executing, then a modest
amount of information will be written to these log files. If it is unset ( =0 ) then very little
information is written to these files. You can set the variable from your shell startup file (e.g.
.profile), or .cshrc, or in vision.conf. Changing the variable will not affect logging from a proxy-
server that is already running, so you need to terminate and restart the Vision Resume session.

Controlling a Vision Resume session
A Vision Resume session can be controlled using a graphical user interface to the xresume
program. For XVision Eclipse, the user interface is the Vision Resume Session Control dialog
box provided in the Vision X Server. When you choose an operation from this dialog box, a
connection is opened to the Resume host, using the transport specified for that host in the Vision
Communications Database. The xresume program is run using the remote execution service
specified for that transport.

For XVision 6.2 and any other X servers that support Resume, the user interface is the Vision
Resume Session Manager program xresmgr that runs on the UNIX host.

Using Vision Resume Session Control dialog box
XVision Eclipse provides the Vision Resume Session Control dialog box to control a Vision
Resume session.
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To display the Vision Resume Session Control dialog box

1 Do one of the following:
§ If the server is running hidden, then click the X Server icon in the notification area of the

taskbar with the right mouse button and click Vision Resume. (For older versions of
Windows NT, display the root menu and then click Vision Resume.)

§ If the server is not hidden, click the X Server icon on the taskbar with the right mouse
button and click Vision Resume.

§ If the server is running in single-window mode, click the Control menu and then click
Vision Resume.

2 If there is no current Resume session, and a Resume Host has not been specified in the X
Server profile, then you will be prompted to choose one. If the profile specifies the Resume
host then you will not see this dialog box.

If you want to set this Resume Host name in the X Server profile, click the check box.
The Vision Resume Session Control dialog box is displayed.

3 Choose the option you want.
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Using Vision Resume Session Manager
The Vision Resume UNIX software includes the Vision Resume Session Manager program for
controlling a Vision Resume session.

To run the Vision Resume Session Manager

1 Do one of the following:
§ If you are using XVision 6.2, double-click the Vision Resume icon in the Visionware

group in Program Manager.
§ Use any method to execute the command xresume -manage on the Resume host.
The Vision Resume Session Manager is displayed.

2 Choose the option you want.

Starting or resuming a Vision Resume
session
You can resume an existing session or start a new one if there is no current session.

To start or resume a Vision Resume session

1 Display the Vision Resume Session Control dialog box, or run the Vision Resume Session
Manager.

2 Click Start/Resume Session.

If a Resume session already exists for this user, the connection between the proxy-server and the
X display is re-established, and then any client windows are redrawn.
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If a Resume session does not already exist, xresume starts the proxy-server, and then tries to
execute a session file that specifies the X clients to be run (see �Configuring Vision Resume on
UNIX�). If the file is not found then no clients are started.

A Resume session may have been suspended when no X clients are running. In this case,
resuming the session will not display any clients. If you wish to see the clients in the session file,
you should terminate the current session and start a new one.

Note  For XVision Eclipse, the Let XVision Automatically Manage My Resume Session option is
provided in the server profile. If this option is enabled, then when the Vision X Server starts, any
existing session will be resumed or a new session will be started.

Starting clients in a Vision Resume
session
If a session file is found when you start a Resume session, then the clients specified in the file will
be started on the proxy-server and appear on your display. If one of these clients is an xterm,
you can use this to start other clients. The DISPLAY environment variable within this xterm is
set to the proxy-server display, so that all clients launched from that xterm will also default to
running on the proxy-server.

If you want to start clients manually from a terminal emulator, then use xresume -proxydisplay
to find out the X display name and server number that X clients can use to contact the proxy-
server.

For XVision Eclipse, you can use Remote Program Starter to start clients that will become part
of the current Resume session. When a Resume session starts, details of the proxy-server display
are stored on the PC, and Remote Program Starter uses this information to start clients on the
proxy-server.

If you are using the Vision Resume Session Manager, you can use the Start Client command on
the File menu to start clients that will be part of a current Resume session. Enter the host name
and the command you want in the dialog box.
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Window Management
Do not run a host-based window manager as part of a Resume session. If you want to use a host-
based window manager, start it running before you start the Resume session.

Suspending a Vision Resume session
When an X session is suspended, all windows that are part of the X session are removed from
the X display. The clients continue to run on the proxy-server until they terminate or suspend
waiting for the proxy-server to process requests from them.

To suspend a Vision Resume session

1 Display the Vision Resume Session Control dialog box, or run the Vision Resume Session
Manager.

2 Click Suspend Session.

X clients that are part of this Resume session will be removed from the X display.

Relocating a Vision Resume session
A Vision Resume session may be relocated from the X display you are currently using to any X
display that supports the Resume extension. The normal security mechanisms that control access
to a display by X clients still apply.

To relocate a Vision Resume session

1 Display the Vision Resume Session Control dialog box, or run the Vision Resume Session
Manager.

2 Click Relocate Session.
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3 Type the name of the display on which you want to relocate the session. For example,
chrisa:0.

All X clients that are part of this Resume session will be removed from the X display and will
reappear on the specified display.

To return the session to the original X display, choose the Start/Resume Session option on the
original display.

Note  The X display on which you wish to relocate the session must allow access by the host on
which the Vision Resume proxy-server is running.

Quitting a Vision Resume session
When you quit a Vision Resume session, all clients running on the proxy-server will be
terminated.

To quit a Vision Resume session

1 Close any X clients that are part of this Resume session, using the recommended exit
procedure for each application.

2 Display the Vision Resume Session Control dialog box, or run the Vision Resume Session
Manager.

3 Click Terminate Session.

All X clients still running that are part of this Resume session will be terminated.

Abnormal Termination
In the event of a system crash causing abnormal termination of a Vision Resume session, and
before trying to start a new Resume session, you should display the Vision Resume Session
Control dialog box or run the Vision Resume Session Manager and choose Terminate Session.
This will remove temporary files left from the aborted session.

Using Vision Resume with a serial or
modem connection
To run X clients over a serial line or modem, you should use NCD�s XRemote protocol (see
�Using NCD XRemote� in the �Starting X Programs� chapter). You can use Vision Resume over
an XRemote connection by starting the Resume session from the XRemote session file. For
simplicity, move any client-starting commands in the XRemote session file .xinitremoterc into
the Resume session file .tpsession or default.tpsession. Then in the .xinitremoterc file, place the
following lines:
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REMOTE_DISPLAY=$DISPLAY
export REMOTE_DISPLAY
xresume -xremotestart

Note that xresume -xremotestart must be the last command in .xinitremoterc, and xresume must
be on the user search path.

When you start an XRemote session, any existing Resume session will be restored, or a new
Resume session will be started and the commands in the Resume session file will be executed.

To suspend or stop the resume session, use the -xremotesuspend or -xremotestop options from
within an xterm started by the session. For example, xresume -xremotestop will stop the Vision
Resume session and terminate any X clients associated with the session. Note that the X Server is
not terminated automatically, and you should close it manually.
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Terminal emulation overview
Vision97 terminal emulators allow you to run character-terminal applications on remote UNIX
computers and display them in Microsoft Windows on your PC. The following emulators are
available:

• ANSI
• VT420
• Wyse 60

When you use a terminal emulator, it connects to the remote host over a network or serial line.
You can then run any host application intended for this type of terminal. In addition to
comprehensive terminal emulation, there are these additional benefits:

• The ability to automatically open the connection, log in to the host operating system, and run
a command. Serial lines and modem connections are supported, in addition to a wide range
of networks. If Vision Services for UNIX software is installed on the host, then you can run
several emulator sessions over a single serial line.

• Sharing of data between Windows applications and remote applications.
• The ability to create new emulator session documents in Windows, and to save settings from

a current session.
• The ability to open emulator documents within an ActiveX compatible browser.
• Configuration through Windows properties dialog boxes. Some properties can be configured

from the right mouse button. Configuration details can be stored as a style, so that you can
easily change the configuration when running different applications.

• Colors can be specified for the screen foreground and background, and for all styles of text.
These colors override any colors specified by the remote application.

• The keys on the PC keyboard are mapped to keys that appear on the keyboard of a real
terminal, and this mapping works for most International PC keyboards. In addition, any key
or combination of keys can be mapped by the user with a simple point and click interface.

• Toolbars provide easy access to common functions. In addition to using the standard
toolbars, you can create custom toolbars. The toolbars can either float or dock with the
window at any location.

• Uses TrueType fonts for smoother scaling as the window is resized.
• The ability to print the screen contents on a Windows printer, after optionally seeing a

preview.
• A terminal session can be recorded and either played back immediately, or stored for future

use.
• The ability to respond to events such as the arrival of data or the loss of a connection.
• Windows-style copy and paste, including drag and drop.
• The ability to move, resize and iconize the terminal emulator window using normal Windows

methods.
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• A split-screen facility to allow you to view a history of previous output. This �History view�
can be configured separately from the normal virtual screen.

• Hot links to other Windows applications, allowing you to copy and paste to another
document and have data updated if it changes in the emulator window.

• The ability to embed terminal emulator sessions in other Windows applications.
• Support for OLE Automation, allowing a Windows program to control a hidden emulator

and so provide a new graphical interface for a legacy character-based application.
• Support for ActiveX scripting, allowing terminal emulators to run scripts written in a

scripting language such as VBScript or JavaScript.

Opening a terminal connection
You can use any of the terminal emulators to open a connection.

To connect using a terminal emulator

1 Do one of the following:
§ Click the Start button, point to Programs, point to Vision, and then click ANSI Emulator,

VT420 Emulator or Wyse 60 Emulator.
§ For older versions of Windows NT, open the Vision group in Program Manager, then

double-click either the ANSI Emulator, VT420 Emulator or Wyse 60 Emulator icon.

2 On the Session menu, click Connect.
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3 In the Host box, type a host name or choose a host from the drop-down list.
4 In the Command Line box, enter the command required to start the application.

The command to start an application is similar to the one that you would type at the system
prompt on the remote host. For example, to start WordPerfect, you would type wp. If you
want to run a UNIX shell (command interpreter), then you need to need to type the name of
the shell, such as sh (Bourne shell), csh (C shell) or ksh (Korn shell). Note that if the shell is
not your default login shell, then you will get a non-login instance of the shell, and the
commands in your startup file (.profile or .login) will not be executed.
Alternatively, click the browse button (...) to browse the UNIX neighborhood for a host and
or command. If no host is specified, all hosts are shown. If the Host entry already specifies a
host, your home directory on that host is shown. Browse until you find the program or shell
script you want to execute.
If you do not type a command, then the UNIX login program will be run, which will prompt
you for username and password before starting your default login shell.

A dialog box displays status messages during the connection process, and then the program you
specified appears in the window.

If you have difficulty connecting to the remote host, then you can use the Connection Monitor
to monitor and control the connection process. To display the Connection Monitor, hold down
the SHIFT key when opening a connection. Refer to �Using Connection Monitor� in the �Vision
Communications Architecture� chapter for more information.

For more information about using a terminal emulator, click Help Topics on the Help menu.
The same information can be seen by choosing How To Use a Terminal Emulator from the main
Vision Help Contents.

VCA Terminal service
Vision Communications Architecture (VCA) includes a Terminal service that provides the ability
to log in to a UNIX system and execute commands.

The VCA Terminal service can be provided by the following methods:

• Using the USP Task service if Vision Services for UNIX is installed on the host.
• Using a remote log in service provided as part of the UNIX operating system or network

software, for example rlogin.

A similar service is provided using any of these methods, and is made available to applications
through the Terminal API.
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Choosing a terminal connection method
In Windows Control Panel, the Vision Communications option allows you to configure
Transports. When you add or modify a transport, you can select the method to use for the
Terminal Connection service using the Advanced tab in the Transport Properties dialog box (see
�Configuring Transports� in the �Vision Communications Architecture� chapter).

If the transport uses a USP protocol, then the only option is to use USP Terminal, which is
provided by the USP Task service. If the transport uses a TCP/IP protocol, then the default is
rlogin, with telnet as an alternative.

USP Task service
The Vision USP Task service provides the ability to log in to a remote host system and run a
program. It provides an alternative to standard UNIX services such as rlogin and rexec. You can
choose it as an option when configuring the Terminal Connection service for a transport. The
key design points of the Task service relating to a terminal connection include the following:

• Using the Task service overcomes the problem of different versions of UNIX producing
different responses to login requests using their native login services. This makes opening a
connection from a PC simpler and faster.

• The USP Task service uses the VCA Authentication service, which does not send unencrypted
usernames and passwords across the network. By comparison, rlogin does require a username
and password to be sent as clear text.
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• The Task service optionally intercepts messages sent to you by other UNIX users, and
displays them in Message Pad instead of on the terminal emulator screen.

• The Task Server is called tsrv, and it can handle multiple login sessions from many clients. By
comparison, the standard UNIX rlogin program forks a separate process to handle each
session.

• The Task Server can handle multiple connections up to a maximum number which varies, but
when that limit is reached it forks another tsrv.

• If a terminal type was specified in the call, the Task Server treats the message as a request for
a terminal connection, and forks a process to run a shell. This process has the UID of the
client, and the shell is the default shell for the user. The Task Server uses a pseudo-tty to
communicate with the shell process, which appears to the shell as a normal tty. If the client
specified a program to be executed, the shell forks a process which inherits the stdin and
stdout of the shell and thus talks to the pseudo-tty. The Task Server passes the data from the
pseudo-tty back to the PC.

The terminal command line
If the terminal connection is made using the USP Task service, then the command line is
interpreted as shown below.

Command Line Operation

(none) Runs the UNIX login program, which prompts for username and
password and uses these to log in, and then starts your default login
shell.

program Runs program. If program is the name of your default login shell,
then it will run as a login shell. Any other shell will run as a non-
login instance of the shell. For example, the C shell run as a login
shell will read both your .cshrc and .login files, but run as a non-
login shell will read only .cshrc.

newterm program Runs program in the same way as when the program name alone is
specified, but creates an entry for the terminal in the UNIX utmp
file. If the newterm keyword is entered without specifying a
program, then the effect is the same as when no command is
specified. (The utmp file is handled by login.)

The utmp file
UNIX messaging programs use the utmp file to find out which terminal a user is logged in at.
The Task Server normally creates a single entry in utmp the first time a user logs in, and listens
for messages sent to that username. The Task Server acts as an RPC client to send these messages
to the Message Pad server on the appropriate PC. In this case, the Task Server does not create
entries in utmp for the actual pseudo-tty devices associated with terminal emulator sessions.
When the last connection for a user is closed, the Task Server removes the entry for the user
from the utmp file.
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You can change the way the Task Server manipulates the utmp file. If you want a specific
terminal emulator session to have its own entry in the utmp file (some applications require this),
then use the newterm parameter on the command line. If you want all terminal connections
opened with your username to have separate utmp entries, then place the following entry in the
tsrv.rc file:

#!UTMP-USERS
username

where username is your UNIX username.

For more information about message handling, refer to the �Message Handling� chapter.

Terminal emulator documents
An emulator document is a settings file (*.ans, *.v42, *.w60) for a specific type of terminal
emulator. It contains all the configurable settings that you can specify for an emulator session.
For Windows 95 or NT 4.0, a document can be created on the Start menu, on the desktop or in
another folder. For older versions of Windows NT, documents can be saved in any folder.

An emulator document can be opened from the desktop, or from within any application that
supports ActiveX documents such as Microsoft Internet Explorer or the Microsoft Office Binder.
The connection to the host is opened, the log in process completed, and the specified command
is run.

Whenever you make any changes to settings during an emulator session, you will be prompted to
save them when you exit.

Creating a document in Windows 95 or NT 4.0
This section shows you how to create an emulator document on the Start menu or on the
desktop. You can also create documents in other folders.

To create an emulator document on the Start menu

1 Click Start, and then click New Unix Program.
2 Follow the instructions of the Unix Application Wizard, which creates an entry for the

application in the Unix Programs folder on the Start menu.

To create an emulator document on the desktop

1 Use the right mouse button to click an empty part of the desktop.
2 Click New, and then click Unix Program.
3 Follow the instructions of the Unix Application Wizard, which places an icon for the new

settings document on the desktop.
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Creating a document in Windows NT 3.51
For Windows NT 3.51, you can create an emulator document by running an emulator, and
saving current settings in a file.

To create an emulator document

1 In a terminal emulator, click the Properties menu and then click Program.
2 Type a Title and a Command Line, and choose a host from the drop-down list.

If the program displays output and then exits, like who, then disable the Close on Disconnect
option so that you can read the output before the window closes.

3 Change any other properties you want. You can get Help on an item by pressing SHIFT+F1 to
see the Help pointer, then clicking the item. Click OK to close the dialog box.

4 Click the File menu, and then click Save As. Type a name for the document, and choose a
folder in which to store it.

Configuring an emulator document
You can configure the properties of an emulator document without opening the document.

To configure documents from the desktop or a Program Manager group

Do one of the following:

§ If you have an emulator document object on desktop, click it with the right mouse button and
click Properties on the shortcut menu.

§ If you have an emulator document object in a Program Manager group, press the CTRL key
and then double-click the document icon.

Use the tabs to switch between the various emulator properties. To save changes and close the
properties dialog box, click OK. For changes to take effect before you close a properties dialog
box, click Apply.

Summary information
Summary information describing this emulator document will appear on the Summary tab, which
is added to the emulator document Properties dialog box. Unless you enter information in this
dialog box, the Summary tab will not be visible. The Summary tab also displays some
information provided on the Program tab. You cannot modify the information from the
Summary tab. The Summary tab is only visible when the emulator document properties are
viewed before the document is opened, for example when you view the properties of a document
on the desktop or in a folder.
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Opening a document
If you created a document on the Start menu in Windows 95 or NT 4.0, then to open it click
Start, point to Unix Programs, then click the document you want. If the document appears as an
icon on the desktop, or in a folder or Program Manager group, double-click the icon to open the
document. The connection to the remote host is opened, the log in process is carried out
automatically and the specified command is run.

For information about opening an emulator document in another application that acts as an
ActiveX document container, see �Using an Emulator as an ActiveX Document� later in this
chapter.

Changing the window size and position
A terminal emulator window can be moved and resized by using normal Windows methods, i.e.
by dragging the window sizing borders and the title bar. New positions and sizes are reflected in
the preview screens of the Size and Position, Display and Font properties dialog boxes and the
Height and Width, Top and Left boxes in the Size and Position properties dialog box.

For an emulator document, the initial size and position of the window when the document is
opened can be specified using the Size and Position properties dialog box. You can adjust the size
of the miniature window in the Preview section of the dialog box, or specify pixel values. You
can also set the emulator to appear in the default size and position, which is where a new,
untitled emulator would appear. In this case any values that you entered will be grayed, and the
default values will be used instead.

Displaying the History view
The terminal emulator has a �virtual screen� that holds the correct number of rows and columns
for the terminal being emulated, for example 24 rows by 80 columns. The emulator window
shows a view of this virtual screen, and may be split so that a History view can also be displayed.
This shows a history of previous text that has scrolled off the standard terminal display.
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To display the history of screen output

1 Click in the emulator window with the right mouse button, and then click Split Screen.
2 Drag the split to the desired position.

The maximum number of lines that can be displayed in History view is specified in the Display
properties dialog box.

Fonts
The terminal emulators use a combination of three TrueType fonts. Most characters are
displayed using the primary font which by default is Courier New, although this can be changed
using the Font properties dialog box to be any TrueType font. Microsoft Line Draw is used for
drawing lines and boxes, and a proprietary font called Vision is used for additional characters
required by the emulators. Microsoft LineDraw and Vision are both installed during Setup.

You can specify a font size in the Font properties dialog box, and the default for Courier New is
7x15. The font is fixed at this size if the Font Varies With Window Size option is disabled. If this
option is enabled, then the font size you specify is used as the initial size when the document is
opened, but the font size will vary as you resize the window.
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Colors
The terminal emulators allow you to specify the default foreground and background colors for
the screen, and also to set colors and other attributes such as bold or underline for different text
items. If you specify options in the Attributes properties dialog box, they will override any
attributes specified by the UNIX application. For example, you could specify that text that
would appear underlined on a real terminal should appear in red on the emulator screen.

You can specify settings for both the Terminal and the History sections of the window. You can
save attribute schemes and also customize existing attribute schemes (including the default
scheme). Schemes can be added, deleted and saved within a document. They can also be saved as
part of a style.

The emulator comes with two predefined attribute schemes: the default scheme, and Black on
White. The default scheme is white text on a black background. Black on White is black text on
a white background, which is used automatically when you use the print facility or when you
choose Print style from the Styles properties dialog box.

Toolbars
The terminal emulators have the following built-in toolbars.

Toolbar Purpose

Standard Provides easy access to common tasks.
Function Keys Sends function key control codes.
Terminal Options Allows you to change terminal settings easily.

You can customize these toolbars to add additional functionality, and you can create new
toolbars tailored to your working environment. Toolbar buttons can carry out commands, run
playback sessions, activate styles, enter text strings and send function key control codes. You can
include non-printable characters (see �Non-printable Characters� later in this chapter). Toolbars
can be active or hidden, and can either float or dock with the window at any location. Toolbars
can be added, deleted and saved within a document. They can also be saved as part of a style.

Keyboard input
A terminal emulator associates keys on the PC keyboard with keys found on a real terminal. For
each type of emulator there is a default mapping for each type of keyboard, and this mapping
can be overridden by new or imported mappings stored as part of an emulator document. The
default mappings are described in �Terminal Emulator Keymaps� in the Appendices.
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When a key is pressed on the PC keyboard, the emulator decides whether the key has a mapping
associated with it. If it does, then the mapping is evaluated. If there is no mapping for the key,
the default translation provided by Windows is used. The alphanumeric keys are never mapped.

The default keyboard maps (*.dft) are stored in the \Program Files\Vision\System folder and are
shown in the following table.

Keymap Emulator

Ansi.dft ANSI
Vt420.dft VT420

Wyse60.dft Wyse 60

Each file contains a keyboard map (�keymap�) for the standard IBM PC Extended keyboard, and
there may be additional keymaps for vendor-specific keyboards. The appropriate mappings for
your type of keyboard will be used in a new emulator document.

Configuring keymaps
Within an emulator document, you can create a new keymap by using the Keyboard properties
dialog box. The new keymap is given a name, and initially contains the same mapping as the
default keymap. When you choose to edit the new keymap, it appears as a temporary file within
the Keymap Editor.

This program allows you to change the mapping for any non-alphanumeric key. It also gives you
a wide range of actions and events to map to keys, including strings, built in commands,
emulator recordings and styles. When you save the changes you have made, the mappings are
stored as part of the emulator document. To make the keymap active, click it in the Available
Keymaps list and then click Set As Default.
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The Keymap Editor can also be run as a stand-alone program (click the Start button, point to
Programs, point to Vision, point to Accessories, and then click Keymap Editor), in which case it
would normally generate a stand-alone keymap file (*.kmp). To use a keymap created in this way
with a Vision97 terminal emulator, click the Properties menu, click Keyboard, and then click the
Import button. Choose the keymap file from the dialog box. A copy of the keymap is created
inside the emulator document. To make the keymap active, click it in the Available Keymaps list
and then click Set As Default. The current keymap is shown by the Keymap In Use text item.
Note that if you subsequently edit an imported keymap within the emulator document, any
changes you make will not propagate back to the original keymap file.

The System Administrator may wish to use the Keymap Editor as a stand-alone program to alter
a default keymap. To do this, run the Keymap Editor from the Start menu and then select the
appropriate Emulator Type and Keyboard Type from the Options menu. Make the changes you
want, then save to overwrite the appropriate *.dft file.

Note  To enter non-printable characters when mapping strings, use the codes shown in the table
below.

Code Meaning

\n New line
\r Carriage return
\t Tab
\b Backspace
\nnn nnn is the octal value of a character

For full instructions on using Keymap Editor, click Help Topics on the Help menu. The same
information can be seen by choosing How To Use Keymap Editor from the main Vision Help
Contents.

Copying and pasting
Information displayed in a terminal emulator window can be copied to the Windows Clipboard,
from where it may be pasted back into the emulator or into another Windows document.

The information to be copied to the Clipboard must first be selected. Once a selection has been
made, it remains active until it is copied, or another selection is made. Any activity which causes
the screen display to be refreshed (such as writing to the window or changing the active window)
cancels a selection.

You select lines or columns of text by dragging with the mouse. Hold down the SHIFT key while
dragging to select a column. When text has been selected it can be copied to the Clipboard by
clicking the Copy button on the standard toolbar. You can then use the Paste button to insert the
text at the current cursor position in the terminal emulator, or switch to another Windows
application and paste the text there. You can also select text and then drag it with the mouse to a
new location.
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Note  If you drag text or use the Paste command to copy text to a document that is OLE aware,
then the text will be embedded as an emulator document.

For information about how to select and copy information, click Help Topics on the Help menu
and look up �selecting� or �copying, data from an emulator window� in the Help Index.

Events
The terminal emulators allow you to map emulator events to actions. When the event occurs, it
triggers the associated action. Events include the window becoming active, a connection being
opened, or data arriving. Actions include sending a key, playing a recorded session, changing the
current style, executing a menu command, or sending a text string. You can include non-
printable characters (see �Non-printable Characters�).

Events can be mapped, unmapped and saved within a document. They can also be saved as part
of a style.

For information about how to map events to actions, click Help Topics on the Help menu and
look up �events� in the Help Index.

Non-printable characters
To enter non-printable characters when configuring toolbars or events, use the codes shown in
the table below.

Code Meaning

\n New line
\r Carriage return
\t Tab
\b Backspace
\nnn nnn is the octal value of a character

Styles
The terminal emulators allow you to create styles (or settings) comprised of various properties,
within each emulator document. You can save a unique configuration as a recallable style. The
properties that can be set are: Size and Position; Display; Font; Attributes; Keyboard; Terminal;
Toolbars; Events.
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This enables you to have emulator styles customized for specific UNIX applications. For
example, for running the Vi text editor, you may wish to have a style that has a specific toolbar,
with buttons that carry out Vi commands, that has a different keymap, different terminal
settings, different display attributes and so on. You then may wish to have a different style for
running electronic mail, which has its own toolbar and other unique properties. Whenever you
want to run either of these applications, you use your customized styles.

When you have created a new style you simply set it as default to activate it, although you can
create a button on a toolbar to do the same if you wish. You can delete any style, including
Normal, from the Styles list.

The emulator contains the predefined styles shown in the following table.

Style Purpose

Normal The default style when you start an untitled emulator. The screen is black
with white text.

Print This style automatically activates on the Print and Print Preview commands.
It converts the color of the display to black text on a white background.
After printing or closing the print preview screen, the style reverts to the
previous one.

132 column Based on the current style with the number of columns displayed set to 132.
80 column Based on the current style with the number of columns displayed set to 80.
Simple Based on the current style but with all forms of window decoration, e.g.

toolbars, menu bars, removed. This makes it look like a standard terminal.
To change to another style, click with the right mouse button on the
emulator window, and click either Fonts or Attributes. This brings up the
emulator properties dialog boxes; use the tabs to display the Style properties
dialog box.

For information about how to apply, create or delete styles, click Help Topics on the Help menu
and look up �styles� in the Help Index.

Recording and playback
The terminal emulators allow you to automate tasks by recording commands, keystrokes, and
mouse clicks, and saving them as a Recording session. Each time you want to carry out one of
these tasks, you play the session. Recording sessions can be added, deleted and saved with an
emulator document. They can be saved as part of a style, played from a toolbar button, or
mapped to events and keys.

For information about how to record, play back or delete a recording session, click Help Topics
on the Help menu and look up �recording� in the Help Index.
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Scripts
The terminal emulators allow you to run scripts written in an ActiveX scripting language such as
VBScript and JavaScript. Vision97 objects, functions and event handlers can be used within
scripts to add functionality to a terminal emulator. Scripts can be executed from the menu bar. A
single script can be saved with an emulator document, and executed automatically when the
document is loaded. For further information, see the �Emulator Scripting� chapter.

For information about how to execute or stop a script, click Help Topics on the Help menu and
look up �scripts� in the Help Index.

Printing from a terminal emulator
The terminal emulators include two mechanisms for printing data:

• The print screen mechanism prints the current contents of the window using the Microsoft
Windows printer driver.

• The slave printing mechanism sends all output from the application to a printer attached to
the PC.

Print screen
Real Wyse 60, VT420, and ANSI terminals have a �Print Screen� key which can be used to send
the current contents of the screen to the printer. With Vision97 emulators this functionality is
achieved by choosing the Print command from the File menu. This will print the current
contents of the emulator window. If the window does not show all the virtual terminal screen,
only the data which is visible when Print is chosen will be printed.

If required, printing can be aborted by choosing the Cancel button.

The Print command uses the Microsoft Windows printer driver. Consequently the text will be
automatically converted into the correct format, for example PostScript. There is no need to use
a filter as there is with slave printing (see the following section for details).

The output from the Print command is sent to the currently selected Windows printer.

Before you print a document, it�s often a good idea to make sure that it will be printed the way
you want it. Use the Print Preview command from the File menu to see the page(s) to be printed
and make last-minute changes to a document.
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Slave printing
Vision97 emulators provide a facility for �slave printing,� which means that output can be sent
to a printer instead of (or as well as) to the screen. This facility can be activated from the PC by
opening the Terminal properties dialog box, clicking Printer, and then specifying Transparent or
Auto mode. The UNIX application could also send control codes to change the print mode,
which would override this setting.

The output can be sent to a file (default), or to a specified COM or LPT port, or to a �pseudo
printer� which means the Windows default printer. Note that the Windows printer driver is not
used, so if a printer requires control information to be embedded in the text (e.g. PostScript or
Hewlett-Packard PCL), then the multi-user application, or the remote print spooler, should be
set up to generate output exactly as if the printer were attached to the multi-user system itself. In
the case of the pseudo printer, the terminal emulator interprets bold and underline control
codes.

For information about how to enable slave printing, click Help Topics on the Help menu and
look up �slave printing� in the Help Index.

Using OLE
The terminal emulators support Object Linking and Embedding (OLE), which encompasses the
majority of Microsoft�s component integration technology. It enables you to embed an emulator
object in a document produced by another Windows application. For example, you could write a
report in Microsoft Word that refers to stock levels, and embed an emulator document that
opens the stock inquiry program on a UNIX server. OLE also allows you to create a link between
text shown in an emulator window and a different document. For example, you could create
links between an Excel spreadsheet and an emulator window displaying a UNIX stock inquiry
program. You can also write programs or macros that interact with emulator documents, for
example to create a graphical interface to a character-based UNIX application.

The emulators also provide the standard implementation of the OLE Clipboard and OLE Drag
and Drop. This supports basic functionality common to all OLE applications, such as dragging
text from a Windows application and dropping it into an emulator window, or vice versa.

Embedding emulator objects
As terminal emulator data files have a standard OLE structure, an emulator object can be
embedded in a document produced by another Windows application. This can be done in two
ways:

• By embedding a new emulator object, that will exist entirely within the Windows document.
• By embedding an existing emulator document that is stored in an external file. If you specify

Link to File in the Windows document, then a link is created to the source file, enabling
changes in the emulator document to be reflected in the embedded object.
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To embed an emulator object in a Windows document

1 Open the application, click the Insert menu, and then click Object.
2 Either click a new emulator object type, or search for a document saved to a file.

If you choose to embed a new emulator document, then the emulator opens within the
application�s window, and replaces the application�s menu bar with its own. You may like to
configure the new document by clicking the Properties menu, and then clicking Program. Enter
details such as the host to which you want to connect and the command to be run on the host in
the spaces provided. If you choose to embed an emulator document saved to a file, then the
document appears as an object within the application�s window but does not open.

The object can subsequently be opened within the Windows document and will run either in-
place or out-of-place. In-place activation is an OLE compound document technology that allows
an embedded active object to be manipulated within a compound document. The Windows
document (the container) and the emulator document will merge elements of their user interface
into the container�s window space, with the object bringing its editing tools to the container.
This includes menus, toolbars and small child windows that are all placed within the container.
In-place activation creates a document-centric work environment for the user, with everything
that�s needed for the task in hand being available within one document.

To open an emulator in-place

1 Click the emulator object to select it.
2 On the Edit menu, point to Document Object, and click Edit.

The emulator opens within the application�s window, and replaces the application�s menu bar
with its own. (Unless the object is linked to an external emulator document or is a selection
copied from an emulator window, in which case the emulator runs in a separate window.) All
the menu commands now belong to the emulator, with the exception of the File menu, which
remains the container�s. The emulator is now running in-place in the container�s window.
Normal emulator operations can be performed. For example, to connect to a UNIX server,
click the Session menu, and click Connect.
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3 To return control to the Windows document, click outside the emulator object frame. The
emulator will close.

You can also open the emulator object out-of-place where it will run outside the container�s
frame, allowing you to manipulate it in a separate window.

To open an emulator out-of-place

1 Click the emulator object to select it.
2 On the Edit menu, point to Document Object, and click Open.

The object runs in a separate window outside the container�s frame. The illustration below
shows an ANSI Emulator, embedded in a Word document, running outside the container.
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Any changes that you make in the opened emulator document are reflected in the object within
the Windows container. You can save these changes back to the Windows document, or you can
save them as an external emulator file. Click the File menu, and then either click Update, or Save
Copy As. When running an embedded emulator outside the container�s frame, the File menu
belongs to the emulator.

The emulator object within the Windows document is locked while the emulator document is
open, preventing you from opening more than one instance of the object.

For further information about embedding objects, refer to the documentation for your Windows
application.

Copying text from an emulator document into
another application
You can copy text from an emulator window and paste it into another Windows application.

To copy text from an emulator document into another application

1 Select some text in an emulator window, click the Edit menu, and then click Copy.
2 Make the Windows application into which you want to paste the information active, and

select an insertion point.
3 Click the application�s Paste Special command and then select Unformatted Text. You have

the option of embedding the text as an emulator document though this is not normally
applicable. You could also choose to paste the text as a picture.

The selected text appears in the document.

Note  Copying text from an emulator document to another OLE-aware document using the
Paste command or by dragging and dropping will cause the text to be embedded.

Creating hot links
The terminal emulators support the Paste Link facility, which creates a hot link between an
emulator document and a Windows application. Changes in the emulator document are reflected
in the Windows application. The Paste Link operation regards the emulator document as the
data source, or the server, and the Windows application as the user of objects, or the client.

To set up a hot link

1 In a Terminal Emulator, click the Properties menu, and then click Program.
2 Click Advanced.
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3 Click Paste Links to enable the option.
4 In the Paste Update box, specify an interval at which data that is linked from the emulator

document should be updated.
5 Select some data in the emulator window, click the Edit menu, and then click Copy.
6 Make the Windows application into which you want to paste the information active, and

select an insertion point.
7 Click the application�s Paste Special command and then click Paste Link. Select whether you

want to link the data as a document object, a picture, or unformatted text, and click OK.
Normally, you will choose Unformatted Text.

The selected text will appear in the document. The text has not been pasted directly from the
Clipboard, but a link has been inserted into the document and the data has been retrieved using
the link. Using this link, you can also open and configure the emulator document directly from
the Windows application.

For further information about links and the Paste Special options, refer to the documentation for
your Windows application.

Note  When performing a Paste Link operation you must have saved the emulator document to
a file, as Paste Link will not work with the document in an untitled state. In addition, there
should be only one instance of the emulator document open, as the document will become
locked during the Paste Link operation.

OLE Automation
Using OLE Automation you can create a new Windows interface to a UNIX character-based
application running in a terminal emulator. The emulator window can be hidden so that the user
is only aware of the Windows program.
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For example, a UNIX stock control program written to display on a VT420 can be controlled by
a new Windows program, providing all the benefits of a graphical user interface to a legacy
application.

OLE Automation is a primary means of sharing information between two applications. It allows
programmers to define a set of operations and make them accessible to other applications. The
end result is that scripts or programs can affect more than one application at a time.

It comprises of two components: automation objects and automation controllers. Automation
objects are programmable components, which provide information about everything the object
can do. Automation controllers are programming environments in which a developer can write
scripts or create applications that drive the objects.

A Vision97 terminal emulator functions as an automation object. These emulator objects can be
manipulated by Vision97 functions, and by programming languages such as Microsoft Visual
Basic or Visual C++, or applications such as Microsoft Excel or Word, that support Visual Basic
for Applications. Through the use of the Vision97 object types and functions, a Windows
application can �scrape� information off a UNIX application running in an emulator and display
it in its own window, without the emulator being seen by the user.

Vision97 objects and functions can also be used within scripts written in a scripting language to
enhance the functionality of an emulator. Two scripting languages commonly used with the
Vision97 terminal emulators are VBScript and JavaScript. A set of event handlers not available to
OLE Automation are also provided. For further information, and for reference information on
the objects and functions available to OLE Automation, refer to the �Emulator Scripting�
chapter.

For more information on using OLE Automation, refer to the documentation for your
programming language.

Using an emulator as an ActiveX
document
ActiveX documents can be opened within any application that functions as an ActiveX document
container. For example, you can open an emulator document in Microsoft Internet Explorer, or
include an emulator as a section in a Microsoft Office binder.

ActiveX document technology extends the concepts introduced in OLE compound document
technology, enhancing the functionality of embedded in-place activation. Instead of forming a
distinct piece of the content of a document, an ActiveX document can represent an entire
document within an application.

Note  You cannot use a terminal emulator as an ActiveX control, embedded in a Web page. You
can only display an emulator document in a Web browser, either using the whole window or a
frame to display the document file.
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Opening a document in a browser
An emulator document can be opened within an ActiveX compatible Web browser, such as
Microsoft Internet Explorer 3.0. Choose the Open command from the File menu, or type the
URL of the file directly into the Address box.

A toolbar is added to the window, and menus from the terminal emulator are merged with those
of the document container application.

Tip  If you open an emulator document in a frame instead of in the browser window, you will
not see the emulator�s menus or any docked toolbars. To allow you to control the emulator, you
can provide a floating toolbar. Before saving the emulator document that you intend to use in a
frame, undock the Standard toolbar by dragging it away from the edge of the window.

Adding a document to a Microsoft Office binder
An emulator document can be added as a section in a Microsoft Office binder. In the following
example, a binder contains emulator sessions to a number of different UNIX systems.
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You can add a section by choosing either the Add command or the Add From File command
from the Section menu. If you choose Add, you are presented with a list of available document
objects. Use Add From File if you have already saved an emulator document.

A toolbar is added to the window, and menus from the terminal emulator are merged with those
of the document container application.

ANSI Emulator
The ANSI terminal emulator is based on the console device for SCO UNIX 3.2.

Applications designed for SCO UNIX may take advantage of your PC�s capabilities by using this
emulation.

Programmers requiring further information should refer to the SCO® UNIX® Operating System,
System Administrator�s Reference manual, produced by The Santa Cruz Operation, Inc.

Unsupported features
The following features are not supported:

Feature Escape Sequence

Set bell duration and tone CSI=p;dB
Background color intensity on/off CSI=xD
Blink/bold bit set on/off CSI=xE
Set overscan color CSI=cA
Switch screen CSI=nz
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ANSI terminal settings
The ANSI Emulator allows you to set control functions that govern the ANSI terminal display
and functionality, including terminal identity (how the terminal perceives itself to applications)
and dimensions of the virtual page.

For further information on an option, click  in the dialog box title bar, and then click the item.

Code Pages
Character sets are provided in the form of code pages, which emulate the console terminal of
industry standard PCs. The term �code pages� refers to page numbers in IBM�s standard
character set manual. Each code page defines both the exact set of characters and assignment of
code positions in the range 0-255. Once configured, the code page is not normally changed
within a single application.

The ANSI Emulator supports the following PC code pages:

International (437)
Multilingual (850)
Portuguese (860)
French/Canadian (863)
Danish/Norwegian (865)

You can select the code page you want in the Advanced Settings dialog box.

Scan code support
Some applications prefer to receive raw scan codes rather than characters as input from the
keyboard.

Scan code mode can be enabled or disabled from the Advanced Settings dialog box when the
Identity Type on the Terminal Properties dialog box is set to ANSI.

VT420 Emulator
The VT420 Emulator is based on the Digital VT420 video terminal. This is a single session text
video terminal, featuring advanced keyboard and communications flexibility, that has both ANSI
and ASCII display and text processing capabilities.

Applications designed for any of the DEC video terminals may take advantage of your PC�s
capabilities by using this emulation.

Programmers requiring further information should refer to the VT420 Video Terminal
Programmers Information manual, produced by Digital Equipment Corporation.
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Unsupported features
VT420 features not supported are:

Monitor mode
Local peripheral device interface (bar code readers, etc.)
Macros
CGI graphics
Loadable color palette
Report of preferred multinational character set

VT420 terminal settings
The Terminal properties dialog box allows you to set ANSI control functions that govern the
VT420 terminal display and functionality.

You can set terminal identity (how the terminal perceives itself to applications) and dimensions
of the virtual page. This includes the number of data lines and columns in the display, and the
number of lines for each page in page memory. The VT420 supports three pages of off-screen
memory in the following configurations:

3 pages x 24 lines (default)
2 pages x 25 lines
2 pages x 36 lines
1 page x 41 lines
1 page x 42 lines
1 page x 48 lines
1 page x 52 lines
1 page x 53 lines
1 page x 72 lines

You can also set tab stops for all the virtual pages, specify terminal printing options and character
sets.

The Advanced Settings dialog box enables you to set additional terminal management controls
and display extensions.

For further information on an option, click  in the dialog box title bar, and then click the item.

VT420 character sets
The VT420 Emulator provides both VT 8-bit multinational sets and the 7-bit National
Replacement Character Set for displaying output.
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The VT420 supports the full range of VT 8-bit multinational character sets and provides ISO
Latin-1 and DEC Multinational as User Preferred Supplemental sets. These are sets used most
often as special standby sets. DEC and ISO character sets conform to the structure and rules of
ISO 2022.

The VT 8-bit multinational character sets are formed from two 7-bit character �halves.� ASCII is
used as the left half and the corresponding named supplemental set is used as the right half.
Although these halves can be invoked independently, in practice they are almost always used
together. 8-bit character sets contain more than 127 characters.

When 7-bit National Replacement Character Sets is selected, a corresponding 7-bit set is used
depending on the keyboard language selected. 7-bit character sets contain up to 127 characters.

For further information on an option, click  in the dialog box title bar, and then click the item.

Wyse 60 Emulator
The Wyse 60 Emulator is based on the Wyse 60 terminal. This is a full function ASCII and ANSI
terminal with advanced display and keyboard features.

Applications designed for the Wyse 60 may take advantage of your PC�s capabilities by using this
emulation.

Programmers requiring further information should refer to the WY-60 Users Guide, produced by
Wyse Technology, Inc.

Unsupported features
Wyse 60 features not supported are:

Monitor mode
Block mode
Multiple page split screen
Send cursor characters
Downloadable fonts
Screen boxes and rectangles
Key repeat
Screen saver
Wyse Word mode
Line lock
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Wyse 60 terminal settings
The Terminal properties dialog box allows you to set ANSI control functions that govern the
Wyse 60 terminal display and functionality, including terminal identity (how the terminal
perceives itself to applications) and dimensions of the virtual page. This includes the number of
columns in the display, the maximum number of data lines that can be viewed on the virtual
screen at any one time, and the number of visible lines for each page.

You can also set tab stops for all the virtual pages and specify terminal printing options.

The Advanced Settings dialog box enables you to set additional terminal management controls
and display extensions.

For further information on an option, click  in the dialog box title bar, and then click the item.
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This chapter covers the scripting facilities available with the Vision97
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Emulator scripting overview
Vision97 terminal emulators implement ActiveX scripting, allowing you to add Windows-style
functionality to character-based UNIX applications. For example, you could detect URLs that
occur in text displayed in the emulator, and make them active. Another possibility would be to
make parts of a formatted screen responsive to mouse clicks.

You can run scripts written for any available ActiveX scripting engine (as determined from the
Windows Registry). Scripting engines for Visual Basic Scripting Edition (VBScript) and
JavaScript are included with your Vision97 product and installed at Setup time if not already
present.

A script can be associated with an emulator document, and started or stopped using menu
commands. The script can be saved as part of the document, and optionally executed
automatically when the document is loaded.

The set of objects and functions provided for ActiveX scripting can also be used in OLE
Automation. However, the event handlers can not be used in OLE Automation. Refer to �OLE
Automation� in the �Terminal Emulation� chapter for more information.

This chapter provides information about the functions and events that are provided with the
terminal emulators. It assumes that you already know how to use the ActiveX scripting language
of your choice. A large amount of information about VBScript and JavaScript is available on the
Web, and there are many books available about these languages.

Working with scripts
A script is a program that is interpreted line by line when it is run. A scripting language is a set of
rules and keywords that comprise a functional script. Two scripting languages commonly used
with the Vision97 terminal emulators are VBScript and JavaScript.

Usually you want execution of parts of your script to be triggered by something. Although you
may want to do some things immediately the script runs, such as connecting to a remote host,
mostly you want the script to react to events. An event can be the result of user action, such as
clicking the mouse button; or it may be the result of something happening in the UNIX program,
such as data being sent to the terminal emulator. This type of script is said to be event-driven.

Functions and event handlers relevant to the Vision97 terminal emulators are provided that you
can use in scripts. Functions allow you to carry out actions such as setting attributes or executing
commands. Event handlers recognize when specific events occur, enabling you to carry out
appropriate actions. For example, a function can be used to specify a pattern of characters that
you are interested in. An event handler can recognize when that pattern appears, and then call
other functions to make areas of the screen sensitive to mouse clicks. Further event handlers can
then determine what happens when such an area is clicked. This is the outline of a script that
recognizes the screens in a remote UNIX application and provides mouse-driven access to its
commands.
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Scripting provides a new dimension for terminal emulation. Imaginative use of scripts can
rejuvenate traditional character-based UNIX applications by enhancing the user interface to
exploit the facilities of the Windows desktop.

Emulator objects
An emulator object is an instance of a terminal emulator that has been created by an ActiveX
script, or by an external script or program using OLE Automation. For example, an ActiveX
script controlling an emulator session for entering a sales order might wish to open a new
window to allow the user to check a customer's credit rating in a separate database application.

Vision97 provides three emulator objects. The following table lists the object types with their
programmatic IDs, which are used to identify objects within scripts and to other applications
installed on your system.

Object Programmatic ID

ANSI emulator ANSI.document
VT420 emulator VT420.document
Wyse 60 emulator Wyse60.document

Emulator scripting provides a NewObject function, which you can use to create an emulator
object. For example:

SET Ansi = Emulator.NewObject("ANSI.document")

For OLE Automation, you can use the Visual Basic call CreateObject to create an instance of an
emulator that can be used from another application. For example:

SET VT420 = CreateObject("VT420.document")

When you use NewObject or CreateObject with any of the emulator types, you start an instance
of the emulator initialized with default configuration, in the same way as if you created a new
emulator document on the desktop. You can then alter this configuration by setting properties
associated with the object type. The following table lists these properties with examples of their
use:

Property Description Examples

Command Sets or retrieves the command VT420.Command = "csh"

to be executed on the host MsgBox "Command = " + VT420.Command

computer

ConnectOnOpen Specifies that a connection VT420.ConnectOnOpen = 0

to the host will be opened VT420.ConnectOnOpen = 1

when the emulator document
is opened
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Property Description Examples

CurColumn Retrieves the column Label6.Caption = Ansi.CurColumn

number of the current
cursor position

CurLine Retrieves the line number Label5.Caption = Ansi.CurLine

of the current cursor
position

Host Sets or retrieves the host VT420.Host = "jupiter"

name MsgBox "Host = " + VT420.Host

NumLines Sets or retrieves the number Ansi.NumLines = 50

of lines in the virtual screen MsgBox "NumLines = " + Ansi.NumLines

NumColumns Sets or retrieves the number Ansi.NumColumns = 132

of columns in the emulator MsgBox "NumCols = " + Ansi.NumColumns

display
Prompt Turns prompts on or off. Ansi.Prompt = 0

This determines whether Ansi.Prompt = 1

the user is prompted for
confirmation when a
connection is opened

TermType Sets or retrieves the terminal VT420.TermType = "vt220"

identity. MsgBox "TermType = " + VT420.TermType

This determines how the
terminal identifies itself to
host software

Title Sets or retrieves the description VT420.Title = "Unixshell"

that appears in the window's title MsgBox "Title = " + VT420.Title

bar

Note  If you set Command, Host, Prompt, or TermType, then you must do so before
connecting to the UNIX server. The others can be altered after connecting.

Type libraries
The following type libraries for use with Microsoft Visual C++ are supplied. They are located in
the Devkit directory on the Vision97 CD.

Ansiterm.tlb

V420term.tlb

Wy60term.tlb
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Functions
Functions are provided to enable you to manipulate the emulator or any declared emulator
objects. You can call functions directly, for example Connect( ), or as emulator methods, for
example Emulator.Connect( ). The use of each function is described in detail in the following
pages. All examples in this chapter are written in VBScript and call functions as emulator
methods.

Note  If an emulator object has been declared for use within a script or from another
application, then you must use the object's programmatic ID. See �Emulator objects� earlier in
this chapter for details.

Connect Connect to a UNIX server
CreateHotSpot Create a hot spot
CreatePattern Create a pattern
DestroyHotSpot Destroy a hot spot
DestroyPattern Destroy a pattern
Disconnect Disconnect from a UNIX server
DoDefaultCommand Execute the default command
GetApplicationBuffer Return the contents of an application's buffer
GetApplicationDataLength Return the length of the data held in an application's data buffer
GetDelimitedString Return a delimited string
GetRectAttributes Return a rectangle's attributes
LastError Return the last error
Load Load a specified configuration file
Message Display a message
MsgBoxShow Show or hide emulator message boxes
NewObject Create an object
PlayRecording Play a terminal emulator recording session
Save Save a specified emulator document
Scrape Scrape text from a UNIX application
SendKey Send a key value to a UNIX application
SendString Send a string to a UNIX application
SetRectAttributes Set a rectangle's attributes
SetStyle Set a style
ShowToolbar Show or hide toolbars
ShowWindow Show or hide the emulator window
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Connect

Syntax
boolean Connect ( strHost , strCommand )

Description
This function opens a connection to a UNIX server and runs a command. The parameters
are:
strHost A host name. If you specify a host for which Vision Communications does

not have your username and password, then the Authentication dialog box
will appear.

strCommand The remote command to run on the host.
Returns TRUE if successful.

Example
The following VBScript code opens a connection to a host called Pluto and run a C shell:
Emulator.Connect ("pluto", "csh")
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CreateHotSpot

Syntax
boolean CreateHotSpot ( intLineStart , intColStart , intLineEnd , intColEnd , intButton ,

intRef )

Description
This function creates a hot spot at a given position on the emulator screen. A hot spot is an
area of the emulator screen that responds to a mouse action. The parameters are:
intLineStart The line position at which the hot spot will start.
intColStart The column position at which the hot spot will start.
intLineEnd The line position at which the hot spot will end. This must be greater than or

equal to intLineStart.
intColEnd The column position at which the hot spot will end. This must be greater

than or equal to intColStart.
intButton The mouse buttons to which the hot spot is sensitive. 0 for any button, 1 for

the left button only, and 2 for the right button only.
intRef The identifier to return when the hot spot is hit.
All screen areas are inclusive or their start and end coordinates. Screen coordinates are
calculated from the top left corner of the emulator screen and begin at line 1, column 1. They
are also displayed on the emulator's status bar.
Returns TRUE if successful.

See also
DblClick, to handle mouse double clicks.
DestroyHotSpot, to destroy hot spots.
HotSpotHit, to handle hot spot hits.

Example
The following VBScript code creates a hot spot that is only sensitive to the left mouse button,
and returns 1 when hit:
Emulator.CreateHotSpot (6, 2, 6, 28, 1, 1)
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CreatePattern

Syntax
boolean CreatePattern ( intLineStart , intColStart , intLineEnd , intColEnd , strPatternText ,

boolFindAny , intNotifyMask , intRef )

Description
This function creates a pattern and searches for an exact match. A pattern is a predefined
string that is searched for whenever the emulator screen changes. The parameters are:
intLineStart The line position at which pattern matching will begin.
intColStart The column position at which pattern matching will begin.
intLineEnd The line position at which pattern matching will end. This must be greater

than or equal to intLineStart.
intColEnd The column position at which pattern matching will end. This must be

greater than or equal to intLineStart.
strPatternText The string to find.
boolFindAny Specify 1 to find every instance of the pattern, and 0 to only find the pattern

if it starts at the first cell in the specified area.
intNotifyMask The state at which to notify a change in pattern matching. Specify 1 for when

the pattern appears, 2 for when the pattern disappears, and 3 for when the
pattern appears or disappears.

intRef The identifier to return when the pattern is found.
All screen areas are inclusive or their start and end coordinates. Screen coordinates are
calculated from the top left corner of the emulator screen and begin at line 1, column 1. They
are also displayed on the emulator's status bar.
As pattern matching occurs whenever the emulator screen changes, to minimize overheads
you should limit pattern matching to the smallest possible area.
Returns TRUE if successful.

See also
DblClick, to handle mouse double clicks.
DestroyPattern, to destroy patterns that are no longer required. This improves the efficiency
of a script.
PatternHit, to handle a pattern's detection.

Example
The following VBScript code creates a pattern that detects Web addresses on the emulator
screen:
Emulator.CreatePattern (1, 1, 24, 80, "http:", 1, 1, 4)
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DestroyHotSpot

Syntax
boolean DestroyHotSpot ( intRef )

Description
This function destroys hot spots. The parameter is:
intRef The hot spot's reference number. Specify -1 to destroy all hot spots.
Returns TRUE if successful.

See also
CreateHotSpot, to create hot spots.

Example
The following VBScript code destroys all the hot spots on an emulator screen:
Emulator.DestroyHotSpot (-1)
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DestroyPattern

Syntax
boolean DestroyPattern ( intRef )

Description
This function destroys patterns that have been created within an emulator script. A pattern is
a predefined string that is searched for whenever the emulator screen changes. Destroying
patterns that are no longer required improves the efficiency of a script. The parameter is:
intRef The pattern's identifier. Specify -1 to destroy all patterns.
Returns TRUE if successful.

See also
CreatePattern, to create a pattern and specify its search parameters.

Example
The following VBScript code destroys all the patterns within a script:
Emulator.DestroyPattern (-1)
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Disconnect

Syntax
void Disconnect ()

Description
This function closes a connection to a UNIX server.

Example
The following VBScript code closes the current connection:
Ansi.Disconnect
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DoDefaultCommand

Syntax
boolean DoDefaultCommand ()

Description
This function must be used in conjunction with the Command event handler.
DoDefaultCommand gives you control over when an emulator command is executed. It can
only be used once per command.
Returns TRUE if successful.

See also
Command, to handle emulator commands.

Example
The following VBScript code displays a message before and after processing the default
command associated with an emulator event:
FUNCTION Emulator_Command (ByVal, nCommand)
    ' Do some pre processing
    Emulator.Message ("Processing this command may take some time")
    ' Now execute the command
    Emulator.DoDefaultCommand ()
    ' Do some post processing
    Emulator.Message ("Command complete")
    ' Exit the function
    Emulator_Command = 0
END FUNCTION
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GetApplicationBuffer

Syntax
variant GetApplicationBuffer ()

Description
This function returns the contents of a remote application's data buffer as a byte array in a
variant. When using this function, you should consider the lifetime of the application's data
buffer.

See also
ApplicationEvent, to handle application events.
GetApplicationDataLength, to return the length of an application's data buffer.

Example
The following VBScript code responds to an application event by retrieving the contents of
the application's data buffer, converting it to a string, and then, if it is not empty, displaying
that string:
SUB Emulator_ApplicationEvent (EventID, DataLength)
    IF EventID = 1 THEN
        DIM AppData
        DIM Cnt
        DIM Text
        AppData = Emulator.GetApplicationBuffer ()
        FOR Cnt = LBOUND (AppData) TO UBOUND (AppData)
            Text = Text + STRING (1, AppData(Cnt))
        NEXT
        IF Text <> "" THEN
            MSGBOX (Text)
        ELSE
            MSGBOX ("No text received.")
        END IF
    END IF
END SUB
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GetApplicationDataLength

Syntax
long GetApplicationDataLength ()

Description
This function returns the length of the data held in a remote application's data buffer.

See also
ApplicationEvent, to handle application events.
GetApplicationBuffer, to return the contents of an application's data buffer.

Example
The following VBScript code tests whether there is data in an application's buffer:
FUNCTION DataCheck ()
    DataCheck = True
    DIM Data
    Data = Emulator.GetApplicationDataLength ()
    IF Data = 0 THEN
        DataCheck = False
    END IF
END FUNCTION
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GetDelimitedString

Syntax
string GetDelimitedString ( intLine , intCol , strDelimiters )

Description
This function returns a string delimited by one or more delimiters. Delimited strings must
appear on a single line of the emulator screen. The parameters are:
intLine The line on which the delimited string appears.
intCol The column at which the delimited string appears.
strDelimiters A string of valid delimiters.

Example
The following VBScript code returns a string delimited by asterisks on the fourth row of the
emulator screen:
Emulator.GetDelimitedString (4, 1, "*")
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GetRectAttributes

Syntax
variant GetRectAttributes ( intLineStart , intColumnStart , intLineEnd , intColumnEnd ,

intAttrMask )

Description
This function returns a rectangle's attributes as an array of longs in a variant. The parameters
are:
intLineStart The line position at which the rectangle starts.
intColumnStart The column position at which the rectangle starts.
intLineEnd The line position at which the rectangle ends. This must be greater than or

equal to intLineStart.
intColumnEnd The column position at which the rectangle ends. This must be greater than

or equal to intColumnStart.
intAttrMask The attributes you wish to retrieve. To retrieve only specific attributes,

specify the numbers associated with those attributes. This is known as a
mask.

All screen areas are inclusive or their start and end coordinates. Screen coordinates are
calculated from the top left corner of the emulator screen and begin at line 1, column 1. They
are also displayed on the emulator's status bar.
To create a mask, use the Hex values for the various screen attributes. For a table giving these
Hex values, refer to �SetRectAttributes� later in this chapter.

Example
The following VBScript code could be used to return the foreground color of a given
rectangle:
' For readability declare a variable and set
' it to the value that means foreground color.

DIM Foreground
Foreground=63488

Emulator.GetRectAttributes (LineStart, ColStart, LineEnd, ColEnd, Foreground)
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LastError

Syntax
string LastError ()

Description
This function returns the text of the last error reported in the terminal emulator.

Example
The following VBScript code returns the last error:
Emulator.LastError ()
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Load

Syntax
boolean Load ( strPath )

Description
Loads the specified emulator document. The parameter is:
strPath The path for the emulator document.
Returns TRUE if successful.

Example
The following VBScript code loads the emulator document C:\Settings\Pluto.ans:
Emulator.Load ("c:\settings\pluto.ans")
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Message

Syntax
void Message ( strMessage )

Description
This function displays a message in a message box. The parameter is:
strMessage The message to be displayed.

Example
The following VBScript code displays a message:
Emulator.Message ("Click OK to proceed")
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MsgBoxShow

Syntax
void MsgBoxShow ( boolShow )

Description
This function dictates whether emulator message boxes will run hidden in the background, or
in the foreground with the window visible. The parameter is:
boolShow Specify 1 for show, and 0 for hide.

Example
The following VBScript code hides emulator message boxes:
Emulator.MsgBoxShow (0)
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NewObject

Syntax
IDispatch* NewObject ( strClass )

Description
This function creates an object for use within a script. The parameter is:
strClass The type of object to be created.
Every application that supports OLE Automation provides at least one type of object.

See also
�Emulator objects� earlier in this chapter, for information on the Vision97 emulator objects.
�OLE Automation� in the �Terminal Emulation� chapter, for information on controlling
emulator objects from remote applications.

Example
The following VBScript code creates an Internet Explorer object, which can be called within
an emulator script:
SET Explorer = Emulator.NewObject ("InternetExplorer.Application")
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PlayRecording

Syntax
boolean PlayRecording ( intPlayType , strRecName )

Description
This function plays a terminal emulator recording session. The parameters are:
intPlayType Specify 0 for normal play, 1 for fast play, and 2 for continuous play.
strRecName The name of the recording session.
Returns TRUE if successful.

See Also
�Recording and playback� in the �Terminal Emulation� chapter.

Example
The following VBScript code plays a recording called Stock Report at normal speed:
Emulator.PlayRecording (0, "Stock Report")
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Save

Syntax
boolean Save ( strString )

Description
Saves configuration settings to the specified file. The parameter is:
strString The path to the emulator document in which the settings should be saved.
Returns TRUE if successful.

Example
The following VBScript code saves the emulator's configuration settings to the file
C:\Settings\Pluto.ans:
Emulator.Save ("c:\settings\pluto.ans")
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Scrape

Syntax
string Scrape ( intLine , intColumn , intLength )

Description
This function scrapes text from the emulator screen. The parameters are:
intLine The starting line position that text is to be scraped from.
intColumn The starting column position that text is to be scraped from.
intLength The number of characters from the start position to be scraped.
Screen coordinates are calculated from the top left corner of the emulator screen and begin at
line 1, column 1. They are also displayed on the emulator's status bar.

Example
The following VBScript code retrieves 80 characters of text from the top left hand corner of
the emulator screen:
Emulator.Scrape (1, 1, 80)



Chapter 9 � Emulator Scripting 219

SendKey

Syntax
boolean SendKey ( intKey )

Description
This function sends function key values to the UNIX application. It is useful for sending
escape sequences to the remote application. The parameter is:
intKey The value mapped to the key.
These values are listed in emulator specific files with the extension .bas or .h, for example
Ansidef.bas and Ansidef.h contain the values for the keys in the ANSI emulator. An entry
may be of the type:
Global Const ANSI_F1 = 500

The files are located in the Devkit directory on the Vision97 CD.
Returns TRUE if successful.

Example
The following VBScript code sends the ANSI F1 key value to a remote UNIX application:
Emulator.SendKey (ANSI_F1)
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SendString

Syntax
boolean SendString ( strString )

Description
Sends a character string to the remote UNIX application. The parameter is:
strString The string to send.
To enter non-printable characters, use the codes shown in the table below.

Code Meaning

\n New line
\r Carriage return
\t Tab
\b Backspace
\nnn nnn is the octal value of a character

Returns TRUE if successful.

Example
The following VBScript code sends the command ls -a to a remote UNIX application:
Emulator.SendString ("ls -a \r")
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SetRectAttributes

Syntax
boolean SetRectAttributes ( intLineStart , intColumnStart , intLineEnd , intColumnEnd ,

intAttrMask , intAttribute )

Description
This function sets a rectangle's attributes. The parameters are:
intLineStart The line position at which the rectangle starts.
intColumnStart The column position at which the rectangle starts.
intLineEnd The line position at which the rectangle ends. This must be greater than or

equal to intLineStart.
intColumnEnd The column position at which the rectangle ends. This must be greater than

or equal to intColumnStart.
intAttrMask The attributes you wish to set. To set only specific attributes, specify the

numbers associated with those attributes. This is known as a mask.
intAttribute The attribute setting.
All screen areas are inclusive or their start and end coordinates. Screen coordinates are
calculated from the top left corner of the emulator screen and begin at line 1, column 1. They
are also displayed on the emulator's status bar.
Returns TRUE if successful.
To create an attribute mask, use the values shown in the table below. The table begins with
some of the more useful masks.

Attribute Mask (Hex)

Font 0x00000600
Foreground color 0x0000F800
Background color 0x001F0000
Everything 0xFFFFFFFF
Bold 0x00000001
Dim 0x00000002
Blinking 0x00000004
Underline 0x00000008
Protected 0x00000010
Non-eraseable 0x00000020
Inverse 0x00000040
Invisible 0x00000080
Italic 0x00000100
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Attribute Mask (Hex)

Font 1 0x00000200
Font 2 0x00000400
Foreground color bit 1 0x00000800
Foreground color bit 2 0x00001000
Foreground color bit 3 0x00002000
Foreground color bit 4 0x00003000
Foreground color bit 5 0x00004000
Background color bit 1 0x00010000
Background color bit 2 0x00020000
Background color bit 3 0x00040000
Background color bit 4 0x00080000
Background color bit 5 0x00100000
High intensity 0x00200000
3D character 0x00400000

3D box 0x00800000

Hex values for colors are given in the table below.

Color Foreground Background

Black 0x00000000 0x00000000
Red 0x00000800 0x00010000
Green 0x00001000 0x00020000
Yellow 0x00001800 0x00030000
Blue 0x00002000 0x00040000
Magenta 0x00002800 0x00050000
Cyan 0x00003000 0x00060000
White 0x00003800 0x00070000
Dark Grey 0x00004000 0x00080000
Dark Red 0x00004800 0x00090000
Dark Green 0x00005000 0x000A0000
Dark Yellow 0x00005800 0x000B0000
Dark Blue 0x00006000 0x000C0000
Dark Magenta 0x00006800 0x000D0000
Dark Cyan 0x00007000 0x000E0000
Grey 0x00007800 0x000F0000
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The hexadecimal number notation used by the two of the more commonly used scripting
languages is given in the table below.

Language Notation

VBScript &HF800
JavaScript 0xF800

See also
GetRectAttributes, to return a rectangle's attributes.

Example
The following VBScript code could be used to change the font of a given rectangle to blue
and underline it:
' For readability, declare variables for the
' attributes and mask, and give them settings.
' Hex 0xF800, Hex 0x2000 and Hex 0x8 respectively

DIM Foreground
DIM Blue
DIM Underline

Foreground = 63488
Blue = 8192
Underline = 8

Emulator.SetRectAttributes (LineStart, ColStart, LineEnd, ColEnd,
Foreground|Underline, Blue|Underline)
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SetStyle

Syntax
boolean SetStyle ( strStyle )

Description
This function allows you to apply styles. The parameter is:
strStyle The style's name.
Returns TRUE if successful.

See Also
�Styles� in the �Terminal Emulation� chapter.

Example
The following VBScript code applys a style called Custom to the emulator:
Emulator.SetStyle ("Custom")
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ShowToolbar

Syntax
boolean ShowToolbar ( strToolbarName , boolShow )

Description
This function shows or hides toolbars. The parameters are:
strToolbarName

The toolbar's name. Specify the empty string �� to denote all toolbars.
boolShow Specify 1 for show, and 0 for hide.
Returns TRUE if successful.

Example
The following VBScript code displays all the toolbars associated with an emulator:
Emulator.ShowToolbar ("", 1)
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ShowWindow

Syntax
void ShowWindow ( intShow )

Description
This function dictates whether the emulator will run hidden in the background, or in the
foreground with the window visible. The parameter is:
intShow Specify 1 for show, and 0 for hide.

Example
The following VBScript code hides the emulator window:
Emulator.ShowWindow (0)
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Event handlers
Event handling functions are executed when events occur within a terminal emulator. The use of
each function is described in detail in the following pages. All examples in this chapter are
written in VBScript.

Note  If an emulator object has been declared for use within a script, then you must use the
object's programmatic ID. See �Emulator objects� earlier in this chapter for details.

ApplicationEvent Report an application event
ButtonDown Report a mouse button being clicked down
ButtonUp Report a mouse button being released
Command Report when a command is executed
DblClick Report a mouse double-click
Event Report an emulator event
HotSpotHit Report a hot spot being hit
KeyDown Report a key being pressed down
KeyUp Report a key being released
PatternHit Report a pattern being hit
RecvdData Report the arrival of data
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ApplicationEvent

Syntax
void ApplicationEvent ( intEventID , intDataLength )

Description
This event handling function reports when it receives the application event escape sequence
from a remote application. This indicates that an event has occurred in the remote
application. The parameters are:
intEventID The event's ID. Event IDs are the sole responsibility of the remote

application.
intDataLength The length of the data held in the application's data buffer.
To specify the escape character recognized by ApplicationEvent, in a terminal emulator, click
the Properties menu, and then click Script.

See also
GetApplicationBuffer, for how to return the content of an application's data buffer.
GetApplicationDataLength, for how to return the length of an application's data buffer.

Example
The following VBScript code displays a message when a specified event occurs in a remote
application:
SUB Emulator_ApplicationEvent (EventID, DataLength))
    IF EventID = 999 THEN
        Emulator.Message ("Remote application has terminated")
    END IF
END SUB
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ButtonDown

Syntax
boolean ButtonDown ( intLine , intColumn , intModifier, intButton )

Description
This event handling function reports when a mouse button is clicked down. The parameters
are:
intLine The line that was clicked.
intColumn The column that was clicked.
intModifier A key used in conjunction with the mouse. 0x0004 for SHIFT, and 0x0008

for CTRL.
intButton The mouse button. 0x0001 for left, and 0x0002 for right, and 0x0010 for

middle.
Return TRUE to ignore the default mouse action.

Example
The following VBScript code displays a message when the user clicks line 4 column 6 on the
emulator screen with the left mouse button:
SUB Emulator_ButtonDown (Line, Col, Modifier, Button)
    IF Button = 1 AND Line = 4 AND Col = 6 THEN
        Emulator.Message ("This option is not available")
    END IF
END SUB
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ButtonUp

Syntax
boolean ButtonUp ( intLine , intColumn , intModifier, intButton )

Description
This event handling function reports when a mouse button is released. The parameters are:
intLine The line at which the button was released.
intColumn The column at which the button was released.
intModifier A key used in conjunction with the mouse. 0x0004 for SHIFT, and 0x0008

for CTRL.
intButton The mouse button. 0x0001 for left, and 0x0002 for right, and 0x0010 for

middle.
Return TRUE to ignore the default mouse action.

Example
The following VBScript code displays a message when the user releases the right mouse
button:
SUB Emulator_ButtonDown (Line, Col, Modifier, Button)
    IF Button = 2 THEN
        Emulator.Message ("Right mouse button released at " & Line & ", " & Col)
    END IF
END SUB
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Command

Syntax
boolean Command ( intCommand )

Description
When an emulator command is run, this event handling function returns the unique ID for
that command. The parameters are:
intCommand The unique ID associated with the command run.
The values returned for commands are shown in the table below.

Value Command

0xE100 ID_FILE_NEW
0xE101 ID_FILE_OPEN
0xE103 ID_FILE_SAVE
0xE104 ID_FILE_SAVEAS
0xE10C ID_FILE_SEND_DOCUMENT
0xD11F ID_FILE_SEND_SCREEN
0xD126 ID_FILE_PRINT
0xE109 ID_FILE_PRINT_PREVIEW
0xE105 ID_FILE_PAGE_SETUP
0xE110 ID_FILE_MRU_1
0xE111 ID_FILE_MRU_2
0xE112 ID_FILE_MRU_3
0xE113 ID_FILE_MRU_4
0xE141 ID_FILE_EXIT
0xE122 ID_EDIT_COPY
0xE125 ID_EDIT_PASTE
0xE801 ID_VIEW_STATUS_BAR
0xD10F ID_VIEW_SPLIT_SCREEN
0xD118 ID_VIEW_FONT_LARGER
0xD119 ID_VIEW_FONT_SMALLER
0xD101 ID_SESSION_CONNECT
0xD102 ID_SESSION_DISCONNECT
0xD124 ID_SESSION_LOG_TO_FILE
0xD115 ID_RECORDING_START
0xD117 ID_RECORDING_PLAY
0xD116 ID_RECORDING_STOP
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Value Command

0x0000 ID_SCRIPT_EXECUTE
0x9C4D ID_SCRIPT_STOP
0xD103 ID_PROPERTIES_PROGRAM
0xD10B ID_PROPERTIES_SIZE_AND_POSITION
0xD104 ID_PROPERTIES_DISPLAY
0xD105 ID_PROPERTIES_FONT
0xD106 ID_PROPERTIES_ATTRIBUTES
0xD107 ID_PROPERTIES_KEYBOARD
0xD108 ID_PROPERTIES_TERMINAL
0xD10A ID_PROPERTIES_TOOLBARS
0xD112 ID_PROPERTIES_STYLES
0xD114 ID_PROPERTIES_EVENTS
0xD113 ID_PROPERTIES_RECORDINGS
0x9C4E ID_PROPERTIES_SCRIPT
0xD128 ID_PROPERTIES_COMMUNICATIONS
0xE142 ID_HELP_TOPICS
0xE145 ID_HELP_WHAT_IS_THIS
0xE140 ID_HELP_ABOUT
0xE122 ID_CONTEXT_COPY
0xE125 ID_CONTEXT_PASTE
0xD10E ID_CONTEXT_FIXED_FONT
0xD118 ID_CONTEXT_LARGER_FONT
0xD119 ID_CONTEXT_SMALLER_FONT
0xD105 ID_CONTEXT_FONT
0xD10F ID_CONTEXT_SPLIT_SCREEN
0xD10D ID_CONTEXT_AUTO_TRACK
0xD106 ID_CONTEXT_AUTO_ATTRIBUTES

Return TRUE to ignore the default command action.
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See Also
DoDefaultCommand, to control when the default command is executed.

Example
When the user chooses an emulator command, the following VBScript code displays a
message containing the command's unique ID. When the user clicks OK, the command is
executed.
FUNCTION Emulator_Command (CommandID)
    Emulator.Message ("Command ID: " & HEX (CommandID))
    Emulator.DoDefaultCommand ()
END FUNCTION
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DblClick

Syntax
boolean DblClick ( intLine , intColumn , intModifier , intButton )

Description
This event handling function responds to a mouse double-click. The parameters are:
intLine The line at which the double-click occurred.
intColumn The column at which the double-click occurred.
intModifier A key used in conjunction with the mouse. 0x0004 for SHIFT, and 0x0008

for CTRL.
intButton The mouse button. 0x0001 for left, and 0x0002 for right, and 0x0010 for

middle.
Screen coordinates are calculated from the top left corner of the emulator screen and begin at
line 1, column 1. They are also displayed on the emulator's status bar.
Return TRUE to ignore the default mouse action.

Example
The following VBScript code calls a function based on DblClick's parameters:
SUB Emulator_DblClick (Line, Col, Modifier, Button)
    IF Line = 4 AND Col = 6 THEN
        IF Button = 1 THEN
             CALL DoOnLeftDblClick
        ELSEIF Button = 2 THEN
             CALL DoOnRightDblClick
        END IF
    END IF
END SUB
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Event

Syntax
boolean Event ( intEvent )

Description
When an emulator event occurs, for instance, the window is minimized, this event handling
function is called with the unique ID for that event. The only exception to this is the arrival
of data which is handled by the RecvdData function. The parameter is:
intEvent The unique ID associated with the emulator event.
The values returned for emulator events are shown in the table below.

Value Emulator Event

0xD461 IDS_EVENT_INIT
0xD462 IDS_EVENT_CONNECT
0xD463 IDS_EVENT_DISCONNECT
0xD465 IDS_EVENT_CLOSE
0xD466 IDS_EVENT_MAXIMIZE
0xD467 IDS_EVENT_MINIMIZE
0xD468 IDS_EVENT_ACTIVATE
0xD469 IDS_EVENT_DEACTIVATED
0xD46A IDS_EVENT_DEACTIVATE
0xD47A IDS_EVENT_RESTORE

Return TRUE to ignore the default event action.

See Also
RecvdData, to handle the arrival of data.
�Events� in the �Terminal Emulation� chapter.

Example
The following VBScript code displays a message when a connection is opened or closed:
FUNCTION Emulator_Event (EventID)
    IF EventID = 54370 THEN
        Emulator.Message ("Connection Established")
    END IF
    IF EventID = 54371 THEN
        Emulator.Message ("Connection Lost")
    END IF
    Emulator_Event = 0
END FUNCTION
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HotSpotHit

Syntax
void HotSpotHit ( intRef , intLine , intColumn )

Description
This event handling function reports a hot spot being activated. A hot spot is an area of the
emulator screen that responds to a mouse action. The parameters are:
intRef The hot spot's identifier.
intLine The line at which the hit occurred.
intColumn The column at which the hit occurred.
Screen coordinates are calculated from the top left corner of the emulator screen and begin at
line 1, column 1. They are also displayed on the emulator's status bar.

See also
CreateHotSpot, to create hot spots.
DblClick, to handle double clicks on the mouse.
DestroyHotSpot, to destroy hot spots.

Example
The following VBScript code performs an action based on the identifier returned when a hot
spot is hit:
SUB Emulator_HotSpotHit (Ref, Line, Column)
    IF Ref = 1 THEN
        Emulator.SendString ("1\r")
    ELSEIF Ref = 2 THEN
        Emulator.SendString ("2\r")
    ELSEIF Ref = 3 THEN
        Emulator.SendString ("3\r")
    END IF
END SUB



Chapter 9 � Emulator Scripting 237

KeyDown

Syntax
boolean KeyDown ( intChar )

Description
This event handling function reports a key being pressed down. The parameter is:
intChar The virtual keycode for the key pressed.
See Flags.txt in the Devkit directory on the Vision97 CD for a list of virtual keycodes.
Return TRUE to ignore the default key action.

Example
The following VBScript code calles a function when the user presses the F4 function key:
FUNCTION Emulator_KeyDown (VirtKey)
' &H73 is the F4 function key
    IF VirtKey = &H73 THEN
        Call OnF4DoThis
' Stop mapping F4
    Emulator_Keydown = 1
END FUNCTION



Vision97 Reference238

KeyUp

Syntax
boolean KeyUp ( intChar )

Description
This event handling function reports a key being released. The parameter is:
intChar The virtual keycode for the key released.
See Flags.txt in the Devkit directory on the Vision97 CD for a list of virtual keycodes.
Return TRUE to ignore the default key action.

Example
The following VBScript code calls a function when the user releases the SHIFT key:
FUNCTION Emulator_KeyUp (VirtKey)
' &H10 is the Shift key
    IF VirtKey = &H10 THEN
        Call OnShiftUp
' Stop mapping Shift
    Emulator_KeyUp = 1
END FUNCTION
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PatternHit

Syntax
void PatternHit ( intRef , intNotify , intLine , intColumn )

Description
This event handling function reports a pattern being detected. A pattern is a predefined string
that is searched for whenever the emulator screen changes. The parameters are:
intRef The pattern's identifier.
intNotify The state of the pattern. 1 denotes that the pattern has appeared, and 2

denotes that it has disappeared.
intLine The line at which the pattern was detected.
intColumn The column at which the pattern was detected.
Screen coordinates are calculated from the top left corner of the emulator screen and begin at
line 1, column 1. They are also displayed on the emulator's status bar.

See also
CreatePattern, to create a pattern and specify its search parameters.
DblClick, to handle double clicks on the mouse.
DestroyPattern, to destroy patterns that are no longer required. This improves the efficiency
of a script.

Example
The following VBScript code performs calls a function based on the identifier returned when
a pattern is matched:
SUB Emulator_Main ()
    Emulator.CreatePattern (2, 2, 2, 9, "Screen1", 0, 1, 1)
    Emulator.CreatePattern (2, 2, 2, 9, "Screen2", 0, 1, 2)
END SUB

SUB Emulator_PatternHit (Ref, Notify, Line, Col)
    IF Ref = 1 THEN
        CALL Screen1
    ELSEIF Ref = 2 THEN
        CALL Screen2
    END IF
END SUB
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RecvdData

Syntax
boolean RecvdData ()

Description
This event handling function reports the arrival of data to an emulator.
Return TRUE to ignore the data received event.

See also
Event, to handle other emulator events.
�Events� in the �Terminal Emulation� chapter.

Example
The following VBScript code calls a function when data arrives at the emulator:
SUB Emulator_RecvdData ()
    CALL DoOnData
END SUB
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Tvdemo example script
Tvdemo.bas is a example script written in VBScript that operates on the Tvdemo application.
Both are supplied with the Vision97 terminal emulators.

Tvdemo.bas is located in the Demos\Scripts directory on the Vision97 CD. The Tvdemo
application is installed with Vision Services for UNIX on your host machine. Typically, Tvdemo
is in /usr/local/vision/demos. To run the Tvdemo application, enter tvdemo at the system
prompt. We recommend that you run the Tvdemo application and script in an ANSI emulator.

The Tvdemo application is a character based application with limited functionality. Tvdemo.bas
enhances this functionality by providing the user with mouse access to certain menu commands.
It is intended to illustrate just some of the possibilities that scripting offers you for application
rejuvenation.

Although Tvdemo.bas is written in VBScript, it makes almost exclusive use of the functions and
event handlers supplied with the Vision97 terminal emulators. Rewriting Tvdemo.bas in another
scripting language, such as JavaScript, should be straightforward.

Using Tvdemo.bas
As shown below, when Tvdemo.bas is started, areas of the emulator screen become bold, yellow
and underlined. These areas indicate the parts of the Tvdemo application that the Tvdemo script
has control over. Tvdemo.bas makes some menu options responsive to clicks with the left mouse
button, and it allows you to use the F4 function key.
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On the Main Menu screen, if you click menu option 2, the Tvdemo application displays the
Addresses screen. If you press the F4 function key, the Tvdemo application terminates and
returns you to the system prompt.

On the Addresses screen, if you click menu option 3, the Tvdemo application displays the
Vendors screen. If you press the F4 function key, the Tvdemo application returns to the Main
Menu screen.
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On the Vendors screen, if you click menu option 1, the Tvdemo application displays the Vendor
Maintenance screen. If you click option 2, the Vendor Inquiry screen is displayed. Both of these
screens are shown below. If you press the F4 function key, the Tvdemo application returns to the
Main Menu screen.

No mouse activated commands are available on the Vendor Maintenance screen. If you press the
F4 function key, the Tvdemo application returns to the Main Menu screen.

The Vendor Inquiry screen displays a message box. When you click OK, the Tvdemo application
returns to the Main Menu screen.
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The Tvdemo.bas source code
The Tvdemo.bas script enhances the user interface to the Tvdemo application supplied with the
Vision97 terminal emulators. The script's source code is listed below. Tvdemo.bas is written in
VBScript.

' Tvdemo.bas
'
' This script is written in VBScript.
' Emulator functions are called as emulator methods.
' Tvdemo.bas operates on the Tvdemo application supplied with the
' Vision97 terminal emulators.
' You should run Tvdemo.bas in an ANSI emulator.
' Tvdemo.bas makes areas of the screen responsive to mouse clicks.
' It also makes the F4 key active. Active areas of the screen and
' active functionality appear in yellow, bold and underlined text.

OPTION EXPLICIT

' Declare the global variables Tmp, Screen, Mask and Settings.
' Tmp is used whenever a temporary assignment is required.
' The Emulator_Keydown function uses Screen to determine which
' keystrokes to send to Tvdemo when the F4 key is pressed.
' Mask and Settings are declared to assist readability and are
' used to set display attributes. Their values are set to the
' appropriate hexadecimal values.
' Decimal 63489 equals
' Hex 0xF800 plus Hex 1 plus Hex 8 which equals
' Foreground color plus bold plus underline.
' Decimal 6145 equals
' Hex 0x1800 plus Hex 1 plus Hex 8 which equals
' yellow foreground color plus bold plus underline.

DIM Tmp
DIM Screen
DIM Mask
DIM Settings

Mask = 63497
Settings = 6153

' MainHotSpots creates a hot spot on the emulator screen.
' MainHotSpots is called when the pattern "Main Menu" appears on the
' emulator screen.
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FUNCTION MainHotSpots
    ' Set the value of Screen to 1.
    Screen = 1
    ' Destroy any existing hot spots.
    Emulator.DestroyHotSpot (-1)
    ' Create a hot spot that is sensitive to the left mouse button
    ' and returns 1 when hit.
    Tmp = Emulator.CreateHotSpot (7, 4, 7, 15, 1, 1)
    ' Set the text of the hot spot to yellow, bold, underline
    Tmp = Emulator.SetRectAttributes (7, 4, 7, 15, Mask, Settings)
END FUNCTION

' AddressHotSpots creates a hot spot on the emulator screen.
' AddressHotSpots is called when the pattern "Addresses" appears on the
' emulator screen. For comments, see the function MainHotSpots but note
' that in this case the value of Screen is set to 2.

FUNCTION AddressHotSpots
    Screen = 2
    Emulator.DestroyHotSpot (-1)
    Tmp = Emulator.CreateHotSpot (7, 4, 7, 16, 1, 2)
    Tmp = Emulator.SetRectAttributes (7, 4, 7, 16, Mask, Settings)
END FUNCTION

' VendorHotSpots creates hot spots on the emulator screen.
' VendorHotSpots is called when the pattern "Vendors" appears on the
' emulator screen. For comments, see the function MainHotSpots but note
' that in this case the value of Screen is set to 3.

FUNCTION VendorHotSpots
    Screen = 3
    Emulator.DestroyHotSpot (-1)
    Tmp = Emulator.CreateHotSpot (5, 4, 5, 27, 1, 3)
    Tmp = Emulator.SetRectAttributes (5, 4, 5, 27, Mask, Settings)
    Tmp = Emulator.CreateHotSpot (6, 4, 6, 23, 1, 4)
    Tmp = Emulator.SetRectAttributes (6, 4, 6, 23, Mask, Settings)
END FUNCTION

' VendorMaintenance is called when the pattern "VW Vendor Maintenance"
' appears on the emulator screen. It sets the value of Screen to 4.

FUNCTION VendorMaintenance
    Screen = 4
END FUNCTION

' Emulator_Main is the scripts starting point.
' Create the patterns that determine which Tvdemo screen is displayed,
' and detect F4 on the emulator screen.
' Patterns are created to identify five screens and the pattern F4.
' As pattern matching occurs whenever the emulator screen changes,
' pattern matching for the five screens has been restricted to the
' smallest possible area, and the pattern is only matched if it starts
' at the first cell in the specified area. This makes the script more
' efficient.
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' The pattern F4 is matched anywhere on the emulator screen.
' Patterns are only matched when they appear.
' The final parameter is the value returned when the pattern is
' matched. This value is used by the procedure Emulator_PatternHit.

SUB Emulator_Main ()
    Tmp = Emulator.CreatePattern (2, 37, 2, 45, "Main Menu", 0, 1, 1)
    Tmp = Emulator.CreatePattern (2, 38, 2, 46, "Addresses", 0, 1, 2)
    Tmp = Emulator.CreatePattern (2, 41, 2, 47, "Vendors", 0, 1, 3)
    Tmp = Emulator.CreatePattern (1, 38, 1, 54, "VW Vendor Inquiry", 0, 1, 4)
    Tmp = Emulator.CreatePattern (1, 36, 1, 56, "VW Vendor Maintenance", 0, 1, 5)
    Tmp = Emulator.CreatePattern (1, 1, 26, 80, "F4", 1, 1, 6)
END SUB

' Emulator_PatternHit responds to a pattern being matched.
' When one of the five screen patterns is matched, a function is called.
' When the pattern F4 is matched, its display attributes are set to
' yellow, bold, underline.

SUB Emulator_PatternHit (Ref, Notify, Line, Col)
    IF Ref = 1 THEN
        CALL MainHotSpots
    ELSEIF Ref = 2 THEN
        CALL AddressHotSpots
    ELSEIF Ref = 3 THEN
        CALL VendorHotSpots
    ELSEIF Ref = 4 THEN
        CALL ReturnToMain1
    ELSEIF Ref = 5 THEN
       CALL VendorMaintenance
    ELSEIF Ref = 6 THEN
        Tmp = Emulator.SetRectAttributes (Line, Col, Line, (Col+1), Mask, Settings)
    END IF
END SUB

' Emulator_HotSpotHit responds to a user clicking a hot spot
' with the left mouse button.
' The hot spot's return value is used to determine which keystrokes
' to send to the Tvdemo application.

SUB Emulator_HotSpotHit (Ref, Line, Column)
    IF (Ref = 1) OR (Ref = 4) THEN
        Emulator.SendString ("2\r")
    ELSEIF Ref = 2 THEN
        Emulator.SendString ("3\r")
    ELSEIF Ref = 3 THEN
        Emulator.SendString ("1\r")
    END IF
END SUB

' Emulator_KeyDown responds to a user pressing a key. This is used
' to make the F4 key active.
' If the virtual keycode for the key pressed equals &H73 (F4), the
' value of Screen is used to determine which keystrokes to send to



Chapter 9 � Emulator Scripting 247

' the Tvdemo application, or, in the case of the VW Vendor
' Maintenance screen, to call the function ReturnToMain2.

FUNCTION Emulator_KeyDown (VirtKey)
    IF VirtKey = &H73 AND Screen = 1 THEN
        Emulator.SendString ("q\r")
    ELSEIF VirtKey = &H73 AND (Screen = 2) OR (Screen = 3) THEN
        Emulator.SendString ("\r")
    ELSEIF VirtKey = &H73 AND Screen = 4 THEN
        CALL ReturnToMain2
    END IF
' Stop mapping F4 as the required action has been performed
    Emulator_Keydown = 1
END FUNCTION

' ReturnToMain1 is called when the VW Vendor Inquiry screen is
' displayed. It returns the user to the Main Menu screen.
' A message box is displayed. When the user clicks OK, they
' are returned to the Main Menu screen.

SUB ReturnToMain1
    Emulator.DestroyHotSpot (-1)
    Emulator.Message ("Return to Main Menu")
    Emulator.SendString ("\r\r")
END SUB

' ReturnToMain2 is called when the user presses the F4 key in
' the VW Vendor Maintenance screen. It uses a For loop to send the
' keystrokes required to return the user to the Main Menu screen.

SUB ReturnToMain2
    DIM i
        FOR i = 1 TO 27
            Emulator.SendString ("\r")
        NEXT
END SUB

Script summary
The Tvdemo.bas script enhances the user interface to the Tvdemo application supplied with the
Vision97 terminal emulators. It makes some menu options responsive to clicks with the left
mouse button, and it allows the user to use the F4 function key to exit the current screen or the
application.

The Emulator_Main procedure creates patterns that identify which of the Tvdemo application's
screens is currently displayed in the emulator. It also creates a pattern to detect the presence of
F4 on the emulator screen.

The Emulator_PatternHit procedure handles the appearance of a pattern. If one of the patterns
that identifies a screen appears, a function is called to provide the user interface required by that
screen, such as hot spots on menu commands.
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When the user clicks a hot spot, the Emulator_HotSpotHit procedure uses that hot spot's unique
reference to call functions that perform the appropriate action.

Whenever the pattern F4 is matched, its display attributes are changed to bold, yellow and
underline. This is only to indicate to the user that the F4 key can be used. The actual use of the
F4 function key is handled by a separate procedure called Emulator_KeyDown. If the user
presses a key and that key is F4, functions are called to perform the necessary action in the
Tvdemo application.

The Tvdemo.bas script demonstrates a number scripting's features. The pattern matching
functions CreatePattern and PatternHit are used to ensure that a user interface suitable for the
current screen is displayed. The hot spot functions CreateHotSpot, DestroyHotSpot and
HotSpotHit are used to ensure that only valid hot spots are available on each screen, and that
when the user clicks a hot spot, the correct action is taken. The KeyDown function is used to
enable the F4 function key. The Message function is used to display a message box. Finally,
throughout the script, the SetRectAttributes function is used to set screen attributes, and the
SendString function is used to send keystrokes to the Tvdemo application.

Script initialization
The starting point for Tvdemo.bas is the procedure Emulator_Main. This uses the CreatePattern
function to create six patterns. Five patterns are created to uniquely identify screens in the
Tvdemo application, and one pattern is created to detect the presence of F4 on the emulator
screen.

As pattern matching occurs whenever the emulator screen changes, pattern matching for the five
screens has been restricted to the smallest possible screen area, and the pattern is only matched if
it starts at the first cell in the specified area. This makes the script more efficient. As we want to
detect F4 anywhere on the emulator screen, the coordinates for the entire screen are given.
Patterns are only matched when they appear, and when a pattern is matched, a unique reference
number is returned.

Four global variables are declared. Tmp is used whenever a temporary assignment is required.
Screen is used by the Emulator_KeyDown procedure to differentiate between the screens in the
Tvdemo application.

Mask and Settings are declared to assist readability and are used by the SetRectAttributes
function to set display attributes. Mask is set to the decimal value 63497. This equals the sum of
Hex 0x1800, Hex 1 and Hex 8, which are the Hex values for foreground color, bold and
underline respectively. Mask instructs SetRectAttributes to only set these specific attributes.
Settings is set to the decimal value 6153. This equals the sum of Hex 0x1800, Hex 1 and Hex 8.
0x1800 is the Hex value for foreground color yellow. Settings is used to set the attributes
specified in Mask. For details about Hex values and setting attributes, refer to
�SetRectAttributes� earlier in this chapter.
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Event handling
The Tvdemo.bas script can handle three events in the Tvdemo application: the detection of a
pattern, a mouse click on a hot spot, and a key press.

If one of the patterns created by the Emulator_Main procedure is matched, an event occurs. This
event is handled by the Emulator_PatternHit procedure. Based on the unique reference number
returned when a pattern is matched, a function is called. For example, when the pattern
Addresses is matched, the Emulator_PatternHit procedure, on the basis of the return value 2,
calls the function AddressHotSpots.

The function AddressHotSpots creates a hot spot on the emulator screen. Firstly it sets the value
of the global variable Screen to 2. This value is used by the Emulator_Keydown procedure. The
function DestroyHotSpot is then called to ensure that any existing hot spots are destroyed. The
CreateHotSpot function then creates a hot spot at the given set of coordinates. The hot spot
responds to the left mouse button only and it returns the value 2 when hit. The SetRectAttributes
function is then used to make the text of the hot spot appear bold, yellow and underlined. This is
how menu options in the Tvdemo application are made sensitive to the mouse.

When the pattern VW Vendor Inquiry is matched, the Emulator_PatternHit procedure calls the
user-defined function ReturnToMain1. This uses the Message function to display a message box.
When the user clicks OK, the SendString function sends two carriage returns to the Tvdemo
application. This returns the user to the Main Menu screen.

When the pattern F4 is matched, the Emulator_PatternHit procedure calls the SetRectAttributes
function to make F4 appear bold, yellow and underlined. SetRectAttributes uses the Line and
Col parameters from Emulator_PatternHit to determine where F4 appears on the emulator
screen.

When the user clicks a hot spot with the left mouse button, an event occurs. This event is
handled by the Emulator_HotSpotHit procedure. Based on the reference returned when the hot
spot was hit, the SendString function is called with the appropriate keystrokes. The keystrokes
are what a user would enter to access the menu option if using the Tvdemo application without
the Tvdemo script.

When the user presses a key, an event occurs. This event is handled by the Emulator_KeyDown
function. If the key pressed is &H73 (the virtual keycode for the F4 function key), the value of
the global variable Screen is used to determine which function to call. The called function sends
the keystrokes required to either exit the Tvdemo application or return to the Main Menu
screen.
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Vision ODBC driver overview
The Vision ODBC driver allows a Windows application to access multiple databases on multiple
hosts simultaneously. It does not require the presence of database network software such as
SQL*Net or INGRES/Net. This architecture allows you to use powerful Windows query builder
and report writer applications to merge data from many different databases, and you can also
update remote data if you have permission to do so. The Vision ODBC driver is fast, because of
a unique read-ahead facility.

Part of the Vision ODBC driver runs on the PC, and part on the remote UNIX system. The PC
part is called Vwodbc32.dll, and it is installed in the \Windows\System directory. On the UNIX
host, there is a �server module� which is specific to a particular DBMS on a specific version of
UNIX. The two modules communicate using the RPC mechanism. The Vision ODBC driver uses
the USP RPC service built into Vision Communications Architecture. The lite version of the
Vision ODBC driver does not use Vision Communications Architecture, it uses an RPC
mechanism built into the driver instead. Vwodbc32.dll can access multiple server modules on
one or more hosts simultaneously.

Note  The term Vision ODBC driver refers to both versions of the driver unless specifically
noted.

Open Database Connectivity
Open Database Connectivity (ODBC ) is Microsoft�s strategic interface which eases the burden
of data access by creating an open and powerful means of accessing a wide range of database
systems. ODBC is an emerging standard and a component of the Microsoft Windows Open
Services Architecture (WOSA). The diagram below shows components of the Vision ODBC
model.
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ODBC-Aware Windows Application.  A Microsoft Windows application that supports ODBC
can manipulate a data source.

Non-ODBC Windows Application.  Some Microsoft Windows applications do not support
ODBC, but do support Dynamic Data Exchange (DDE) links to other Windows applications.
This type of application can use SQL-Exchange to access ODBC data sources indirectly.

JDBC-Aware Application/Applet.  A Java application/applet that uses the JDBC API can
manipulate a data source.

JDBC Driver Manager.  The JDBC API defines Java classes to represent database connections,
SQL statements, result sets, database metadata, and so on. The JDBC API is implemented via a
driver manager that can support multiple drivers connecting to different databases. The driver
manager is provided by Sun Microsystems.

JDBC/ODBC Bridge.  The bridge driver translates JDBC method calls into ODBC function
calls. The bridge driver is provided by Sun Microsystems.

SQL-Exchange.  If the application is not able to access ODBC directly, it may send DDE
messages to SQL-Exchange which in turn calls corresponding ODBC functions and returns
results to the client. SQL-Exchange is provided by SCO.

ODBC Driver Manager.  This is a dynamically-linked library (DLL) provided by Microsoft. It
uses the ODBC Data Sources key in the Windows Registry or the appropriate .dsn file for a file
data source to map data source names specified by an application to drivers, which it loads as
required on behalf of the application.
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Vision ODBC Driver.  The driver is a DLL that processes ODBC function calls, and returns
results to the application. The Vision ODBC driver is a �multiple-tier� driver that processes
ODBC calls, and passes SQL statements to the data source.

Server Module.  The Vision ODBC driver has a PC-based component and a server module that
are connected through the RPC mechanism.

Data Source.  Consists of the data the user wants to access and its associated operating system,
DBMS, and communications link (if any) required to access the DBMS.

Adding, modifying and deleting data
sources
An ODBC data source is a specific instance of a combination of a DBMS product and any remote
operating system and network necessary to access it. For example, an Ingres database called
Training on a host called Jupiter running SunOS and accessed over a TCP/IP network. You need
to add data sources before you can access data with the Vision ODBC driver. You can change or
delete a data source at any time.

To add a user data source

1 Do one of the following:
§ Click the Start button, point to Settings, and click Control Panel. Double-click the 32bit

ODBC icon.
§ For older versions of Windows NT, open the Main group in Program Manager, then

double-click the Control Panel icon. Double-click the 32bit ODBC icon.
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2 Click the Add button.

3 Select SCO Vision ODBC from the list.
4 Click the Finish button.
5 Complete the configuration dialog box. If you are using the lite version of the Vision ODBC

driver, the dialog box will contain a Connection tab. You need to use this tab to supply
connection details for the database host.
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For Help on an item, click  at the top of the dialog box, and then click the item.

A data source can be set up with a system data source name that can be used by more than one
user on the same machine. The system data source name can also be used by a system-wide
service, which can then gain access to the data source even if no user is logged onto the machine.

To add a system data source

1 Do one of the following:
§ Click the Start button, point to Settings, and click Control Panel. Double-click the 32bit

ODBC icon.
§ For older versions of Windows NT, open the Main group in Program Manager, then

double-click the Control Panel icon. Double-click the 32bit ODBC icon.
2 Click the System DSN tab.
3 Click the Add button.
4 Select SCO Vision ODBC from the list.
5 Click the Finish button.
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6 Complete the configuration dialog box. If you are using the lite version of the Vision ODBC
driver, the dialog box will contain a Connection tab. You need to use this tab to supply
connection details for the database host.
For Help on an item, click  at the top of the dialog box, and then click the item.

You can also configure a file data source in which connection information is stored in a .dsn file
that can be shared among several users.

To add a file data source

1 Do one of the following:
§ Click the Start button, point to Settings, and click Control Panel. Double-click the 32bit

ODBC icon.
§ For older versions of Windows NT, open the Main group in Program Manager, then

double-click the Control Panel icon. Double-click the 32bit ODBC icon.
2 Click the File DSN tab.
3 Click the Add button.
4 Select SCO Vision ODBC from the list.
5 Click Next.
6 Type the name of the file data source in the space provided. If you want the file to be saved

in a different location (by default the C:\Program Files\Common Files\ODBC\Data Sources
folder), click the Browse button.

7 Click Next.
8 Click Finish.

A connection is opened and the Data Source Connection Information dialog is displayed to
allow you to specify connection information for the data source.

9 Complete the dialog box. For the Vision ODBC driver, you do not have to specify the Host
Username and Password, as the Username and Password entries for the specified host in the
Vision Communications database will be used by default. For the lite version of the Vision
ODBC driver, you should specify the Host Username and Password in the spaces provided.
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For Help on an item, click  at the top of the dialog box, and then click the item.

Note  If you are using the lite version of the Vision ODBC driver with a file data source, you
will be prompted for a username and password each time you subsequently connect to the data
source (because the username and password you suppy when configuring the data source are
only used to verify the connection and are not stored). To get around this you can edit the
appropriate .dsn file with a text editor and use the UID= and PWD= connection string settings
to supply your username and password. See �Connection String� later in this chapter for more
information.

To modify a data source

1 Do one of the following:
§ Click the Start button, point to Settings, and click Control Panel. Double-click the 32bit

ODBC icon.
§ For older versions of Windows NT, open the Main group in Program Manager, then

double-click the Control Panel icon. Double-click the 32bit ODBC icon.
2 Do one of the following:
§ In the ODBC Data Source Administrator dialog box, select the data source from the list

and click the Configure button.
§ For a system data source, click the System DSN tab, select the data source from the list,

then click the Configure button.
§ For a file data source, click the File DSN tab, select the data source from the list, then

click the Configure button.
3 In the SCO Vision ODBC Setup dialog box (or the Data Source Connection dialog box for a

file data source), set the option values as necessary.
For Help on an item, click  at the top of the dialog box, and then click the item.
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To delete a data source

1 Do one of the following:
§ Click the Start button, point to Settings, and click Control Panel. Double-click the 32bit

ODBC icon.
§ For older versions of Windows NT, open the Main group in Program Manager, then

double-click the Control Panel icon. Double-click the 32bit ODBC icon.
2 Do one of the following:
§ In the ODBC Data Source Administrator dialog box, select the data source you want to

delete from the list.
§ For a system data source, click the System DSN tab, then select the data source you want

to delete from the list.
§ For a file data source, click the File DSN tab, then select the data source you want to

delete from the list.
3 Click the Remove button.

Advanced configuration options
When you connect to a data source, the application passes a connection string to the ODBC
Driver Manager. The connection string may contain several settings, as described in �Connection
String� later in this chapter. If any settings are not specified in the connection string passed by
the application, the Driver Manager looks in the Windows Registry for a user or system
(machine) data source or the appropriate .dsn file for a file data source and uses values stored
there when you configured the data source. If the Driver Manager does not find required
settings, it will prompt the user to enter them at connect time.

Some connection string settings are optional, and have default values if not specified. If you want
to specify new values for settings which are not configurable from the dialog box, you need to
modify the HKEY_CURRENT_USER\SOFTWARE\ODBC\ODBC.INI\data-source-name key
for a user data source or HKEY_LOCAL_MACHINE\SOFTWARE\ODBC\ODBC.INI\data-
source-name key for a system data source using Registry Editor. For a file data source, you can
edit the appropriate .dsn file (normally stored in the C:\Program Files\Common
Files\ODBC\Data Sources folder) with Windows Notepad or another text editor.

Enabling fields in the SCO Vision ODBC Setup
dialog box
The Database Name, Username, Password and Options fields in the General tab of the SCO
Vision ODBC Setup dialog box will be available or unavailable depending on whether or not
they are normally applicable to the selected DBMS. If required this availability may be changed
by modifying the values stored in the DBMS-specific subkey of the
HKEY_LOCAL_MACHINE\SOFTWARE\SCO\VWODBC.INI key in the Windows Registry.
There is a subkey containing values for each supported DBMS. For example, the values for
Informix are:
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Name Data

DBname yes
DBuser no
DBauth no
DBoptions no

When a value is �yes� then that option will be active in the SCO Vision ODBC Setup dialog box.
If the value is �no� then the option will be unavailable.

Distributing data sources
You can use SCO SuperVision to distribute sharable file data sources to other users if this
software is in use at your site. (Unsharable file data sources as the name implies cannot be shared
amongst users.) Each .dsn file contains configuration information for one data source. If you
want to distribute multiple data sources in one file, then you can use Data Source Export. Data
Source Export is a utility provided with the Vision ODBC driver that allows a selection of user
or system data sources to be saved as one Registry file. This can also be distributed using
SuperVision.

To save data sources as a Registry file

1 Do one of the following:
§ In My Computer or Windows Explorer, open the \Program Files\Vision folder, and then

double-click Dsexp.exe.
§ For older versions of Windows NT, open the Main Group in Program Manager, double-

click File Manager, open the \Vision folder, and then double-click Dsexp.exe.
2 In the Data Sources list, select the data sources you want to distribute. To select more than

one data source, hold down the CTRL key, and then click the data sources you want. Note
that the list shows both user and system data sources enabling both types of data source to be
distributed as one file.

3 Click the Save button. Type a name for the file, and choose a folder in which to store it.
4 Click the Close button.

Connecting to an ODBC data source
When you connect to an ODBC data source, the application may prompt you for additional
information. It may display the Select Data Source dialog box for you to choose a data source.
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Depending on how much information you specified when configuring the data source, the
connection process to the remote host may be initiated and the database opened. If this is the
first time you have connected to this host, you will be prompted to enter a username and
password.

If you omitted information such as the database username or password, then you will be
prompted to specify the missing information. The Data Source Connection Information dialog
box is displayed:

For Help on an item, click  at the top of the dialog box, and then click the item.
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Creating the demonstration database
To allow you to test the Vision ODBC driver, and follow the examples of using it with popular
applications, you are recommended to create a number of demonstration tables. The tables are
based on the requirements of a fictitious supplier of sporting goods, the west-coast based Ocean
Paradise, Inc. This is a wholesale company supplying small retail outlets in northern California.
The database tables are described in detail in the Appendices.

You use the SCO SQLGold program to create the tables, but first you must have created a data
source called �scodemo�. Refer to �Adding, Modifying and Deleting Data Sources� earlier in this
chapter for instructions about creating the data source. The �scodemo� data source should be
associated with a test database in which you can create tables. For hints about creating or
accessing a database, see �Demonstration Database� in the section on the server module for your
DBMS later in this chapter.

To create the demonstration tables

1 Do one of the following:
§ Click the Start button, point to Programs, point to Vision, and click SQL Gold.
§ For older versions of Windows NT, open the Vision group in Program Manager, and

double-click the SQL Gold icon.
2 On the Database menu, click Open Database.

The Select Data Source dialog box is displayed.
3 Do one of the following:
§ If you configured �scodemo� as a user or system data source, click the Machine Data

Source tab.
§ If you configured �scodemo� as a file data source, click the File Data Source tab.

4 Choose �scodemo�.
Wait for the message �DB open� to appear in the status bar at the bottom of the SQLGold
window.

5 On the File menu, click Open.
6 Select the SQL file Scodemo.sql.

Setup placed the SQL files in the \Program Files\Vision\Examples folder or \Vision\Examples
on older versions of Windows NT.
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7 When the SQL statements appear in the window, click the Run button.
When SQLGold has finished executing statements, the Ready message is redisplayed in the
status bar.

8 To confirm that the demonstration tables have been created, click the Tables button.
A list of the tables in the data source is displayed.

9 Double-click the �sales� table.
A SELECT statement to query the table is generated and appears in the SQL Statements pane.

10 Click the Run button.
The Sales table should appear, confirming that the tables have been created successfully.

The VCR-style buttons are only enabled when Form view is selected. Use the Options menu to
change the view preference. Click Help Topics on the Help menu for full instructions. The same
information can be seen by choosing How To Use SQLGold from the main Vision Help
Contents.

Deleting the demonstration database
You can use SQLGold to delete the Scodemo tables from your data source. Open the SQL file
called Dropsco.sql, and run the SQL statements to drop the tables.
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Connection string
The connection string for the Vision ODBC driver uses the following settings.

Setting Description

DSN=string The name of the data source. Default is a null string (��) which
causes the SQL Data Sources dialog box to be displayed for the user
to choose a data source.

UID=string The user login ID. Default is to use the Username from the host
entry in the Vision Communications database if this is available.

PWD=string The user login password. Default is to use the Password from the
host entry in the Vision Communications database if this is
available.

Hostname=string The name of the host as specified in the Vision Communications
database if this is available.

ServerID=string The database type of the server module (e.g. Ingres).
DBname=string The name of the database.
DBuser=string The username required to access the DBMS.
DBauth=string The password required to access the DBMS.
DBoptions=string Database-specific options separated by commas in a text string.

Refer to notes about the various server modules later in this
chapter.

FetchCache=0|1 Specifies whether caching is enabled.
0 Disabled
1 Enabled (default)

CacheMemory=Kbytes Specifies the cache size in Kbytes. The maximum cache size that can
be specified is 64 Kbytes. The default is 32 Kbytes.

CacheRows=num Specifies the cache size in terms of the number of rows to be read
into the cache. The number of rows requested should not exceed
the 64 Kbyte cache size limit. The default for CacheRows is 0,
disabling the setting. To enable CacheRows, set CacheMemory to
0, then specify a value for CacheRows.

CacheIdle=num Specifies the time in milliseconds that the UNIX server should wait
for requests from the PC, before starting to refill the cache with
data. Any requests received from the PC within the period of time
specified by num will be honored. The default is 100 milliseconds.
A value of 0 will disable this setting.

ReadOnly=0|1 If this option is enabled, then the data source will be opened for
read-only access.
0 Disabled (default)
1 Enabled



Chapter 10 � Vision ODBC Driver 267

Setting Description

VirtualServer=0|1 If this option is enabled, then only one connection to the remote
host will be opened for each Windows application using the data
source. The ODBC driver will allow an application to open
multiple �connections,� but in fact these are connections to �virtual
servers� and there is only one real server per application, per data
source. Note that this option should only be used for read-only data
sources. It is possible to enable the VirtualServer option without
enabling the ReadOnly option but this is not recommended.
0 Disabled (default)
1 Enabled

ServerOptions=num Specifies server module options. The decimal values of options may
be added together. Further explanation of the options is given in
context in the notes about the various server modules later in this
chapter. The default is 1.
0 None.
1 Allow write access to tables when using Microsoft

Access.
2 Reserved for future use.
4 Use owner names in catalog functions.
8 Hold cursor support enabled.
16 Support for the SQL ORDER BY clause disabled.
32 Hold commit requests until all transactions are complete

when autocommit is enabled.
64 Disable the reporting of the Informix DECIMAL column

precision as 15 rather than 16.
128 Disable the reporting of Ingres hash, isam, and btree

indices.
256 Enclose owner names with quotation marks during the

processing of SQL statements.
512 Disable the reporting of the period symbol (.) as a

qualifier name separator.
1024 Show Progress System tables in User table list.
2048 Enable applications such as Microsoft Access to update

Progress data sources.
4096 Disable the simplification of SQL generated by Microsoft

Access when an Ingres table with multiple column
indexes is linked.

8192 Enable applications such as Microsoft Access to read and
update records in tables where Oracle NUMBER
columns with integer values are used as a key.

16384 Map Ingres varchar and text data types of length greater
than 254 characters to the SQL_VARCHAR data type.

32768 Enable Microsoft Access to perform joins between local
and remote tables more efficiently.
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Setting Description

DebugOptions=num The level of debug information required. 0 is no debug (default).
See �Using Debug Mode� later in this chapter.

DebugPCFile=string The name of the debug file on the PC. The default is
C:\Vwodbc.txt.

DebugHostFile=string The name of the debug file on the host. The default is vwodbc.log
in the home directory.

DebugHostAppend=0|1 Specifies the way in which debug information is written to the host
debug file.
0 Overwrite contents of the log file with new debug

information each time the host module of the Vision
ODBC driver is called upon to provide it.

1 Append debug information to the host log file (default).
DebugPCAppend=0|1 Specifies the way in which debug information is written to the PC

debug file.
0 Overwrite contents of the log file with new debug

information each time the PC part of the Vision ODBC
driver is called upon to provide it.

1 Append debug information to the PC log file (default).
EnvironmentFile=filename The name of the configuration file on the host used to set up the

necessary environment variables needed to access the DBMS. The
host module of the Vision ODBC driver will look for .filename in
the user�s login directory, then for filename in the /usr/local/vision/
etc directory, where filename is the name of the specified
configuration file. If you include a path, the host module will look
for filename in the directory that you specify. The default is the
Vision ODBC driver configuration file, for example infsqld.conf for
Informix.

Timeout=num Specifies the number of minutes after the last communications
activity that the UNIX server should wait before exiting. The
default value of 0 specifies that no timeout is to be applied.

QueryTimeout=num Specifies the number of seconds that the Vision ODBC driver
should wait for an SQL statement to execute before returning to the
application with an error message. The default value of 0 specifies
that no query timeout is to be applied. Note that if an application
allows you to specify a query timeout, then it will override this
setting.

Port=num Specifies the port used by the UNIX server module. This should be
used in conjunction with the -l server command line option (for
further information, look up �odbc_server� in the Help index). By
default the RPC portmapper will be used to supply the port
number. This setting only is only applicable to the lite version of
the Vision ODBC driver.
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Setting Description

TCPOptions=num Specifies remote TCP/IP options of which there are two,
TCP_NODELAY and TCP/IP Keepalive. The default is 1.
0 The TCP_NODELAY option is enabled on the remote

socket. This allows the remote TCP/IP layer to send small
packets without making an attempt to coalesce them.
The use of �keep alive� packets as a means of timing out
the UNIX server is disabled.

1 The TCP_NODELAY option is enabled on the remote
socket. TCP �keep alive� packets are used as a means of
detecting that the PC is no longer active, enabling the
UNIX server to exit. The length of time that the UNIX
host will wait, after a connection becomes idle, before
sending �keep alive� probes is a configurable TCP/IP
parameter in the kernel configuration file. The usual
default for this parameter is two hours.

2 The TCP_NODELAY option is disabled on the remote
socket. The use of �keep alive� packets as a means of
timing out the UNIX server is disabled.

3 The TCP_NODELAY option is disabled on the remote
socket which can cause the remote TCP/IP layer to buffer
small packets until a larger packet can be sent. TCP
�keep alive� packets are used as a means of detecting that
the PC is no longer active, enabling the UNIX server to
exit.

SQLSyntax=num Specifies the way ODBC SQL grammar should be translated to the
native database SQL grammar. This currently applies to the
extensions for dates and times, scalar functions, outer joins, and
procedures. The default is 3.
0 The SQL is translated to native database SQL and passed

to the DBMS. If SQL that does not conform to ODBC
grammar is found during translation, a syntax error is
returned.

1 No translation is done. The SQL is passed directly to the
DBMS.

2 The SQL is translated to native database SQL and passed
to the DBMS. If SQL that does not conform to ODBC
grammar is found during translation, it is passed to the
DBMS without generating an error.

3 The SQL is initially executed without translation. If the
DBMS returns an error then the SQL is translated and
resubmitted to the DBMS.
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Setting Description

TranslationName=string The name of the default translator, for example �SCO Vision
Language Translator�. See �Translating Data� later in this chapter.

TranslationDLL=string The full pathname of the default translation DLL, for example
C:\Windows\System\Vwxlt32.dll. See �Translating Data� later in
this chapter.

TranslationOption=num Specifies options to the translation DLL. If the SCO Vision
Language Translator is used, the only option is a decimal number
specifying the language. This number refers to a subkey of the
HKEY_LOCAL_MACHINE\SOFTWARE\SCO\VWXLT.INI key
in the Windows Registry which contains values for the character
mappings to be used.

For example, to connect to a data source called �scodemo� that is currently associated with an
Ingres database called �stevel� on a host called �jupiter,� you might specify a connection string as
follows:

DSN=scodemo

Assuming that all required elements were entered when the data source was configured, no other
settings need to be specified. The Driver Manager will read settings from the Windows Registry
or the appropriate .dsn file for a file data source, and supply default values where the option is
not otherwise specified.

Error messages
When an error occurs, the Vision ODBC driver returns the native error number, the SQLSTATE
(an ODBC error code), and an error message. The driver derives this information both from
errors detected by the driver and errors returned by the DBMS.

Native Error
For errors that occur in the data source, the Vision ODBC driver returns the native error
returned to it by the DBMS. For errors detected by the driver or the Driver Manager, the Vision
ODBC driver returns a native error of zero. For a list of native errors, refer to the
documentation for your DBMS.

SQLSTATE
For errors that occur in the data source, the Vision ODBC driver maps the returned native error
to the appropriate SQLSTATE. If the error occurs in the data source and can�t be mapped, the
Vision ODBC driver returns SQLSTATE 37000 (Syntax error or access violation). For errors
that are detected by the driver or the Driver Manager, the Vision ODBC driver or Driver
Manager generates the appropriate SQLSTATE.
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Error Message
For errors that occur in the data source, the Vision ODBC driver returns an error message based
on the message returned by the DBMS. For errors that occur in the Vision ODBC driver or the
Driver Manager, the Vision ODBC driver returns an error message based on the text associated
with the SQLSTATE. For a list of error messages that can be returned by the DBMS, see the
documentation for your DBMS.

Error messages have the following format:

[vendor][ODBC-component][data-source]error-message

where the prefixes in brackets ([ ]) identify the source of the error. The following table shows the
values of these prefixes returned by the Vision ODBC driver.

Note  When the error occurs in the data source, the [vendor] and [ODBC-component] prefixes
identify the vendor and name of the ODBC component that received the error from the data
source.

Error Source Prefix Value

Driver Manager [vendor] [Microsoft]
[ODBC-component] [ODBC DLL]
[data-source] N/A

SCO Vision Driver [vendor] [SCO]
[ODBC-component] [ODBC Driver]
[data-source] N/A

DBMS [vendor] [SCO]
[ODBC-component] [ODBC Driver]
[data-source] [database-type]

e.g. Ingres

ODBC API functions
The Vision ODBC driver supports all core and Level 1 functions and the following Level 2
functions:

SQLMoreResults
SQLExtendedFetch
SQLNumParams
SQLProcedures
SQLProcedureColumns
SQLNativeSql

In addition, the Vision ODBC driver supports translation DLLs.
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Limitations to ODBC API functions
The following functions in the Vision ODBC driver don�t meet the specifications in the
Microsoft ODBC SDK Programmer�s Reference. These comments apply to all databases; further
limitations may be noted in the sections on the specific server modules.

Function Description

SQLSetConnectOption
When used with SQL_LOGIN_TIMEOUT, the driver returns
SQL_SUCCESS, but the login timeout is not changed.

SQLGetData, SQLBindCol
The RPC mechanism which is used for communications between
the PC part and the host part of the driver has a packet size limit of
64 Kbytes. If you attempt to retrieve a larger amount of data in a
single transfer, then the results will be unpredictable.

SQLExtendedFetch
This can only be used in conjunction with static, forward-only
cursors. In addition, retrieved rowset data must be bound in a
column-wise fashion. A more sophisticated implementation of
SQLExtendedFetch will require the Microsoft ODBC Cursor
Library to be enabled for a connection.

Implementation issues
The following implementation-specific issues might affect the use of the Vision ODBC driver.

Issue Description

Cursor Library The Microsoft ODBC Cursor Library is supported, and will be
installed by Setup if not already present in your \Windows\System
directory.

Translating Data The Vision ODBC driver supports the use of a translation DLL to
translate all character data that passes between the driver and the
data source.

Translating data
The Vision ODBC driver supports the use of a translation DLL to translate all character data
(data values, SQL statements, table names, and so on) that passes between the driver and the data
source. The Vision Language Translator is supplied with the Vision ODBC driver.
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A default translation DLL can be specified for each data source by modifying the
TranslationName and TranslationDLL values in the data-source-name key in the Windows
Registry or the file-data-source-name.dsn file for a file data source. If the Vision Language
Translator is specified, then you must also specify the TranslationOption value to specify the
language. An application can override these settings by specifying the options in the connection
string when opening a connection to the data source. Example settings are shown below.

Name Data

Driver C:\WINDOWS\SYSTEM\vwodbc32.dll
Description SCO Vision ODBC Driver
Hostname sun4
ServerOptions 1
ServerID Ingres
DBname stevel
DBuser
DBauth
DBoptions
TranslationName SCO Vision Language Translator
TranslationDLL C:\WINDOWS\SYSTEM\vwxlt32.dll
TranslationOption 3

The SCO Vision Language Translator can be used to translate characters between 7-bit UNIX
values and 8-bit ANSI values on the PC. This is necessary because many UNIX applications are
not able to handle 8-bit data. (Your communications link may not be able to handle 8-bit data,
either.) The language for which translation is required should be specified using the
TranslationOption setting in the data-source-name key. Each language has a number associated
with it. This number refers to a subkey of the
HKEY_LOCAL_MACHINE\SOFTWARE\SCO\VWXLT.INI key which contains values for the
character mappings to be used for that language.

Using debug mode
Debug information can be obtained from both the PC and host modules of the Vision ODBC
driver. When debug is enabled, information is written to files on the PC and host. The default
pathname of the PC file is C:\Vwodbc.txt, and the default on the host is vwodbc.log in the home
directory. You can change these defaults by specifying different file names in the DebugPCFile
and/or DebugHostFile settings in the connection string when connecting to a data source.
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To enable debug, specify a value greater than zero in the DebugOptions setting in the connection
string when opening a connection to the data source. You can make this the default for the data
source by enabling the appropriate debug value when configuring the data source with the SCO
Vision ODBC Setup dialog box. However, if you do use this method, be sure to turn off debug
mode when you have finished. The following table shows the possible values for the
DebugOptions setting. The decimal values associated with the functions you are interested in
should be added together.

Value ODBC Functions Affected

0 No debug.
1 SQLAllocEnv, SQLAllocConnect, SQLConnect, SQLDriverConnect,

SQLBrowseConnect, SQLDisconnect, SQLFreeConnect, SQLFreeEnv,
SQLFreeStmt, SQLCancel, SQLTransact.

2 SQLGetInfo, SQLGetTypeInfo.
4 SQLGetConnectOption, SQLGetStmtOption, SQLSetConnectOption,

SQLSetStmtOption.
8 SQLAllocStmt, SQLPrepare, SQLSetParam, SQLParamOptions,

SQLGetCursorName, SQLSetCursorName, SQLSetScrollOptions.
16 SQLExecute, SQLExecDirect, SQLNativeSql, SQLDescribeParam,

SQLNumParams, SQLParamData, SQLPutData.
32 SQLRowCount, SQLNumResultCols, SQLDescribeCol, SQLColAttributes,

SQLBindCol, SQLFetch, SQLExtendedFetch, SQLGetData, SQLSetPos,
SQLMoreResults, SQLError.

64 SQLColumnPrivileges, SQLColumns, SQLForeignKeys, SQLPrimaryKeys,
SQLProcedureColumns, SQLProcedures, SQLSpecialColumns, SQLStatistics,
SQLTablePrivileges, SQLTables.

256 Host-end datatype conversion routines.
512 Host-end SQL syntax translation routines.

Log files
The log files produced by the Vision ODBC driver when debug is enabled (see �Using Debug
Mode�) can be examined using Windows Notepad, or a similar text editor.

The many components of Vision Communications Architecture can produce log files. These are
meaningful only to Technical Support specialists, and if you contact your supplier in the event of
a problem you may be asked to follow their instructions to produce log files.
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Security Manager
Security Manager is a component of the host module of the Vision ODBC driver that allows a
System Administrator to control user access to the database or to specific tables in the database.
Access to the database can be granted or revoked by application, enabling restrictions coded into
the application itself (for example, if the application will only allow the user to perform queries)
to complement restrictions imposed by Security Manager. Any restrictions imposed by Security
Manager are in addition to ones imposed by the DBMS which take precedence. Security
Manager is enabled when the UNIX server starts by specifying the -r option in the entry for the
server in the servers database. For further information, look up �servers file� in the Help index.

Granting and revoking privileges
Entries in Security Manager�s configuration file sqlrsec.conf, determine what privileges a user
has. For further information, look up �sqlrsec.conf file� in the Help index. A sample
configuration file sqlrsec.sample is provided with example entries illustrating the use of Security
Manager to grant and restrict access to tables in the demonstration database. You should save the
file as sqlrsec.conf and then modify the example entries or create new ones according to your
own requirements using a text editor (you need Superuser privilege to do this).

A number of keywords can be used to create groups of users, databases, applications, SQL
statements and so on that may be used in entries granting and revoking privileges. The example
below demonstrates the use of USERGROUP to create the SALES group of which andy and lee
are members.

USERGROUP SALES = andy, lee

The format of entries granting and revoking privileges is:

GRANT | REVOKE user database:reserved:owner:table:application = privilege,...

It is these entries that determine whether a user is subject to restrictions imposed by Security
Manager. Therefore if a user is not specified either directly or as a member of a group of users in
a GRANT or REVOKE entry, then no restrictions imposed by Security Manager will apply to
that user. Note that the fields in these entries do not have to be groups or members of groups
defined in sqlrsec.conf.

The following entry grants the members of the SALES group the ability to perform queries on all
tables in Scodemo using SQLGold.

GRANT SALES scodemo:ALL:ALL:ALL:gold32 = SELECT

Alternatively, you may choose to limit the privileges a user has on a database by specifying an
application with built-in restrictions. For example, in the following entry the Visual Basic ODBC
demonstrator application VB4 Demo is specified in the application field. As VB4 Demo will only
allow a user to execute SELECT statements, the effect of the entry below is the same as the entry
in the preceding example:

GRANT SALES scodemo:ALL:ALL:ALL:vb4demo = ALL
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Note that if a user has been granted privileges on a database using a specific application, then
Security Manager will cause attempts to access that database using other applications to fail at
the connection stage.

If an application launches another application to query a database, then the application that
actually interacts with the database needs to be specified in the the GRANT entry. For example,
if a user was using Query to return data to Excel, then Query would need to be specified in the
GRANT entry.

To revoke all the privileges of a user or group of users, you should use the following entry (with
the appropriate modification to the name field).

REVOKE andy ALL:ALL:ALL:ALL:ALL = ALL

If you want to revoke the privileges of a user or group of users more selectively, you should first
grant the user privileges either explicitly or as a member of a group of users, and then selectively
revoke the privileges you want. In the example below the ability of lee to perform queries on the
Sales table (granted by virtue of him being a member of the SALES group) is revoked.

REVOKE lee scodemo:ALL:ALL:sales:gold32 = SELECT

ALL or the asterisk character (*) can be used as a wildcard in any field. If ALL is specified in the
privilege field, then a predefined group of every SQL statement supported by the Vision ODBC
driver will be used (for further information, look up �sqlrsec.conf file� in the Help index). In
situations therefore where it is desirable to grant all users all privileges using all applications
apart from a few specific exceptions, you may choose to use the following entry:

GRANT ALL ALL:ALL:ALL:ALL:ALL = ALL

and then selectively revoke the privileges of appropriate users.

The order in which entries granting and revoking privileges are read by Security Manager is not
necessarily the physical order in which they appear in the configuration file. Security Manager
uses the user field to sort the entries, processing entries where ALL or * is specified in the field
first, where a group of users is specified second, and where an individual user is specified last. If
multiple entries have the same value in the user field, then the database and application fields are
used to differentiate between them, again with entries containing the most generic values in these
fields being processed first and the most specific last. In the following example the GRANT ALL
entry will be read first, the REVOKE ALL entry second (because even though ALL is specified in
the user field of both these entries, a specific database is specified in the database field of the
REVOKE entry) and the remaining GRANT entry last (because a specific user is specified in the
user field).

GRANT ALL ALL:ALL:ALL:ALL:ALL = CREATE TABLE, CREATE INDEX, SELECT

GRANT timp scodemo:ALL:ALL:ALL:ALL = DELETE

REVOKE ALL scodemo:ALL:ALL:ALL:ALL = SELECT
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Informix server module
The features of the host software which are specific to the Informix version are discussed in this
section. This section tells you about the files installed on the host system and how to create a
new database to use with the ODBC demonstrator applications. In addition, information about
how ODBC data types are mapped to the DBMS data types is provided along with details of the
scalar functions supported by the Vision ODBC driver for Informix.

SQL Services for Informix files
SQL Services for Informix installs the following files on a UNIX host:

File Function

/usr/local/vision/bin/sqlr.inf40.d

The server program for use with the Informix DBMS.

/usr/local/vision/sqlrrm.inf

The removal script.

/usr/local/vision/etc/infsqld.conf

The Vision ODBC driver configuration file. This can be used to set
up any environment variables you require to access Informix.
Normally such variables are set in the user�s .login file but the use
of the RPC mechanism by the Vision ODBC driver means that this
is by-passed.
In order to access the Informix DBMS, the INFORMIXDIR
environment variable must point to the directory where Informix is
installed.
When using the Informix Standard Engine, the SQLEXEC
environment variable must be set to the appropriate value, either in
this file or in a .infsqld.conf file in the user�s login directory.

The infsqld.conf file may also be copied to the user�s login directory, where it should be renamed
to .infsqld.conf.

The following file may also be modified:

/etc/rpc

Data type mapping
The data types supported by the Vision ODBC driver and Informix are not identical. The
mappings shown in the table below are used to convert ODBC data types to Informix data types.
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ODBC Data Type Informix Data Type

SQL_CHAR char
SQL_VARCHAR varchar (char)
SQL_DECIMAL decimal
SQL_NUMERIC numeric
SQL_SMALLINT smallint
SQL_INTEGER integer
SQL_REAL smallfloat
SQL_FLOAT float
SQL_DOUBLE float
SQL_LONGVARCHAR varchar (char)
SQL_BIT smallint
SQL_TINYINT smallint
SQL_BIGINT decimal
SQL_BINARY byte (NULL)
SQL_VARBINARY byte (NULL)
SQL_LONGVARBINARY byte (NULL)
SQL_DATE date
SQL_TIME datetime (hour to second)

SQL_TIMESTAMP datetime

Note  The data types shown in parentheses will be used when using the Informix Standard
Engine, which does not have varchar and byte data types.

For converting Informix data types to ODBC data types the following mappings are used:

Informix Data Type ODBC Data type

char SQL_CHAR
varchar SQL_VARCHAR
smallint SQL_SMALLINT
integer SQL_INTEGER
smallfloat SQL_REAL
float SQL_DOUBLE
decimal SQL_DECIMAL
money SQL_DECIMAL
serial SQL_INTEGER
date SQL_DATE
datetime SQL_TIMESTAMP
datetime (hour to second) SQL_TIME
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Informix Data Type ODBC Data type

interval SQL_VARCHAR
text SQL_LONGVARBINARY
byte SQL_LONGVARBINARY

Note  The data types varchar, text and byte are only available in Informix Online.

Mapping of the datetime data type
When mapping data of Informix datetime data type to the SQL_TIMESTAMP data type, unused
fields will be filled with the lowest allowed value. For years this is 0000, for months and days it
is 01, and for hours, minutes and seconds it is 00. For example, a value of one hour, thirty
minutes (01:30) would be filled out to give a value of 0000-01-01 01:30:00.000000000.

The ODBC SQL_TIMESTAMP data type will support up to nine decimal places whereas the
Informix datetime data type can have a maximum of five decimal places. Consequently, the
fractional part of SQL_TIMESTAMP data may be truncated during its conversion.

Demonstration database
Before using the demonstrators included with the Vision ODBC driver, you need to create a
number of demonstration tables. You are recommended to create a new database called
�scodemo� to hold these tables. Use the standard Informix isql program to create a new
database:

To create a database

1 In the Run dialog box, type the following in the space provided:
telnet

To display the Run dialog box, click the Start button, and then click Run. For older versions
of Windows NT, click the File menu in Program Manager, and then click Run.

2 On the Connect menu, click Remote System.
3 In the Host Name box, type the name of the host, and then click the Connect button.
4 When the prompt appears, log in as normal.
5 Type the following at the system prompt:

isql

6 Type �Q� for Query Language.

7 Select one of the displayed databases.
It does not matter which one or whether you can access it.

8 Type �N� for New.
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9 Type either:
create database dbname with log

or if you want an ANSI style database operation:
create database dbname with log mode ansi

10 Press ESCAPE followed by �R� for Run.
11 Press �E� repeatedly to exit from isql.

When you have created the database, you can use the SCO SQLGold program supplied with the
PC software to create the demonstration tables.

The SQLGetInfo function
When the ODBC function SQLGetInfo is used with the fInfoType parameter equal to
SQL_CONCAT_NULL_BEHAVIOR, a value of 1 is returned. The result of this call represents
the concatenation of non-null values.

The SQLProcedureColumns function
The Informix DBMS only provides sufficient information for the SQLProcedureColumns
function to return input parameters.

Scalar functions
The Vision ODBC driver for Informix supports the following scalar functions:

DAYOFMONTH TRUNCATE
LENGTH USER
MONTH YEAR
ROUND

For information about the arguments and return values of scalar functions, see the Microsoft
ODBC SDK Programmer�s Reference.

Owner names
In a Mode ANSI database, the ODBC functions SQLTables, SQLColumns and SQLStatistics
return the owner name surrounded by single quotation marks ( � � ) as this is how the owner
name should be specified when qualifying a table.
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You may request that owner names used to qualify database objects in SQL statements be
enclosed in quotation marks during the processing of the statement by adding 256 to the value of
the ServerOptions setting in the appropriate data source specification key in the Windows
Registry or the appropriate .dsn file for a file data source. This will preserve the case of the
owner name in a Mode ANSI database and a non-Mode ANSI database when case is important.
If the ServerOptions entry is modified in this way, owner names returned by the SQLTables,
SQLColumns and SQLStatistics functions are not enclosed by quotation marks.

When an owner name is supplied as the search condition for the SQLTables, SQLColumns,
SQLStatistics or SQLSpecialColumns functions, any enclosing quotation marks are ignored.

Decimal numbers
The default precision for the Informix DECIMAL column at the time of table definition is 16.
The ODBC specification however, recommends a maximum precision of 15. This causes some
applications to map Informix DECIMAL data types (having the default precision) to character
columns, therefore not allowing functions such as AVG, MAX, MIN, and SUM to be performed
on them. To overcome this problem, the Vision ODBC driver will report the precision of
DECIMAL columns as 15 when the table is linked from the data source. If you want to disable
this behavior, then you should modify the appropriate data source specification key in the
Windows Registry or the appropriate .dsn file for a file data source and add 64 to the value of
the ServerOptions setting.

Hold cursors
The Vision ODBC driver supports hold cursors and reports that its cursor COMMIT and
ROLLBACK behavior is to preserve a result set. However, there is a performance penalty
associated with hold cursors and they are therefore disabled by default. If you require hold
cursor support, then you should modify the appropriate data source specification key in the
Windows Registry or the appropriate .dsn file for a file data source and add 8 to the value of the
ServerOptions setting.

Ingres server module
The features of the host software which are specific to the Ingres version are discussed in this
section. This section tells you about the files installed on the host system and how to create a
new database to use with the ODBC demonstrator applications. In addition, information about
how ODBC data types are mapped to the DBMS data types is provided along with details of the
scalar functions supported by the Vision ODBC driver for Ingres.
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SQL Services for Ingres files
SQL Services for Ingres installs the following files on a UNIX host:

File Function

/usr/local/vision/bin/sqlr.ing40.d

The server program for use with the Ingres DBMS.

/usr/local/vision/sqlrrm.ing

The removal script.

/usr/local/vision/etc/ingsqld.conf

The Vision ODBC driver configuration file. This sets up the
environment variables required to access Ingres. Normally these
variables are set in the user�s .login file but the use of the RPC
mechanism by the Vision ODBC driver means that this is by-passed.
The II_SYSTEM environment variable is used to locate the Ingres
system and may be changed if the DBMS is moved. The other
environment variables set by this file MUST NOT be changed by
the user.

The ingsqld.conf file may also be copied to the user�s login directory, where it should be
renamed to .ingsqld.conf.

The following file may also be modified:

/etc/rpc

Data type mapping
The data types supported by the Vision ODBC driver and Ingres are not identical. The mappings
shown in the table below are used to convert ODBC data types to Ingres data types.

ODBC Data Type Ingres Data Type

SQL_CHAR char
SQL_VARCHAR varchar
SQL_DECIMAL float
SQL_NUMERIC float
SQL_SMALLINT smallint
SQL_INTEGER integer
SQL_REAL float4
SQL_FLOAT float
SQL_DOUBLE float
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ODBC Data Type Ingres Data Type

SQL_LONGVARCHAR varchar
SQL_BIT integer1
SQL_TINYINT integer1
SQL_BIGINT varchar
SQL_BINARY varchar
SQL_VARBINARY varchar
SQL_LONGVARBINARY varchar
SQL_DATE date
SQL_TIME date

SQL_TIMESTAMP date

For converting Ingres data types to ODBC data types the following mappings are used:

Ingres Data Type ODBC Data type

char SQL_CHAR
varchar(<=254) SQL_VARCHAR
varchar(>=255) SQL_LONGVARCHAR
smallint SQL_SMALLINT
integer2 SQL_SMALLINT
integer SQL_INTEGER
float4 SQL_REAL
float SQL_DOUBLE
float8 SQL_DOUBLE
integer1 SQL_TINYINT
date SQL_TIMESTAMP
c1-c2000 SQL_CHAR
text(<=254) SQL_VARCHAR
text(>=255) SQL_LONGVARCHAR
money SQL_DECIMAL

Mapping of the varchar and text data types
Ingres varchar and text data types of length greater than 254 characters will be mapped to the
SQL_LONGVARCHAR data type. If you do not require this behavior, then you should modify
the appropriate data source specification key in the Windows Registry or the appropriate .dsn
file for a file data source and add 16384 to the value of the ServerOptions setting. This will
cause Ingres varchar and text data types to be mapped to SQL_VARCHAR regardless of length.
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Demonstration database
Before using the demonstrators included with the Vision ODBC driver, you need to create a
number of demonstration tables. You are recommended to create a new database called
�scodemo� to hold these tables:

1 In the Run dialog box, type the following in the space provided:
telnet

To display the Run dialog box, click the Start button, and then click Run. For older versions
of Windows NT, click the File menu in Program Manager, and then click Run.

2 On the Connect menu, click Remote System.
3 In the Host Name box, type the name of the host, and then click the Connect button.
4 When the prompt appears, log in as normal.
5 Type the following at the system prompt:

createdb scodemo

In order to run this command on a UNIX system, $II_SYSTEM/ingres/bin must be in the user�s
path and the environment variable II_SYSTEM must be set. The user must also have been given
permission to use the DBMS by the Database Administrator.

When you have created the database, you can use the SCO SQLGold program supplied with the
PC software to create the demonstration tables.

The SQLProcedureColumns function
The Ingres DBMS does not provide the information necessary to support the
SQLProcedureColumns function.

Scalar functions
The Vision ODBC driver for Ingres supports the following scalar functions:

ASCII MONTH
ABS MOD
ATAN NOW
COS PI

CONCAT POWER
DAYNAME QUARTER
DAYOFMONTH RADIANS
DEGREES RIGHT
EXP SECOND
HOUR RTRIM
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IFNULL SIN
INSERT SUBSTRING
LCASE SQRT
LEFT TIMESTAMPADD
LENGTH TIMESTAMPDIFF
LOCATE UCASE
LOG USER
MINUTE YEAR

Note  The TIMESTAMPADD and the TIMESTAMPDIFF functions will support the following
intervals, SQL_TSI_SECOND, SQL_TSI_MINUTE, SQL_TSI_HOUR, SQL_TSI_DAY, SQL_TSI_MONTH, and
SQL_TSI_YEAR.

For information about the arguments and return values of scalar functions, see the Microsoft
ODBC SDK Programmer�s Reference.

Locking mode
Users of Microsoft Access will not be able to cut (delete) records from a linked table with Ingres�
default locking in operation. In order to get around this problem you need to add the following
line to either the .ingsqld.conf file in your home directory, or to the global /usr/local/vision/etc/
ingsqld.conf file:

ING_SET=set lockmode session where readlock=nolock

Owner names
By default, when the Ingres server creates a result set following a catalog function call (e.g.
SQLTables), the owner names in this set are NULL. This is necessary to prevent Microsoft
Access qualifying column names with both the table name and the owner name (which is not
allowed in the DBMS). If you require owner names to be returned, or if you want to be able to
restrict your selection by owner name, then you should modify the appropriate data source
specification key in the Windows Registry or the appropriate .dsn file for a file data source and
add 4 to the value of the ServerOptions setting.

Multiple column indexes
The Vision ODBC driver simplifies SQL generated by Microsoft Access when a table with
multiple column indexes is linked. This is necessary to allow tables with multiple indexes to be
updated in Access. If do not require this behavior, then you should modify the appropriate data
source specification key in the Windows Registry or the appropriate .dsn file for a file data
source and add 4096 to the value of the ServerOptions setting.
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Keyed storage structures
The Vision ODBC driver reports hash, isam, and btree keys to applications requesting table key
information. If you want to disable this behavior, then you should modify the appropriate data
source specification key in the Windows Registry or the appropriate .dsn file for a file data
source and add 128 to the value of the ServerOptions setting.

InterBase server module
The features of the host software which are specific to the InterBase version are discussed in this
section. This section tells you about the files installed on the host system and how to create a
new database to use with the ODBC demonstrator applications. In addition, information about
how ODBC data types are mapped to the DBMS data types is provided.

SQL Services for InterBase files
SQL Services for InterBase installs the following files on a UNIX host:

File Function

/usr/local/vision/bin/sqlr.int40.d

The server program for use with the InterBase DBMS.

/usr/local/vision/sqlrrm.int

The removal script.

/usr/local/vision/etc/intsqld.conf

The Vision ODBC driver configuration file. This can be used to set
up any environment variables you require to access InterBase.
Normally such variables are set in the user�s .login file but the use
of the RPC mechanism by the Vision ODBC driver means that this
is by-passed.
The Vision ODBC driver does not require any specific InterBase
environment variables to be set. The default intsqld.conf file is
provided to enable you to make any settings specific to your
InterBase installation.

The intsqld.conf file may also be copied to the user�s login directory, where it should be renamed
to .intsqld.conf.

The following file may also be modified:

/etc/rpc
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Data Type mapping
The data types supported by the Vision ODBC driver and InterBase are not identical. The
mappings shown in the table below are used to convert ODBC data types to InterBase data types.

ODBC Data Type InterBase Data Type

SQL_CHAR char
SQL_VARCHAR varchar
SQL_DECIMAL long float
SQL_NUMERIC long float
SQL_SMALLINT smallint
SQL_INTEGER integer
SQL_REAL float
SQL_FLOAT long float
SQL_DOUBLE long float
SQL_LONGVARCHAR varchar
SQL_BIT smallint
SQL_TINYINT smallint
SQL_BIGINT varchar
SQL_BINARY varchar
SQL_VARBINARY varchar
SQL_LONGVARBINARY varchar
SQL_DATE date
SQL_TIME char
SQL_TIMESTAMP char

For converting InterBase data types to ODBC data types the following mappings are used:

InterBase Data Type ODBC Data type

char SQL_CHAR
varchar SQL_VARCHAR
smallint SQL_SMALLINT
integer SQL_INTEGER

float SQL_REAL
long float SQL_DOUBLE
date SQL_DATE
blob SQL_LONGVARBINARY

Note  Due to limitations in accessing blob data types in InterBase 3.2 with SQL, requests for
such data will return a null value.
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Demonstration database
Before using the demonstrators included with the Vision ODBC driver, you need to create a
number of demonstration tables. You are recommended to create a new database called
�scodemo� to hold these tables. Use the standard InterBase QLI program to create a new
database:

1 In the Run dialog box, type the following in the space provided:
telnet

To display the Run dialog box, click the Start button, and then click Run. For older versions
of Windows NT, click the File menu in Program Manager, and then click Run.

2 On the Connect menu, click Remote System.
3 In the Host Name box, type the name of the host, and then click the Connect button.
4 When the prompt appears, log in as normal.
5 Type the following at the system prompt:

qli

Providing that the InterBase directory (/usr/interbase/bin) is in your path the QLI prompt will
appear.

6 Type the following at the QLI prompt:
create database scodemo

This will create the database in your home directory.
7 Type quit to exit from the QLI program.

When you have created the database, you can use the SCO SQLGold program supplied with the
PC software to create the demonstration tables.

Event alerters not supported
The InterBase event alerter mechanism is not supported because it is not part of the ODBC
specification.

The SQLGetInfo function
A call to the ODBC SQLGetInfo function with the fInfoType parameter equal to
SQL_CONCAT_NULL_BEHAVIOR requests the effect of concatenation if one of the values is
null. However, InterBase does not support concatenation and so the return value from this call is
irrelevant.

The SQLSpecialColumns function
The fNullable parameter for the SQLSpecialColumns function is ignored. It is not known if the
columns returned can contain NULL values.
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Procedures
InterBase does not support procedures. The SQLProcedures and SQLProcedureColumns
functions therefore return an empty result set.

Owner names
Owner names used to qualify tables, views and indexes are ignored. InterBase does not allow
owner names to be used as qualifiers to database objects.

For example:

select * from fred.sales

becomes

select * from sales

You may request that owner names should be returned by catalog functions by adding 4 to the
value of the ServerOptions setting in the appropriate data source specification key in the
Windows Registry or the appropriate .dsn file for a file data source. However, although the
driver would return owner names, they could not subsequently be used in SQL statements.

Oracle server module
The features of the host software which are specific to the Oracle version are discussed in this
section. This section tells you about the files installed on the host system and how to create a
new database to use with the ODBC demonstrator applications. In addition, information about
how ODBC data types are mapped to the DBMS data types is provided along with details of the
scalar functions supported by the Vision ODBC driver for Oracle.

SQL Services for Oracle files
SQL Services for Oracle installs the following files on a UNIX host.
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File Function

/usr/local/vision/bin/sqlr.ora40.d

The server program for use with the Oracle DBMS.

/usr/local/vision/sqlrrm.ora

The removal script.

/usr/local/vision/etc/orasqld.conf

The Vision ODBC driver configuration file. This can be used to set
up any environment variables you require to access Oracle.
Normally such variables are set in the user�s .login file but the use
of the RPC mechanism by the Vision ODBC driver means that this
is by-passed.
In order to access the Oracle DBMS, the environment variable
ORACLE_HOME must point to the directory where Oracle is
installed and ORACLE_SID must be set to the Oracle system
identifier.
Versions of Oracle earlier than 7.3 normally require the
TW0_TASK environment variable to be set to specify the Pipe
Driver. However, this can result in ODBC connection failure in
which case you should remove or comment out the entry using the
number sign (#).

The orasqld.conf file may also be copied to the user�s login directory, where it should be
renamed to .orasqld.conf.

The following file may also be modified:

/etc/rpc

Data type mapping
The data types supported by the Vision ODBC driver and Oracle are not identical. The mappings
shown in the table below are used to convert ODBC data types to Oracle data types.

ODBC Data Type Oracle Data Type

SQL_CHAR char

SQL_VARCHAR varchar2
SQL_DECIMAL number (precision, scale)
SQL_NUMERIC number (precision, scale)
SQL_SMALLINT number (5)
SQL_INTEGER number (10)
SQL_REAL number
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ODBC Data Type Oracle Data Type

SQL_FLOAT number
SQL_DOUBLE number
SQL_LONGVARCHAR long
SQL_BIT number (1)
SQL_TINYINT number (3)
SQL_BIGINT number (20)
SQL_BINARY raw
SQL_VARBINARY raw
SQL_LONGVARBINARY long raw
SQL_DATE date
SQL_TIME date

SQL_TIMESTAMP date

For converting Oracle data types to ODBC data types the following mappings are used:

Oracle Data Type ODBC Data type

char SQL_CHAR
varchar2 SQL_VARCHAR
long SQL_LONGVARCHAR
raw SQL_VARBINARY
long raw SQL_LONGVARBINARY
date SQL_TIMESTAMP
mlslabel SQL_VARBINARY
rowid SQL_VARCHAR
number SQL_DOUBLE
number (precision, scale) Varies (see below)

Where the number data type is qualified with precision and scale the mapping to ODBC data
type varies as follows:

p < 3, s <= 0 SQL_TINYINT
p < 5, s <= 0 SQL_SMALLINT
p < 10, s <=0 SQL_INTEGER
p <= 19, s <= 0 SQL_BIGINT
p <= 15, s < 15 SQL_DECIMAL
other SQL_DOUBLE
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Demonstration database
Before using the demonstrators included with the Vision ODBC driver, you need to create a
number of demonstration tables. You are recommended to create a new database username
�scodemo� with password �scodemo� to own these tables. Use the standard Oracle SQL*Plus
program to create the new username:

1 In the Run dialog box, type the following in the space provided:
telnet

To display the Run dialog box, click the Start button, and then click Run. For older versions
of Windows NT, click the File menu in Program Manager, and then click Run.

2 Click the Connect menu and then click Remote System.
3 In the Host Name box, type the name of the host, and then click the Connect button.
4 When the prompt appears, log in as normal.
5 Type the following at the system prompt.

sqlplus system/ password

where password is the password for the �system� username.
Provided that $ORACLE_HOME/bin is in your path, SQL*Plus will start.

6 Type the following at the SQL prompt to create the �scodemo� username:
create user scodemo identified by scodemo:

grant connect, resource to scodemo:

7 Type exit to exit from the SQL*Plus program.

When you have created the database, you can use the SQLGold program supplied with the PC
software to create the demonstration tables.

Database options
The following values may be added to the comma-separated list for DBoptions in the connection
string when opening a connection to the data source. To make these values the default for the
data source, include the settings in the appropriate data source specification key in the Windows
Registry or the appropriate .dsn file for a file data source.

Value Meaning

alltables Return information on all tables to which you have access. By default the
ODBC catalog functions will return only information for the tables you own.

longsize=bytes Maximum size of long and long raw data which can be retrieved, where
bytes is the maximum number of bytes that can be returned. Default is
1,000,000.

arraysize=num Controls the host array size used for DB fetches. Default is 50.
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The SQLProcedureColumns function
The Oracle DBMS does not provide the information necessary to support the
SQLProcedureColumns function.

Scalar functions
The Vision ODBC driver for Oracle supports the following scalar functions:

ABS MOD
ASCII MONTH
CEILING MONTHNAME
CHAR NOW
CONCAT PI
COS POWER
CURDATE QUARTER
CURTIME REPLACE
DAYNAME RIGHT
DAYOFMONTH ROUND
DAYOFWEEK RTRIM
EXP SECOND
FLOOR SIGN
HOUR SOUNDEX
IFNULL SQRT
LCASE SUBSTRING
LEFT TAN
LENGTH TRUNCATE
LOCATEUSER UCASE
LOG WEEK
LTRIM YEAR
MINUTE

For information about the arguments and return values of scalar functions, see the Microsoft
ODBC SDK Programmer�s Reference.
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NUMBER data type
The conversion of integer values in Oracle NUMBER columns where no precision is specified
can sometimes be inaccurate. This causes applications such as Microsoft Access to fail to read
and update records in tables where NUMBER columns with integer values are used as a key for
the table. To overcome this problem, you should modify the appropriate data source
specification key in the Windows Registry or the appropriate .dsn file for a file data source and
add 8192 to the value of the ServerOptions setting.

Progress server module
The features of the host software which are specific to the Progress version are discussed in this
section. This section tells you about the files installed on the host system and how to create a
new database to use with the ODBC demonstrator applications. In addition, information about
how ODBC data types are mapped to the DBMS data types is provided along with details of the
scalar functions supported by the Vision ODBC driver for Progress.

SQL Services for Progress files
SQL Services for Progress installs the following files on a UNIX host.

File Function

/usr/local/vision/bin/sqlr.pro40.d

The server program for use with the Progress DBMS.

/usr/local/vision/sqlrrm.pro

The removal script.

/usr/local/vision/etc/prosqld.conf

The Vision ODBC driver configuration file. This can be used to set
up any environment variables you require to access Progress.
Normally such variables are set in the user�s .login file but the use
of the RPC mechanism by the Vision ODBC driver means that this
is by-passed.
In order to access the Progress DBMS, the DLC environment
variable must point to the directory where Progress is installed.

The prosqld.conf file may also be copied to the user�s login directory, where it should be
renamed to .prosqld.conf.

The following file may also be modified:

/etc/rpc



Chapter 10 � Vision ODBC Driver 295

Data type mapping
The data types supported by the Vision ODBC driver and Progress are not identical. The
mappings shown in the table below are used to convert ODBC data types to Progress data types.

ODBC Data type Progress Data Type

SQL_BIT logical
SQL_VARCHAR char
SQL_NUMERIC numeric
SQL_DECIMAL decimal
SQL_INTEGER integer
SQL_SMALLINT smallint
SQL_FLOAT float
SQL_REAL real
SQL_DOUBLE double
SQL_DATE date

For converting Progress data types to ODBC data types the following mappings are used:

Progress Data Type ODBC Data type

logical SQL_BIT
char SQL_VARCHAR
numeric SQL_NUMERIC
decimal SQL_DECIMAL
integer SQL_INTEGER
smallint SQL_SMALLINT
float SQL_FLOAT
real SQL_REAL
double SQL_DOUBLE
date SQL_DATE

Demonstration database
Before using the demonstrators included with the Vision ODBC driver, you need to create a
number of demonstration tables. You are recommended to create a new database called
�scodemo� to hold these tables. Use the standard Progress PRO program to create a new
database.
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To create a database

1 In the Run dialog box, type the following in the space provided:
telnet

To display the Run dialog box, click the Start button, and then click Run. For older versions
of Windows NT, click the File menu in Program Manager, and then click Run.

2 On the Connect menu, click Remote System.
3 In the Host Name box, type the name of the host, and then click the Connect button.
4 When the prompt appears, log in as normal.
5 Type the following at the system prompt:

pro

In order to run this command, the environment variable DLC must be set.
6 From the Tools menu, choose Data Dictionary.
7 From the Database menu, choose Create.

The Create Database dialog box is displayed.
8 In the New Physical Database Name: box, type �scodemo�.
9 From the Database menu, choose Exit.
10 From the File menu, choose Exit.

Note  You need to start a server for the database each time you want to connect to it. Do this by
entering the command:

proserve scodemo

When you have created the database, you can use the SQLGold program supplied with the PC
software to create the demonstration tables.

Database options
The following values may be added to the comma-separated list for DBoptions in the connection
string when opening a connection to the data source. To make these values the default for the
data source, include the settings in the appropriate data source specification key in the Windows
Registry or the appropriate .dsn file for a file data source.

Value Meaning

-db db1.db -l logicaldb The syntax for specifying a logical database name.
-db db1.db -db db2.db The syntax for specifying multiple databases.

The SQLSpecialColumns function
The SQLSpecialColumns function returns an empty result set.
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Scalar functions
The Vision ODBC driver for Progress supports the following scalar functions:

ABS LOG10
ASCII LTRIM
CHAR MONTH
CURDATE PI
DAYOFMONTH POWER
DAYOFWEEK RADIANS
DATABASE REPLACE
DEGREES RIGHT
EXP RTRIM
LCASE SPACE
LEFT SQRT
LENGTH SUBSTRING
LOCATE UCASE
LOG YEAR

For information about the arguments and return values of scalar functions, see the Microsoft
ODBC SDK Programmer�s Reference.

System tables
Progress System tables start with the underscore character (_). The Vision ODBC driver does not
normally show these tables in the User table list. If you require tables starting with the
underscore character to be included in the User table list, then you should modify the
appropriate data source specification key in the Windows Registry or the appropriate .dsn file
for a file data source and add 1024 to the value of the ServerOptions setting.

Updating data sources
Following an INSERT, UPDATE, or DELETE statement, Progress does not provide the count of
the number of rows modified. The SQLRowCount function cannot therefore provide this
information. Some applications, for example Microsoft Access, rely upon this count when
updating. To overcome this problem, you can modify the appropriate data source specification
key in the Windows Registry or the appropriate .dsn file for a file data source and add 2048 to
the value of the ServerOptions setting. This causes the Vision ODBC driver to return the number
1 from SQLRowCount to facilitate updates.
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Security
Progress can utilize its own username and password system if required in addition to the UNIX
login. If you want to connect to a database for which security is enabled, then you need to
modify the HKEY_LOCAL_MACHINE\SOFTWARE\SCO\VWODBC.INI\Progress key in the
Windows Registry so that the DBuser and Dbauth settings are �yes� to enable the Username and
Password fields in the General tab of the SCO Vision ODBC Setup dialog box. Enter your
Progress username and password in these fields when you configure the data source.

Procedures
There is no support in Progress SQL for procedures. The SQLProcedures and
SQLProcedureColumns functions therefore return an empty result set.

Sybase server module
The features of the host software which are specific to the Sybase version are discussed in this
section. This section tells you about the files installed on the host system and how to create a
new database to use with the ODBC demonstrator applications. In addition, information about
how ODBC data types are mapped to the DBMS data types is provided along with details of the
scalar functions supported by the Vision ODBC driver for Sybase.

SQL Services for Sybase files
SQL Services for Sybase installs the following files on a UNIX host.

File Function

/usr/local/vision/bin/sqlr.syb40.d

The server program for use with the Sybase DBMS.

/usr/local/vision/sqlrrm.syb

The removal script.

/usr/local/vision/etc/sybsqld.conf

The Vision ODBC driver does not require any specific Sybase
environment variables to be set. The default sybsqld.conf file is
provided to enable you to make any settings specific to your Sybase
installation.

The sybsqld.conf file may also be copied to the user�s login directory, where it should be
renamed to .sybsqld.conf.

The following file may also be modified:

/etc/rpc
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Data type mapping
The data types supported by the Vision ODBC driver and Sybase are not identical. The mappings
shown in the table below are used to convert ODBC data types to Sybase data types.

ODBC Data Type Sybase Data Type

SQL_CHAR char
SQL_VARCHAR varchar
SQL_DECIMAL decimal (precision, scale)
SQL_NUMERIC numeric (precision, scale)
SQL_SMALLINT smallint
SQL_INTEGER integer
SQL_REAL real
SQL_FLOAT float
SQL_DOUBLE double
SQL_LONGVARCHAR text
SQL_BIT bit
SQL_TINYINT tinyint
SQL_BIGINT integer
SQL_BINARY binary
SQL_VARBINARY varbinary
SQL_LONGVARBINARY image
SQL_DATE datetime
SQL_TIME datetime
SQL_TIMESTAMP datetime

For converting Sybase data types to ODBC data types the following mappings are used:

Sybase Data Type ODBC Data type

char SQL_CHAR
varchar SQL_VARCHAR
nchar SQL_CHAR
nvarchar SQL_VARCHAR

text SQL_LONGVARCHAR
bit SQL_BIT
tinyint SQL_SMALLINT
smallint SQL_SMALLINT
int SQL_INTEGER
numeric (precision, scale) SQL_NUMERIC
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Sybase Data Type ODBC Data type

decimal (precision, scale) SQL_DECIMAL
float SQL_REAL (4 byte)/SQL_DOUBLE (8 byte)
double precision SQL_DOUBLE
real SQL_REAL
smallmoney SQL_DECIMAL
money SQL_DECIMAL
smalldatetime SQL_TIMESTAMP
datetime SQL_TIMESTAMP
binary SQL_BINARY
varbinary SQL_VARBINARY

image SQL_LONGVARBINARY

Demonstration database
Before using the demonstrators included with the Vision ODBC driver, you need to create a
number of demonstration tables. You are recommended to create a new database username
�scodemo� with password �scodemo� to own these tables. Use the standard Sybase isql program
to create a new database and login:

1 In the Run dialog box, type the following in the space provided:
telnet

To display the Run dialog box, click the Start button, and then click Run. For older versions
of Windows NT, click the File menu in Program Manager, and then click Run.

2 On the Connect menu, click Remote System.
3 In the Host Name box, type the name of the host, and then click the Connect button.
4 When the prompt appears, log in as normal.
5 Type the following at the system prompt:

isql -Usa -P password

where password is the password for the System Administrator.
Provided that $SYBASE_HOME/bin is in your path, isql will start.
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6 Type the following at the SQL prompt:
sp_addlogin scodemo, scodemo

go

create database scodemo

go

use scodemo

go

sp_changedbowner scodemo

go

sp_adduser guest

go

use master

go

sp_dboption scodemo, "ddl in tran", true

go

sp_modifylogin scodemo, defdb, scodemo

go

quit

When you have created the database, you can use the SQLGold program supplied with the PC
software to create the demonstration tables.

Scalar functions
The Vision ODBC driver for Sybase supports the following scalar functions:

ACOS LOCATE
ASCII LTRIM
ASIN MOD
ATAN PI
ATAN2 RAND
CEILNG REPEAT
CHAR RIGHT
CONCAT RTRIM
DATABASE SIGN
FLOOR SUBSTRING
IFNULL TAN
LCASE USER
LENGTH

For information about the arguments and return values of scalar functions, see the Microsoft
ODBC SDK Programmer�s Reference.
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ODBC applications overview
This chapter provides hints about using the Vision ODBC driver with several popular Windows
applications and development environments. It is not intended to provide full details about using
ODBC with these applications, which should be covered by the application's own
documentation. Rather, this chapter provides some simple examples to get you going, and points
out any obvious pitfalls.

The applications chosen for inclusion in this chapter were among the most popular ODBC-aware
applications at the time of writing. Exclusion of other applications does not imply that they will
not work with the Vision ODBC driver.

Microsoft Access
This section describes using Microsoft Access 7.0 with the Vision ODBC driver.

Access is a relational database management system (RDBMS) that takes full advantage of
Windows 95 functionality such as shortcuts to the desktop and Briefcase replication to keep
multiple copies of your database synchronized. It includes many wizards, builders, and add-ins
that make it easy to create and maintain databases and database objects.

The Vision ODBC driver allows Access to be used as a powerful front-end to UNIX databases.
Access can �link� tables from any ODBC data source, and a linked table can be used in the same
way as a local table for queries or reports. You can also import a table from a remote database,
so that a copy of the data is stored as a local Access table.

Importing and linking SQL database tables
Microsoft Access provides two ways to work with data from an external data source. You can
import the data, and convert it into regular Microsoft Access tables. Alternatively, you can leave
the data in its original format in the remote database, and use Access as an alternative way to
view and edit that data. When you link to an external table, you do not store any of the data
locally, but you can create queries, forms and reports that use that data.

To import or link SQL database tables

1 Open a database, or switch to the Database window for the open database.
2 To import tables, on the File menu, point to Get External Data, and then click Import.

To link tables, on the File menu, point to Get External Data, and then click Link Tables.
If you want to work with a local copy of the data, choose Import. To work with the original
table on the remote system, choose Link Tables.
Note  If you choose to import a table, you should be aware that certain tables on your SQL
database may be very large.
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3 In the Import (or Link) dialog box, select ODBC Databases in the Files Of Type box.
4 In the SQL Data Sources dialog box, double-click the ODBC data source that contains the

data you want to import or link.
5 If some information was omitted from the data source, the Data Source Connection

Information dialog box may be displayed. Enter the missing information.
Microsoft Access connects to the SQL database and displays the list of tables in the SQL
database that you can import or link.

6 Click each table you want to import or link. If you're linking a table and it doesn't have an
index that uniquely identifies each record, Microsoft Access displays a list of the fields in the
linked table. Click a field or a combination of fields that will uniquely identify each record.
This will enable you subsequently to edit the linked table, for more information see �Editing
a Linked Table� later in this chapter. When you have finished importing or linking, click the
Close button. Note that the Save password setting has no effect.

Linked tables are indicated by a special icon in the list of tables in the Database window. The
icon represents the link to the SQL table.
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Using linked external tables
After you have linked a table from an SQL database you can use it in much the same way as a
local Microsoft Access table. The table is represented by an icon in the Database window.

Opening linked tables in datasheet view
You can open a linked table in datasheet view by selecting the table in the Database window and
clicking Open.
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Renaming linked tables
The first thing you may want to do is to rename a linked table. For example, when you link an
Ingres table, the table name is preceded by the database name, which may not be meaningful to
all users. You could rename a table called �scodemo_customers� to simply �Customers.� For
instructions on renaming database objects (including tables), look up �renaming database
objects� in the Microsoft Access Help index.

Setting properties for linked tables
When you open a linked table in Design view, it looks much like a regular Microsoft Access
table. However, you are not permitted to change the structure of the table (add, delete, or
rearrange fields). Neither are you allowed to designate a primary key. Any relationships between
tables which may have been defined in the host database are not preserved within the linked
table structure. You cannot define relationships between linked tables within Access.

You are permitted to set certain field properties for linked tables (look up �linking tables,
properties� in the Microsoft Access Help index).

Editing a linked table
To edit a linked SQL database table, normally the table must contain a unique index on the
server. If you want to edit a table that doesn't have a unique index or you want to edit an SQL
view, you can create an index within Microsoft Access that the SQL database isn't aware of.
When you link an SQL database table that doesn't have a unique index, Microsoft Access asks
you to select one or more fields to generate a unique index (see �Importing and Linking SQL
Database Tables� earlier in this chapter). However, Microsoft Access doesn't test to make sure
the field or fields you selected actually uniquely identify each record. If there are duplicates in
the index Microsoft Access builds, you won't be able to update those records.

If you think the field or fields you selected did not create a unique index, delete the link to the
table, link it again, and then select the appropriate field or fields to establish a unique index.

Alternatively, you can create an index within Microsoft Access by creating a data-definition
query, using the CREATE INDEX statement. Again, the index must be created on a field in
which each value is unique. If the field contains any non-unique values, all updates to the table
will fail. To delete the index, use another data-definition query.

To create an index for a linked table

1 In the Database window, click the Queries tab, and then click New.
2 In the New Query dialog box, click the Design View button.

3 Without adding tables or queries, click the Close button in the Show Table dialog box.
4 On the Query menu, point to SQL Specific, and then click Data Definition.
5 Type a CREATE INDEX statement.

For example, to create an index for the Customer table in the Scodemo demonstration
database, type the following:
create unique index custom_idx on customer(custom_num)
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You must have already linked the Customer table to the current database, and the table name
specified in the CREATE INDEX statement must be identical to the table name shown in the
list of tables in the Database window. For example, the table name may be prefixed by the
database name. For more information, look up �creating data-definition queries� and
�CREATE INDEX statement� in the Microsoft Access Help index.

6 To run the query, click the Run button on the toolbar.

7 On the Control menu, click Close to close the Data Definition Query window. Choose No
when asked whether to save the query.

When the index has been created, you will be able to alter data stored in the linked table.

Changing links to linked tables
If the structure of an SQL database table changes after you link it, you need to refresh the link.
Likewise, if details of the data source are changed, for example because the database is moved to
a different host computer, then the link must be updated. You use the Linked Table Manager to
refresh links to linked tables. To start Linked Table Manager, on the Tools menu, point to Add-
ins, and then click Linked Table Manager. When the dialog box is displayed, press F1 for further
information.

Viewing link information for linked tables
Microsoft Access stores information about the link to a linked table in the Description property
of the linked table. These details are for information only, and although you can change the
Description property it will not change the actual link to the linked table.
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To view link information

1 Open the table in Design view.
2 Click the Properties button on the toolbar.

The Description property at the top of the property sheet contains information about the link to
the linked table.

Viewing or modifying SQL statements
When you create a query in the Query window, Microsoft Access constructs the equivalent SQL
statement. You can work directly with a query's underlying SQL statement if you're familiar with
SQL.

To view or modify the SQL statement

1 Create a new query or open an existing query in Design view.
2 Click the arrow next to the View button on the toolbar, and then click SQL View.

Microsoft Access displays the SQL statement that is equivalent to what you created in Design
view.

3 If you want to make changes, type your changes in the SQL statement.
4 To see the changes in the design grid, click the arrow next to the View button on the toolbar,

and then click Design View.
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The Microsoft Access SQL statement you see in the SQL dialog box is not necessarily what is
sent to the ODBC data source. Remember that you can construct a query that includes tables
from several different sources, including local Access tables and SQL database tables. Access may
need to generate several SQL statements to obtain parts of the information required from the
various data sources.

Performance with linked tables
Microsoft Access Help contains some hints for achieving optimal performance with linked tables
(look up �performance, optimizing� in the Microsoft Access Help index). When designing
solutions that use Access as a front-end to a remote database you should try to minimize the
amount of data transferred across the network.
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Microsoft Excel
This section describes using Microsoft Excel 7.0 with the Vision ODBC driver.

Excel provides many ways of working with external data. This section provides examples of the
following:

• Using Microsoft Query
• Using the SQLRequest Worksheet Function

The following additional methods can be used, and you should consult the Microsoft Excel
documentation for further information:

• Using the PivotTable Wizard
• Writing Macros using the Data Access Objects (DAO) library
• Writing Macros using ODBC Visual Basic language extensions
• Writing Macros using Microsoft Query command equivalents

Using Microsoft Query
Microsoft Query is an ODBC-supporting application that allows you to query a database using
point and click mouse techniques. The Query Add-in allows you to use Query from within Excel.
You can interact with it using menu commands and buttons, or use command equivalent
functions to write macros. Excel communicates with Query using dynamic data exchange (DDE).

Follow the steps below to display the Sales data from the Scodemo demonstration database on a
worksheet. You should already have created an ODBC data source for the Scodemo database.
Refer to �Creating the Demonstration Database� in the �Vision ODBC Driver� chapter if you
have not yet created the database.

To retrieve the Sales data

1 Open a new workbook.
2 On the Data menu, click Get External Data.

If the Get External Data Command is not available, then the Query Add-in is not installed.
Refer to the Excel documentation for information about installing the Query Add-in.
Microsoft Query is displayed in a window, with the Select Data Source dialog box visible.
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3 Choose �scodemo� from the list of available data sources.
Note  If you have not used Microsoft Query to access this data source before, then it will not
be included in the list of Available Data Sources. Click the Other button, and select
�scodemo� from the ODBC Data Sources dialog box. This adds the data source to the list of
Available Data Sources, and it will appear in the list in future Query sessions.

4 Click the Use button.
The Query window appears, and the Add Tables dialog box is displayed.

5 Select Sales from the Table list, then click the Add button, and then click the Close button.
The Sales table field list appears in the Table pane.
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6 Double-click the asterisk (*) in the field list for the Sales table.
The data from the Sales table appears in the Data pane.

7 On the File menu, click Return Data To Microsoft Excel.
A dialog box is displayed with a number of options such as displaying column headings.

8 Set the options you want.
The data from the Sales table appears in the Excel worksheet.
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Using the SQLRequest worksheet function
The SQLRequest worksheet function connects with an external data source and executes a SQL
query. It returns the result as an array without the need for macro programming. When you use
SQLRequest, you use ODBC directly from Excel.

You should consider using SQLRequest if you want to place items of external data in a specific
cell or cell range on your worksheet. The external data will be updated each time you open the
worksheet, and you can also force the data to be updated at any time.

You need to enter a SQL query statement as one of the parameters to SQLRequest. If you can't
write SQL, then use Microsoft Query to build the query for you. You can then copy the SQL
statement for use in a SQLRequest function.

To use SQLRequest, the Microsoft Excel ODBC Add-in must be installed.

Installing the ODBC Add-in
The Microsoft Excel ODBC Add-in (Xlodbc.xla) must be installed if you want to use ODBC
directly from Excel.

To install the Microsoft Excel ODBC Add-in

1 On the Tools menu, click Add-ins.
2 In the Add-ins Available box, select the ODBC Add-in check box.

SQLRequest syntax
The format of the SQLRequest function is:

=SQLRequest(�dsn=data_source_name�, �query_text�, output_ref, driver_prompt,
 column_names_logical)

The first parameter is the connection string, which supplies the information required by the
ODBC driver to open the database. For the Vision ODBC driver, the string should contain the
name of an ODBC data source. The data source must previously have been configured (see
�Adding, Modifying and Deleting Data Sources� in the �Vision ODBC Driver� chapter).

The query_text is the SQL statement to be executed, which would normally be a SELECT
statement. The remaining parameters are optional, look up �SQLRequest Function� in the Excel
Help index for details.

Example: using the SQLRequest function
The easiest way to insert a SQLRequest function into a worksheet is to use the Function Wizard.
Follow the steps below to display the Sales data from the Scodemo demonstration database on a
worksheet. You should already have created an ODBC data source for the Scodemo database.
Refer to �Creating the Demonstration Database� in the �Vision ODBC Driver� chapter if you
have not yet created the database.
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To insert a SQLRequest function

1 Open a new workbook.
2 Select an area containing five columns and nine rows of cells.

The SQLRequest function returns data as an array, so to see all the data you need to select a
range of cells the same size as the table returned by the SQL SELECT statement.

3 On the Insert menu, click Function.
The Function Wizard appears.

4 In the Function Category box, click Database.
5 In the Function Name box, click SQLRequest. Do not choose SQL.REQUEST by mistake.
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Note  If you have just started Excel, and you have not previously used any of the functions in
the Xlodbc.xla Add-in, then the SQLRequest function may not be listed. In this case, choose
SQL.REQUEST, choose Next, and when the Xlodbc.xla Add-in has loaded, choose Cancel.
Repeat this step, and SQLRequest will now be available.

6 Click the Next button.
The Function Wizard prompts you to enter the parameters for the function.

7 In the ConnectionStr box, type �dsn=scodemo� and in the QueryText box, type �select *
from sales�. Do not type the quote marks, because these are added automatically by the
Function Wizard. In the ColNamesLogical box, type �true�.

8 Click the Finish button.
The Function Wizard is removed. Only the first cell in the range contains a value.

9 Press F2, then CONTROL+SHIFT+ENTER.
The data appears in the selected range.
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If you save the workbook and quit Excel, and then reopen the workbook, Excel will ask whether
to re-establish links. If you choose Yes, the message �SQLRequest on XLODBC.XLA is not
defined or is too complex� is displayed. Ignore this message, and choose OK. Excel loads
Xlodbc.xla at this point, and the remote data is updated. If you choose No when asked whether
to update links, Excel does not display the strange message, but opens Xlodbc.xla and updates
the data anyway.

Tips on using arrays
The SQLRequest function returns data as an array. You use an �array range� (of cells) to display
the array on the worksheet.

Selecting an array range.  If you select a range of cells which is smaller than that required to
display all the rows and columns in the data returned by a SQLRequest function call, then Excel
displays the relevant items in the selected cells when you enter the function and press
CTRL+SHIFT+ENTER. If you select an area which is larger than is required to display the returned
data, then the excess cells will be empty.

Once you have entered a remote reference as an array formula, you must select all the cells in the
array range before attempting to change any cell. Otherwise, the message �Cannot change part of
an array� will be displayed.

Refreshing an external data array.  An array of external data, returned by the SQLRequest
function, is updated automatically when you open the workbook containing it. You can also
force an array to be updated at any time.

To update an external data array

1 Select any cell in the array range.
2 Press F2.
3 Press CTRL+SHIFT+ENTER.

If you do not hold down CTRL and SHIFT while pressing ENTER, the message �Cannot change
part of an array� will be displayed.

The worksheet will be updated with the external data.

You can use this method to extend the size of an array range. For example, if you forgot to hold
down CTRL and SHIFT when pressing ENTER when you initially entered the remote reference, you
can select the cell containing the remote reference, extend the selection to a range of cells, and
then force the reference to be updated.

You cannot reduce the size of a formula array range, because the message �Cannot change part
of an array� is displayed if you select only part of an array and try to force an update. You must
clear the array range, and re-enter the remote reference (use the Copy and Paste commands to
avoid retyping the formula).
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Clearing an array range.  You can delete an array range from your worksheet.

To clear an array range

1 Select the entire array range.
2 On the Edit menu, click Clear, and then click All.

Converting an array range to constant values.  Because of the restrictions that apply to
editing an array range, you may want to convert the values returned by a remote reference into
constant values. You can then edit individual values in the range, but of course the values will
never be updated because the original remote reference formula no longer exists.

To convert to constant values

1 Select the array range.
2 On the Edit menu, click Copy.
3 On the Edit menu, click Paste Special.
4 Under Paste, select the Values check box.

The Profit model
The Profit model demonstrates the use of the SQLRequest worksheet function to access external
data.

The data source name �scodemo� is coded into the formulas on the Profit worksheet, so you
need to have created the demonstration tables in a data source of this name. Refer to �Creating
the Demonstration Database� in the �Vision ODBC Driver� chapter if you have not yet created
the database.

Loading the Profit model
Follow the instructions in this section to load the the Profit model.

To load the Profit model

1 Start Microsoft Excel.
Normally, a blank worksheet is automatically provided when you start Excel. This is not
required for the Profit model, so close it.

2 Open Profit.xls.
By default Profit.xls is located in the \Program Files\Vision\Examples\Excel folder or
\Vision\Examples\Excel on older versions of Windows NT.
The Profit worksheet is displayed, and then a message box asks whether remote links should
be restored.

3 Click the Yes button.
If you have just started Excel, the message �SQLRequest on XLODBC.XLA is not defined or
is too complex� is displayed. Ignore this message, and choose OK.
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There will now be a pause of a few seconds while the ODBC requests are made, and then the
remote data should appear on the worksheet.

You may need to enlarge the Excel window so that you can see all of the worksheet, which is
shown in the following illustration. Notice that the gridlines and row and column headings have
been turned off. These are useful when you are developing a worksheet, but are a distraction
when the worksheet is finished and ready to receive some data.

The figures for Sales, Cost of Sales and the individual expense items on the simplified profit and
loss account worksheet have been extracted from the SQL database table called Nominal (see
�Demonstration Database� in the Appendices). Each of these cells contains a formula similar to
the following example:

=SQLRequest("dsn=scodemo", "select nom_value from nominal where nom_code = '20001001'"

Refer to �SQLRequest Syntax� earlier in this chapter for an explanation of this formula.

Quitting the Profit model
Follow the instructions in this section to quit the Profit model.

To quit the Profit model

1 Close the Profit worksheet, or exit from Excel.
A dialog box is displayed asking if you want to save changes made to the Profit worksheet.

2 Click the No button.
If you choose Yes, then the data retrieved from the remote database in this session will be
saved and will reappear next time you open the worksheet.
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Microsoft Word
This section describes using Microsoft Word 7.0 with the Vision ODBC driver.

Word can access external data through ODBC, using either Database fields in the document, or
WordBasic macros. If Microsoft Query is available, Word can use DDE links to retrieve data
selected by Query.

Using Microsoft Query
Microsoft Query is an ODBC-supporting application that allows you to query a database using
point and click mouse techniques. Word communicates with Query using dynamic data exchange
(DDE).

Microsoft Query is not currently distributed as part of the stand-alone Word 7 package. You
need to install Microsoft Excel in order to install Microsoft Query (see �Microsoft Excel� for
details). If you purchased Word as part of Microsoft Office, then Excel is available as part of the
Office suite of applications.

Follow the steps below to display the Sales data from the Scodemo demonstration database in a
Word document. You should already have created an ODBC data source for the Scodemo
database. Refer to �Creating the Demonstration Database� in the �Vision ODBC Driver� chapter
if you have not yet created the database.

To retrieve the Sales data

1 Position the insertion point where you want the new table of external data to be included.
2 On the Insert menu, click Database.

Until you select a data source, only the Get Data button is available in the Database dialog
box.
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3 Click the Get Data button.
The Open Data Source dialog box appears. Ignore the parts of the dialog box concerning file
selection, which are not relevant when using a multiple-tier ODBC driver such as the Vision
ODBC driver.

4 Click the MS Query button.
If the MS Query button does not appear in the dialog box, then Microsoft Query is not
installed.
Microsoft Query is displayed in a window, with the Select Data Source dialog box visible.
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5 Choose �scodemo� from the list of available data sources.
Note  If you have not used Microsoft Query to access this data source before, then it will not
be included in the list of Available Data Sources. Click Other, and select �scodemo� from the
ODBC Data Sources dialog box. This adds the data source to the list of Available Data
Sources, and it will appear in the list in future Query sessions.

6 Click the Use button.
The Query window appears, and the Add Tables dialog box is displayed.

7 Select Sales from the Table list, then click the Add button, and then click the Close button.
The Sales table field list appears in the Table pane.

8 Double-click the asterisk (*) in the field list for the Sales table.
The data from the Sales table appears in the Data pane.



Chapter 11 � ODBC Applications 323

9 On the File menu, click Return Data to Microsoft Word.
The Database dialog box is redisplayed, with all options now available. Clicking Query
Options returns to Microsoft Query.

10 To format the table, click Table AutoFormat.
You can choose one of the many predefined table formats available in Word.

11 Click the Insert Data button.

In the Insert Data dialog box, you can specify the range of records you want to insert. The
range refers only to the records that were selected by the query. If you want to be able to
update the information in the table, make sure Insert Data As Field is checked.

The data from the Sales table appears in the Word document.
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Using a Database field
A Database field inserted into a Word document is used to query an external data source, and
return the result as a table. When you use a Database field, you access the ODBC data source
directly. You can update the field at any time to query the database again.

If Microsoft Query is installed on your system, then you may find that that application provides
a convenient way to insert Database fields into your documents. Word provides the option of
inserting the data returned by a query as a Database field.

Note  The Microsoft Word 7 documentation suggests that only single-tier ODBC drivers can be
used. In fact, multiple-tier drivers such as the Vision ODBC driver can also be used.

Database field syntax
The format of the Database field is:

database \c �DSN=data_source_name�, \s �query_text�, switches

The \c switch specifies the connection string, which supplies the information required by the
ODBC driver to open the database. For the Vision ODBC driver, the keyword DSN (in upper
case) is followed by the name of an ODBC data source. The data source must previously have
been configured (see �Adding, Modifying and Deleting Data Sources� in the �Vision ODBC
Driver� chapter).

The \s switch supplies the query_text, which is the SQL statement to be executed. This would
normally be a SELECT statement. Other optional switches are available, for example to apply
auto formatting to the returned table. Look up �DATABASE field� in the Word Help index for
details.
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Example: using the Database field
Follow the steps below to display the Sales data from the Scodemo demonstration database in a
Word document. You should already have created an ODBC data source for the Scodemo
database. Refer to �Creating the Demonstration Database� in the �Vision ODBC Driver� chapter
if you have not yet created the database.

To insert a Database field

1 Position the insertion point where you want the new table of external data to be included.
2 On the Insert menu, click Field.
3 In the Field dialog box, click All in the Categories box.
4 In the Field Names box, click Database.
5 In the Field Codes box, type the following field specification:

DATABASE \c "DSN=scodemo" \s "select * from sales"

Click the Options button if you wish to browse the available switches, and see a description
of their purpose. Use context Help on the Field Options dialog box for information on the
Database field.
The completed Field dialog box is shown in the following illustration.

6 Click the OK button.
The data appears in the Word document.

Tips on using fields
Instead of using the Insert Field command to enter a database field, you can press CTRL+F9 and
then type the field code between the field characters, which look like braces ({ }). Next, press
SHIFT+F9 to toggle to field result view, and press F9 to update the field.

Instead of using SHIFT+F9 to toggle between the view of the field code and field results, you can
position the insertion point anywhere in the field code or the table of results, press the right
mouse button, and choose Toggle Field Codes from the shortcut menu.

You can also use the shortcut menu to update a field. Position the insertion point anywhere in
the result table, press the right mouse button, and choose Update Field.
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Microsoft Visual Basic
This section describes using the Vision ODBC driver with Microsoft Visual Basic 4.0 for
developing 32-bit applications. You can also use the Vision ODBC driver with Visual Basic 4.0
for developing 16-bit applications. Note that Visual Basic only supports ODBC in the
Professional and Enterprise Editions, not in the Standard Edition.

Visual Basic uses the Jet Database Engine to access data, which is the same database engine that
powers Microsoft Access. In addition to its native database format, the Jet engine provides
seamless access to other standard database formats such as dBASE and Paradox, and to ODBC
data sources.

Data access objects (DAO) such as Database, TableDef, Field and Index objects allow you to
manipulate databases with the minimum of programming. As well as simplifying code, the data
object model insulates you from the underlying structure and mechanics of retrieving and
updating data. Users of the Enterprise Edition also have the option of using the Remote Data
Objects (RDO) programming model to access ODBC data sources.

It is also possible to develop applications that call the ODBC API directly, although this method
is more complex to implement.

Some Visual Basic terms
You should already be familiar with programming in Microsoft Visual Basic. However, some
basic terms are defined below.

bound control
A data-aware control such as a text control that is associated with a field in a data control. The
bound control �exposes� the data field, so that the user can view or edit it. When you move
from record to record in the data control, the bound control changes to reflect the current
record.

control
A control is an object which is placed on a form. Some controls are used to get user input and
display output, such as text boxes, command buttons, and list boxes. Other controls are not
visible to the user, and are manipulated by the program.

custom control
A custom control is an extension to the Visual Basic toolbox. You use custom controls in the
same way as built-in controls. A custom control is stored in a dynamic link library file (.ocx). To
use a custom control you add it to a project, and an icon is then added to the Toolbox. Custom
controls are stored in the \Windows\System directory.
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data control
A control that provides access to data stored in databases, and allows you to move from record
to record and display data from each record in bound controls. Using a data control, you can
perform most data access operations without writing any code at all.

database object
A Database object maintains information about the name of the open database, the rules by
which it may be accessed, as well as other information concerning the database and its structure.
The Database property of a data control is a Database object representing the source of the data
appearing in other controls bound to the data control. The Database property is not available at
design time, but it corresponds to the database specified by the Database Name and Connect
properties. If you do not want to use a data control, you can create an object variable of type
Database using the Dim and Set statements.

event procedure
A Visual Basic application is event-driven, which means that it reacts to user actions such as
clicking a button, or to changes in its environment. For each type of object you create, there is a
predefined set of events to which you can make the program react by writing code called an
event procedure.

form
A form is represented as a window, which has a border and may have a title bar, control box and
size buttons. The window normally contains controls. Associated with the form and controls are
event procedures, and there may also be general procedures stored with the form which are not
attached to objects. A typical application has one main form, several dialog boxes which are all
separate forms, and possibly other subsidiary forms. Each form is stored in a separate file (.frm).

function
A function is another type of general procedure, and unlike a subroutine it returns a value to the
calling procedure. A user-written function can be called in a similar way to one of Visual Basic's
built in functions.

method
A Visual Basic keyword similar to a function or statement, that always acts on an object.

module
Subroutines and functions which are not associated with a specific form can be placed in a
module file (.bas).

object
Forms and controls are objects. An object can have many properties associated with it. Each
object is defined by a class.
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project
A project is a collection of files that make up an application, which can be compiled to form a
single executable file (.exe). The list of files is stored in a project file (.vbp).

property
Every characteristic of an object in Visual Basic is specified by a property. These characteristics
include the object's name, contents, size, position, and color. Visual Basic defines a specific set of
properties for each type of object. The value of a property is called a setting.

recordset object
A Recordset object represents the records that result from running a query. There are three types
of Recordset object: table, dynaset, and snapshot. A dynaset-type Recordset is the result of a
query and can contain updatable records. It can contain records from one or more tables. A
snapshot-type Recordset is similar to a dynaset except that the data cannot be updated. Note that
the table-type Recordset cannot be used with ODBC data sources.

subroutine
A subroutine is a general procedure which is not invoked until another part of the application
explicitly calls it. Subroutines can be created on a form, or if they are relevant to more than one
form, they can be created in a module.

Visual Basic files supplied
The following Visual Basic files are placed by Setup in the \Program Files\Vision\Examples\Vb
folder or \Vision\Examples\Vb on older versions of Windows NT.

File Description

Datacon.vbp The project file for the data control example.
Datacon.frm The main form for the data control example.
Vb4demo.exe The Vb4 Demo executable file.
Vb4demo.vbp The Vb4 Demo project file.
Vb4demo.frm The main form for Vb4 Demo.

Updating tables
If you want to be able to update a table in an SQL database, then the table must have a unique,
non-null index. For example, if you want to experiment by adding an index to the Customer
table in the demonstration database, you can use SQLGold to execute the following SQL
statement:

create unique index ixcust on customer ( custom_num );
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To subsequently delete the index, the SQL statement is:

drop index ixcust;

Using a data control
The simplest way to access data in an ODBC data source from a Visual Basic application is to use
a data control. For full details, see �Accessing Databases with the Data Control� in the Visual
Basic Programming Guide. Follow the steps below to display the Sales data from the Scodemo
demonstration database on a form. You should already have created an ODBC data source for
the Scodemo database. Refer to �Creating the Demonstration Database� in the �Vision ODBC
Driver� chapter if you have not yet created the database.

To use the data control with an ODBC data source

1 In the Toolbox, select the data control icon and draw a data control on a form.
The data control icon looks like this:

2 In the Properties window, set the Connect property to �odbc;dsn=scodemo�.
You do not need to set the DatabaseName property because you are specifying the data
source name in the Connect string.

3 Set the RecordSource property to �sales�.
Providing the data source is currently accessible, you can select the Sales table from the drop-
down list for the RecordSource property. The connection to the data source will be opened
when you open the drop-down list. You may be prompted for information needed to connect
to the data source if this was not completely specified when the data source was configured.
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4 Draw a text box on the form to display the database information.
This control will be used to display a selected field from the Sales table.

5 In the Properties window, set the DataSource property for Text1 to the name of the data
control (Data1).
You can select Data1 from the drop-down list for the DataSource property.

6 Set the DataField property for Text1 to �fname�.
Providing the data source is currently accessible, you can select the field name from the drop-
down list for the DataField property.

7 Add a label to indicate the name of the database field this text box will expose.
8 Set the Caption property for Label1 to �First Name:� and the Alignment property to �Right

Justify�.
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9 Repeat steps 4 to 8, to add text fields to expose the �lname� and �actual� fields, and to add
labels of �Last Name:� and �Sales to Date:�.

Now run the application. You can use the four arrow buttons on the data control to move from
record to record through the Sales data, or to the first or last record.

If the Sales table was updatable, then you could change the value displayed in one of the bound
controls, and Visual Basic would automatically save the changes when you moved to a new
record. However, in order to update a table in an ODBC data source, it must contain a unique,
non-null index, and the Sales table is not normally indexed. Refer to �Updating Tables� for
instructions about creating an index.

Programming for data access
Visual Basic allows you to assign data access objects to variables, so that you can manipulate data
through program code. Using the methods and properties of object variables, you can query the
database, navigate through its tables, perfom updates, add or delete records, and more. For full
information, refer to the Guide to Data Access Objects in Microsoft Visual Basic Professional
Features Book 2.

The Vb4 Demo project
The Vb4 Demo project is provided to give a simple introduction to using data access objects and
methods. When you understand the basics, you are recommended to study the Visdata
application provided with Visual Basic Professional and Enterprise Editions, which is a more
comprehensive application that operates on ODBC data sources.
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Using Vb4 Demo
The Vb4 Demo application allows you to open an ODBC data source, type in an SQL SELECT
statement, and display the results.

To load Vb4 Demo

Do one of the following:

§ Open My Computer or Windows Explorer, open the C:\Program Files\Vision\Examples\Vb
folder, and then double-click Vb4demo.exe.

§ For older versions of Windows NT, open the Main Group in Program Manager, double-click
File Manager, open the C:\Vision\Examples\Vb folder, and then double-click Vb4demo.exe.

To open a data source

1 On the Database menu, click Open Database.
2 Select from the list of available data souces.

You may want to open the �scodemo� data source, which you should have created already to
access the Scodemo demonstration database.

To execute an SQL statement

1 In the SQL Select box, type an SQL SELECT statement.
For example, if you opened the �scodemo� data source, you could type:
select * from sales

2 Press ENTER, or click Run.
The selected records appear in a grid.



Chapter 11 � ODBC Applications 333

To quit Vb4 Demo

4 On the Database menu, click Exit.

How Vb4 Demo works
The Vb4 Demo project contains only a single form. It includes the custom controls
Threed32.ocx (3D frame) and Grid32.ocx (the grid control).

The Main form
The main form is called Vb4demo.frm. It contains a text box called TXT_SQL to allow the user
to type the SQL statement, and a grid control called GRD_Result to display the selected records.
The Database menu allows the data source to be opened and closed, and has an Exit command.
There is a command button called BTN_Run to initiate the SQL query.

Processing
The Form_Load procedure sets the input focus to the text box. It has to Show the form before
making this call.

The user is then expected to choose the Open Database command, and the
MNU_OpenDatabase_Click procedure includes the following statement to open the ODBC data
source:

Set Db = DBEngine.Workspaces(0).OpenDatabase("", False, False, "ODBC;")
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Note that no data source is specified either in the dbname argument nor the source argument.
This causes the SQL Data Sources dialog box to be displayed at run time to prompt the user to
choose a data source. If you wanted to open a specific data source, you would include the DSN
(data source name) option in the Connect parameter, for example �ODBC; DSN=scodemo".
The result of the OpenDatabase call is assigned to the Db variable, which is declared as a form-
level variable of object data type Database.

The user should then type an SQL SELECT statement in the text box, and choose the Run
button. The Default property of BTN_Run is set to True, so pressing ENTER has the same effect
as clicking the button with the mouse. The BTN_Run_Click method is used to create a dynaset,
and display the data in a grid control. First, the grid is initialized to the same state as at form
load time (which is necessary if data has previously been displayed during the current session).
Examine the properties of the GRD_Result control to see the initial state. Then the procedure
checks the Text property of SQL_TXT to ensure that the user has entered an SQL SELECT
statement.

The OpenRecordset method is called to create a dynaset-type Recordset from the specified SQL
statement. Note that the OpenRecordset method is applied to the Db database variable, to which
a Database object must previously have been assigned. If the user has not yet opened the
database, an error will occur, which is trapped by the error handler routine. The result of the
OpenRecordset call is assigned to the Rst variable, which is declared as a form-level variable of
object data type Recordset. The number of rows and columns in the recordset are determined,
and the grid size adjusted accordingly.

  ' Create dynaset-type Recordset, using SQL from text box.
  On Error GoTo ErrCreateRst
  Set Rst = Db.OpenRecordset(TXT_SQL.Text, dbOpenDynaset)
  ' Get number of rows and columns.
  On Error GoTo 0
    Rst.MoveLast                 ' Must do this to get correct RecordCount.
    Rows = Rst.RecordCount
    Cols = Rst.Fields.Count

  ' Set grid size
  GRD_Result.Rows = Rows
  GRD_Result.Cols = Cols

Now the record pointer is reset to the first record:

  Rst.MoveFirst                ' First record.
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A loop is used to fill the grid with the recordset. The loop includes some code to ensure that
each column is wide enough to display the largest item from that field in the recordset. The
statement that assigns the contents of a field in the recordset to the Text property of a grid cell
is:

  GRD_Result.Text = Rst(j) ' Place result item in grid.

where j is a variable used as an index into the recordset. The MoveNext method is used to move
to the next record:

  Rst.MoveNext             ' Next record

To close the data source, the user should choose the Close Database command. This closes both
the recordset and the database:

' Close the recordset and then the database
    On Error Resume Next
    Rst.Close
    Db.Close

The MNU_CloseDatabase_Click procedure is also called from the MNU_Exit_Click routine. The
MNU_Exit_Click routine is called from the Form_Unload procedure, so that the close database
routine is always executed if the user terminates the application.
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Borland Delphi
This section describes using Borland Delphi 2.0 with the Vision ODBC driver. Note that Delphi
only supports ODBC in the Developer and Client/Server Editions, not in the Desktop Edition.

Delphi integrates the Borland Database Engine (BDE), providing a high performance, scaleable
database architecture with an extensive collection of data controls for quickly creating database
applications and reports. BDE provides a uniform and consistent API to access multiple database
formats including dBASE, Paradox, Text, InterBase, Oracle, Sybase, and Microsoft SQL Server as
well as any ODBC data source.

Some Delphi terms
Some basic Delphi terms are defined below, for further information consult the Delphi
documentation.

component
Components, including forms, are objects you can manipulate. Each component encapsulates
some element of an application such as a window or dialog box. Although each has its own
unique aspects, all components share certain qualities they inherit from a common ancestor
object called TComponent. TComponent defines the minimum set of attributes necessary for a
component to operate in the Delphi environment.

component palette
The Component palette contains all the components you can use in a Delphi application.

control
A control is a visible element such as a text box, command button, or list box that the user can
interact with. Some controls can look and act �live� at design time, for example a data grid
connected to an active data set displays actual data. There are two subcategories of controls,
windowed controls which can get input focus and graphical controls that cannot receive focus.

data access component
A component that enables you to connect to a database and access its data.

data control component
A component that enables you to create the interface of a database application. Each control is
linked to one or more fields or records, and controls how a user sees a field or record in an
application. Data controls are linked to data access components through a data source
component.
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dataset
A dataset component encapsulates data in a database, such as a table or the result set returned by
a query.

event handler
Events represent user actions (or internal system occurrences) that your program can recognize,
such as a mouse click. In Delphi, almost all the code you write will be executed in response to
such an event. The code that specifies how a component should respond to an event is called an
event handler.

form
Forms are specialized objects that contain other components, and which generally appear as
windows and dialog boxes in a running application. Forms are stored in two separate files. The
.dfm file stores a binary image of the form. Any edits you make to the form's visual properties,
such as changing the height, color, border, and so forth, are stored in the .dfm file. The unit file
(.pas) stores the source code for the .dfm file. In the .pas file you write event handlers that
specify how the form and its components behave in the running application.

function
A function executes code that performs a specific task and returns a value when it stops running.
A user-written function can be called in a similar way to one of Delphi's built in functions.

method
A procedure or function declared within an object such as a component or control.

procedure
A procedure executes code that performs a specific task. Unlike a function, a procedure returns
no value. All event handlers are procedures.

property
Properties are attributes that define how a component appears and responds. There are a number
of properties common to all components such as position, size, and display and properties that
are particular to specific groups of components.

project
A project is a collection of all the files that make up an application or dynamic-link library,
which can be compiled to produce an executable file (.exe) or DLL (.dll). The list of files is
stored in a project file (.dpr).

unit
A unit is a collection of constants, data types, variables, and procedures that can be shared by
applications. Units are most commonly associated with forms although it is possible to have units
with no form associated with them.
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Delphi files supplied
The following Delphi files are placed by Setup in the \Program Files\Vision\Examples\Bd folder
or \Vision\Examples\Bd on older versions of Windows NT.

File Description

Bd2demo.exe The Bd2 Demo executable file.
Bd2demo.dpr The Bd2 Demo project file.
Bd2cust.dfm The derived form for Bd2 Demo.
Bd2cust.pas The unit file for BD2cust.dfm.
Bd2std.dfm The standard form for Bd2 Demo.
Bd2std.pas The unit file for BD2std.dfm.
Bd2demo.res The Bd2 Demo project resource file.

Note  You will only be able to run the BD2 Demo project if you have the Borland Database
Engine (as supplied with the Developer and Client/Server Editions) installed on your PC.

Refreshing data
If you want to use the Refresh method to reread records accessed with a table component, then
the underlying SQL database table must have a unique, non-null index. For example, if you want
to experiment by adding an index to the Customer table in the demonstration database, you can
use SCO SQLGold to execute the following SQL statement:

create unique index ixcust on customer ( custom_num );

To subsequently delete the index, the SQL statement is:

drop index ixcust;

Setting up an ODBC driver connection alias
You need to set up BDE aliases for your ODBC data sources before they can be accessed from
Delphi and you use the BDE configuration utility to do this. You should already have created an
ODBC data source for the Scodemo database. Refer to �Creating the Demonstration Database�
in the �Vision ODBC Driver� chapter if you have not yet created the database.

To set up an ODBC driver connection alias

1 In the BDE configuration utility, click the Pages menu, and then click System.
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2 Set the AUTO ODBC parameter to �TRUE�.
The AUTO ODBC setting enables the BDE to configure itself automatically for ODBC.
ODBC data source and driver information are automatically imported from the ODBC.INI
subkey in the Windows Registry.

3 On the File menu, click Save.
4 On the File menu, click Exit.
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Using the Database Form Expert
You can use the Database Form Expert to generate a form that displays data from an ODBC data
source. Follow the steps below to display the Sales data from the Scodemo demonstration
database. You should already have created an ODBC data source for the Scodemo database and
set up a BDE alias for the data source. Refer to �Creating the Demonstration Database� in the
�Vision ODBC Driver� chapter if you have not yet created the database. Refer to �Setting up an
ODBC driver connection alias� earlier in this chapter if you have not yet set up the alias.

To display the Sales data using the Database Form Expert

1 In Delphi, click the Database menu, and then click Form Expert to display the Database Form
Expert.

2 Click the Next button.
3 In the Drive or Alias name box, select �scodemo�. Then click the Next button.
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4 In the Delphi Database Login dialog box, enter your UNIX username and password.

5 In the Table Name box, type or select �sales�. Then click the Next button.

6 Click the �>>� button to add all the fields in the Sales table to the form. Then click the Next
button.
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7 Click Horizontal. Then click the Next button.

8 Click the Finish button to generate the new form.

Now run the application. Supply your UNIX username and password when the Delphi Database
Database Login dialog box appears. You can use buttons on the database navigator to browse
through the Sales data, edit the records or insert a new record. In order to refresh the record
display however, the underlying SQL database table must have a unique, non-null index, and the
Sales table is not normally indexed. Refer to �Refreshing Data� for instructions about creating an
index.
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The Bd2 Demo project
The Bd2 Demo project is provided to give a simple introduction to using a Delphi application
with the Vision ODBC driver.

Using Bd2 Demo
The Bd2 Demo application allows you to display either all or a filtered subset of the Customer
data from the Scodemo demonstration database. You should already have created an ODBC data
source for the Scodemo database and set up a BDE alias for the data source. Refer to �Creating
the Demonstration Database� in the �Vision ODBC Driver� chapter if you have not yet created
the database. Refer to �Setting up an ODBC driver connection alias� earlier in this chapter if you
have not yet set up the alias. Note also that because the Refresh method is used to make the filter
take effect, you must add a unique, non-null index to the Customer table. Refer to �Refreshing
Data� for instructions about creating an index.

To load Bd2 Demo

Do one of the following:

§ Open My Computer or Windows Explorer, open the C:\Program Files\Vision\Examples\Bd
folder, and then double-click Bd2demo.exe.

§ For older versions of Windows NT, open the Main Group in Program Manager, double-click
File Manager, open the C:\Vision\Examples\Bd folder, and then double-click Bd2demo.exe.
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To open the Customer table

1 Click the Open button.
2 In the Delphi Database Login dialog box, enter your UNIX username and password.

The data from the Customer table appears in the Bd2 Demo application window.

To filter the records

1 In the Filter/Search Criteria list, choose a City.
2 If Filtered Records Only is checked, then only the records for the City you specified will be

displayed.
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If Filtered Records Only is clear, then you can use the Find Next and Find Prior buttons to
browse through the whole table for records in the City you specified.

To quit Bd2 Demo

4 Click the Close button.

How Bd2 Demo works
The Bd2 Demo project contains two forms. One form is derived from a standard ancestor form
and therefore inherits the ancestor's components.

The standard form
The standard form is called Bd2std.dfm. It contains a button called CloseBtn to allow the user to
close the data source.
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The derived form
The derived form is called Bd2cust.dfm. It contains two non-visual data-access components
(TDataSource and TTable) and one data-aware visual component (TDBGrid). The TTable
component is called CustTable and is used to retrieve the data from the Customer table. The
TDataSource component, called CustDataSource, provides a conduit for data between CustTable
and the TDBGrid component (CustomerGrid) enabling the Customer data to display in BD2
Demo. Two buttons called OpenBtn and CloseBtn (the latter inherited from the standard form)
allow the Customer table to be opened and closed. A list box called SearchCriteria is provided to
allow the user to choose a City on which to filter or search through the records in the Customer
table. Filtering the records is facilitated by a check box named FilterBox. Searching through the
records by City is facilitated by two buttons named NextBtn and PriorBtn.

Processing
The user is expected to choose the Open button, and the OpenBtnClick procedure sets
CustTable's Active property to True to open the Customer table (after first checking that table is
not already open):

if not CustTable.Active then
     begin
          { Open table }
          CustTable.Active := True;

CustTable's DatabaseName property is set to specify �scodemo� and the TableName property is
set to specify �customer�. Therefore setting CustTable's Active property to True causes the
Customer data to be retrieved from the demonstration database.

The user is expected to select a City from the list box on which to filter or search through
records in the Customer table. This component is therefore enabled when the table is open. The
Cities in the list box are strings that are stored in a list box string object (TListBoxStrings) which
is derived from TStrings. The value of ItemIndex is set to 0 so that the first City in the list is
displayed in the list box when the data source is opened.

          { Enable combo box and derive list box contents
            from params entries }
          SearchCriteria.Enabled := True;
          { Set filter criteria to first item in box }
          SearchCriteria.ItemIndex := 0;

The user is expected to use the check box to filter the records on a particular City. The following
code activates CustTable's Filtered property if FilterBox is checked:

          CustTable.Filtered := FilterBox.Checked;
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When the filter is activated only records meeting the criteria defined in the
CustTableFilterRecord handler will be displayed. CustTableFilterRecord is the handler assigned
to the OnFilterRecord event (which occurs when filtering is active). The filter handler uses the
Accept parameter to indicate whether or not a record passes the filter condition, namely that a
record's City field matches the string specified in SearchCriteria. If a record does pass the filter
condition, then Accept is set to True and the record is included. If it does not, then Accept is set
to False and the record is excluded.

  with SearchCriteria do
  Accept := DataSet['city'] = Items.Strings[ItemIndex]

The Refresh method is called to make the filter take effect.

          if CustTable.Filtered then CustTable.Refresh;

The user can also clear the check box and use NextBtn and PriorBtn to browse through the
whole table for records in the specified City. They are therefore enabled (assuming that the table
has been opened) if FilterBox's Checked property is set to False, which is the case when the
check box is clear.

  NextBtn.Enabled := not FilterBox.Checked;
  PriorBtn.Enabled := not FilterBox.Checked

The handler assigned to NextBtn's OnClick event calls FindNext to find the next record that
matches the filter criteria. FindNext turns on filtering (it is off because FilterBox's Checked
property is False) to find the next matching record, then turns it off.

  CustTable.FindNext;

Similarly, the handler assigned to PriorBtn's OnClick event calls FindNext to find the previous
record that matches the filter criteria.
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Powersoft PowerBuilder
This section describes using Powersoft PowerBuilder 5.0 for 32-bit Windows with the Vision
ODBC driver. Note that the Vision ODBC driver is compatible with the Enterprise and
Professional editions of PowerBuilder. PowerBuilder Desktop users are restricted to the ODBC
drivers shipped with the product.

PowerBuilder is a graphical object-oriented application development environment. The user
interface of a PowerBuilder application consists of menus and windows that users interact with.
Users control what happens by the actions they take.

DataWindow objects shield you from having to deal with databases to get and send data. All the
necessary SQL is created dynamically. DataWindows can be built from several data sources and
presentation styles provided by PowerBuilder.

Using the Vision ODBC driver, you can easily develop high-perfomance PowerBuilder
applications that access data from remote UNIX databases.

Some PowerBuilder terms
Some basic PowerBuilder terms are defined below, for further information consult the
PowerBuilder documentation.

application object
An application object is the entry point into a PowerBuilder application. When an application is
run an Open event occurs in the application object. This event triggers the script that initiates all
activity in an application.

control
A control is an object which is placed in a window that allows the user to interact with the
application. Controls can have events that trigger scripts to perform actions or call functions.

DataWindow control
A DataWindow control is an object placed in a window that acts as a container for a
DataWindow object.

DataWindow object
A DataWindow object is used to connect to the database, retrieve and display rows, and update
the database. It is necessary to initialize the appropriate transaction object, using the
SetTransObject function, before a DataWindow object can be used to access a database.



Chapter 11 � ODBC Applications 349

event
An action such as clicking the mouse or pressing a key, recognized by an object, that can trigger a
script.

function
A function is a program or routine that can be called to perform specific processing. All
PowerScript functions return values. A user-written function can be called in a similar way to one
of PowerBuilder's built-in functions.

library
A PowerBuilder library, identified by the file extension .pbl, is used to store objects such as
applications, windows, and DataWindows. A library is a collection of compiled object definitions
(compiled binary representation) and source objects (including scripts) stored in the same
location.

object
Windows and controls are objects. Each object has a set of attributes associated with it that
describe its appearance and behavior.

painter
A painter is a collection of tools for building an object of a specific type. Each of the main
components of a PowerBuilder application is built in its own specific painter window.

repository
A set of five system tables used by PowerBuilder to store any additional information you provide
when you create or modify a database table in PowerBuilder. Such information might include
display format, font information, and validation rules.

script
A script is a collection of statements, written in the PowerBuilder language PowerScript, that
perform processing in response to an event.

SQL Communications Area
SQL Communications Area (SQLCA) is the default transaction object for PowerBuilder. SQLCA
is global and therefore available in any script.

transaction object
A transaction object is a nonvisual object that serves as a communication area between the
application and the database. Each transaction object has fifteen attributes, ten of which connect
to the database, the remaining five return status information about the success or failure of
database activities. The transaction object, which identifies a specific database to PowerBuilder,
must be established before you can access a database with a DataWindow object in a window.
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window
A window is a workspace in which you place the controls you want to appear in your
application, such as DataWindows, command buttons, and list boxes. Typical window attributes
might include a border, control menu, and title bar. Associated with the window and the
controls placed in it are events, which trigger the execution of scripts.

PowerBuilder files supplied
The following PowerBuilder files are placed by Setup in the \Program Files\Vision\Examples\Pb
folder or \Vision\Examples\Pb on older versions of Windows NT.

File Description

Pb5demo.exe The Pb5 Demo executable file.
Pb5demo.pbl The Pb5 Demo source library file.

Note  You will only be able to run the Pb5 Demo project if you have either PowerBuilder
Enterprise or Professional, or the PB 5.0 Deployment Kit for Intel 32 as supplied with these
editions, installed on your PC.

Connecting to an ODBC data source in
PowerBuilder
You can connect to an ODBC data source in PowerBuilder either by defining and using database
profiles or by being prompted for the connection parameters.

Connecting to an ODBC data dource using prompts
Follow the steps below to connect to the Scodemo demonstration database by being prompted
for the connection parameters. You should already have created an ODBC data source for the
Scodemo database. Refer to �Creating the Demonstration Database� in the �Vision ODBC
Driver� chapter if you have not yet created the database.

To connect to an ODBC data source using prompts

1 Start PowerBuilder.
The PowerBar is displayed.

2 Click the Database Painter button in the PowerBar.
PowerBuilder connects to the database you were last working with. The Select Tables dialog
box is displayed.

3 Click the Cancel button.
4 On the File menu, point to Connect, and then click Prompt.

The DBMS dialog box is displayed.
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5 Choose ODBC from the list.
The SQL Data Sources dialog box is displayed.

6 Choose �scodemo� from the list of available data sources.
The Select Tables dialog box for the Scodemo demonstration database is displayed.

7 Select the tables you want, and choose Open.

Connecting to an ODBC data source using a database profile
If you are working with multiple data sources, the most convenient way to move between them is
by using a database profile. Database profiles are named sets of parameters that specify a
particular database connection.

A database profile is automatically created for ODBC data sources configured within
PowerBuilder. However, database profiles must be defined manually for all ODBC data sources
configured using the Microsoft ODBC Administrator program.

Follow the steps below to connect to the Scodemo demonstration database by defining and using
a database profile. You should already have created an ODBC data source for the Scodemo
database. Refer to �Creating the Demonstration Database� in the �Vision ODBC Driver� chapter
if you have not yet created the database.

To define a database profile for an ODBC data source

1 Click the Database Profile button in the PowerBar.
If your PowerBar does not include the Database Profile button, right-click the PowerBar, and
then click Customize in the pop-up menu. In the Customize dialog box, drag the Database
Profile button from the Selected Palette box to the Current Toolbar box.

2 In the Database Profiles dialog box, click the New button.
The Database Profile Setup dialog box is displayed.

3 In the Profile Name box, type �scodemo�, in the DBMS box, choose ODBC, and then click
the OK button.

The SQL Data Sources dialog box is displayed.
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4 Choose �scodemo� from the list of available data sources, and click OK.
Your newly defined database profile appears in the Database Profiles dialog box.

5 Click the Cancel button to return you to the PowerBar.

You can now connect to a data source by choosing the appropriate profile. Assuming you have
added the Database Profile button to the PowerBar, you can now connect to the data source you
want before going into the Database painter. Otherwise, you connect to the data source you
were last working with in the Database painter, which may or may not be the one you want.

To connect to an ODBC data source using a database profile

1. Click the Database Profile button in the PowerBar.
The Database Profiles dialog box displays, listing the names of defined profiles. If you are
currently connected to a database, the name of its profile is highlighted.

2. Select the �scodemo� database profile, and click OK.
PowerBuilder connects to the database.

3. Click the Database Painter button in the PowerBar.
The Select Tables dialog box for the Scodemo demonstration database is displayed.

4. Select the tables you want, and click Open.

You can also use the Database Profile button to move between data sources in the Database
painter. Click the Database Profile button in the PowerBar to display the Database Profiles dialog
box. Select the database profile you want, then choose OK. Click the Open button in the
PainterBar to display the Select Tables dialog box. Alternatively, choose Connect from the File
menu, and select the database profile you want from the submenu. The Select Tables dialog box
is displayed automatically.
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Configuring an ODBC Data Source in
PowerBuilder
You can also configure an ODBC data source in PowerBuilder. This has the advantage of
automatically generating a database profile for each new data source configured in this way.
Follow the steps below to define a data source using the PowerBuilder Configure ODBC dialog
box.

To define a data source

1 Do one of the following:
§ Click the Configure ODBC button in the PowerBar.

If your PowerBar does not include the Configure ODBC button, right-click the PowerBar,
and then click Customize in the pop-up menu. In the Customize dialog box, drag the
Configure ODBC button from the Selected Palette box to the Current Toolbar box.

§ In the Database painter, click the File menu, and then click Configure ODBC.
The Configure ODBC dialog box is displayed showing a list of installed drivers.

2 In the Installed Drivers box, select SCO Vision ODBC.
The currently configured data sources for the Vision ODBC Driver appear in the Data
Sources for Selected Drivers box (the list may be empty).

3 Click the Create button.
The SCO Vision ODBC Setup dialog box is displayed.
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4 Complete the configuration dialog box.
You can get Help on an item by clicking the question mark button in the title bar, then
clicking the item.

5 Click the OK button.
The Configure ODBC dialog box is displayed with your newly defined data source in the
Data Sources for Selected Drivers box.

6 Click the Close button.

PowerBuilder generates a database profile for the new ODBC data source definition. Although
ODBC data sources configured using the Microsoft ODBC Administrator program appear in the
PowerBuilder Configure ODBC dialog box, database profiles are not generated for them
automatically. Refer to �Connecting to an ODBC Data Source using a Database Profile� earlier
in this chapter if you want to define a database profile for these data sources.

The Pb5 Demo project
The Pb5 Demo project is provided to give a simple introduction to using a PowerBuilder
application with the Vision ODBC driver.

Using Pb5 Demo
The Pb5 Demo application allows you to display and update the Customer and Stock tables from
the Scodemo demonstration database. You should already have created an ODBC data source for
the Scodemo database. Refer to �Creating the Demonstration Database� in the �Vision ODBC
Driver� chapter if you have not yet created the database.
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To load Pb5 Demo

1 Do one of the following:
§ Create a shortcut to start Pb5 Demo. Right-click the shortcut, and then click Properties in

the shortcut menu. In the Shortcut Properties dialog box, click the Shortcut tab and type
the location of the Powersoft system modules in the Start in box. The files are located in
the C:\Program Files\Common Files\Powersoft Shared folder, or C:\Pwrs\Sys32 if you
chose to install PowerBuilder with short file names.

§ For older versions of Windows NT, create a Program item to start Pb5 Demo. In the
Program Items Properties dialog box, type the location of the Powersoft system modules
in the Working Directory box. The files are located in the C:\Program Files\Common
Files\Powersoft Shared folder, or C:\Pwrs\Sys32 if you chose to install PowerBuilder with
short file names.

2 Double-click the icon for Pb5 Demo.
The SQL Data Sources dialog box is displayed.

3 Choose �scodemo� from the list of available data sources, and click OK.

To display the Customer or Stock tables

4 On the File menu, point to Open, and then click Customers or Stock.
Click on a record in the top DataWindow to display full details for the record in the bottom
DataWindow.
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To add a record

1 On the Edit menu, click Insert.
2 Type the fields for the new record.

Use the TAB key to move to the next field.
3 When you finish entering data, on the Edit menu, click Update to add the record.

Repeat steps 1 to 3 to add more records.

To delete a record

1 Click the record in the top DataWindow you want to delete.
2 On the Edit menu, click Delete.

The records are removed.

To quit Pb5 Demo

4 On the File menu, click Exit.

How Pb5 Demo works
The Pb5 Demo project contains an application object, an MDI frame window, and two windows
each containing a master and a detail DataWindow.
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The Application Object
The application object is called pb5demo.

The Main Window
The main window is an MDI frame called w_genapp_frame. The main window has a menu
called m_genapp_frame that allows the user to open and close the Customer and Stock tables
and quit the application.

The Ancestor Master/Detail Window
The ancestor Master/Detail window is called w_master_detail. It contains two DataWindow
controls inherited from the user object u_dwstandard, called dw_master and dw_detail. Attached
to w_master_detail is a menu called m_fileopen that allows the user to update the data source.

The Descendent Master/Detail Windows
The descendent master/detail windows are called w_customers and w_stock and are used to
display the Customer and Stock data respectively. Attached to the master and detail
DataWindow controls in w_customers are two DataWindow objects named d_custlist and
d_customer that retrieve the Customer data. Similarly, the DataWindow objects d_stocklist and
d_stock retrieve the Stock data in w_stock. D_stock contains a DropDownDataWindow object
named d_dddw_manufact that displays the data from the Manufact table. This allows the user to
see what the values in the Manufacturer's Code column of the Stock table represent.

Processing
The following script is used to instruct the Open event for pb5demo to open the main window:

Open (w_genapp_frame)

In order for the Customer and Stock data to be retrieved, the DBMS property of the default
transaction object is first set to recognize ODBC as the desired method of communicating with
the database. This is coded in the open for w_pb5demo event:

sqlca.DBMS = "ODBC"

No parameters are specified for the transaction object's DBParm property which causes the SQL
Data Sources dialog box to be displayed at run time. The user is expected to choose "scodemo"
from the list of available data sources.

sqlca.DBParm = ""

The SQL statement CONNECT is then used to connect to the database.

CONNECT;

The following SetTransObject calls cause the master and detail DataWindow controls to look in
the default transaction object SQLCA for the information needed to communicate with the
database.

dw_master.settransobject ( sqlca )
dw_detail.settransobject ( sqlca )
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The following line in w_master_detail's Open event triggers the ue_retrieve event. The keyword
this refers to the current object, which is either w_customers or w_stock (as they are descended
from w_master_detail they inherit the code specified for that window's Open event).

this.EVENT ue_retrieve()

The ue_retrieve event executes the Retrieve function. This performs the SQL Select statement
associated with the DataWindow object (either d_custlist or d_stocklist) and places the retrieved
rows in the dw_master DataWindow control. For example, when w_customers is opened, the
following SQL statement (defined when d_custlist was created) is performed:

  SELECT customer.custom_num,
         customer.fname,
         customer.lname,
         customer.company
  FROM customer
ORDER BY customer.custom_num ASC

The script for the RowFocusChanged event of dw_master is used to retrieve data into the
dw_detail DataWindow. The RowFocusChanged event occurs before the DataWindow is
displayed and when the user moves through the records by clicking in a row or using the arrow
keys. The following line uses a DataWindow data expression to obtain the item number in
column 1 of the currently selected row in dw_master. The number is stored in the ll_itemnum
variable, which is declared as a local variable with the long data type.

ll_itemnum = this.object.data[currentrow, 1]

A retrieval request is sent to dw_detail along with the retrieval argument the DataWindow
expects (defined when the DataWindow object was created), which will be a Customer Number
or a Unit Price depending on which window is active. If the retrieval operation fails, a message
box is displayed informing the user of the failure.

IF dw_detail.Retrieve(ll_itemnum) = -1 THEN
    MessageBox("Retrieve", "Retrieve error-detail")
END IF

Pb5 Demo allows the Customer and Stock table to be updated. To add a record the user is
expected to choose the Insert command on the Edit menu and then the Update command. When
the Insert command is chosen the following script executes. This clears, inserts a new row into,
and sets the focus to, dw_detail:

dw_detail.Reset()
dw_detail.InsertRow(0)
dw_detail.SetFocus()

To update the database, the user must choose the Update command on the Edit menu. This
action triggers the ue_update event which executes the following script. The script commits
changes to the database only if an update was successfully carried out:
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IF dw_detail.Update() = 1 THEN
    COMMIT using SQLCA;
    MessageBox("Save","Save succeeded")
ELSE
    ROLLBACK using SQLCA;
END IF

COMMIT is an SQL statement that permanently updates the most recent database operation.
ROLLBACK cancels the most recent database operation. A retrieve request is sent to dw_master
to display the new record:

dw_master.Retrieve()

To remove a record, the user should choose the Delete command on the Edit menu which
triggers the ue_delete event. The script associated with this event deletes the currently selected
row from both dw_master and dw_detail.

dw_master.DeleteRow(0)
dw_detail.DeleteRow(0)
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Browsing overview
Vision97 software provides facilities for browsing remote hosts, offering the following benefits:

• You can browse remote UNIX hosts as easily as browsing the local hard disk.
• Files can be moved, copied, deleted or renamed.
• Files can be copied between the PC and UNIX systems.
• File types can be registered so that you can start a program or open a document by double-

clicking its icon.
• You can create shortcuts to UNIX programs and documents on the desktop.
• For Windows 95 or NT 4.0 users, the Unix Neighborhood browser provides a similar look

and feel to Network Neighborhood, and Host Explorer is similar to Windows Explorer. In
fact, Unix Neighborhood and Host Explorer are different modes of using one program, in the
same way that My Computer, Network Neighborhood and Explorer all run the same
program in Windows.

• For users of older versions of Windows NT, the Host Manager application can be used,
which is similar in appearance to File Manager.

• Drag and drop methods can be used to move or copy files, and to carry out actions such as
opening or printing a document.

Note  In this documentation, where information is applicable to both Unix Neighborhood and
Host Explorer, the latter program name is used.

Browsing on Windows 95 or NT 4.0
Unix Neighborhood and Host Explorer provide alternative views of UNIX hosts for Windows
95 or NT 4.0 users.

To use Unix Neighborhood

1 Double-click Unix Neighborhood on the desktop.
You can see the hosts that Host Finder has detected, plus any others that you configured
manually.
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A host that was detected by Host Finder, but which is currently not available, has its icon
marked with a cross.

2 Double-click any of the enabled hosts to see the contents of your home folder on that host.

Files with a recognized file type have a distinctive icon. Use the right mouse button to click an
icon to see a shortcut menu that shows what you can do.

To use Host Explorer

1 Click the Start menu, point to Programs, point to Vision, and then click Host Explorer.
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2 Click a host in the left side of the window. If this is the first time you have connected to this
host, you will be prompted to enter a username and password. The tree is then expanded to
show the contents of your home folder on the host.

Click Help Topics on the Help menu for full instructions. The same information can be seen by
choosing How To Use Host Explorer from the main Vision Help Contents.

Using the Paths button
When you use Host Explorer to connect to a host running Vision Services for UNIX, you can use
the Paths button to provide quick access to the directories in your UNIX path. Host Explorer
cannot read the PATH environment variable directly, so you need to run the dumppath utility to
write the contents of PATH to a file. To ensure that this happens automatically, place a
command to run this program in your startup file (.login or .profile) or ask the System
Administrator to add it to a global startup file if all users require this facility.
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If the file created by dumppath does not exist, defaults supplied by the File Access Server are
displayed.

Browsing on Windows NT 3.51
Host Manager is the means by which users of Windows NT 3.51 can browse UNIX hosts.

To use Host Manager

1 Open the Vision Group in Program Manager, then double-click the Host Manager icon.
A window shows your PC disks, any connected Windows drives, and currently configured
UNIX hosts.

2 To see what�s on any of these items, double-click the item.
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Files with a recognized file type have a distinctive icon. Use the right mouse button to click an
icon to see a shortcut menu that shows what you can do.

Click Help Topics on the Help menu for full instructions. The same information can be seen by
choosing How To Use Host Manager from the main Vision Help Contents.

VCA File Access service
Vision Communications Architecture (VCA) includes a File Access service that provides the
ability to browse and manipulate files and folders on a UNIX system.

The VCA File Access service can be provided by the following methods:

• Using the USP File Access service if Vision Services for UNIX is installed on the UNIX host.
• Using FTP file access on a TCP/IP network.

The service is made available to applications through the File Access API. There are some
restrictions using the FTP method.

Choosing a file access method
In Windows Control Panel, the Vision Communications option allows you to configure
Transports. When you add or modify a transport, you can select the method to use for the File
Access service using the Advanced tab in the Transport Properties dialog box (see �Configuring
Transports� in the �Vision Communications Architecture� chapter).
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If the transport uses a USP protocol, then the only option is to use the USP File Access service. If
the transport uses a TCP/IP protocol then the only option available is to use FTP file access.

USP File Access service
The Vision USP File Access service provides the ability to browse and manipulate the file store
on a remote host. It also allows files to be transferred between hosts. The key design points of
the File Access service include the following:

• The ability to open, close, read, write, move and delete files.
• The ability to create, open, close, change, and remove folders.
• Information about files and folders can be supplied.
• If the dumppath command is run to create the .visionpath file, then Host Explorer can

display the folders in the user�s UNIX path. If this file does not exist, defaults supplied by the
File Access Server are displayed.

• Files can be copied between the PC and UNIX systems.
• Files can be copied directly from one UNIX system to another.
• The ability to specify whether a file to be transferred contains text or binary data, with

appropriate conversion of line terminators on text files.
• The ability to change access permissions for a file.
• The ability to supply status information during a file transfer, and to abort the transfer.
• The file access service runs over the Vision Remote Procedure Call (RPC) service.

FTP file access
If you access a host using a TCP/IP transport without USP support (because Vision Services for
UNIX is not installed), then the FTP protocol is used for file access. The facilities for
manipulating files are similar to those described for the USP File Access service, with the
following exceptions:

• You cannot change access permissions for a file.
• You cannot display the Paths folder in Host Explorer.
• If you copy a file from one folder to another on a UNIX system, or from one remote host to

another, then the file is transferred to the PC and then back to the target folder. With USP
file access, the file would be copied directly from source to target.

When you access an FTP host, you can view the text of the FTP conversation. In Unix
Neighborhood, open the host and then click Host Response on the View menu to display the
Chat Viewer window.
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In Host Manager, click Text Pane on the Window menu to display the Text Pane at the bottom
of the window.

File types
Host Explorer and Host Manager recognize certain types of files, and allow you to open the
program or document by double-clicking its icon. Distinctive icons are used to represent files
that are recognized.
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Host Explorer allows you to set up file types for remote UNIX files. Host Manager allows you to
set up remote file types, and also local Windows file types.

Local file types
Host Manager allows you to configure local file types in the same way as File Manager. It
modifies the Hkey_Local_Machine\Software\Classes section of the Windows Registry. File types
configured in Host Manager will appear in File Manager, and vice versa.

A Windows file type is recognized by a three-character extension following the dot (.) in the file
name. All files have an extension, even when long file names are used in Windows 95 and
Windows NT.

Associated with each file type are one or more actions that may be performed on the file. For
each action, you can specify the command used to perform the action. For example, the Text
Document file type, associated with the .TXT extension, has Open and Print actions configured
when you install Windows. The command specified for the Open action is notepad %1 and for
the Print action is notepad /p %1. The actions are available in the menus when a file of this type
is selected.
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Remote file types
You can configure remote file types from either Host Explorer or Host Manager, and the
information is stored as files in subfolders in the \Program Files\Vision\User\Browser\Classes
folder. There are two categories of remote file type: program and document. Program types also
fall into two categories: basic program types corresponding to Vision terminal emulators and
Remote Program Starter; and UNIX application types that are �based on� one of the basic
program types.

A appropriate selection of remote file types is installed, depending on which Vision product you
purchased. You can add a new program type, which must be based on an existing type. You must
register an application as a program file type before you can register an associated document
type.

To add a program type

1 In Host Explorer or Host Manager, click the View menu, an then click Options.
2 Click the File Types tab.

3 Click Add Program.
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4 Enter a description in the space provided. Choose one of the existing program types from the
drop-down list in the Based On box. Add run arguments and drop arguments if required. You
should not normally need to alter the Advanced options. Use context Help to get information
about these dialog box options. Click  in the title bar, then click an option.
The OK button remains grayed until you select something in Based On or you select a
document type in the Advanced section.

The new program type appears in the Registered File Types box. You should now add one or
more patterns so that browser programs can recognize files of this type.

To add a document type

1 In Host Explorer or Host Manager, click the View menu, an then click Options
2 Click the File Types tab.
3 Click Add Document.
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4 Enter a description in the space provided, and click Ascii Document if it�s a text file.
5 Click Change Icon to choose an icon to represent the document type. Click an icon in the

Current Icon box, or use Browse to select another Windows file containing icons.
6 In the Actions area, click Add.

7 Enter a name, such as Open. Choose the type of program you want to run on the PC to
handle the action for this type of document, for example an ANSI Emulator. Then specify the
remote command to run on the UNIX system in order to carry out the action, such as starting
a viewer program and loading the file. To change the properties of your selected program,
click Properties.

The action appears in the list. To add another action repeat step 6.

For more information about changing or deleting file types, click Help Topics on the Help
menu. The same information can be seen by choosing How To Use Host Explorer or How To
Use Host Manager from the main Vision Help Contents.

Pattern matching
A remote file type has one or more pathname patterns associated with it. If a file�s pathname
matches one of these patterns then the browser program will recognize it as a file of this type.
The VT420 Emulator file type has the pattern bin/* configured, so that any file in a directory
with a pathname that includes �bin,� such as /usr/local/bin, will be recognized as a VT420
application. For an application such as Uniplex, the only pattern set up is the executable name,
uniplex.

For a document file type, the pattern often includes a wildcarded string with a dot and some
identifying characters such as *.doc for a Word Perfect document. Note that in UNIX these are
not file name extensions, hence the need to use a pattern matching technique. The advantage is
that you are not restricted to recognizing files by extension, and you can set up as many patterns
as you like for one file type. For example, the Text Document file type is initially associated with
the following patterns: *.c, *.cc, *.h, *.txt, docs/*, README*. Therefore, the file README.TV
would be recognized as a text document. You can easily add new patterns to existing file types.
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To add a new pattern

1 In Host Explorer or Host Manager, click the View menu, an then click Options
2 Click the File Types tab.
3 Click a file type.
4 In the Patterns area, click Add.

5 Enter a pattern in the space provided, and specify what type of expressions you are using. Use
context Help to get information about these dialog box options.

6 Specify whether the setting of the execute bit is relevant.

Actions
For a document file type, you specify one or more actions, such as Open or Edit. These actions
are based on one of the program types, and also specify a command to run on the UNIX host.
For example, the Open action for the Word Perfect document type is based on the Word Perfect
Application file type, which in turn is based on the VT420 Emulator file type configured to run
in VT220 mode. The command specified for the Open action is wp �%1�. The actions are
available in the browser program menus when a file of this type is selected.

Properties
Properties for a file type are initially inherited from the file type it is based on, but can then be
changed. You can change the properties for the pre-configured emulator or Remote Program
Starter file types. An application program file type based on one of these basic file types inherits
its properties. Likewise, a document file type inherits the properties of the application program
file type.

For example, the Lotus 123 Application file type is based on the VT420 Emulator, so clicking
the Properties button in the Program Type dialog box displays the VT420 Emulator properties
dialog box. The properties inherited from the VT420 Emulator file type have been changed, for
example to select the Lotus 123 icon. In the Lotus 123 Document file type, you have another
opportunity to specify different properties, but would not normally do so.
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Associations
The disadvantage of identifying UNIX file types by pattern matching is that it is not as definitive
as the extension method available for Windows file types. You may find that only some of the
files in your UNIX file system are recognized automatically because they match one of the
configured patterns. Files that are not recognized will be displayed in the browser application
with a generic document icon, and instead of the menus containing commands for file type
actions, they contain the Open With command. This command allows you to choose the
program to use to open the file from a list of the configured file types. The Associate With
command is also available to allow you to manually specify the type of a file without opening it.

The Associations tab in the Options dialog box shows any manual file associations you have set
up. It does not show associations made automatically by the pattern matching mechanism.

For more information about using associations, click Help Topics on the Help menu. The same
information can be seen by choosing How To Use Host Explorer or How To Use Host Manager
from the main Vision Help Contents.
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Copying and moving files
Host Explorer (for Windows 95 or NT 4.0) and Host Manager (for Windows NT 3.51) allow
you to move or copy files:

• Within a UNIX file system.
• From one UNIX file system to another.
• Between the PC and UNIX.

For basic information about moving and copying files and folders, choose How To Use Host
Explorer or How To Use Host Manager from the main Vision Help Contents.

File names

Case sensitive file names
File names in Windows 95 and Windows NT are case-sensitive, and the file names will be the
same on UNIX. Note that when viewing files in a Windows program such as My Computer, you
may not see the file names with their true capitalization. This can cause problems if you have not
included uppercase variants when specifying patterns for UNIX file type definitions. For
example, if you specify that a text file should be recognized by the pattern *.txt, then files copied
as *.TXT will not be recognized as text files. If a file being copied to UNIX is not recognized as
one of the registered file types, then it will not be displayed with a distinctive icon in the file
browser program (Host Explorer or Host Manager) and the associated actions will not be
available.

Invalid file names
In Host Explorer, if you copy a PC file to UNIX and the file name is invalid, then the UNIX
system will either generate an error or take its normal corrective action. For example, it may
truncate a long file name. If you try to copy a UNIX file to the PC and the file name is invalid in
Windows, then Host Explorer will attempt to create a valid file name.

In Host Manager, you can specify options that control the action when a file name is invalid on
the target system. You can specify that a valid file name should be created, and/or that a prompt
should be displayed for the user to confirm the suggested new name or type a new one. If these
options are disabled, then the target operating system will either generate an error or take its
normal corrective action.

Line terminators
When you copy or move a file from one location to another, you normally want to create an
exact binary copy on the target system. The exception is when you copy a text file between
systems that use different end-of-line characters in ASCII text files. For example, Windows text
files use carriage return and line feed characters at the end of a line, while UNIX files have only a
line feed character.
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By default, the ASCII Document setting in the file type specification automatically determines
whether or not line terminators are translated. This means that files with a recognized file type
will have the correct translation applied, but for non-recognized files it defaults to a binary copy.
You can choose to explicitly specify Text or Data as the Transfer Data Type in Host Explorer or
Host Manager. Note that when the Transfer Data Type is set to Automatic, both the Text
Transfer and the Data Transfer buttons on the toolbar are in the up position.

Batch files
Host Manager can accept a batch file containing a list of copy or move operations. The format of
this file is:

source  target  options

where source and target identify the file(s) to be copied and their destination, respectively. The
options are command line switches, described in �The hostmgr Command.� Examples of batch
file entries are shown below.

local:c:\steve\accounts\assets\rvass1.xls  vision:assets/* /d
local:d:\work\contract\*.doc  vision:contract/*  /d
vision:/usr2/stevel/prices.sbd  local:c:\steve\*.*  /d

To run a batch file, enter a command in File Manager�s File Run dialog box of the form:

hostmgr@batch-file-name

The hostmgr command
The hostmgr command is used to start Host Manager. The format of the command is:

hostmgr  [source  target] [ /d ] [ /e ] [ /m ] [ /n ] [ /N ] [ /r ] [ /R ] [ /t ] [ /x ]

or

hostmgr  [@batch-file]

Note  Since the folder containing Host Manager is not normally included in your MS-DOS
PATH, you may need to specify full pathnames when entering an hostmgr command.

If no files are specified after the hostmgr keyword, then when Hostmgr.exe starts, the user must
select files for transfer. If options are specified on the command line, they set the initial state of
options.

If source and target are specified, they identify the file(s) to be copied and their destination,
respectively. Both can include a host name and a file specification, separated by a colon. For
example:

hostmgr local:c:\steve\myfile.txt vision /N /m /e
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If a batch-file is specified (preceded by an @ symbol), then Host Manager will look in that file
for a list of transfers. The batch-file is an ASCII text file containing lines with the following
format:

source  target  options

which are the same as when typed directly on the command line.

The option switches are:

/d Transfer file as binary data. Use this option for all files except line-
terminated text files. (Default.)

/e Exit on completion.
/m Start Host Manager minimized.
/n Notify on completion. (Default.)
/N Do not notify on completion.
/r Prompt for confirmation that an existing file on the target system should be

replaced.
/R Do not prompt for confirmation. (Default.)
/t Transfer text file.

When moving an MS-DOS file to UNIX, the <CR><LF> (ASCII 13, 10) at
the end of each line is replaced by <LF> (ASCII 10). The opposite change is
made when moving files from UNIX to MS-DOS.

/x Delete the source file on completion, if it resides on the local host.
/X Do not delete the source file. (Default.)

Note that when using a batch file transfer, some switches (such as /t) should be applied to
individual lines within the batch file, and others (such as /e) should be placed on the command
line that invokes the batch file. It depends on whether the switch refers to the file, or to the
transfer application itself.

Desktop shortcuts
In Windows 95 and NT 4.0, the screen background is known as the desktop. You can create a
shortcut on the desktop with an icon that represents a UNIX folder, program or document. Just
find the item you want in Unix Neighborhood, then drag its icon to the desktop.
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Double-clicking on a folder shortcut starts Unix Neighborhood to display the contents of the
folder. Double-clicking on a program shortcut starts the program, and a document shortcut starts
the associated program with the document loaded.

When you drag a UNIX file or folder to the desktop, a Remote Information File (.rif) is created
in the \Windows\Desktop folder. This contains information about the host, the path, and the
icon of the associated UNIX file. For a program or document, the same mechanism as that used
by Unix Neighborhood is used to start the correct program. For a folder, Unix Neighborhood is
started to display the folder contents.

Copying to Program Manager
If you are using Host Manager, you can copy a program or document item to Windows Program
Manager. Select the item, then choose Copy to Program Manager from the File menu. You will
be prompted to choose the action you want to export (e.g. Open or Edit) and the Program
Manager group you want to create the item in. The Program Manager item that is created
contains a command string to run the Windows viewer program, load an action template,
connect to a host, run a UNIX program and possibly load a document.
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This chapter discusses how you can execute programs on a remote
UNIX system, without opening a terminal connection.
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Executing remote programs overview
Vision97 software provides facilities for starting UNIX programs without having to log in using
a terminal emulator. The main benefits are:

• An easy method of starting X clients, if you have the Vision X Server installed.
• A convenient way of starting programs that do not require user interaction, such as daemon

processes or other background tasks.
• You specify a command, and the host you want to run it on. The process of connecting to the

host and authenticating the user is carried out automatically.
• You can browse the UNIX neighborhood for hosts and executable programs.
• Remote Program Starter settings can be stored in documents on the desktop or in folders.

You can start a UNIX program by double-clicking the document icon. The X Server can be
loaded automatically if required. You can also include Remote Program Starter settings
documents in your Web pages.

• You can specify whether you want to see any output, such as UNIX system messages or text
output by the program.

Executing a program
You can execute a program on a remote host using the Remote Program Starter application on
your PC.

To execute a program

1 Do one of the following:
§ Click the Start button, and then click Run Unix Program.
§ Click the Start button, point to Programs, point to Vision, point to Accessories, and then

click Program Starter.
§ For older versions of Windows NT, when the X Server is in single-window mode, click

Run on the Control menu.
§ For older versions of Windows NT, open the Vision group in Program Manager, then

double-click the Program Starter icon.
A new Remote Program Starter window appears.
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2 In the Host box, type a host name or choose a host from the drop-down list.
3 In the Command box, enter the command to be executed on the host system. The drop-down

list allows you to choose from the last five previously-used commands.
For a UNIX system the command syntax is similar to what you would type at the system
prompt on the remote system, except that you do not type an ampersand (&) to indicate that
the process should run detached from a terminal. For an X application you do not need to
type -display since by default the DISPLAY environment variable is set automatically.
Alternatively, click the Browse button. If the Host box is empty, all the configured hosts will
be displayed. If you specified a host in the Host box, then the contents of your home
directory on that host will be displayed. Browse the host until you find the program or shell
script you want to execute.

4 If you want to change other settings, choose a command from the Properties menu. The
Display, Size and Color properties are not relevant unless you are running an X application.

5 Click Run.

A connection is then made to the host and the command you specified executed. By default, you
will not see any status or error messages, nor any output of the UNIX program. To view this
output, you need to edit the Program properties and change View Reply to Always or On Data.
Then any output will appear in the Host Replies window as shown in the following example.
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Click Help Topics on the Help menu for full instructions. The same information can be seen by
choosing How To Use Remote Program Starter from the main Vision Help Contents.

VCA Remote Execution service
Vision Communications Architecture (VCA) includes a Remote Execution service that provides
the ability to execute a command on a UNIX system. Once the command has been executed,
there is normally no residual logical connection between the PC and the host as there would be if
you used a terminal service to log in and run a command.

The VCA Remote Execution service can be provided by the following methods:

• Using the USP Task service if Vision Services for UNIX is installed on the UNIX host.
• Using a remote execution service provided as part of the UNIX operating system or network

software, for example rexec.
• Using a terminal service, such as telnet.

A similar service is provided using any of these methods, and is made available to applications
through the Execution API.

Choosing a remote execution method
In Windows Control Panel, the Vision Communications option allows you to configure
Transports. When you add or modify a transport, you can select the method to use for the
Remote Execution service using the Advanced tab in the Transport Properties dialog box (see
�Configuring Transports� in the �Vision Communications Architecture� chapter).
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To change the method

1 Click the Service you want to change, and then click Change Method.
2 In the Change Method box, choose a method from the drop-down list.

If the transport uses a USP protocol, then the only option is to use USP Execution, which is
provided by the USP Task service. If the transport uses a TCP/IP protocol then the default is
rexec, with rsh, rlogin or telnet as alternatives.

USP Task service (remote execution)
The Vision USP Task service provides the ability to log in to a remote host system and run a
program. It provides an alternative to standard UNIX services such as rlogin and rexec. You can
choose it as an option when configuring the Remote Execution service for a transport. The key
design points of the Task service relating to remote execution include the following:

• The USP Task service uses the VCA Authentication service, which does not send unencrypted
usernames and passwords across the network. By comparison, rexec does require a username
and password to be sent as clear text.

• The Task Server is called tsrv, and it provides both Terminal and Remote Execution services.
If it receives a call that does not specify a terminal type, then it treats the message as a request
for detached execution. It forks a process to run a shell, which inherits the network socket
connection from tsrv, which has no further contact with the shell.

rexec command processor
Remote Execution Processor (rexec) is available on most UNIX systems using TCP/IP.

On UNIX systems, rexecd is the server for the rexec routine. Rexecd provides remote execution
facilities after verifying the username and password. Rexecd listens for remote connection
requests on a predefined port (512).

An application wishing to execute a command initiates a connection request to the rexecd port.
If the connection was successful, the application passes the command string to rexecd. Rexecd
then validates user information, as is done at login time and, if the authentication was successful,
changes to the user�s home directory and establishes the user and group protections of the user.
If any of these steps fail, the connection is aborted.

Next, the command is passed to the normal login shell of the user. The shell inherits the network
connections established by rexecd. The shell specified by the user�s login then executes the
command.

rsh command processor
Remote Shell Processor (rsh) is available on most UNIX systems using TCP/IP (although it is
sometimes called remsh). It is considered less secure than rexec, and so rexec should be used
instead if possible.
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On UNIX systems, rshd (or remshd) is the server for the rsh routine. Rshd provides remote
execution facilities after verifying the privileged port numbers. Rshd listens for remote
connection requests on a predefined port (514).

An application wishing to execute a command initiates a connection request to the rshd port. If
the connection is successful, rshd checks the application�s source port number. If it is not in the
range 0-1023, rshd aborts the connection. Next, rshd checks the address of the PC running the
application. If the address is associated with a host for which no corresponding entry exists in
the host name database on the UNIX host, rshd will abort the connection. Rshd uses the PC
node address to retrieve the PC node name from the /etc/hosts file.

The application must supply a username, and on most UNIX systems this is interpreted as a user
identity on the UNIX host machine and the password supplied (if any) is interpreted as the user
identity on the PC running the application.

Note  There are some UNIX machines that reverse the username and password. The username
supplied by the application is interpreted as a user identity on the PC running the application.
The password supplied (if any) is interpreted as the user identity on the UNIX host machine.

Rshd then validates the user account according to the following steps. Rshd looks up the
username in the password file and performs a chdir to the user�s home directory. If either the
lookup or the chdir fails, the connection is terminated. For user accounts that are not set up as
superuser, rshd consults the /etc/hosts.equiv (or hosts.lpd) file for a list of hosts considered
�equivalent.�  The authentication is considered successful if the PC�s node name is present in this
file. If the lookup fails, or the user is the superuser, then rshd checks the file .rhosts in the home
directory of the username account on the UNIX host for the PC�s node name and PC user
identity. If this lookup fails, the connection is terminated.

The command supplied by the PC application is passed to the normal login shell of the user. The
shell inherits the network connections established by rshd. The shell specified by the user�s login
then executes the command.

Remote Program Starter documents
You can save all the settings required to execute a remote program in a Remote Program Starter
settings document. Run the Remote Program Starter, configure the options, and then choose
Save from the File menu.

If the Unix Application Wizard is installed by your Vision97 product, then you can use it to
create .rps settings documents. The wizard guides you through the process and sets the options
according to the type of UNIX program you want to run. To run the wizard, click the Start
menu and then click New Unix Program.

You can include .rps settings documents in your Web pages and thereby start remote UNIX
programs from a Web browser and make X applications available across corporate intranets. To
use this functionality, you must ensure that your browser is configured to associate the .rps file
type with the MIME type �application/rps�. When the user activates a link to a remote
application, the connection to the host is made with the user�s own login and password ensuring
complete system integrity and security.
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This chapter describes how UNIX applications can print on a printer
attached to a PC, and how Windows applications can use a UNIX
printer.
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Printing overview
Some versions of UNIX provide a facility which allows you to configure a remote printer. You
can print to the remote printer over the network, in the same way as you would print to a
printer attached directly to the local computer. Vision97 software extends this remote printing
facility so that a UNIX application can print to a printer attached to a PC, and also enables a PC
application to print to a UNIX printer.

A Print Server runs on the PC, which listens for print requests. It also acts as a client for sending
print requests to a remote UNIX system. If you are on a TCP/IP network and your UNIX host
supports the standard LPD service, then Print Server can use that service. Otherwise, it uses the
Vision USP RPC service.

UNIX to PC local printing
The Print Server program runs on the PC and accepts print requests from UNIX systems. You
need to configure one or more �local printers,� associating a logical printer name with a physical
Windows printer. You can choose whether the logical printer listens for print requests using the
standard LPD protocol, or using the Vision USP RPC protocol. A local printer called Default is
set up for you when you install the Vision97 software, configured to use the LPD protocol.

If you use the LPD protocol, then you need to configure a remote printer in UNIX. The way this
is done varies between different versions of UNIX, as described later in this chapter.

If you use the RPC protocol, then you need to configure a UNIX printer so that print requests
are handled by a shell script which passes the print data to the pcprtclnt program. This UNIX
program is an RPC client which communicates with the Print Server on the PC. The printer must
be configured in a UNIX file called $VISION_ETCDIR/printers. For further information, look
up �printers file� in the Help index.

The shell script that calls pcprtclnt will be a print interface script on UNIX System V systems, or
an output filter on BSD UNIX printing systems. The script files are located in the
VISION_ETCDIR directory. Refer to �Configuring a Remote Printer on UNIX System V to use
RPC� or �Configuring a Remote Printer on BSD UNIX to use RPC� for more information about
configuring remote printers.

When printing from UNIX you must ensure that the print output can be interpreted by your
Windows printer. Your UNIX application may allow you to select an appropriate printer. For
PostScript output, you could use a filter to package raw text output as PostScript code.
Alternatively, if you enable the Line Printer Mode option in the Local Printer settings, output
will be interpreted as text. Note that if you send PostScript output to a printer with this option
enabled then the PostScript code will be printed!
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Adding a local printer

To add a local printer

1 In Windows Control Panel, double-click Vision Services, and then click the Printing tab.

The currently configured local and remote printers are shown in the Printers list. The local
printer called Default was set up when you installed the Vision97 software, configured to
print to the default Windows printer, and using the LPD protocol. You may want to edit this
printer to specify a different printer, or change the protocol.

2 To add a new local printer, click Add Local.

3 In the Logical Printer Name box, type a new name.
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4 In the Physical Printer Name box, choose a Windows printer from the drop-down list.
5 Make any changes you want to the other options. You can get Help on an item by clicking 

in the title bar, then clicking the item.

You also need to configure the PC printer as a remote printer on your UNIX host.

Configuring a remote printer on BSD UNIX to
use LPD

To configure a remote printer on BSD UNIX to use LPD

1 Use a text editor to edit the file /etc/printcap. You require Superuser (root) privilege.
2 Add a new printer definition to the end of the file. For example:

pcprinter|My PC printer:\
        :sd=/usr/spool/lpd/pcprinter:lf=/usr/adm/lpd-errs:\
        :sh:rm=mypc:rp=default:

The printer is called pcprinter on UNIX. The sd flag specifies a spool directory, which must
exist. The lf option names a log file for errors. The sh flag means suppress header, and must
be included if your PC printer is a PostScript device. The rm flag names the remote machine,
in this case the PC called mypc. The rp flag must specify the logical printer name specified in
the Local Printer service settings on the PC, in this case default.

Tips
§ When editing /etc/printcap, do not introduce trailing spaces after any of the lines.
§ You can use the following command to view the printer queue:

lpq -Ppcprinter

Configuring a remote printer on BSD UNIX to
use RPC

To configure a remote printer on BSD UNIX to use RPC

1 Use a text editor to edit the file /usr/local/vision/etc/printers. You require Superuser (root)
privilege.

2 Add a new printer definition to the end of the file. The following example is for a printer
attached to a PC called mypc that is called pcprinter on UNIX and default in the Local
Printer service settings on the PC.
pcprinter:mypc:default

For further information, look up �printers file� in the Help index.
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3 Copy or link the file /usr/local/vision/etc/lpr_rpc to a file whose name is the same as the local
printer name (i.e. the name of the printer on UNIX). For example, if the printer is to be
known as pcprinter, link /usr/local/vision/etc/lpr_rpc to /usr/local/vision/etc/pcprinter. Note
that this shell script must be executable.

4 Use a text editor to edit the file /etc/printcap. You require Superuser (root) privilege.
5 Add a new printer definition to the end of the file. For example:

pcprinter|My PC printer:\
        :sd=/usr/spool/lpd/pcprinter:lf=/usr/adm/lpd-errs:\
        :sh:lp=/dev/null:of=/usr/local/vision/etc/pcprinter:

The printer is called pcprinter on UNIX. The sd flag specifies a spool directory, which must
exist. The lf option names a log file for errors. The sh flag means suppress header, and must
be included if your PC printer is a PostScript device. The lp flag is the device name to open
for output, which should be set to /dev/null. The of flag specifies the output filter, which is
the shell script created in step 3.

The new printer is implicitly enabled.

Tips
§ When editing /etc/printcap, do not introduce trailing spaces after any of the lines.
§ You can use the following command to view the printer queue:

lpq -Ppcprinter

Configuring a remote printer on UNIX System V
to use LPD

To configure a remote printer on UNIX System V to use LPD

4 Various methods are used to configure remote printers on UNIX systems based on UNIX
System V. Consult your UNIX documentation.

Configuring a remote printer on UNIX System V
to use RPC

To configure a remote printer on UNIX System V to use RPC

1 Use a text editor to edit the file /usr/local/vision/etc/printers. You require Superuser (root)
privilege.

2 Add a new printer definition to the end of the file.  The following example is for a printer
attached to a PC called mypc that is called pcprinter on UNIX and default in the Local
Printer service settings on the PC.
pcprinter:mypc:default

For further information, look up �printers file� in the Help index.
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3 Check that the print queues are empty, then shut down the print scheduler by entering the
command:
/usr/lib/lpshut

4 Create a new printer interface by entering a command such as:
/usr/lib/lpadmin -ppcprinter -v/dev/null -mdumb

The -p switch specifies that the new printer is called pcprinter. The -m switch specifies the
model of printer, and you should choose a model appropriate to the printer attached to the
PC. If there is no obviously appropriate model set up on your system, choose a generic
printer such as �dumb�, or the equivalent on your system.
This command creates a printer interface script file with the name you specified for the
printer, located in a directory such as /usr/spool/lp/interface or /usr/spool/lp/admins/lp/
interfaces depending on the version of UNIX. For example, /usr/spool/lp/interface/pcprinter.

5 You now need to either replace the printer interface file with one supplied with the Vision97
software, or merge the two files. The script lp_rpc runs the RPC client program pcprtclnt that
converses with the Print Server on the PC.
If you are using a dumb printer specification, then rename the printer interface file generated
by lpadmin (for example, to old_pcprinter) and copy /usr/local/vision/etc/lp_rpc to the
interface directory, naming the copy with the original printer name. For example:
cp /usr/local/vision/etc/lp_rpc  /usr/spool/lp/interface/pcprinter

Make the script executable. For example:
chmod  +x  pcprinter

If you use a printer other than dumb, then you need to merge the printer interface file
generated by lpadmin with the relevant parts of lp_rpc. Contact Product Support if you
require assistance.

6 Enable the new printer by entering the command:
enable pcprinter

7 Start the scheduler again by entering the command:
/usr/lib/lpsched

8 Tell the spooler to accept the new printer by entering the command:
/usr/lib/accept pcprinter

The print device pcprinter is now available to UNIX users for queuing print jobs.

Tip
§ You can use the following command to view the print queue:

lpstat -t

Viewing print requests
You can make the Print Server window visible on the PC, so that you can see print requests
received from remote UNIX systems.
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To make the Print Server window visible

4 Click the Show Window box so that a check mark appears, then click Apply or OK.

PC to UNIX remote printing
The Print Server on the PC in fact also acts as a client to allow Windows programs to send print
requests to UNIX printers. You need to configure one or more �remote printers,� associating a
logical printer name with both a Windows printer and a remote UNIX printer. You can choose
whether the logical printer sends print requests using the LPD protocol, or using the Vision USP
RPC protocol.

The Windows printer that you choose when configuring a logical printer must send its output to
a file, instead of a physical printer port. This file is monitored by Vision Services on the PC and
the print request is sent to the UNIX print spooler. To print to the remote printer from a
Windows application you simply select the appropriate Windows printer.

Print requests sent to the UNIX system using the RPC protocol are handled by the printsrv
program. No special configuration is required on the UNIX end.
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Adding a remote printer
Configuring a remote UNIX printer involves three separate actions:

1 On your UNIX host, set up the printer which is to receive printing requests from your PC.
For example, the printer might be called room123.

2 Add a new Windows printer that sends its output to a file on the PC.
3 Configure the remote printer in Vision Services.

When you have configured the remote printer, you will be able to print to it by choosing it in
your Windows application, just like any local printer.

To add a printer on Windows 95

1 On the PC, click the Start button, point to Settings, and then click Printers.
2 Double-click the Add Printer icon.

The Add Printer wizard starts, and you should follow the instructions to set up a new printer.
Choose Local Printer, and then select the type of printer attached to the UNIX system. When
you are asked to choose a port, none of the existing ports are suitable for remote printing, so
temporarily select LPT1:. Specify a meaningful printer name, for example QMS-PS810 on
UNIX. Do not choose to print a test page.
When the wizard has finished, the new printer appears in the Printers window.



Chapter 14 � Printing 395

3 Click the new printer icon with the right mouse button, and click Properties.
4 On the Details tab, click Add Port.
5 Click Other, and select Local Port in the list box. Click OK.
6 Type a filename as a new port name. For example, c:\tmp\unixprt.tmp. Click OK.

7 The new �port� will now be shown in the Print to the Following Port box. Click OK to exit
from the Printer Properties dialog box.
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You can now proceed to add a remote printer in Vision Services, as described later in this
section.

To add a printer on Windows NT 3.51

1 Edit the [Ports] section in the Windows WIN.INI file to add a file as a port, for example,
c:\tmp\unixprt.tmp. You can use Windows Notepad to edit the file.

2 Restart Windows so that Windows recognizes the new port.
3 In Windows Control Panel, double-click Printers, then click Add.
4 In the List of Printers, choose the type of printer attached to the UNIX system, and click

Install. You will be prompted to insert the disk containing the printer driver. When the driver
has been copied, the new printer appears highlighted in the Installed Printers list.
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3 Click Connect.
4 In the Ports list, select the file you created as a port, for example, c:\tmp\unixprt.tmp.

5 Click OK to exit from the dialog box.

You can now proceed to add a remote printer in Vision Services.

To configure a remote printer in Vision Services

1 In Windows Control Panel, double-click Vision Services, and then click the Printing tab.
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The currently configured local and remote printers are shown in the Printers list.
2 Click Add Remote.

3 In the Logical Printer Name box, type a new name.
4 In the Physical Printer Name box, choose the Windows printer you just set up (for example,

�QMS-PS810 on UNIX on c:\tmp\unixprt.tmp�).
5 Specify the name of the remote host, and the remote printer (for example, room123).
6 Specify the communications protocol (LPD or RPC) by which print data will be sent from

your PC to the selected UNIX host. If the UNIX host handles incoming LPD remote printing
requests, and your PC is able to establish a TCP/IP connection to the UNIX host, select LPD
Protocol; otherwise select RPC Protocol.
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Note  If you are using the LPD protocol, you may have to add your PC�s network name to the
/etc/hosts.equiv or /etc/hosts.lpd file on the host (refer to the LPD documentation on the host).
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This chapter covers the enhanced messaging capabilities of Vision97.
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Message handling overview
Vision97 software provides facilities for handling messages sent to PC users, offering the
following benefits:

• When you open a terminal connection from your PC, messages sent to you from UNIX
appear in the Message Pad window, not in your terminal emulator screen.

• The User Viewer program allows you to send messages to other PC users, which appear in
Message Pad.

• You can send and receive multimedia messages, including sound and video clips.

Message Pad
Message Pad is an RPC server program that runs on a PC and displays messages sent to the user
in a window.

If the PC is connected to a UNIX server using a USP transport, then any messages sent to the
user from UNIX will appear in Message Pad. Text messages and multimedia messages can also be
sent by the User Viewer program (see �Text Messages� and �Multimedia Messages� later in this
chapter).

Use the right mouse button to click in the window to see a shortcut menu that shows what you
can do. Click Help Topics on the Help menu for full instructions. The same information can be
seen by choosing How To Use Message Pad from the main Vision Help Contents.
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How is Message Pad started?
Because Message Pad is an RPC server program, it is started automatically by the Local Name
Agent the first time a message is sent to the user.

What happens when a message is received?
If a message is received when the Message Pad window is minimized, then an audible note is
sounded. A small icon appears in the notification area at the right of the task bar. For older
versions of Windows NT, the Message Pad icon flashes.

To display Message Pad

Do one of the following:

§ Click the icon in the notification area.
§ For older versions of Windows NT, restore the window by double-clicking the icon.

The Message Pad window is displayed. If more than one message has been received, then you
would see a note such as �2 of 2� and you can click the �turned back� part of the page at the
bottom right to cycle through the messages. Alternatively, use the right mouse button to click in
the main part of the window, and choose Next Message or Previous Message.

When a multimedia message is received, it appears as an icon on a page, and the appropriate
viewer program is opened. When you close the viewer, the message remains on Message Pad.
Double-click a message icon to run the viewer and see or hear the message again. When you
close Message Pad, all messages will be deleted.

Saving messages from Message Pad
You can copy text from Message Pad by selecting it with the mouse, and pressing CTRL+INS. You
can paste the text into Windows WordPad or Notepad, and save it as a document. To save any
other form of message, open it in the viewer program, then use the Save command on the File
menu to name and save a file.
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Text messages
You can use User Viewer to send a text message to another Vision user, and the message appears
in Message Pad on the target PC.

To send a text message

1 In the User Viewer window, click the name of the user to whom you want to send a message.
2 On the File menu, click Send Text Message.
3 Type in the message in the space provided.

4 Click Send.

User Viewer connects to the remote user and the message appears on their computer in Message
Pad.
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Multimedia messages
You can use User Viewer to send the following types of multimedia messages to another user,
where they will be recognized by Message Pad:

• Text files (*.txt)
• Word documents (*.doc)
• Animation files (*.avi)
• Bitmap files (*.bmp)
• Midi sequence files (*.mid)
• Sound files (*.wav)

User Viewer uses the RPC mechanism to send a file to Message Pad, which writes it to the
Windows Temp folder, and launches the appropriate viewer program. When Message Pad is
closed, the temporary files are deleted.

Only the file types shown above are recognized by Message Pad; you cannot add additional file
types. These file types are normally registered in the Windows Registry when you install
Windows. However, if you do need to register a file type, you can use Windows Explorer or File
Manager.

To send a multimedia message

1 In Windows Explorer (Windows 95 or NT 4.0) or File Manager (Windows NT 3.51), click
the file you want to send as a message.

2 Make sure the User Viewer window is visible.
3 Drag the file(s) to the PC name you want in the User Viewer window.
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4 If you have enabled Confirm Multimedia Message in the Configure dialog box, you must
confirm the action before continuing.

An appropriate program starts on the PC and the file is automatically opened. Message Pad also
starts, displaying the name of the open file. For a sound or video message, the person receiving
the message normally needs to click Play to run the file. The example below shows a sound
message.

For examples of other message types, choose �Introducing Vision97� then �Sending Messages�
from the online Help contents.
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UNIX messages
When you are logged in to a UNIX system, users can send messages to you using programs such
as write or wall. You may also receive �new mail� messages sent by an email program, and
various other system messages. If you are using a real character-based terminal, these messages
will appear on the terminal screen.

When you use a Vision terminal emulator, the way messages are handled depends on the method
used to provide the terminal service. If you use a transport that is configured to use the standard
UNIX rlogin service, for example, then messages will appear on your terminal emulator screen
exactly as they would for a real terminal. The rlogin program creates an entry in the UNIX utmp
file showing which terminal device you logged in on. A program that wants to send a message to
your username can look in the utmp file to find out which terminal device it should write to.

If you use a USP transport, then requests for terminal connections are handled by the USP Task
Server tsrv. By default, the Task Server does not create an entry in utmp for the terminal you
logged in on. Instead, it creates an entry in utmp that is associated with a different pseudo-tty
device. It listens for messages sent to users for whom it has created such entries in utmp. When a
message is received, the Task Server acts as an RPC client program to pass the message to the
Message Pad RPC server on the correct PC.

You can prevent the Task Server handling messages in this way if you wish, in which case it will
create utmp entries in the same way as rlogin.
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This chapter shows how to find out which PCs are currently running
Vision97 software.
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User viewing overview
The User Viewer program allows you to obtain a list of all PC users running Vision software.
The program contacts the Name Space Manager (NSM) via an RPC call and obtains a list of all
PCs that have registered Local Name Agents (LNA).

If SuperVision is in use at your site, then User Viewer also displays user group information. This
information is also held by the NSM, providing that the pclist program has been run on the
administration host. This program is normally run by the LNA on the administration host at the
start of a session.

The User Viewer program can be used to send text and multimedia messages to a user, as
discussed in the �Message Handling� chapter.

Viewing users
You can use the User Viewer program to see which PCs are currently running Vision software.

To view current users

1 Click the Start button, point to Programs, point to Vision, point to Accessories, and then click
User Viewer.
The User Viewer appears on your screen.

Users are shown as icons organized by groups in a hierarchical tree. The System group
includes all users. If SuperVision is in use at your site, additional groups shown are those
defined in the administered file store. Note that a user that appears in a SuperVision group is
also shown in the System group.
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2 For more information, click a user with the right mouse button, and then click Properties.

Click Help Topics on the Help menu for full instructions. The same information can be seen by
choosing How To Use User Viewer from the main Vision Help Contents.

Viewing user properties
When you click a user�s icon in User Viewer with the right mouse button and click Properties,
the Options dialog box is displayed giving personal information about the user.

If you perform this operation on your own PC, then User Viewer reads the current information
from the Windows Registry. You can change any of the settings, and then save the changes.

If you request the properties for another user, then User Viewer contacts the Name Space
Manager (NSM) requesting the infosrv service on the target PC. The NSM asks the Local Name
Agent (LNA) on the target PC to start the Information Server Infosrv.exe, and this supplies the
user properties to User Viewer on your PC. You are not allowed to edit the properties for
another user.
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Zones

This part is only relevant to XVision. It describes how windows can be
organized into several zones by creating a virtual desktop space.

Chapter 17 � Organizing the Desktop with Zones 415

This chapter describes the Zones program that allows you to organize windows into
several zones by creating a virtual desktop space.
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Zones overview
The Zones program allows you to organize windows into several zones by creating a virtual
desktop space. The main benefits are:

• Instead of all the applications you work with sharing the area of your screen, you can
organize them into �zones� that you can easily switch between using the zonebar.

• An application�s window may appear in one zone, or in several, or in all zones.
• The desktop background, including icons representing available programs or documents,

appears in all zones.
• The Windows taskbar appears in all zones. The taskbar buttons represent the windows in the

current zone. Items in the notification area remain the same for all zones.
• Each zone has a StartUp folder to allow applications to be started automatically.
• Available for Windows 95 and Windows NT 4.0 or later.

Note  This documentation refers to the primary zone as Zone 1. You should be aware that the
name of the primary zone may be changed.

Organizing zones
You can use the Zones program to organize applications, that are currently running, into
separate groups or zones that you can easily switch between.

To use Zones

1 Click the Start button, point to Programs, point to Vision, point to Accessories, and then click
Zones.
The zonebar appears, normally at the top of your screen.

The Zones button on the left displays a menu. The other buttons represent the different
zones. If you have already customized Zones, then you may have changed the names of the
zones, and the zonebar may appear in a different location on the screen, or be hidden.
All programs running when you started Zones are placed into Zone 1. The zone that is
initially made the current zone depends on the setting in the Zones Properties dialog box.
The default is Zone 1, but you could specify another zone, or the last zone used.

2 Click a zone button if you want to switch to a different zone.
3 Start any applications you want to appear in the new zone.
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If you try to start an application that is already running in another zone, then normally the Zone
Police dialog box asks you to choose whether to start a new instance of the program, or take an
alternative action. If the application does not allow more than one instance, the effect of trying
to start another depends on the application. For example, the window may come to the
foreground in the other zone (so you see no effect in the current zone), or the window may be
moved to the current zone.

You can disable Zone Police from the General tab on the Zones Properties dialog box.

Click Help Topics on the Zones menu for full instructions. The same information can be seen by
choosing How To Use Zones from the main Vision Help Contents.

Quitting Zones or deleting a zone
When you exit from Zones, only the applications whose windows appear in Zone 1 can continue
to run. Therefore any application running in a zone other than Zone 1 must be terminated or
moved to Zone 1.



Vision97 Reference418

A similar dialog box is displayed if you delete a zone that contains applications whose windows
appear only in that zone. Also, if you delete a window from a zone using Zone Control, and the
application�s window does not appear in any other zone, then a similar dialog box will ask you
to confirm that the window should be closed.

Deleting a zone that has a StartUp folder containing shortcuts causes the following dialog box to
be displayed:

The StartUp folder will only be deleted if you choose to delete all the shortcuts.

Using Zone Control
The Zone Control window allows you to create, delete or rename zones. You can also change
the properties of a zone, or for all zones. Applications currently running can be moved between
zones, and you can specify applications to be started automatically for each zone.
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To display the Zone Control window

4 On the Zones menu, click Control.

Use the mouse to drag window icons from one zone to another. You can also copy windows
using the right mouse button, so that the application�s window appears in more than one zone.
In this case, only one instance of the application is running, and if you close the application then
its window will be removed from all zones. For details of how to carry out operations on zones
and windows, click the Help button in the window, and then choose the Related Topics button
in the Help window.

Viewing zone properties
When you click a zone�s icon on the zonebar with the right mouse button and click Properties,
the Properties dialog box is displayed.
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You can change the name of the zone, and also the hot key used to quickly switch to the zone
using a keyboard shortcut. You can also change the zone�s icon. Refer to �Starting Programs
Automatically� for information about the StartUp tab.

You can also display properties for the zones top level that allow you to specify options for the
zonebar, and also to specify StartUp programs.

Starting programs automatically
Each zone has a StartUp folder in which you can place shortcuts to start programs automatically.
In addition, there is a StartUp folder at the top level that allows you to start programs that
should appear in all zones.

Starting a program automatically in all zones
If you add a shortcut to the StartUp folder at the zones top level, then the program will be
started when Zones starts, and its window will appear in all zones.

To start a program automatically in all zones

1 On the Zones menu, click Properties and then click the StartUp tab.
2 Click Add. Follow the instructions on the screen to create a shortcut.

Although a program�s window may appear in more than one zone, only one instance of the
program is running. Closing the application would remove its window from all zones.

If you do not wish to be prompted to confirm that a program should be started, disable
�Confirm on Zone Startup� on the General tab in the Zones Properties dialog box.
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Starting a program automatically in one zone
If you want an application to appear in a specific zone, then place a shortcut in the StartUp
folder for that zone. If a shortcut is in the StartUp folder for the initial zone, then the program
will be started when Zones starts. For any other zone, the programs in the StartUp folder are
started when you switch to that zone for the first time.

To start a program automatically in one zone

1 On the zonebar, click on the zone button using the right mouse button, click Properties and
then click the StartUp tab.

2 Click Add. Follow the instructions on the screen to create a shortcut.

If you do not wish to be prompted to confirm that a program should be started, disable
�Confirm on Zone Startup� on the General tab in the Zones Properties dialog box.
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Managing PCs remotely
As the use of PCs spreads into every part of an organization, the cost of maintaining and
supporting PC systems becomes an increasing burden. In fact, the major part of the cost of a PC
during its lifetime is taken up by management and support, with only a minor portion being the
initial purchase cost. However, if these PCs are connected to a network, either directly or via a
modem link, then SCO SuperVision can help to reduce the cost of ownership by managing PCs
remotely.

SuperVision is part of the Vision97 suite of PC to UNIX integration products from SCO. It
allows files and other objects to be distributed to PCs, and enables tasks to be carried out on PCs
automatically. The System Administrator can monitor PCs and directly manipulate the files and
folders. (The term System Administrator used in this documentation means the individual
responsible for managing the UNIX server, the network, and the community of PCs.)

SuperVision has a UNIX component and a PC component. The UNIX software includes the
Vision Services for UNIX infrastructure, plus the Administration Services module that provides
an administration database and a set of tools. It also has a UNIX-based scripting facility that
allows tasks to be automated.

The PC component includes the Administration Agent which should be installed on all PCs to be
administered, and also the Administration Workbench which should only be installed on the
System Administrator�s PC. The Administration Agent is included with other Vision97 products,
so you do not need to install SuperVision on a PC if you have already installed one of these
products. The Administration Workbench is used by the System Administrator to maintain the
database, and also to obtain remote access to other PCs. Note that the UNIX commands include
some that provide an alternative to using the Administration Workbench for some operations.

SuperVision is intended primarily for administering communities of PCs running other Vision97
products such as TermVision, XVision or SQL-Retriever.

Organizing PCs
The task of administering a large number of PCs can be made easier by organizing them into
groups. Operations can then be carried out on an entire group, and PCs within the group will
have the same configuration. For example, all PCs within the Sales department could be grouped
together and provided with pre-configured desktop items that allow access to the UNIX
programs they need. Restrictions could be placed on the group to prevent users altering the
configuration.

SuperVision allows a System Administrator to define the PCs within his domain or area of
responsibility. A UNIX server is designated as the �administration host� for this domain. PCs can
be connected to the UNIX server by a network or by modem link. For modem links, Vision
Communications allows a PC to connect to any UNIX server running Vision Services for UNIX,
which will then act as a proxy for the PC on the network.
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There is a special group called System, which includes all administered PCs. The System
Administrator can define any number of other groups, and organize PCs by making them
members of one or more groups.

SuperVision components
This section covers the components of SuperVision.

SuperVision for UNIX
The UNIX software supplied with SuperVision must be installed on one server in the System
Administrator�s domain. This server becomes the �administration host� for all managed PCs in
the domain. PCs will be notified automatically of their administration host.

There may be more than one administration host on a subnetwork if necessary, for example if
different departments within a company have their own System Administrators for groups of
UNIX servers and PCs.

Administration database
The administration host holds the administration database, which contains the files and objects
to be downloaded to the PCs. There are three sections to the administration database: System,
Groups and PCs. The System Administrator must create a PC folder for each PC that is to be
administered by this administration host. All these PCs appear in the System folder. Group
folders can be created, and PCs added to them, to organize users into logical groups with similar
needs.

Files and objects for distribution can be placed in individual PC folders, or at the Group or
System level.

Administration Workbench Server
The Administration Workbench Server runs on the administration host and is responsible for
carrying out all operations on the administration database. This UNIX program is called
workbsrv and it is started by the Local Name Agent following a request from a client program on
a PC, and then continues to run until the Administration Workbench is closed. The server and
client communicate using the Remote Procedure Call Service provided by Vision
Communications.

Index
The administration database is indexed, and the index includes a version number for each file or
object. Whenever any changes are made to the database, the index should be rebuilt. The System
Administrator can do this using the Administration Workbench, or using the UNIX command
admindex.
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Updating PCs
Whenever the index is rebuilt, changes to the administration database are made available for
updating PCs. An administered PC will be updated at boot time, and can also request an update
at any time. The System Administrator can force an update at any time using Administration
Workbench, or the UNIX command admupdate.

SuperVision for Windows
The Vision97 Setup program provides two product options for installing SuperVision:

• SuperVision Agent  Install on any PC that is to be administered remotely, to provide the
Administration Agent, and accessories such as the Host Explorer, Printing, Message Pad and
User Viewer. You do not need to install SuperVision if another Vision97 product is already
installed, because they include the Administration Agent.

• SuperVision Administrator  Install only on the System Administrator�s PC, to provide the
Administration Workbench.

Administration Workbench
The Administration Workbench (Workbnch.exe) runs under Microsoft Windows on a PC, and
allows the System Administrator to configure the administration database on the UNIX host.
Administration Workbench offers a graphical view of the database that is similar to Windows
Explorer. Using this tool the System Administrator can create PC folders and organize them in
Groups, and specify the files and other objects that are to be distributed to them. The illustration
below shows Administration Workbench as it appears when started for the first time. A
connection has been made to the administration host, with its name in the title bar. The window
is split into two panes: the Folders Pane on the left and the Files Pane on the right.



Chapter 18 � Administration Concepts 429

For more information click Help Topics on the Help menu. The same information can be seen
by choosing How To Use Administration Workbench from the main Vision Help Contents. For
an overview, see the �Managing the Administration Database� chapter.

Administered PCs
The Administration Agent must be installed on any PC that is to be administered by SuperVision.
The agent includes three programs that make the PC ready for remote administration. The
Administration Server (Adminsrv.exe) is started by the LNA when admupdate runs on the
administration host to begin an update operation. Administration Update (Admupdat.exe) is a
program which initiates an update of the database for the PC it is run on, by looking in the
Registry for the name of the administration host, and then starting admupdate on the
administration host. The Workbench Server (Workbsrv.exe) allows the System Administrator to
browse PCs directly from the Administration Workbench.

For a PC to be administered by SuperVision, a PC folder needs to be created for it in the
administration database. This is done by the System Administrator using Administration
Workbench.

The Name Space Manager (NSM) maintains an internal list of all administered PCs on the
subnetwork, and notes the administration host responsible for each PC. The program pclist is
run when the Local Name Agent starts on the administration host in order to initially populate
the NSM�s list of administered PCs. Subsequent changes to the administered PCs are notified to
the NSM by the UNIX Workbench Server.

The first time Host Finder runs on an administered PC, it will find out the name of the
administration host and enter it into the Windows Registry.

When an update is run for the first time on the administered PC to download files and objects,
the user will be prompted to enter a username and password for the administration host.

Preventing SuperVision from accessing a PC
A PC user can prevent SuperVision from administering it by disabling the Allow this PC to be
Administered by SuperVision option in the Admin tab of the Vision Services dialog box. The
dialog box can be displayed by choosing Vision Services from the Windows Control Panel. This
would prevent downloading of any items, and would prevent the System Administrator directly
accessing the PC.
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Note  Some PC users who deal with confidential information should consider using this option
to prevent access to their PC by any other person. If SuperVision access is allowed, then the
Administration Workbench can access the PC without the user being aware.

Distributing files
SuperVision allows files to be distributed from a UNIX server to PCs, including those on a
network and those connected through a modem link. This facility is intended for distributing
configuration files for other Vision97 software products. For example:

• Vision Communications Architecture configuration files, such as hosts, transports and scripts.
• Browser classes (file types in Host Explorer and Host Manager).
• Keyboard configuration files (keymaps).
• Fonts.
• Program Starter documents to run X Window System clients.
• Terminal emulator documents configured for specific UNIX applications.

Many System Administrators will find the mechanism useful for distributing files associated with
other Microsoft Windows applications. For full details, see the �Managing the Administration
Database� chapter.
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Managing desktops
SuperVision allows the System Administrator to manipulate or control what appears on the
Windows desktop for an administered PC. For Windows 95 or NT 4.0, this means that items can
be added or removed from the Programs folder, affecting what appears on the Start menu. For
older versions of Windows, program items can be added or removed from Program Manager
groups.

For further details, see the �Managing the Administration Database� chapter.

Remote configuration
SuperVision can be used to remotely configure other Vision97 programs. For example: changing
the default font for a terminal emulator; changing the default keymap; changing the location of
resources, such as Help files.

The System Administrator can restrict the actions of PC users for a variety of Vision97 programs.
For example, a user may be restricted from changing the configuration of the program, or may
be allowed to view documents but not change them. 

For further details, see the �Managing the Administration Database� chapter.

Performing tasks on PCs using scripts
Tool Command Language (Tcl) is a scripting language designed to be used by applications as a
common command language. It consists of a library of C routines that can be added to an
application, and is easily extensible either by adding new C routines or by writing new
procedures in the Tcl language.

SuperVision provides an interpretive shell called admsh that allows you to type Tcl commands
interactively, or run script files. Several new C routines have been added to the Tcl interpreter to
enable a script executing on a UNIX system to manipulate a PC that is connected via the Vision
Communications Architecture. Using Tcl commands you can:

• Execute a program on a PC, and monitor the result.
• Display a message box to obtain user input to the Tcl script.
• Mount and unmount network drives, and get information about drives.
• Get folder and file information from a PC.
• Modify the Windows Registry or initialization (*.ini) files.
• Get information about administered PCs, and manipulate the administration database.
• Copy files between PCs and UNIX servers.
• Reboot a PC.

For full details, see the �Using Tcl Scripts� chapter.
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Controlling and monitoring PCs
remotely
SuperVision includes tools that assist the System Administrator in his task of supporting large
groups of PCs. The Administration Workbench can connect directly to an administered PC and
manipulate folders and files. The System Administrator could upload a file from a PC for
inspection and then replace the file. The Administration Workbench can also monitor what
programs a PC is running, and take a screen shot of a PC�s display, so you can see a pictorial
representation of the active tasks.

The User Viewer utility supplied with other Vision97 products can then be used to send
messages that include text, sound or video instructions to a user. For full details, see the
�Controlling and Monitoring PCs Remotely� chapter.

Other administration facilities
Vision97 products for the PC all include the Administration Agent, and have some additional
facilities of use to the System Administrator.

License Management
Built into Vision Communications Architecture, which comes with most Vision97 products, is
the License Management facility. This allows the System Administrator to monitor usage of
Vision97 products, and optionally to restrict their use to ensure that the licensed number of users
is not exceeded.

User Viewer
The User Viewer provides the System Administrator with a graphical representation of all PCs
running Vision97 software.
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Users are shown as icons organized by groups in a hierarchical tree. The System group includes
all users on the subnetwork. When you install SuperVision and create groups of users in the
administration database, these groups also appear in User Viewer. Note that a user that appears
in a SuperVision group is also shown in the System group.

Messaging
The advanced message handling facilities provided by User Viewer and Message Pad will be
useful to the System Administrator. Messages can be sent to an individual PC user, to a group of
users, or to all users. In addition to text messages, the System Administrator or Technical
Support person could send spoken instructions or a video clip to explain a procedure to a PC
user.
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This chapter describes how to organize PCs into groups, and describes
the various items that can be created in the administration database.
It discusses how to create and delete these items, including the use of
aliases, and shows how to update PCs.
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Administration database overview
The administration database resides on the UNIX administration host, and is maintained by the
Administration Workbench which runs on the System Administrator�s PC. The database is
structured in three sections: System, Groups and PCs. These appear as folders which can contain
files or other objects that can be downloaded to the relevant PCs. They also provide access to the
PCs for other administration functions.

Obtaining Administrator privilege
To use the Administration Workbench, you require Administrator privilege within the Vision
Communications Architecture authentication scheme.

To obtain Administrator privilege

1 Log in as root on the administration host.
2 Change to the directory indicated by the VISION_ETCDIR variable, which is normally

/usr/local/vision/etc.
3 Use a text editor to edit the authentication database visionpriv and add an entry for your

username with the format user:username:1.
4 Force the Authentication Server to read the information from the authentication database

again by entering the command authsrv -r. You need Superuser privilege to run this
command.

Database items
The items that may be stored in the administration database are:

System folder Contains items to be distributed to all PCs with entries in the
database.

Group folder Contains items to be distributed to all PCs in the group. Properties
of the folder are the membership list which shows the PCs which
belong to the group, and a list of available restrictions, that could
be downloaded to the PCs in the group.

PC folder Contains items to be distributed to a PC. Properties of the folder
are the membership list which shows the groups to which the PC
belongs, a list of available restrictions, a task list of programs
currently running on the PC, and a screen shot of the PC�s display.

Drive Represents a disk drive or network drive on a PC.
Folder Represents a folder on a PC.
File Any kind of file.
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Alias Represents a folder path.
Program Manager item Contains details of a Program Manager or Start menu item.
Registry file Contains Registry entries.
Task A Tcl script that runs on UNIX and performs some actions on a PC.
Restrictions Actions that inhibit users.

Creating Groups and PCs
The administration database is structured in three sections:

System Items common to all PCs in the database.
Groups Items common to all PCs in a computer group.
PCs Items specific to an individual PC.

The Groups and PC folders contain subfolders that represent specific groups of computers or
individual PCs on the network. Each group or PC folder contains four subfolders: Files; Objects;
Tasks; and Browse.

To create a PC item

1 In the Folders Pane of Administration Workbench, click PCs.
2 On the File menu, point to New and then click PC.

3 In the Files Pane, type the network node name of a PC on the network, and then press
ENTER.
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To create a group

1 In the Folders Pane of Administration Workbench, click Group.
2 On the File menu, point to New and then click Group.

3 In the Files Pane, type a name for the new group, and press ENTER.
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Group ordering
A computer group may be set up to contain several PCs, and a PC may belong to more than one
group. For example, the sales group may contain the PCs andy, jim and sarah, and andy may
also belong to the manager group.

If the PC andy belongs to two or more groups, then one of the groups will be known as the
�primary group.� andy will continue to get files and objects from both groups, but will only get
program restrictions from his primary group. For more information on restrictions, see
�Restrictions� later in this chapter.

In addition, andy will get files from aliases in all groups, except where the same alias exists in
different groups with different paths. In this case, it is the path in the primary group that will be
created on the PC. The alias path in other group(s) is ignored. Files contained in there resolve to
the path from the primary group.  For more information on aliases, see �Aliases Overview� later
in this chapter.

In the illustration below, the PC andy belongs to both manager and sales groups, with manager
being the primary group by virtue of it being at the top of the list. The primary group can be
altered using the arrow keys. andy does not belong to groups WinNT and Win95.
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Active and inactive PCs
When a PC is created in the database it will either be �active� or �inactive.� To be active, Vision
Services must be running on the PC, with the Local Name Agent (LNA) enabled. This PC will be
represented in Administration Workbench by a highlighted icon. An active PC can be
administered using the full range of SuperVision functions.

If a PC is represented by a grayed out icon, then this PC does not have Vision Services running
or LNA enabled, and so is inactive. This prevents you from browsing the PC, retrieving task lists
and screen shots. For further information, see the �Controlling and Monitoring PCs Remotely�
chapter.

For more information on LNA, see �Local Name Agent� in the �Vision Communications
Architecture� chapter.

In the illustration below geoffs and andy are active, but qatest is inactive:



Chapter 19 � Managing the Administration Database 441

Creating a hierarchy of drives and
folders
Each PC or Group folder and the System folder contains a Files folder. You must create in the
Files folder the same structure of drives and folders that you want the administered PCs to have.
In the Files folder, you can create either drives, or aliases specifying a drive and folder path.
Then you can create folder items below the drive or alias items in the tree structure.

To create a drive

1 In the Folders Pane of Administration Workbench, double-click the system, group or PC item
in which you want to create the drive.

2 Click Files.
3 On the File menu, point to New, and then click Drive.
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4 Press ENTER to accept the default C drive. To change it, type another drive letter in the space
provided and press ENTER. Do not type a colon after the drive letter, since this will be added
automatically.

To create an alias, see �User-defined Alias� later in this chapter.

To create a folder

1 In Administration Workbench, click the drive or alias in the Folder Pane where you want to
place the file.

2 Click the File menu, point to New, and then click Folder.
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3 Type a name for the new folder, and then press ENTER. The folder name can be one that
already exists on the PCs or a new one, which SuperVision will create.

Double-click the folder you have just created. The new structure will now appear in the
Folders Pane.

Aliases
An alias can be used to represent a folder path when specifying the location of files in the
administration database. Aliases are graphically represented in the Administration Workbench
when viewing the database. They can also be used in any text files and can be either
automatically resolved when the files are downloaded to a PC, or manually resolved when a file
is dragged using the right mouse button in Administration Workbench.

There are two types of alias: a well-known alias refers to a pre-set common folder such as the
Windows folder, and a user-defined alias refers to any folder specified by the System
Administrator.

Well-known alias
A Well-known alias is an automatically available alias that defines the location of a common
folder, which may not be the same on each PC. SuperVision will automatically determine the
correct folder on each PC. Well-known aliases are listed below.
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Alias Folder

WINDOWS Main Windows folder, for example C:\Windows.
SYSTEM Windows System folder, for example C:\Windows\System.
DirectionApp Main Vision97 applications folder, for example C:\Program

Files\Vision.
DirectionAppExt Folder containing the Vision97 applications shell extensions, for

example C:\Program Files\Vision\System.
DirectionAuth Folder containing user authorization files, for example C:\Program

Files\Common Files\System\Vision\Auth.
DirectionBrowserClasses Folder containing remote file type files, for example C:\Program

Files\Vision\System\Browser\Classes.
DirectionConfig Vision Communications configuration folder, for example

C:\Program Files\Common Files\System\Vision\Config.
DirectionHosts Folder containing host configuration definitions, for example

C:\Program Files\Common Files\System\Vision\Hosts.
DirectionScripts Folder containing Vision Communications scripts, for example

C:\Program Files\Common Files\System\Vision\Scripts.
DirectionShared Shared Vision components folder, for example C:\Program

Files\Common Files\System\Vision.
DirectionTransports Vision Communications configuration folder, for example

C:\Program Files\Common Files\System\Vision\Config.
DirectionIcons Folder containing Vision Communications Dynamic Link Libraries

containing icons , for example C:\Program Files\Common
Files\System\Vision\Icons.

Desktop Windows desktop folder, containing items for the Windows 95
desktop, for example C:\Windows\Desktop.

Favorites Folder for favorite files and documents, for example
C:\Windows\Favorites.

Fonts Windows folder containing all Windows fonts on the PC, for
example C:\Windows\Fonts.

Nethood Windows folder containing items that appear in Windows Network
Neighborhood, for example C:\Windows\Nethood.

Personal Personal folder, for example C:\Windows\My Documents.
Programs Windows folder containing programs that appear on the Start

menu, for example C:\Windows\Start Menu\Programs.
Recent Windows folder, containing links to recently opened documents,

for example C:\Windows\Recent.
SendTo Windows folder containing shortcuts to locations to place on the

Send To command, for example C:\Windows\Send To.
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Alias Folder

Start Menu Windows folder for Start menu programs, for example
C:\Windows\Start Menu.

Startup Windows folder containing to run on system startup, for example
C:\Windows\Start Menu\Programs\StartUp.

TEMP Temporary folder, for example C:\Tmp.
Templates Windows folder containing document templates for creating

documents on the Windows desktop, for example
C:\Windows\ShellNew.

In addition to these, any aliases from other Vision97 applications already installed will appear in
the list.

User-defined alias
You can use Administration Workbench to create a User-defined alias for any folder path. The
alias is available to the entire system.

To create a User-defined alias

1 In Administration Workbench, click the Session menu, and then click Alias List.
A list of all the SuperVision aliases is displayed.

2 Click New.
3 Type a name and the folder path associated with the alias in the spaces provided and click

OK.
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The Available Alias List dialog box also allows you to change paths and delete User-defined
aliases.

To place files in the alias folder, an alias item needs to be created in the database.

To create an alias item

1 In the Folders Pane of Administration Workbench, double-click the PC, Group or System,
where you want to create the alias.

2 Click Files.
3 On the File menu, point to New, and then click Alias.

4 Click an alias from the Alias drop-down box. This contains all Well-known aliases and any
User-defined aliases that you have created.

5 You can alter the path of a User-defined alias in the space provided. If you make an error,
then click Reset, to return the alias to its original path. Well-known aliases cannot be altered.

The new alias appears in the Files Pane at the current location. You can create folders and drag
files to the alias in the same way as a regular drive.

The alias is local to the place in which it is created, which may be the system, a group, or an
individual PC. For example, an alias ACCOUNTS associated with C:\Winacc\Progs created in
the sales group would be used for all PCs in the sales group. Files specified within that alias
folder will be distributed to all PCs in the group. To specify additional files for a particular PC
within the group for the same alias, you need to create the same alias item at the PC level, and
drag the required files to there.
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Alias folder paths are not fixed, and can be overridden by groups or PCs lower in the database
hierarchy. To override an alias, create the alias at the PC level following the steps above, and
then enter a new path.

Alias paths at PC or group levels will be �inherited� from group or system levels. For example,
andy belongs to the groups manager and sales. The alias ACCOUNTS has been added to the
Available Alias List and resolves to the path C:\Winacc\Progs. Alias items for ACCOUNTS have
been created for both the manager and sales groups, but for the sales group the path has been
changed to C:\Acc\Progs. If the alias ACCOUNTS is then created for andy at the PC level, the
path will be inherited from the sales group and will resolve to C:\Acc\Progs. The PC level path
will be taken from the first group that the PC belongs to that contains a different alias path from
the Available Alias List.

If an alias path is changed at system, group or PC level, the original path can be inherited back
from where it exists in the next level up in the database hierarchy. This includes the Available
Alias List. A PC can inherit a path back from its group or system, and a group can inherit back
from system. For example, if the path for the alias ACCOUNTS was changed for andy, it could
be inherited back from the group sales. The sales group ACCOUNTS alias path can also be
inherited back from the Available Alias List and would resolve again to C:\Winacc\Progs. The
alias path at PC level andy would automatically change to C:\Winacc\Progs.

To inherit an alias path

1 In the Folders Pane of Administration Workbench, double-click the alias.
2 On the File menu, click Properties.

3 Click Inherit.

If you subsequently change the path again, you will be able to inherit it back from the level above
again.
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Alias substitution
When a file is dragged from a PC into Administration Workbench, you have the option to Copy
With Substitution. If selected, any paths corresponding to SuperVision aliases contained within
the file will be contracted down to the relevant alias.

For example, if your file contained the following line:

main.hlp=C:\windows\main.hlp

Copy with Substitution contracts the path down to the well-known SuperVision alias
WINDOWS, leaving the line looking like this:

main.hlp=%WINDOWS%\main.hlp

To copy with substitution

1 In My Computer or Windows Explorer, or File Manager on older versions of Windows NT,
click the file you want to drag to Administration Workbench.

2 Drag the file to the desired location in Administration Workbench, using the right mouse
button (or holding down the SHIFT key on older versions of Windows NT). On releasing the
mouse button, a shortcut menu appears.

Click Copy with Substitution.

The file is then copied into the database and the paths contracted into aliases.

Administration Workbench allows you to decide whether you want to expand the SuperVision
alias back to the pathname when the file is downloaded down to the PCs. This facility allows you
to store text files in system or in group items, and be sure that paths will be resolved correctly
when the file is downloaded to PCs in the system or within the group.
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To resolve aliases back to pathnames during an update

1 Click the file containing the aliases.
2 On the File menu, click Properties.
3 Make sure Expand Aliases is checked. If the file was copied with substitution, then Expand

Aliases is automatically checked. If the file contained an alias instead of the path and copied
normally, then it will not be checked.

If you wanted to place an alias into a file manually, then substitute the alias for all or part of the
folder path, and precede it and follow it with percent symbols (%):

main.hlp=%WINWORD%\main.hlp

If WINWORD has been defined in the Administration Workbench as the alias for the path
C:\Winword, the line would be resolved to:

main.hlp=C:\winword\main.hlp

Specifying files to be downloaded
When you have created the drive and directory structure you want, you can specify files to be
downloaded to the administered PCs.

To specify files to be downloaded

1 Open My Computer or File Manager, and select the file(s) you want from your hard drive or
from a network drive.

2 Drag them to the Administration Workbench and drop them into the Files Pane. The
illustration below shows the file My File.txt in the folder C:\Temp on PC geoffs.
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3 When you have copied all the files you want, build the index by clicking Build Index on the
Session menu. Click OK in the Index confirmation dialog box.

The changes are now marked in the index, and the correct files will be downloaded to the PCs at
the next update. When PC geoffs restarts, My File.txt will be loaded in his C:\Temp folder.

Specifying database objects
As well as distributing files and folders to PCs, the System Administrator can also distribute
�objects.� Objects are saved as files in the database, but, unlike files and folders, are not copied
to PCs during an update.

Instead, the Administration Server on the PC interprets the object and then carries out an
associated action, which will make the object accessible to users without having to install the
files. Objects can be created for the whole system, or just apply to particular groups or PCs.

You can create two types of objects in Administration Workbench:

• Program Manager items
• Registry files

Program Manager items
The Program Manager item lets the System Administrator create a program item that represents
an application or document, that will allow the user to start the application by choosing the icon.
The System Administrator sets properties for the item, including the command line for running
the application, a working folder, where any files that the application creates are stored, and an
icon that represents the application. The Program Manager item is saved with the extension
.PMI.

During an update, the Program Manager item will be created in the PC�s Programs folder, but
the .PMI file will be not be copied.
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To create a Program Manager Item

1 In the Folders Pane of Administration Workbench, double-click the PC, group or system,
where you want to create the Program Manager item.

2 Click Objects.
3 On the File menu, point to New, and then click Program Manager Item.
4 In the Files Pane, type a name for the new Program Manager item, and press ENTER.

5 In the Program Manager Item properties tab, enter a command to run the program in the
Command Line box. Enter a name for the Program Manager group or folder in the Group
box, and type in a name in the Description box.

6 In the Working Directory box, type the path of the folder where the program�s files and
documents are located. This information is optional. If you leave this box blank when
creating a program item, the folder where the program file is located is the working folder.

7 Click OK and build the index.

This item will appear in the Program Manager group or Start menu folder on the specified PCs,
at the next update.

Registry files
The System Administrator is able to drag a Registry file from his PC into an objects folder. This
file contains modified Registry entries which will be interpreted by the Administration Server
and entered into a PCs Registry at the next update.
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Specifying tasks
You can specify a task that should be performed during an update by a Tcl script that runs on the
UNIX administration host and performs actions on a PC. Refer to the �Using Tcl Scripts�
chapter for information about the scripts supplied with SuperVision, and about creating your
own scripts.

To create a task item

1 In the Folders Pane of Administration Workbench, double-click the PC, Group or System,
where you want to perform the task.

2 Click Tasks.
3 On the File menu, point to New, and then click Task.
4 In the Files Pane, type a name in the space provided, and press ENTER.

5 In the Task properties tab, click a script in the drop-down list box and type a description in
the space provided.
The drop-down list will contain some scripts that are not appropriate for performing tasks on
a PC. For example, who.tcl, which lists the PCs in the administration system. Ensure that you
choose a script that actually connects to a PC.

6 In the Execution Options section, specify whether the task is to run only at the first update,
or at every update.
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A script that is run from the UNIX command line that has to connect to a PC has to call the
adm_connect command. It may also have an argument to specify a PC name. A script that is run
from Administration Workbench will be passed a -p argument specifying a PC name. A sample
function to process the task command line called adm_processcmdline is provided in adm.tlib.

After the script has been run, the task will remain in the administration database. If the task was
to be run only once, and you want to run the script again, either recreate the item, or specify
Always in the Execution Options section to have it run every time the PC is updated.

To remove a task from the database, click the task, click the File menu, and click Remove.

Deleting database items
As well as distributing items to PCs, the System Administrator is able to delete items from PCs,
and also from the database on the administration host.

To delete an item from a PC

1 In Administration Workbench, click the item you want to delete.
2 On the File menu, click Delete.
3 Confirm that the item should be marked for deletion. The item will now be covered with a

red cross. In the illustration below, the folder Temp has been marked for deletion as has the
file contained within it.

4 Build the index. The folder and file will be removed from the PC geoffs at the next update.
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5 If you discover that you have marked some items for deletion that you did not intend to, you
can undo the deletion, providing you have not built the index. To undelete, click the item,
click the File menu, and then click Undelete. You cannot undelete a file in a deleted folder.

In addition to deleting items off PCs, you can also remove them from the database, without
necessarily deleting them from the PCs.

To delete an item from the database after it has been deleted from the
PCs

1 In Administration Workbench, click the item that is marked with a red cross for deletion.
2 On the File menu, click Delete.
3 Confirm that the item should be removed from the database.

To remove an item from the database only

1 In Administration Workbench, click the item you want to delete.
2 On the File menu, click Delete.
3 Confirm that the item should be marked for deletion. The item will now be covered with the

red cross.
4 On the File menu, click Delete again.
5 Confirm that the item should be removed from the database.
6 If you want to remove a PC or group, then click the one you want, click the File menu, and

click Remove.
7 Build the index.

The item will be immediately removed from the database, but will remain on the PCs. The
Delete and Undelete commands are recursive, i.e. items within a folder will be deleted if the
folder is deleted.

Restrictions
Restrictions are settings that determine whether a Vision97 program on the PC can perform all
its functions. There are two types of restrictions: Global and Application.

Global restrictions
Global restrictions apply to all Vision97 programs. There are eleven general restrictions, that fall
into two categories: Configuration, and Files and Data. Configuration restriction prevents all
alterations to any configuration, whilst Files and Data restrictions dictate whether changes of
configurations can be saved.

The following restrictions for programs using files and data are duplicated for both local and
remote file and data systems:
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Restriction Description

Modification The program may modify previously created files, for example, editing.
Creation The program may create new files. If this is not allowed, copy operations will

fail.
Deletion The program may delete old files. If this is not allowed, move operations will

fail.

Execution The program may execute another file.

In addition, there are the following restrictions for the Host Explorer and Host Manager
programs that directly manipulate hosts:

Restriction Description

Modification The program may modify an existing host.
Creation/Deletion The program may create or destroy hosts.

Application restrictions
Application restrictions are settings specific to that program. A program�s set of restrictions is
likely to be a combination of relevant global restrictions and application restrictions. A global
restriction is only relevant to a program if the program supports the function that the global
setting restricts. Global restrictions can be overridden by application restrictions.

If a program supports a global restriction, then it is listed as both a global and application
restriction. In the illustration below, the ANSI Emulator supports the global restriction
Configure. This is listed in the Global box and in the Application Settings box, next to the
application restrictions Printing and Send Mail:
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Setting Restrictions
Using Administration Workbench, the System Administrator can set global restrictions and
application restrictions for individual Vision97 programs. The system, groups of PCs, or
individual PCs can therefore get a set of restrictions preventing them from having access to all
the functionality of a particular application. For example, all users in the Sales group may be
prevented from configuring any terminal emulators.

Each PC will get a complete set of restrictions from whatever level they have been set at and each
level of restrictions are mutually exclusive. For example, if they have been set at system, then
everybody will get the same restrictions. If one group set different restrictions, then the PCs
within the group would receive the restrictions from the group and not from system. By the same
token, if restrictions have been set at the PC level, then each PC will have its own set, and will
not receive restrictions from the group or system level. This applies to both global and
application restrictions.

To set a combination of global and application restrictions at group level

1 Click the group you want.
2 Click the File menu, and the click Properties.
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3 To impose restrictions on all Vision97 programs, click the check boxes in the Global Settings
box. To remove a restriction, make sure the check box is clear. In the illustration below, only
the action Remote File Delete is restricted.

4 To set restrictions that apply to a specific program, click its name in the Applications drop-
down list box. If the settings for the program are a combination of global and application
restrictions, then you will be able to override the global settings.

5 In the Applications Settings box, click the check boxes for the actions you want to set. To
accept the setting from Global Settings, click the check box in the Applications Settings box
until it becomes a globe. In the illustration above, Configure is using the global setting, which
is not restricted. If an application restriction check box only alternates between checked and
unchecked, then there is no global restriction for that function.

6 Click OK and build the index.

The System Administrator also has the ability to return an item to the restrictions of the level
above. Using the Inherit button, a PC can abandon its own restrictions and return to those of its
primary group, and groups can do likewise and return to system restrictions.
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Running an update
An administered PC is updated automatically when Vision Services for Windows starts on the
PC, providing the Automatic Update option is enabled in the Admin tab of the Vision Services
dialog box. This effectively means that an update will occur when a PC is switched on and
Windows starts. The System Administrator can also force an update on a selected PC or group
from his PC.

Note  For an update to work, the target PC must recognize its administration host, and be
willing to be administered. If you have just added a PC, then it will not be informed of its
administration host until Host Finder runs again after the specified interval. You can force Host
Finder to run by stopping it and restarting it manually on the target PC. Display the Host Finder
tab in the Vision Services dialog box, clear the Enabled box and click Apply, then check the
Enabled box and click Apply.

To force an update from Administration Workbench

1 In Administration Workbench, click the PC or group you want to update. Note that you
cannot select multiple groups or PCs.

2 On the File menu, click Force Update.

A PC on the network can also request an update:

To request an update from a user�s PC

4 Click the Start menu, point to Programs, point to Vision, point to Accessories, and click
Admin Update.

After an update has been initiated from either location, the Administration Server starts on each
PC. It�s icon will appear in the notification area of the taskbar in Windows 95 or NT 4.0:

On older versions of Windows, the icon appears on the desktop.

Click the icon to maximize the Administration Server dialog box. This informs the user of the
update, and prompts for confirmation. Click Yes to continue or No to refuse the update.
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If you ignore the icon, it will time out after one minute and the update will go ahead.

Listing files to be updated
The System Administrator can display a list of the files that would be updated for a selected PC.
Remember to build the index first if you have recently added files. If you have just added the PC,
then you need to restart Host Finder to inform the PC of its administration host.

To list the files that would be updated

1 In Administration Workbench, click the PC you want to list updates for. Note that you
cannot select groups or multiple PCs.

2 On the File menu, click List Updates.

This opens a Remote Program Starter window and runs the UNIX command admupdate -l to list
all the files that would be updated for the selected PC.

UNIX directory structure
The top-level administration directory on the administration host is indicated by the
VISION_ADMINDIR variable, and is usually /usr/local/vision/admin. The variable is set up by
the /etc/vision.conf file which is the configuration file for Vision Services for UNIX.

The top-level directory contains the directories PCs, groups and system. The PCs directory
contains a directory for each administered PC, below which, a directory structure that mirrors
that on the PC, contains the actual files to be maintained. The groups directory contains a
directory for each computer group, below which is a directory and file tree that mirrors the PC.
Note that aliases may be substituted for directory paths, and that the file names are shortened
forms of the names on the PC.
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File names
Windows 95 and NT can use file names up to 256 characters in length, but some UNIX systems
have a maximum file name length of only 14 characters. When storing files on UNIX,
SuperVision therefore uses a short name of eight characters plus a three character extension, and
follows each file with a header containing the long file name.

When you use the Administration Workbench to view the database, you see the long names. The
admls program is provided to allow you to see both the short names and the long names from
the UNIX command line.



20Controlling and
Monitoring PCs
Remotely

This chapter shows how the System Administrator can view current
activity on an administered PC, and can directly manipulate folders
and files on a remote PC.
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Controlling and monitoring PCs
overview
In addition to using the administration database to carry out system management tasks, the
System Administrator can also connect directly to administered PCs, without using the
administration host. Using Administration Workbench, a direct connection can be made between
the System Administrator�s PC and any active PC, giving the System Administrator the ability to
browse the PC�s file system, retrieve lists of running programs, and view the PC�s screen.

This allows immediate access to a PCs configuration and file system, further enabling effective
remote support and system management.

Browsing PCs
Using Administration Workbench�s browse facility, the System Administrator can browse directly
through a PC�s file system, including network drives. Files and folders can be copied or moved
between the PC and the administration database, and between PC and PC. You can even copy or
move files and folders between two browsed PCs. In addition, folders can be created, files and
folders renamed or deleted, and file properties set.

Note  You cannot run programs or open documents directly on a browsed PC. These need to be
copied to your PC first.

When the System Administrator requests a browse, Administration Workbench calls the
Workbench Server on the PC. Administration Workbench and client PC communicate using the
Remote Procedure Call Service provided by the Vision Communications Architecture.

To browse PCs

1 In Administration Workbench, double-click PCs, and then double-click the PC you want.
2 Click Browse.

Administration Workbench displays all the drives on the PC in the Files Pane:
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3 Click a drive in the Folders Pane to display its folders and files in the Files Pane.

You can now browse through all the folders on the PC. To change drive, simply click another
drive in the Folders Pane. To close the connection to the PC, click the File menu, and then click
Disconnect.

For full instructions on performing operations on a browsed PC, click Help Topics on the Help
menu in Administration Workbench. The same information can be seen by choosing How To
Use Administration Workbench from the main Vision Help Contents.
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Viewing programs running on a PC
The System Administrator is able to view a list of programs currently running on any active PC
and then see a snap-shot of them as they appear on the PC�s screen.

When the System Administrator requests a task list or a screen shot, Administration Workbench
sends a call to the Administration Server on the PC, which retrieves all the necessary information
and sends it back. Administration Workbench and client PC communicate using the Remote
Procedure Call Service provided by the Vision Communications Architecture.

To retrieve a task list from an administered PC

1 In Administration Workbench, click the name of the PC you want.
2 On the File menu, click Properties.
3 Click the Task List tab.

A list of programs currently running on the PC is displayed.
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The System Administrator can then see these programs as the user sees them, by retrieving a
screen shot of the PC�s display. He can see the state of the program windows, and see any error
messages or dialog boxes.

To view a user�s screen

1 In Administration Workbench, click the name of the PC you want.
2 On the File menu, click Properties.
3 Click the Screen Shot tab.

A screen shot of the user�s display is shown. This can be reloaded at any time by clicking Refresh.
The size can also be increased, enabling you to see the content of any open windows more
clearly.

To increase the size of the picture

1 On the Screen Shot tab, click Full Size.
The picture then appears in a separate window



Vision97 Reference466

You can either resize the window by dragging the borders or use the scroll bars to view any
hidden areas.

2 To reload this picture, click the View menu, and then click Refresh.
3 To close the window, click the cross in the top right corner of the title bar (for Windows 95

or NT 4.0) or use the Control menu.
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This chapter describes how the Tool Command Language (TCL) can
be used with SuperVision.
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Tcl overview
The System Administrator is able to perform tasks on PCs using Tcl scripts. Tcl (Tool Command
Language) is a scripting language designed to be used by applications as a common command
language. It consists of a library of C routines that can be added to an application, and is easily
extensible either by adding new C routines or by writing new procedures in the Tcl language.

SuperVision provides a range of Tcl scripts which are described in the section �Tcl Scripts
Supplied with SuperVision� later in this chapter. The script files have filenames of the type
filename.tcl. A System Administrator can also write additional scripts, either based on one
provided or totally new. Script files are text files and can be written and edited in any UNIX-
based text editor, such as vi.

Tcl scripts can be run from the command line on the administration host, using an interpretive
shell called admsh provided by SuperVision, or as tasks from within the administration database,
via Administration Workbench.

UNIX components
SuperVision creates a directory called tcl on the administration host, in the location specified by
the VISION_TCLDIR variable in the vision.conf configuration file. tcl contains the Tcl
initialization script file, TclInit.tcl, and two package library files, adm.tlib and tcl.tlib, containing
packages of Tcl source code. adm.tlib provides SuperVision Tcl functions and commands, and
tcl.tlib provides some standard Tcl commands. Index files (*.indx) correspond to the package
libraries. These are automatically created by Tcl whenever they are out of date. The Tcl script
files buildidx.tcl and loadouster.tcl are part of the standard Tcl distribution for supporting
package libraries.

Further information on Tcl libraries is available in the Tcl online Help, in the subject �libraries.�
To access Help, see �Getting Information about Tcl� later in this chapter.

Within the tcl directory exists a subdirectory called admtasks which contains the script files
supplied with SuperVision.

The Tcl interpreter (admsh)
SuperVision provides an interpretive shell called admsh. This is based on the standard Tcl
interpreter and includes Extended Tcl, which provides additional UNIX commands and
functionality. In addition, admsh includes specific SuperVision Tcl commands provided by SCO,
which are compiled in the interpreter.

To invoke admsh

1 Log in to the administration host.



Chapter 21 � Using Tcl Scripts 469

2 At the system prompt, type the command:
admsh

admsh starts in interactive mode, allowing you to type Tcl commands or run Tcl scripts. It reads
commands from the keyboard and passes them to the interpreter for evaluation.

In order to run scripts from the UNIX command line, it is recommended that the tcl and
admtasks directories be placed in the System Administrator's path.

To run a script from the UNIX command line

4 Type the name of the script you want to run and add additional arguments if necessary, for
example:
% who.tcl -h

The script will output to the command line:
andy
billw  - (pluto)
markh  - (jupiter)
geoffs  - (jupiter)
chas  - (pluto)

Note  You can also run a script from the Tcl command line, by invoking admsh and then typing
the command name.

To execute a command interactively from the Tcl command line, simply type it at the admsh
prompt. You cannot run Tcl commands from the UNIX command line. For a full list of Tcl
commands provided by SuperVision, see �Tcl Commands� later in this chapter.

Note  If you use a SuperVision Tcl command that requires a Windows folder path as part of the
command, back slash characters should be doubled. For example, the network path
\\Jupiter\Writeany\Admin.bmp, specifying the location of a bitmap named Admin, which is
located in a shared folder named Writeany on a computer named Jupiter, would become
\\\\Jupiter\\Writeany\\Admin.bmp.

Getting information about Tcl
For detailed information on writing Tcl scripts, refer to Tcl and the Tk Toolkit by John K.
Ousterhout, in the Addison-Wesley Professional Computing Series, 1994.

Online Help supplied with Tcl is available with SuperVision.

To access Tcl Help

1 Log in to the administration host and invoke the admsh prompt.
2 At the prompt type the following command:

helpcd tcl
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3 To view a list of available subjects type the following command:
help

4 To change to a subject, type helpcd followed by the subject name. For example, to change to
the subject strings, type:
helpcd strings

5 Type help to list available Help pages for that subject. To read a page, type help followed by
the page name. For example, to read the Help entry for format, type:
help format

The Tcl help system is organized in the UNIX file system format. To navigate within the Tcl
Help system use the helpcd command to change directories instead of the UNIX command cd,
and the help command to view a listing of the current directory instead of the UNIX command
ls. For example, to return to the previous directory, you would type the following:

helpcd ..

For further information on the commands within the Help system, change to the tcl/help
directory and read the file help.

Using Tcl scripts for administration
tasks
Tcl scripts can be specified as tasks in the administration database, which will run when the
particular PC or group is updated. Refer to �Specifying Tasks� in the �Managing the
Administration Database� chapter for further information about creating tasks using the
Administration Workbench.

Tcl scripts supplied with SuperVision
The following Tcl scripts files are placed on the administration host in the directory specified by
the variable VISION_TCLSCRIPTDIR, in the vision.conf file. By default this is /usr/local/vision/
tcl/admtasks.

checkxv.tcl
pcinvent.tcl
who.tcl
wingroups.tcl

The syntax used when describing these scripts follows the Tcl conventions, instead of the normal
conventions used elsewhere in this documentation. For example, optional elements are preceded
and followed by a question mark (?).
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checkxv.tcl

Syntax
checkxv.tcl ?-f inventory_file? -p pcname ?-v?

Description
Checks whether XVision is installed on a PC running Windows 95, and, if it is, places an
Xterm object on the Windows desktop. If XVision is not installed then the script displays an
appropriate message box, and exits. If the PC is running another version of Windows the
script will fail. This script can be run as a task from Administration Workbench. If running
from the command line, the options are:
-f  inventory_file Specify a file that contains a list of files which determine whether

the product is installed. The default file is inventory.sv, which will
be used if no inventory file is specified.

-p  pcname Specify a PC to connect to.
-v Run the script in verbose mode. Errors will be printed to the screen,

and the name of the inventory file will be displayed.

Example
% checkxv.tcl -p geoffs -v
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pcinvent.tcl

Syntax
pcinvent.tcl ?-f inventory_file?-p pcname productname | -all

Description
Lists the Vision97 software installed on administered PCs including version numbers. You
must use the -p argument to specify a PC and only one PC can be specified at any one time.
This script should not be run as a task from Administration Workbench. The options are:
-f  inventory_file Specify a file that contains a list of files which determine whether

the products are installed. The default file is inventory.sv, which
will be used if no inventory file is specified.

productname  | -all Specify a particular product to search for. To search for them all,
specify the -all option.

Examples
To list the software on PC stevel:
admsh> pcinvent.tcl -p stevel
Using inventory file /usr/local/vision/tcl/admtasks/inventory.sv

SQL-Retriever not installed
XVision (Version 0.0.0) installed
PC-Connect not installed

To check whether SQL-Retriever is installed on PC geoffs:
admsh> pcinvent.tcl -p geoffs SQL-Retriever
Using inventory file /usr/local/vision/tcl/admtasks/inventory.sv

SQL-Retriever not installed
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who.tcl

Syntax
who.tcl ?-h?

Description
Lists all the active PCs in the administration system. A PC is termed active if its Local Name
Agent is running. This script should not be run as a task from Administration Workbench.
Add the argument -h to identify each PC's administration host.

Examples
To list all the PCs:
admsh> who.tcl
andy
billw
markh
geoffs
chas

To identify their administration hosts:
admsh> who.tcl -h
andy
billw  - (pluto)
markh  - (jupiter)
geoffs  - (jupiter)
chas  - (pluto)
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wingroups.tcl

Syntax
wingroups.tcl

Description
Creates Win31, WinNT and Win95 groups in the SuperVision administration database. All
active PCs will be added to the group corresponding to the version of Windows it is running.
It will create any active PCs that have not yet been created in the administration database. All
groups and PCs created will be visible in Administration Workbench. This script should not
be run as a task from Administration Workbench.

Example
admsh> wingroups.tcl

This script will create Win31, WinNT and Win95 groups
in the SuperVision administration database
(/home/poptart/geoffs/admin).

All active PCs will be added to one of these
groups depending on the version of Windows it is
running.

(Any PCs that don't exist will be created)

Do you want to proceed [y/n?]  y

Connecting to carl...done
   Checking Windows Version...done
   Adding carl to group Win95...done

Connecting to garethj...done
   Checking Windows Version...done
   Adding garethj to group Win95...done

Connecting to geoffs...done
   Checking Windows Version...done
   Adding geoffs to group Win31...done

Connecting to jamesw...done
   Checking Windows Version...done

   Adding jamesw to group WinNT...done
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Tcl commands
adm_checkprocess Check to see whether a Windows process is running.
adm_connect Connect to a PC.
adm_copy Copy a file.
adm_db Return information about files in the administration database.
adm_delete Delete files and folders from a PC.
adm_disconnect Close the connection to a PC.
adm_drives Map and unmap PC network drives.
adm_eventlog Creates an entry in the Vision log file vweventlog.
adm_execute Execute a program on a PC.
adm_fileinfo Return information about a PC file.
adm_getdirlist List a PC folder.
adm_getwinver Return a PC's Windows version number.
adm_group Add and remove SuperVision groups.
adm_ini Read or write a PC's .ini file entry value.
adm_messagebox Display a message box on a PC.
adm_pc Configure a PC in the administration system.
adm_reboot Reboot a PC.
adm_registry Read or write a PC's Registry entry value.
adm_task List or kill tasks running on a PC.
adm_vwgetenv Return an environment variable.

The syntax used when describing these commands follows the Tcl conventions, instead of the
normal conventions used elsewhere in this documentation. For example, optional elements are
preceded and followed by a question mark (?).
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adm_checkprocess

Syntax
adm_checkprocess pcname pid ?statusarg?

Description
adm_checkprocess checks the specified Windows process number (pid) to see whether a
Windows process is running on the specified PC. The command returns 0 if the process is no
longer there, 1 if it is still running, and -1 for any other failure, such as an RPC failure. The
optional status argument is a Tcl variable, which is used to pass the status back, i.e. the return
value of the Windows process.

See also
adm_execute, to run a program on a PC.

Example
adm_checkprocess geoffs "294598215" ver
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adm_connect

Syntax
adm_connect pcname

Description
adm_connect opens a connection to the specified PC and talks to the Administration Server.
If successful, this returns the PC name, if it fails, then it returns the error �Failed to connect
to pcname.�

Notes
You must use adm_connect before executing any other commands that interact with a PC.
You cannot use adm_connect twice in succession for the same PC, as the connection will still
be open.

See also
adm_disconnect, to disconnect from a PC.

Example
adm_connect geoffs
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adm_copy

Syntax
adm_copy ?-from pcname? sourceitem ?sourceitem...?

?-to pcname? destination ?-overwrite?

Description
adm_copy copies sourceitem to destination.
If -from pcname is specified it indicates that the sourceitem exists on the named PC. If the
-from option is omitted, then the file exists on the UNIX system on which the script is
running.
If -to pcname is specified it indicates that the destination is on the named PC. If the -to
option is omitted, then the destination is on the UNIX system.
If the -from and -to options are omitted, then sourceitem must exist on the UNIX system and
is copied to another location on the UNIX system.
The -from and -to options may specify the same PC to indicate that the PC file should be
copied locally.
The -overwrite option specifies that if the file already exists at destination, it should be
overwritten.

Notes
If the copy operation is successful, 1 is returned. 0 is returned if it failed.

See also
adm_getdirlist, to list a folder on a PC.

Examples
To copy a file called Myfile.txt from a UNIX directory to C:\Public on PC geoffs:
adm_copy "admin/PCs/geoffs/Files/c:/temp/Myfile.txt" -to geoffs "c:\\public"

To copy the same file from PC geoffs to C:\Public on PC testjb:
adm_copy -from geoffs "c:\\public\\MyFile.txt" -to testjb "c:\\public"
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adm_db

Syntax
adm_db -getver
adm_db -lfn filename
adm_db -attr filename
adm_db -lock|-unlock

Description
adm_db returns information about files in the administration database. This command
requires Administrator privilege (see �Obtaining Administrator Privilege� in the �Managing
the Administration Database� chapter. The options are:
-getver Return the administration database version number.
-lfn filename Return the long name of the specified file in the administration database.
-attr filename Return the specified file's administration attributes.
-lock|-unlock Locks or unlocks the administration database. This is an exclusive lock for

the duration of this process.

See also
adm_pc, to configure PCs in the administration database.
adm_group, to configure groups in the administration database.

Example
adm_db -lfn "Myfile.txt"
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adm_delete

Syntax
adm_delete pcname path|filename ?-recursive?

Description
adm_delete deletes files and folders from the PC. If you specify the -recursive option, then
deleting a folder will also delete all its contents. Trying to delete a folder that is not empty,
without specifying the -recursive option, will result in the command failing.

Notes
adm_delete will accept SuperVision aliases in place of folder paths.

See also
adm_getdirlist, to list a folder on a PC.

Example
adm_delete geoffs "c:\\public\\junk.txt

adm_delete geoffs "c:\\Winword -recursive
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adm_disconnect

Syntax
adm_disconnect pcname

Description
adm_disconnect closes the connection to the specified PC.

See also
adm_connect, to connect to a PC.

Example
adm_disconnect geoffs
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adm_drives

Syntax
adm_drives pcname -mount netpath ?-drv drive?

?-passwd passwd? ?-perm?
adm_drives pcname -unmount drive ?-force?
adm_drives pcname -list ?-network -local -all?
adm_drives pcname -space drive spacearg
adm_drives pcname -size drive sizearg

Description
adm_drives assigns drive letters to Windows network drives, or removes drive letter
assignments. It can also provide information about network drives. The options are:
-mount  netpath Assign a drive letter to a Windows network drive on the specified

PC. Use the -drv option to specify a particular drive letter and the
-passwd option to specify a password. -perm ensures that the
connection is permanent, so that the drive is always assigned when
the PC starts.

-unmount  drive Remove a drive letter assignment on the specified PC. The -force
option forces the removal even if the drive is in use.

-list List all the assigned drives on the specified PC. Use the -network
option to list the network drives and the -local option to list drives
local to the PC.

-space  drive spacearg Display the amount of free disk space in bytes on the specified
drive. You need to provide an argument to return the data.

-size  drive sizearg Display the size in bytes of the specified disk drive. You need to
provide an argument to return the data.

Notes
If a drive is assigned successfully, a drive letter is returned. If any of the operations fail, 0 is
returned.
adm_drives accepts the Uniform Naming Convention for network paths.

See also
adm_getdirlist, to list a folder on a PC.
adm_copy, to copy files.
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Examples
To map the drive \\Jupiter\Writeany to PC geoffs and assign it to drive letter w:
adm_drives geoffs -mount "\\\\jupiter\\writeany" -drv w:

To remove the above assignment:
adm_drives geoffs -unmount w: -force

To list all the mapped network drives on PC geoffs:
adm_drives geoffs -list -network

To return the amount of free disk space on PC geoffs in the argument spc:
adm_drives geoffs -space c: spc
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adm_eventlog

Syntax
adm_eventlog ?-tag label? message

Description
adm_eventlog creates an entry in the log file vweventlog. This is an ASCII text file that
records events of interest to the System Administrator. If the command is successful, 1 is
returned. The options are:
-tag  label Specify a label to give to the entry. This is usually the program

name. If you omit this option, a default label is used, which, if you
run the command interactively, is TclEvent.

message The text to put into the entry.

See also
vweventlog, Event log file.

Example
The following command:
adm_eventlog -tag TclScript "Writeable session established for geoffs"

creates the following entry in vweventlog:
Sep 12 14:03:09: [619] TclScript: Writeable session established for geoffs
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adm_execute

Syntax
adm_execute pcname ?-wait? ?-mini|-maxi|-hidden? command

Description
adm_execute executes a program on the specified PC. The options are:
-wait Force the command to wait until the program is terminated before

returning a value. adm_execute returns 1 for success, and 0 for
failure. If -wait is omitted the command will return a Windows
process identification number.

-mini|-maxi|-hidden Specify the state of the program window: minimized to an icon;
maximized to the full screen; hidden.

command The name of the executable, including the extension and path, if
necessary.

See also
adm_checkprocess, to check whether a Windows process is running on a PC.

Example
adm_execute geoffs -wait -mini "notepad"
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adm_fileinfo

Syntax
adm_fileinfo pcname -attr filename attributearg sizearg
adm_fileinfo pcname -exists filename ?versionarg?

Description
adm_fileinfo returns information about files located on the specified PC. The options are:
-attr  filename Return an attribute number and the size in bytes of the file. You

need to provide the two arguments attributearg and sizearg to
return the data, otherwise the command will fail. If the command
fails, 0 will be returned, if it is successful, 1 is returned.

-exists  filename Verify that the specified file exists on the PC. If it does, then 1 is
returned, if not, then 0. Will return the version number of the file if
you provide the optional versionarg argument.

Notes
You need to provide a full path for the filename.
The number returned in the attribute argument corresponds to a number or combination of
numbers in the table below:

Attribute Number

FILE_ATTRIBUTE_READONLY 0x00000001
FILE_ATTRIBUTE_HIDDEN 0x00000002
FILE_ATTRIBUTE_SYSTEM 0x00000004
FILE_ATTRIBUTE_DIRECTORY 0x00000010
FILE_ATTRIBUTE_ARCHIVE 0x00000020
FILE_ATTRIBUTE_NORMAL 0x00000080
FILE_ATTRIBUTE_TEMPORARY 0x00000100
FILE_ATTRIBUTE_COMPRESSED 0x00000800

See also
adm_getdirlist, to list a folder on a PC.
adm_copy, to copy files.
adm_db, to return information about files in the administration database.

Examples
adm_fileinfo geoffs -attr "c:\\public\\synd.doc att size"

adm_fileinfo geoffs -exists "c:\\public\\synd.doc" ver
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adm_getdirlist

Syntax
adm_getdirlist pcname dirname ?-full?

Description
Returns a folder listing for the specified folder on the PC in a Tcl list. Specifying the -full
option returns the following information to each file: d or f (directory or file); size in bytes;
day, month, year and time the file was last modified; filename. For example,
{f,145782,Thursday, June 01, 1995 02:19;02 PM,bride.bmp}

Notes
adm_getdirlist will accept SuperVision aliases in place of folder paths.

See also
adm_drives, to map and unmap PC network drives.
adm_fileinfo, to return information about files located on a PC.
adm_copy, to copy files.
adm_delete, to delete files and folders.

Examples
adm_getdirlist geoffs "c:\\Windows"

adm_getdirlist geoffs "WINDOWS"
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adm_getwinver

Syntax
adm_getwinver pcname vermajorarg verminorarg isntarg

Description
Returns the Windows version number for the specified PC. You need to attach three
arguments: vermajorarg to return the major part of the number, verminorarg to return the
minor part of the number; isntarg to ask whether the PC is running Windows NT. This
returns true (1) or false (0). The following values will be returned for the following Windows
versions:

Windows version Major Minor NT

Windows 95 4 0 0
Windows 3.1 3 1 0
Windows 3.11 3 11 0
Windows NT 3.51 3 51 1

See also
adm_reboot, to reboot a PC.

Example
adm_getwinver geoffs maj min nt
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adm_group

Syntax
adm_group -listall
adm_group -listmembers groupname
adm_group -add|-remove grpname

Description
adm_group allows configuration of SuperVision groups in the administration database. This
command requires Administrator privilege (see �Obtaining Administrator Privilege� in the
�Managing the Administration Database� chapter). The options are:
-listall List the currently configured groups in a Tcl list.
-listmembers  groupname

List the members of the specified group.
-add|-remove  grpname Add or remove a group.

See also
adm_db, to return information about files in the administration database.
adm_pc, to configure a PC in the administration database.

Examples
To list the members of the group manager:
adm_group -listmembers manager

To add the group marketing:
adm_group -add marketing
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adm_ini

Syntax
adm_ini pcname -set|-get -string|-int inifile section entry

value|valuearg

Description
adm_ini configures Windows initialization files (.ini) on the specified PC. The options are:
-set|-get Specify whether the data should be inserted into the initialization file or read

from it.
-string|-int Specify whether the data is a string or an integer.
inifile The name of the initialization file.
section The section of the initialization file.
entry The name of the entry.
value|valuearg The value of the entry to be set, or an argument to return the value from the

-get operation.
adm_ini will create the file, section, and entry if necessary.

See also
adm_registry, to read or write a PC's Registry entry value.

Examples
adm_ini geoffs -set -string "c:\windows\system.ini boot drivers mmsystem.dll"

adm_ini geoffs -get -string "c:\windows\system.ini boot drivers" d
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adm_messagebox

Syntax
adm_messagebox pcname ?-button button_type? ?-icon icon_type?

?-title title ? -msg message

Description
adm_messagebox displays a message box on the specified PC enabling user interaction with
the script. The options are:
-button  button_type Specify the type of button to include in the message box.

button_type can be any of the following: OK cancel; abortretry;
yesnocancel; yesno; retrycancel. These are mutually exclusive. If
you do not specify a button, OK will be used.

-icon  icon_type Specify the type of icon to include in the message box. icon_type
can be any of the following: hand; question; exclamation; asterisk.
These are mutually exclusive. If you do not specify an icon, no icon
will be displayed.

-title  title Specify a title to display in the message box title bar.
-msg  message Specify a message. If this is more than one word, then speech marks

must be used. This is not optional.
adm_messagebox will return the following values when the appropriate buttons are pressed:

Button Value

ID_OK 1
ID_CANCEL 2
ID_ABORT 3
ID_RETRY 4
ID_IGNORE 5
ID_YES 6
ID_NO 7

Notes
There is no timeout parameter for adm_messagebox. If a button is not pressed within 30
seconds, the client will fail, resulting the RPC error �Failed to display message box.�

See also
adm_reboot, to reboot a PC.

Example
adm_messagebox geoffs -button yesno -icon question -title "Error" -msg

"Do you want to continue?"
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adm_pc

Syntax
adm_pc pcname -getver
adm_pc -getadminhost pcname
adm_pc -listall|-listactive
adm_pc -add|-remove pcname ?-group grpname? grpname...?

Description
adm_pc returns information about PCs in the administration system, and adds and removes
PCs from the administration database and from SuperVision groups. This command requires
Administrator privilege (see �Obtaining Administrator Privilege� in the �Managing the
Administration Database� chapter). The options are:
pcname  -getver Return the PCs administration database version number. This

number is used to determine whether there are any files or objects
to be downloaded.

-getadminhost  pcname Return the name of the administration host for the specified PC.
This will be empty if the PC is not administered.

-listall|-listactive List all the PCs that have been created in the administration
database on the UNIX system on which the Tcl script is running,
and all the PCs in the administration system that are �active�, i.e.
running the Local Name Agent. These are Tcl lists.

-add|-remove  pcname Add or remove a PC entry to or from the administration database.
Use the -group option to add or remove any of the PCs listed by
-listall to or from a specified group.

See also
adm_db, to return information about files in the administration database.
adm_group, to configure groups in the administration database.
lna, the Local Name Agent.
�Active and Inactive PCs� in the �Managing the Administration Database� chapter.

Examples
To get the administration version number of PC geoffs:
adm_pc geoffs -getver

To get the name of the administration host for PC geoffs:
adm_pc -getadminhost geoffs

To add PC ron to the administration database:
adm_pc -add ron

To add PC ron to the manager group:
adm_pc -add ron -group manager
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adm_reboot

Syntax
adm_reboot pcname ?-wait?

Description
Reboots the specified PC. If you specify the -wait option, then the command does not return
until the PC comes back, enabling the script to continue afterwards. Note that this will not
happen until the PC user logs back on.

Notes
adm_reboot can only reboot into MS-DOS on a PC running Windows 3.1.

See also
adm_messagebox, to display a message box on a PC.
adm_getwinver, to get the Windows version number for a PC.

Examples
adm_reboot geoffs
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adm_registry

Syntax
adm_registry pcname -set|-get -string|-int regkey value|valuearg

Description
adm_registry configures Windows Registry entries on the specified PC. The options are:
-set|-get Specify whether the data should be inserted into the Registry key or read

from it.
-string|-int Specify whether the data is a string or an integer.
regkey The Registry key where the value is to be written to or read from, for

example,
HKEY_LOCAL_MACHINE\SOFTWARE\Vision\Admin\Admin\Host. The
Registry key must be encased in speech marks.

value|valuearg The value of the entry to be set, or an argument to return the value from the
-get operation.

adm_registry will create any part of the Registry key if necessary.

See also
adm_ini, to read or write a PC's Registry entry value.

Examples
adm_registry geoffs -get -string
"HKEY_LOCAL_MACHINE\SOFTWARE\Vision\Admin\Admin\Host" v

adm_registry geoffs -set -string
"HKEY_LOCAL_MACHINE\SOFTWARE\Vision\Admin\Admin\Host" pluto
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adm_task

Syntax
adm_task pcname -get
adm_task pcname -kill taskname ? taskname...?

Description
adm_task returns information about the tasks running on a PC, and can kill one or more
specified tasks. This command requires Administrator privilege (see �Obtaining Administrator
Privilege� in the �Managing the Administration Database� chapter). The options are:
pcname Return the PCs administration database version number. This

number is used to determine whether there are any files or objects
to be downloaded.

-get List all the tasks running on this PC.
-kill  taskname Kill the specified task.

Examples
To get a list of the tasks running on PC geoffs:
adm_task geoffs -get

To kill the task Notepad running on PC geoffs:
adm_task geoffs -kill notepad
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adm_vwgetenv

Syntax
adm_vwgetenv variable

Description
adm_vwgetenv returns the value of selected Vision97 configuration variables. The variables
that can be returned are:
VISION_BINDIR
VISION_ETCDIR
VISION_TCLDIR
VISION_TCLSCRIPTDIR
VISION_DEBUGDIR
VISION_EVENTDIR
VISION_TMPDIR
VISION_ADMINDIR

See also
vision.conf, Vision configuration file.
adm_db, to return information about files in the administration database.
adm_group, to configure groups in the administration database.
adm_pc, to configure a PC in the administration system.

Examples
adm_vwgetenv VISION_EVENTDIR
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Example Tcl scripts
In this section:

Example One - msgbox.tcl

Example Two - checkxv.tcl

Example One - msgbox.tcl
This script connects to a PC and displays a message box. The script closes after the user has
confirmed the message.

Note  If you want to copy this script from online Help, select it, click Options, and then click
Copy.

#main

if { $argc<2 } {
    puts "usage: $argv0 -p <pcname>"
    exit()
}

if [string match [lindex $argv 0] "-p"] {
    set PCName [lindex $argv 1]
}

adm_connect $PCName
adm_messagebox $PCName -button okcancel -title "Admin" -msg "Hello $PCName"
adm_disconnect $PCName

Example Two - checkxv.tcl
This script checks whether XVision is installed on the PC, and if it is, places an Xterm object on
the Windows desktop.

#!/usr/local/vision/bin/admsh
#
#   Script: checkxv.tcl
#
#  Args: -p <pcname>
#
#  Purpose: Script to check whether XVision is installed
#  and if it is, creates an xterm (rps) entry
#   on the Windows 95 desktop.
#
#  This Script currently only supports Windows
#  95.  It will fail gracefully if it is run to
#  any other versions of Windows.
#
#  Returns: Exit status 0 on success, 1 on failure.



Vision97 Reference498

#Proc Name: chkexe
#   Args: AdmPCName - PCName
#
#  Purpose:
#  To check existence of an XVision server.
#
#  Looks in xvision.ini to determine server
#  executable from XVisionExecutable setting.
#  If this ini setting doesn't exist assumes
#  older version of XVision and checks for
#  xvision.exe
#
#  Returns: -1 on failure
#            1 if XVision present
#            0 if XVision not present

proc chkexe {AdmPCName} {

    if [catch {set Ret [adm_ini $AdmPCName -get -string "WINDOWS\\xvision.ini" XVision
XVisionExecutable XVisionExe]} ErrStr] {

return -1
    } else {

if {$Ret<=0} {
    set XVisionExe "XVision\\xvision.exe"
}

    }

    if [catch {set Ret [adm_fileinfo $AdmPCName -exists $XVisionExe
"AdmTmpVer"]} ErrStr] {

return -1
    } else {

return $Ret
    }
}
#Proc Name: chkcommand
#     Args: AdmPCName - PCName
#
#  Purpose:
#  To check whether entry already exists on the
#  Windows 95 desktop.
#
#  Returns: -1 on failure
#  1 if desktop entry present
#  0 if desktop entry not present

proc chkcommand {AdmPCName AdmCommand} {

    if [catch {set Ret [adm_fileinfo $AdmPCName -exists "Desktop\\$AdmCommand"
"AdTmpVer"]} ErrStr] {

return -1
    } else {

return $Ret
    }
}
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#Proc Name: chklog
#     Args: ChkLogMessage - Event message
#
#  Purpose:
#  Output message to stdout or eventlog depending
#  on whether ChkIsVerb is TRUE/FALSE(1/0).
#  Windows 95 desktop.
#

proc chklog {ChkLogMessage} {
    global ChkTag
    global ChkIsVerb

    if {$ChkIsVerb==1} {
puts "$ChkLogMessage"

    } else {
adm_eventlog -tag $ChkTag $ChkLogMessage

    }
}

# main

    set ChkTag "checkxv.tcl"
    set AdmCommand "xterm.rps"

    if {$argc==0} {
puts "usage: \"$argv0 ?-f inventory_file? -p pcname\""
exit 1

    }

    if {$argc==2 } {
if [string match [lindex $argv 0] -f] {
    puts "usage: \"$argv0 ?-f inventory_file? -p pcname\""
    exit 1
}

    }

    # Check for different inventory file, defaults
    # to inventory.sv
    if {[adm_parsecmdline "-f" $argv AdmInvFile]<=0} {

if [catch {set AdmInvFile [adm_vwgetenv "VISION_TCLSCRIPTDIR"]} ErrStr] {
    puts $ErrStr
    exit 1
}
append AdmInvFile "/inventory.sv"

    }

    # Get PCName after -p arg.
    if {[adm_parsecmdline "-p" $argv AdmPCName]<=0} {

puts "usage: \"$argv0 ?-f inventory_file? -p pcname \""
exit 1

    }
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    # Are we running in 'verbose' mode?
    set ChkIsVerb [adm_parsecmdline "-v" $argv V]

    if {$ChkIsVerb==1} {
puts "Using inventory file $AdmInvFile\n"

    }

    set AdmProduct "XVision"

    # Open inventroy file
    set code [catch { set AdmFileId [open "$AdmInvFile" r] } ErrStr ]

    if {$code != 0} {
chklog $ErrStr
exit 1

    }

    # Initialize RPC connection to supplied PCName
    if {[catch {adm_connect $AdmPCName} ErrStr]!=0} {

chklog $ErrStr
exit 1

    }

    set ExitVal 0

    # Check windows version
    if {[catch {adm_getwinver $AdmPCName AdmWinMaj AdmWinMin IsNt} ErrStr]!=0} {

chklog $ErrStr
exit 1

    } else {
if {$AdmWinMaj<4} {
    chklog "This script only supports Windows 95"
}

    }

    # Check xvision.ini exists
    set AdmProdVer [adm_chkinventory $AdmPCName $AdmProduct $AdmFileId]

    if {$AdmProdVer==-1} {
chklog "Error: failed to check existence of \"$AdmProduct\" on PC:$AdmPCName"
set ExitVal 1

    } else {

# Find and check name of XVision executable
set Ret [chkexe $AdmPCName]

if {$Ret==0} {
    # XVision wasn't found
    adm_messagebox $AdmPCName -title "Admin" -msg "You don't have

$AdmProduct installed!"
    set ExitVal 1
} elseif {$Ret==-1} {
    chklog "Error: failed to check existence of \"$AdmProduct\" on

PC:$AdmPCName"
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    set ExitVal 2
}

    }

    if {$ExitVal==0} {

# Get task dir
set AdmTaskDir [ adm_vwgetenv "VISION_TCLSCRIPTDIR" ]
if {[string length $AdmTaskDir]==0} {
    set AdmTaskDir "/usr/local/vision/tcl/admtasks"
}

# Check to see if desktop entry already exists
set Ret [chkcommand $AdmPCName $AdmCommand]

if {$Ret==0} {
    # Create desktop entry
    if [catch {set Ret [adm_copy "$AdmTaskDir/$AdmCommand" -to $AdmPCName

"Desktop\\$AdmCommand"]} ErrStr] {
chklog "Error: failed to create xterm desktop entry on PC:$AdmPCName"
set ExitVal 3

    }
    if {$Ret==0} {

chklog "Error: failed to create xterm desktop entry on PC:$AdmPCName"
set ExitVal 3

    }
} else {
    set ExitVal 0
}

    }

    adm_disconnect $AdmPCName

    exit $ExitVal

#main end

Program Overview
The script's main procedure establishes a connection to the PC, checks whether Windows 95 and
XVision is installed, inserts the desktop entry if there is not one already there, and finally closes
the connection to the PC before exiting.

This uses three procedures that are defined at the beginning of the script. These are described in
the table below:
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Procedure Description

chkexe Checks whether the XVision server exists on the PC. It uses the
adm_ini command to look in the XVision initialization file to
determine the server executable from the XVisionExecutable
setting. If this setting doesn't exist, it assumes there is an older
version of XVision installed and uses the adm_fileinfo command to
check for the XVision executable.

chkcommand Checks whether an Xterm entry already exists on the Windows 95
desktop. This procedure also uses the adm_fileinfo command to
check whether a file called Xterm.rps exists in the
C:\Windows\Desktop folder. This is the remote file type for the
Xterm.

chklog Outputs messages to either the screen or to the Vision eventlog file.

Checking installed software
The script starts by parsing the command line to find the PC name and determining which file to
use as the inventory file. If this has not been specified, it will use the default file, inventory.sv.
The inventory file is used later by the function adm_chkinventory, which exists in the adm.tlib
package library, to determine whether XVision is installed.

After connecting to the PC using the adm_connect command, the script checks the Windows
version, by passing the adm_getwinver command. If this returns a value less than 4, the script
will exit, as this indicates that the Windows version is either 3.1, 3.11 or NT. If the value 4 is
returned, then Windows 95 is installed and the script can continue.

The next task is to determine whether XVision is installed. The script calls adm_chkinventory to
check if the XVision initialization file exists. The chkexe procedure then tries to find the correct
entry or the XVision executable. If XVision cannot be found, then adm_messagebox displays a
message box informing the user that XVision is not installed. The script will consequently exit.

Creating the desktop entry
The chkcommand procedure is called to determine whether a desktop entry for an Xterm
already exists. If there is no desktop entry, the script uses adm_copy to copy the file Xterm.rps
to the C:\Windows\Desktop folder. If the script is unable to create the entry, it will return an
error.

The script disconnects from the PC, using the adm_disconnect command, and exits.
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AGlossary

This appendix gives a glossary of terms used with the SCO Vision97
suite of products.
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administration database
The total collection of items (computer groups, PCs, drives, folders, files, aliases, Program
Manager objects, Registry files) that are administered by SuperVision.

administration host
The UNIX system used as the central server in a SuperVision administration system.

Administration Server
The Administration Server Adminsrv.exe runs on the PC and is responsible for allowing the PC
to be remotely administered by SuperVision. It is started by the Local Name Agent when items
are downloaded to the PC from the administration host, or when task list or screen shot requests
are made by Administration Workbench.

Administration Update
Administration Update contacts the administration host to request an update of any files or other
objects that have changed. This is a PC program called Admupdat.exe.

Administration Workbench
The Administration Workbench supplied with SuperVision allows the System Administrator to
manage all PCs running Vision97 software on a network from a central location. The
Administration Workbench, which runs under Windows on a PC, is used to maintain the
administration database on the central UNIX server, and gives a graphical view of it that is
similar to Windows Explorer.

Administration Workbench Server
The Administration Workbench Server supplied with SuperVision runs on the administration
host and is responsible for carrying out all operations on the administration database. This UNIX
program is called workbsrv and is started by the Local Name Agent following a request from a
client program on a PC. It continues to run until the process is terminated.

anonymous FTP
A method of downloading a file from a host on a TCP/IP network, without requiring a login on
the host. You log in as �anonymous� and supply your email address as the password.

ANSI
American National Standards Institute. A private body that establishes standards in the
computing industry.

ANSI Emulator
The ANSI Emulator allows you to run character-based applications on remote computers and
view them in windows on your PC. The emulator is based on the console device for SCO UNIX.
Applications designed for SCO UNIX may take advantage of your PC�s capabilities by using this
emulation.
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API
Application program interface. Allows a program to utilize software routines by making calls to
standard functions.

application
A computer program used for a particular kind of work, such as word processing. This term is
often used interchangeably with �program.�

ASCII code
American Standard Code for Information Interchange. A standard 8-bit code representing 256
characters. The first 128 of these characters have their meaning defined by the Standards
Institute; the remainder are available for definition and interpretation by individual computer
manufacturers and users.

atom
A unique numeric ID associated with a string name, and used in the X Window System to
identify a property, type or selection.

Authentication Server
The Authentication Server is a key component of the Vision Communications Architecture
security model. It is a program called authsrv that runs on every UNIX host that has License
Services installed. If authorization is necessary to use a service, a client must access the
Authentication Server to gain authority.

backing store
Memory allocated by an X Window System server to hold a copy of the contents of a client�s
window locally on the PC. The purpose is to speed up redrawing the screen if an obscured
window becomes visible. Instead of the server having to send a message to the client asking it to
redraw the newly revealed part of its window, the server can redraw the window from its local
copy.

BDF font
Bitmap Distribution Format.

broadcast
A Windows Sockets option, that allows transmission of broadcast messages on a socket.

Central Processing Unit
The Central Processing Unit (CPU) is the control unit of a computer; the device that interprets
and executes instructions. The CPU or microprocessor, in the case of a microcomputer, has the
ability to fetch, decode and execute instructions and to transfer information to and from the
computer�s main data-transfer path, the bus.
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character
Any letter, number, punctuation mark, or symbol which can be produced on the screen by
pressing a key.

character-terminal application
A UNIX application designed to use a character-based terminal such as VT420.

Clipboard
An area used by Microsoft Windows applications for the temporary storage of text or graphics.

COLA
Certificate of License Authority.

colormap
A set of colorcells, each of which defines an RGB value. A pixel value is used as an index into the
colormap to determine the intensity of the red, green and blue elements of the pixel. Most mid-
range PC displays allow for a single colormap to be installed. If the hardware allows the
colormap to be changed, then any number of �virtual colormaps� can be created and installed or
deinstalled as required.

ComScript
The Vision Communications scripting language used for creating script files to control some or
all of the process of connecting to a host, logging in, and executing a command.

Connection Manager
The Connection Manager runs on the PC when you use a multiplexing protocol such as the
Universal Transport Protocol (UTP) to connect to a proxy host. It manages the PC end of the
multiplexing link. The Connection Manager starts automatically when the first connection is
requested, and is terminated when the last connection using the multiplexed link is closed.

Connection Monitor
The Connection Monitor allows the connection process to be monitored and controlled.

Control-menu icon
The icon in the upper-left corner of a window that enables the user to display the Control menu.

cut-buffer
A property on the X Window System root window used for cut and paste operations. There are
eight cut buffers available, named by the predefined atoms CUT_BUFFER0 to CUT_BUFFER7. Text
may be placed in a cut-buffer by an application, from where it may be retrieved by the same or
another program at some later time.
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data source
An ODBC data source is a specific instance of a combination of a DBMS product and any remote
operating system and network necessary to access it.

Database Server
The Database Server provides access to the Vision Communications database. This is a PC
program called Dbserv.exe. You can specify whether the Database Server should be started at
launch time and run continuously in the background.

database window
The window that appears when you open a Microsoft Access database. It contains Table, Query,
Form, Report, Macro and Module buttons that you can click to display a list of all objects of that
type in the database.

DBMS
A Database Management System is software that controls access to data stored in a database.

DECnet
A proprietary communications network from Digital Equipment Corporation.

DECwindows
Digital Equipment Corporation�s implementation of the X Window System. DECwindows is
available for both VMS and ULTRIX systems.

default
An assumption made by a program when you do not provide a value.

desktop
The Windows desktop is the background of the computer screen which serves as the base for all
windows displayed by all Windows applications.

display mode
The X Server may be used in multiple-windows mode, which allows each X client to appear in
its own Microsoft window, managed by the built-in VWM window manager. Alternatively, in
single-window display mode the whole X world appears within one Microsoft window, and a
separate window manager is used to manage X clients.

docking bar
A possible location to which a toolbar can be docked.
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document
A file created by a program to hold information, for example a report created by a word
processing program. Or, a settings file that controls the behavior of a program such as a terminal
emulator during a session.

Domain Name System
Domain Name System (DNS) offers a hierarchical and static naming service for TCP/IP hosts. A
DNS server has network addresses for each computer on a network. A PC may call a name server
to get address information. A DNS server translates symbolic names into IP addresses.

drag
To point with the mouse, then hold down the mouse button while moving the mouse.

dynamic-link library
A dynamic-link library (DLL) is a file, usually with .DLL extension, that contains the binary code
for routines and data that are linked to a program at run time.

email
The use of electronic communications media to send textual messages such as letters, memos,
and reports.

File Access service
A USP service provided by Vision Communications Architecture that provides the ability to
browse and manipulate the file store on a remote host. It also allows files to be transferred
between hosts.

File Transfer Protocol
The standard Internet application-level protocol for transferring files from one computer to
another.

font
A set of letters, numbers, punctuation marks, and symbols that are a given size and design.

font path
Lists the directories containing X Window System font files. Each directory must contain a
Fonts.dir file which describes the fonts available in the directory.
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font server
A font server is a program running on a remote UNIX or VMS host which can make fonts stored
on that host available to an X server. This makes font administration much easier as it means that
fonts do not have to be installed on each PC on which the X server is used and you always have
access to fonts when using different PCs.

The fonts accessed through a font server may be grouped into named sets called catalogs. The
catalogs equate to the different directories in which the font files are located.

HINTS
The Helpful Interactive Support (HINTS) mechanism provides assistance when a client starts but
then terminates with an error, for example because it cannot find the correct font.

host
Any remote multi-user computer to which you have access, and which is available to run
applications.

Host Explorer
Host Explorer allows Windows 95 or NT 4.0 users to configure remote host computers, browse
through folders and files, and open programs and documents. Files or folders can be created or
deleted, moved or copied on the remote computer, or copied to the PC.

Host Finder
Host Finder detects UNIX hosts on the local network, and creates or modifies entries in the
Vision Communications database. You can specify the type of host to look for and whether it
should run at launch time.

Host Manager
Host Manager allows Windows NT 3.51 users to configure remote host computers, browse
through folders and files, and open programs and documents. Files or folders can be created or
deleted, moved or copied on the remote computer, or copied to the PC. Host Manager can be
used to connect to an Internet FTP server.

ICCCM
The Inter-Client Communications Conventions Manual published by the X Consortium, which
defines how clients and a window manager should interact.

Information Server
The Information Server runs on the PC and is responsible for viewing user properties from User
Viewer. This program, called Infosrv.exe, is started by LNA when user properties are requested.
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Internet
A major world-wide TCP/IP network connecting thousands of sites in six continents. Users
include government departments, educational institutions, the military, and commercial users.

IP address
Internet Protocol address. A unique, 32-bit identifier for a specific TCP/IP host on a network. An
IP address is conventionally written as four decimal numbers between 0 and 254, separated by
periods. For example: 150.126.27.92.

ISO
International Standards Organization. A United Nations agency which coordinates and publishes
standards governing performance.

IPX
The Novell internetwork packet exchange protocol.

keyboard map
A table which associates a key on the PC keyboard with a value.

keycode
The value generated by pressing a key on the PC keyboard.

keymap
A table which associates a key on the PC keyboard with a key on the keyboard of a terminal
being emulated, or with a keysym in the case of the X Window System.

Keymap Editor
The Keymap Editor allows you to create and modify keyboard configuration files (�keymaps�)
that are used by the terminal emulators.

keysym
A defined constant that corresponds to the meaning of a key event.

LAN
Local area network. The linkage of PCs and other computers within a limited area by high-
performance cables so that users can exchange information, share peripherals, and draw on the
resources of secondary storage units.

License Administrator
The person responsible for policing license agreements. The License Administrator is designated
when you install Vision97 software on your UNIX host.
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License Server
The License Server, a program called licsrv, is a component of the License Management
mechanism provided by Vision Communications Architecture. It runs on one of the UNIX hosts
on a subnetwork on which Vision97 License Services software has been installed.

linger
A Windows sockets option, that prevents a socket from closing if unsent data is present.

Local Name Agent
Every PC and UNIX system running Vision97 software has a Local Name Agent (LNA), which is
responsible for starting server programs. Its function is similar to a portmapper in a Sun ONC
RPC system. Some servers are started immediately after the LNA has been run, while other
servers are started in response to client requests.

local printing
Local printing is the ability to print from UNIX applications to a printer attached to your PC.

Log Server
The Log Server, a program called logsrv, provides debug and event logging facilities on UNIX. It
is started at the beginning of a Local Name Agent session, and then remains running.

LPD protocol
Line Printer Daemon protocol. The LPD protocol provides a standard TCP/IP service for remote
printing.

macro
A stored list of two or more application program commands that, when retrieved, replays the
commands to accomplish a task. Macros automate tedious, repetitive tasks which would
otherwise require the user to choose several options or use multiple keyboard commands.

macro language
An application-specific programming language used to write macros as an alternative to
recording them. The more sophisticated macro languages include a full set of program command
structures and allow the use of applications to be significantly automated and customized.

menu bar
The bar at the top of a window which shows the available menus.

Message Pad
The Message Pad program displays text messages sent to the user in a window that looks like a
sticky-paper note, or runs an appropriate viewer program for multimedia messages.
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modem
A device used to translate the digital signals used by computer equipment into analog signals
used in most telephone circuits, or vice versa. The word comes from the name �modulator/
demodulator.�

modifier key
A key which changes the behavior of another key. The modifier keys are the SHIFT, ALT and
CONTROL keys

multiplexed protocol
A protocol such as the Universal Transport Protocol (UTP) which allows multiple applications to
be run over a single serial line, or one network connection.

Name Space Environment
The Name Space Environment (NSE) provides a consistent, transport-independent mechanism
for accessing Vision resources. NSE uses the Uniform Naming Convention (UNC) format for
identifying resources. This allows a client to request a service on a particular host system, using a
string that is independent of any specific form of network addressing.

Name Space Manager
The Name Space Manager (NSM) provides a fault tolerant, replicated naming service. One or
more UNIX systems running Vision97 software are nominated as NSM hosts, on which NSM
processes are started automatically. NSM implements and manages the Name Space Environment
(NSE).

NCP
Network Control Program. A DECnet utility used to locate, manage, and configure network
nodes.

NDIS
Network Driver Interface Specification. A specification developed by Microsoft and 3Com to
provide a common programming interface for media access control drivers and transport drivers.

NetBEUI
NetBIOS Extended User Interface. This is the primary local area network transport protocol used
by Windows 95 and NT.

NetBIOS
Network Basic Input/Output System. It provides an interface between network applications
running on a PC and the underlying network protocol.
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Network Checkout
Network Checkout is a diagnostic program which runs a series of network tests on your TCP/IP
software to ensure that Vision software will run correctly on your system.

non-blocking mode
A Windows Sockets option, that allows a function to be returned even if the associated operation
is incomplete. This is essential otherwise Winsock calls such as recv() would block Windows until
data has been received and Windows would fail.

ODBC
Open Database Connectivity (ODBC) has been developed by Microsoft to provide a standard
method for accessing database management systems from Windows programs. It is a component
of the Microsoft Windows Open Services Architecture (WOSA).

ODBC driver
An ODBC driver is a software module that allows the Driver Manager to access a specific
database. A driver may be either a single-tier driver, or a multiple-tier driver. A single-tier driver
is responsible for processing ODBC calls and SQL statements, whereas a multiple-tier driver
processes ODBC statements and passes SQL statements to the data source.

OLE
Object Linking and Embedding. OLE is the primary technology for transferring and sharing
information between Windows applications.

OLE Automation
OLE Automation allows programmers to define a set of operations and make them accessible to
other applications. This enables the terminal emulators to be used as programmable objects
within another Windows application.

OPEN LOOK
The OPEN LOOK user interface is not a piece of software. Rather it is a specification for the
look and feel of a windowing environment for a multi-tasking computer system. The OPEN
LOOK UI has been implemented by a number of companies on a range of hardware and
operating systems, for example, OpenWindows from SunSoft, Inc. and the AT&T OPEN LOOK
Graphical User Interface.

OSF/Motif
OSF/Motif is an implementation of the X Window System. The OSF/Motif GUI was developed
by the Open Software Foundation and is available from a number of companies. Whilst the basic
features of OSF/Motif remain constant, different distributors may have implemented different
extensions providing additional features.
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panning
A feature which allows a window which is partially off the screen to be moved, in order to make
a different portion of the window visible. In the X Server, moving the mouse pointer to the edge
of the screen within the window causes the window to be repositioned.

pattern matching
A technology that allows browser programs, such as Host Explorer, to identify UNIX files by
matching path name patterns associated with a remote file type. As a result, you are not
restricted to recognizing files by extension, and you can set up as many patterns as you like for
one file type. For example, the Text Document file type is associated with the following patterns
when your Vision97 software is installed: *.c, *.cc, *.h, *.txt, docs/*, README*. Therefore, the
file README.TV would be recognized as a text document.

PCF font
Portable Compiled Format.

PostScript
A sophisticated page description language from Adobe Systems, Inc. for medium- to high-
resolution printing devices. Most Windows applications are capable of producing PostScript
output which can then be printed on any printer with a PostScript interpreter. This includes a
wide range of machines from a typical office laser printer up to expensive typesetting machines
such as those from Linotronic.

PPP
Point to Point Protocol. An industry standard for asynchronous communications that ensures
interoperability with third party remote access software. PPP is the successor to SLIP.

Print Server
The Print Server listens for print requests from remote UNIX systems, and prints on a local
Windows printer. It also acts as a client for sending print requests from a Windows application
to a remote UNIX system. You can specify whether the Print Server should be started at launch
time.

property
A property is a characteristic of an object used to define its state, appearance or value.

protocol
A protocol is a language computers use to communicate with other devices. Two computers must
use the same protocol to communicate with each other.
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proxy
A proxy is a helper process that runs on a UNIX system attached to the network, which acts as a
proxy for your PC on the network.

QWERTY keyboard
The standard typewriter keyboard layout also used for computer keyboards. A QWERTY
keyboard will have the characters QWERTY as the first six keys on the left-hand end of the row
immediately below the numeric keys.

Registry
The Windows Registry is a centralized repository of information needed to set up and configure
the computer.

remote command processor
A program that runs on a UNIX system that executes a command sent to it from a remote
computer, such as your PC.

Remote Execution service
A service provided by Vision Communications Architecture that provides the ability to execute a
command on a remote host system.

remote printing
Remote printing is the ability to print from a Windows application on your PC to a remote
UNIX printer.

Remote Procedure Call service
A USP service provided by Vision Communications Architecture that is based on Sun
Microsystems� public domain remote procedure call (RPC) mechanism. This enables a client
application to execute a function or a procedure on a server machine, which may be different
from that on which the client is running. Thus, RPCs can be used to run functions and
procedures across a network.

Remote Program Starter
Remote Program Starter allows you to execute a program on a remote system from your PC
without having to log in using a terminal emulator. You can save all the settings required to
execute a remote program in a Remote Program Starter (RPS) document.

reuseaddr
A Windows Sockets option, which allows a socket to be bound to an address which is already in
use.
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root window
Windows in X are arranged in a tree-like hierarchy, with the root window as the base. Windows
which are children of the root are known as top-level windows, and there is usually one top-level
window per client. A top-level window may have may child windows within it, some of which
may themselves have children, and so on. When the X Server is in single-window mode, the root
is visible within the main X Server window. In multiple-windows mode, the root is optionally
visible as the Microsoft Windows screen background.

RS232C
RS232C is the industry standard for the serial binary data interchange between a computer and
data communication equipment, typically a modem.

script
An interpreted program written in a scripting language. Two scripting languages commonly used
with the Vision97 terminal emulators are VBScript and JavaScript. Vision97 objects, functions
and event handlers can be used within scripts to add functionality to a terminal emulator.

scroll bar
A bar that appears at the right and/or bottom edge of a window whose contents aren�t
completely visible. Each scroll bar contains two scroll arrows and a scroll box, which allow you
to scroll within the window.

shortcut
A shortcut is an item on the Windows 95 or NT 4.0 desktop with an icon that represents a
UNIX folder, program or document. To open the folder or document, or start the program, just
double-click the icon.

slave printing
The facility, available in VT420 and Wyse 60 terminal emulators, to send output to a printer
instead of (or as well as) to the screen. The Windows printer driver is not used.

SLIP
Serial Line Internet Protocol. An industry standard for asynchronous communications that
ensures interoperability with third party remote access software.

Sockets service
A USP service provided by Vision Communications Architecture that provides a low-level
method for a client program to call procedures in a server program.

SPX
A Novell NetWare protocol which provides a connectionless packet delivery service.
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SQLGold
SQLGold is a Windows program that was written using Visual Basic. It provides a Windows
front-end to SQL databases that is independent of any specific DBMS.

SQL-Retriever
SQL-Retriever is a collection of software components that provide all the connectivity needed to
access SQL databases from Microsoft Windows applications.

status bar
The bar at the bottom of a window that displays messages. The left area of the status bar
describes actions of menu items or toolbar buttons as you select them. The right area of the
status bar indicates whether any of the Caps Lock (CAP), Num Lock (NUM) and Scroll Lock
(SCRL) keys are latched down. This area may also display application specific information.

SuperVision
Vision97 software that allows System Administrators to remotely manage, configure and control
large groups of Windows PCs.

System Administrator
The person or team responsible for administering all PCs and UNIX servers in an enterprise.

TAPI
The Microsoft Windows Telephony Application Programming Interface (TAPI) provides access
to a variety of telephone network services. It allows Windows applications to control voice and
data links, without including any service-specific programming code. In Windows 95 and
Windows NT, TAPI is the standard way of interfacing to modems and digital telephone services
such as ISDN.

Task service
A USP service provided by Vision Communications Architecture that provides the ability to log
in to a remote host system and run a program.

taskbar
The Windows 95 or NT 4.0 taskbar sits at the bottom of your screen and shows all running
applications, enabling you to switch between them. It also contains the Start button.

TCP
The Transmission Control Protocol is a key part of the TCP/IP protocol suite. TCP provides
connection-oriented, reliable, sequenced data transfer between local or remote hosts.
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TCP/IP
Transmission Control Protocol/Internet Protocol. TCP/IP is a suite of protocols used to connect
a world wide network of universities, research laboratories, organizations, corporations and
military establishments. TCP/IP includes standards for communicating between computers and
conventions for connecting networks and routing traffic.

terminal
An input/output device, consisting of a keyboard and video display, commonly used with multi-
user systems.

terminal emulator
A window on the PC screen which contains an emulation of a standard terminal.

Terminal service
A service provided by Vision Communications Architecture that provides the ability to log in to a
remote host system and execute commands. There are two methods by which the Terminal
service can be provided, the Task service, or a remote log in service provided as part of the
UNIX operating system or network software, for example rlogin.

TermVision
TermVision gives Windows PC users transparent access to UNIX character-based applications.
This powerful set of terminal emulators for Windows gives point and click simplicity for PC
users while being highly customizable and controllable for administrators.

PC users, whether in the office or on the road, can work with UNIX applications just as they do
with Windows - all network and connection details are handled by TermVision and kept hidden.

title bar
The bar at the top of a window that contains buttons providing quick mouse access to many
commands on the Control menu, and which may contain information about the current program
or document.

Tool Command Language
Tool Command Language (Tcl) is a scripting language designed to be used by applications as a
common command language. It consists of a library of C routines that can be added to an
application, and is easily extensible either by adding new C routines or by writing new
procedures in the Tcl language.

toolbar
The toolbar provides quick mouse access to many commands used in an application. By default,
the toolbar is displayed across the top of the application window, below the menu bar, but it can
also either float or dock with the window at any location.
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transport
A transport defines a mechanism for accessing a remote host. The definition includes the
protocol used to make the connection, the script used to log in and/or execute a command, the
authentication required, and advanced settings that specify the services available and how they
are to be provided.

translation DLL
A dynamic-link library (DLL) that translates all data passing between an application, such as
Microsoft Access, and a data source. The most common use of a translator is to translate
character data between different character sets. A translator can also perform tasks such as
encryption and decryption or compression and expansion.

Uniform Naming Convention
The Uniform Naming Convention (UNC) refers to the standard format for paths that include a
network file server. A UNC name is a name given to a device, computer or resource to enable
other users and applications to establish an explicit connection and access the resources over a
network. UNC is used by the Universal Session Protocol (USP) to identify resources in the
following format:

\\hostname\service\parameters

where hostname is the Vision Communications Architecture host name, service is the service
name, and parameters are server-specific parameters. Also known as the Universal Naming
Convention.

Universal Session Protocol
The Universal Session Protocol (USP) allows Vision Communications Architecture to support
multiple transport protocols, while presenting a standardized communications interface to other
software layers. USP operates directly over TCP/IP if that transport is available. If TCP/IP is not
available on the PC, a USP proxy process runs on the UNIX system to represent the PC on the
network. The proxy process uses UTP running over any available transport.

Universal Transport Protocol
The Universal Transport Protocol (UTP) is a reliable multiplexing protocol that provides error
corrected transport over any communications environment. It allows Vision PC and UNIX
software to communicate over non-TCP/IP transports such as an RS232C serial link.

Unix Neighborhood
Unix Neighborhood provides Windows 95 or NT 4.0 users with access to the hosts on their
network, using a view similar to Windows Network Neighborhood. Users can configure remote
host computers, browse through folders and files, and open programs and documents. Files or
folders can be created or deleted, moved or copied on the remote computer, or copied to the PC.
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User Datagram Protocol
The User Datagram Protocol (UDP) is a standard TCP/IP protocol that allows an application on
one machine to send a datagram to an application on another machine. UDP uses the Internet
Protocol (IP) to deliver the datagrams. The difference between UDP datagrams and IP datagrams
is that UDP includes a protocol port number, allowing the sender to distinguish between multiple
applications on the remote machine.

User Viewer
The User Viewer program allows you to obtain a list of all PC users running Vision97 software
and can be used to send text and multimedia messages to another Vision user.

USP Services
USP Services are a range of services provided by Vision Communications Architecture that can be
used by Vision programs or third-party applications. The services are feature-rich, and
independent of any specific transport or host operating system. The services are carried by the
Universal Session Protocol (USP) and are implemented on the PC by Vision Service Modules.
They are made available to programs through the Vision Toolkit APIs.

Vision Communications Architecture
A collection of software modules that link Vision products to the underlying communications
transports. Vision Communications software forms a distinct layer which is independent of
applications using it.

Vision Communications database
The Vision Communications database is a collection of files that holds details of all configurable
elements in Vision Communications Architecture. These files are stored in subfolders in the
C:\Program files\Common files\Vision folder on each Vision software PC.

Vision Resume
SCO Vision Resume allows you to suspend an X session and resume it at a later time. X clients
that are part of a Resume session actually run on a �proxy server� on a UNIX host. The proxy
server communicates with an X display to show output and receive user input. A session can be
suspended at any time either by user action, or through an unscheduled event such as
communications failure. The X clients that are part of the session continue to run on the proxy
server. When a session is resumed, the X clients that were previously running reappear on the PC
display and you can continue to work with them.

Vision Services
Vision Services is the general name given to all the USP services that run in the background.
They can all be started and shut down by the Vision Services program, Vservice.exe.
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Vision Window Manager
The Vision Window Manager (VWM) is built into the X Server, and is enabled when the server
is used in multiple-windows mode. VWM provides local window management to X clients and is
compatible with OSF/Motif.

VisionFS
SCO VisionFS allows system administrators managing groups of PCs to provide file and print
sharing capabilities from UNIX servers to Windows PCs.

visual
A structure which describes the color capabilities of an X display. The visual �class� corresponds
to different types of display hardware: StaticGray, GrayScale, StaticColor, PseudoColor,
TrueColor and DirectColor. The visual also includes information about the number of colorcells
in the colormap.

Since a visual really describes a way of using a particular display, several different visuals may be
available for a single screen. For example, it is usually possible to treat a color display as a
monochrome or gray scale device. The X Server specifies which visuals are currently available,
and defines a default visual.

VMS
The multi-user, multi-tasking operating system which runs on Digital Equipment Corporation�s
VAX range of computers.

VT420 Emulator
The VT420 Emulator allows you to run character-based applications on remote computers and
view them in windows on your PC. The emulator is based on the Digital VT420 terminal.
Applications designed for any of the DEC video terminals may take advantage of your PC�s
capabilities by using this emulation.

window manager
A special X Window System client which controls the positioning and size of other clients�
windows on the screen. It also determines the policy for directing user input to windows. A
window manager may recognize �hints� supplied by clients which affect the appearance of the
window, and the user interface.

WAN
Wide area network. Provides data communications capability in areas larger than those served by
local area networks.

World Wide Web
The World Wide Web (the Web or WWW) provides a graphical, easy-to- navigate interface for
looking at documents on the Internet. These documents, as well as the links between them,
comprise a �web� of information.
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Workbench Server
The Workbench Server Workbsrv.exe runs on a PC and is required to allow the System
Administrator to browse PCs directly from the Administration Workbench. It is started by
Administration Workbench when a browse is requested.

Wyse 60 Emulator
The Wyse 60 Emulator allows you to run character-based applications on remote computers and
view them in windows on your PC. The emulator is based on the Wyse 60 terminal. Applications
designed for the Wyse 60 may take advantage of your PC�s capabilities by using this emulation.

X client
In the X Window System model, a client program is normally an application. A window manager
is also a client.

X display
The hardware provided for the user to interact with X. The display consists of one or more bit-
mapped screens, a keyboard, and a pointing device such as a mouse.

X Keymap Editor
Allows you to create or modify a keyboard map for use with the X Server.

X logical font
A font description which describes the characteristics of a font. The elements of the description
are separated by hyphens. For example, the following specifies a Courier 10pt font:

-Adobe-Courier-Medium-R-Normal—10-100-75-75-M-60-ISO8859-1

The asterisk character (*) can be used as a wildcard in any element. For example, the following
would also specify Courier 10pt:

*-Courier-*-R-*-100-*

X server
In the X model, a server program controls the display hardware, and provides an interface
between it and clients.

xdm
X Display Manager. A client supplied with X11R5 to provide a standard way for users to log in
to a UNIX system and start an X session. xdm is used in association with XDMCP.

XDMCP
The X Display Management Control Protocol, which defines the interaction between a server
and a display manager.
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XRemote
A serial line protocol developed by Network Computing Devices Inc. (NCD) to allow the X
Window System to be run over an asynchronous serial connection. The Vision97 X Server
supports XRemote.

xterm
A standard X client which provides a terminal window with access to the host operating system.
Specific X Window System implementations may use other names for this client, for example,
DECterm under DECwindows.

XVision
The Vision97 product which allows X Window System applications to display on a PC screen at
the same time as Microsoft Windows programs.

XVision Font Compiler
Compiles X fonts in PCF or BDF format to Microsoft Windows .FON format font files which
can be used when displaying X clients on the PC.
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This appendix tells you how to prepare your PC before installing
Vision97, by installing network software, or by configuring a serial
line or modem.
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Preparing a network connection
This section tells you how to install Microsoft TCP/IP, and how to test the network connection.

Installing Microsoft TCP/IP on Windows 95
Unless Microsoft TCP/IP was already on your system when you installed Windows 95, then the
TCP/IP software is not typically installed.

To install Microsoft TCP/IP on Windows 95

1 Start the Windows Control Panel and double-click Network.
Your network card and the protocols used on that card are displayed.

2 Click Add.
3 Click Protocol and then click Add.
4 In the Manufacturers list on the left, click Microsoft, and in the Network Protocols list on the

right, click TCP/IP. Click OK to return to the Configuration tab.
5 In �The following network components are installed� box, click �TCP/IP� and then click

Properties.
6 Fill in the required details in the Properties dialog box.

Tips
§ You can get Help on an item, by clicking  at the top of the dialog box and then clicking the

item.
§ For further information refer to the Microsoft Windows Resource Kit.

You should test your TCP/IP to ensure that it is working before installing Vision97 software (see
�Testing the Network Connection� later in this chapter).

Installing Microsoft TCP/IP on Windows NT 4.0
Unless Microsoft TCP/IP was already on your system when you installed Windows NT, then the
TCP/IP software is not typically installed as part of the Windows NT product during Express
Setup.

To install Microsoft TCP/IP on Windows NT 4.0

1 Start the Windows Control Panel, double-click Network, and then click the Protocols tab.
The dialog box shows the installed protocols.

2 Click Add.
3 Click �TCP/IP Protocol� in the Network Protocols list, and then click OK.
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4 Windows NT Setup displays a message asking if you wish to use DHCP to dynamically
provide an IP address. If DHCP is in use at your site, click Yes, and you can ignore step 7 in
these instructions. Otherwise, click No.

5 Windows NT Setup displays a message asking for the full path to the Windows NT
distribution files. Provide the appropriate location, and click Continue. All necessary files are
copied to your hard disk.

6 Click Close.
7 Fill in the required details in the Microsoft TCP/IP Properties dialog box.

Tip
§ You can get Help on an item, by clicking  at the top of the dialog box and then clicking the

item.

You should test your TCP/IP to ensure that it is working before installing Vision97 software (see
�Testing the Network Connection� later in this chapter).

Installing Microsoft TCP/IP on Windows NT 3.51
Unless Microsoft TCP/IP was already on your system when you installed Windows NT, then the
TCP/IP software is not typically installed as part of the Windows NT product during Express
Setup.

To install Microsoft TCP/IP on Windows NT 3.51

1 Start Control Panel from the Main group in Program Manager.
2 Double-click the Network icon.
3 Click Add Software.
4 Click TCP/IP Components And Related Protocols in the Network Software list, and then

click Continue.
5 Check the options for the TCP/IP components you want to install.
6 Windows NT Setup displays a message asking for the full path to the Windows NT

distribution files. Provide the appropriate location, and click Continue. All necessary files are
copied to your hard disk.

7 In the Installed Network Software list, click TCP/IP Protocol and then click Configure.
8 Fill in the required details in the TCP/IP Configuration dialog box.

Tip
§ For information on the options refer to Microsoft Windows NT Help.

You should test your TCP/IP to ensure that it is working before installing Vision97 software (see
�Testing the Network Connection� later in this chapter).



Vision97 Reference530

Testing the network connection
You should test the network connection to ensure that your PC can access the remote system.
Most of the problems experienced by users installing Vision97 software for the first time are
problems with the underlying communications link. Unless you can get this link to work, you
will not be able to use Vision97 software.

If you are using TCP/IP, then use the Telnet program supplied with most network software
packages, or open an MS-DOS window and type:

ping ip-address

or

ping node-name

where ip-address is the Internet address and node-name is the host name of a node on the
network. The documentation for your network software may tell you more about
troubleshooting with the Ping program.

Preparing a serial connection
This section tells you how to set up and test a serial connection, and gives guidelines on choosing
a modem.

Setting up a serial connection
Connect your PC to the host system using a direct RS232C serial cable, or use a modem for a
remote telephone link.

In Windows 95 or NT 4.0, you can install a modem as a Windows TAPI device, using the Install
Modem wizard from the Control Panel. The wizard also allows you to configure dialing and
modem settings, and carry out a diagnostic check on the installed devices. If you require more
information about configuring a modem as a TAPI device, refer to the �Vision Communications
Architecture� chapter.

Configure the serial port on the remote host computer as interactive, and set the line
characteristics (speed, parity and so on).

If Vision97 is installed on the UNIX host, then a helper process is provided to act as a proxy for
your PC on the network enabling access to the full range of USP Services on any network host. A
multiplexing protocol allows several programs to run over a single connection. XRemote may be
available to allow an X session to run over a serial connection. If Vision97 software is not
installed on the host system, then you can use a serial or modem connection to open a terminal
connection, or to execute a program on the remote host.
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Choosing a modem
Please consider the following guidelines when selecting a modem:

• The modem should ideally provide full-duplex transmission at 9600 baud (or faster).
• The modem should comply with the CCITT V.32 standard or V.32 bis for data

communications.
• The modem should incur minimal delays in round-trip transmissions, even when transmitting

small packets.
• Flow control is not required. If you must use a flow control mechanism, hardware flow

control is recommended (either RTS/CTS or DTR/DSR). Software flow control is not
recommended because a noisy modem line can interject spurious XOFF characters, causing
the connection to hang.

• Multiplexing modems or any other data communications equipment that add delay to the
signal path will slow performance.

• In general, the modem and host port must be configured to allow the transfer of 8-bit
characters.

Testing the serial connection
You should test the serial connection to ensure that your PC can access the remote system. Most
of the problems experienced by users installing Vision97 software for the first time are problems
with the underlying communications link. Unless you can get this link to work, you will not be
able to use Vision97 software.

You can test a serial connection using HyperTerminal (supplied with Windows 95 and NT 4.0)
or Terminal (supplied with older versions of Windows NT).





CUNIX Commands

The UNIX commands available in the Vision97 host software are
described in UNIX manual page format.
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UNIX commands summary
admcopy Copy files and directories between a PC and a UNIX host.
admexec Execute a program on a PC.
admindex Build an index of the administration database.
admls List the contents of the administration database.
admupdate Initiate an update of administered PCs.
authsrv Authentication Server.
browsesrv File Access Server.
dumppath Create path environment file.
licadmin Perform license administration.
licsrv License Server.
lna Local Name Agent.
logsrv Log Server.
newterm Create or remove utmp entry for new process.
nsmadmin List the Name Space Managers currently running.
nsmrpcsrv RPC interface to Name Space Manager.
nsmsrv Name Space Manager.
odbc_server Database-specific server module of the Vision ODBC driver.
pclist Register administered PCs.
pcprtclnt Print a UNIX file on PC printer.
printsrv Print Server.
termdump Create a USP Task Server configuration file.
tsrv Task Server.
usputppxy UTP based proxy for USP.
visionver Display the version number of a program.
v97 Control Vision97 services.
workbsrv Administration Workbench Server.
xresume Vision Resume startup program.
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admcopy

Syntax
admcopy  source  destination

Description
admcopy is only available if SuperVision is installed. It is used to copy files and directories
from a UNIX host to a PC, and to copy files only from PC to UNIX.
You need to specify the PC name preceded by a double forward slash (//), followed by the
drive letter, then the path, and then the filename. When copying from UNIX to PC, you must
specify a destination file. For UNIX paths, you can use both relative and full path names.
If you copy a file from UNIX to a PC folder that does not exist, admcopy will create it.

Notes
If you copy a file from the administration database to your PC without using admcopy, you
will not be able to run the file. This is because it will still have the long filename container
attached. The file would only be of use if you then copied it to another database. For further
information on long filename containers, see admls.
Wildcards can be used for UNIX files and directories only when copying from UNIX to PC.
admcopy does not carry out any processing of line terminators.
admcopy uses short filenames, but you can specify long filenames for the PC end, whether it
is the source or destination, providing you place the filename in quotation marks.

Files
vision.conf - Vision configuration file.

Examples
To copy a file called Chimes.wav from your PC to your current UNIX directory:
admcopy //geoffs/c:/windows/media/chimes.wav .

To copy the same file from the administration database to your PC:
admcopy PCs/geoffs/Files/chimes.wav //geoffs/c:/windows/media



Vision97 Reference536

admexec

Syntax
admexec  [ -m ]  [ -M ]  [ -h ]  [ -w ]  [ -i ]  //PCname/{path|alias}/command

Description
admexec is only available if SuperVision is installed. It is used to execute an application on a
specified PC. You can supply an absolute path, an alias representing a folder path defined in
the Windows Registry, or just an executable name if its folder is in the Windows path.
The options are:
-m Start the application minimized.
-M Start the application maximized.
-h Hide the application in the background.
-w Wait for the application to be closed before returning to the UNIX command

prompt. The host will poll the Administration Server every second to see if
the process on the PC is finished.

-i Allow interval time between polls to Administration Server to be changed
from every second. Applies only if -w is specified.

Notes
You need to have administrator privileges to be able to execute applications on PCs other
than your own.
If you want to execute command with an argument, such as a file name, surround
//PCname/{path|alias}/command with quotation marks (��).

Files
visionpriv - Authentication database.

See also
�Aliases� in the �Managing the Administration Database� chapter.

Examples
To start Remote Program Starter maximized, using a full path:
admexec -M //geoffs/progra~1/vision~1/rps

Using a well-known alias:
admexec -M //geoffs/DirectionApp/rps

Specifying a interval of ten seconds for polling the Administration Server:
admexec -Mwi10 //geoffs/DirectionApp/rps

Launching an RPS document (note the quotation marks):
admexec -M "//geoffs/progra~1/vision~1/rps myrps.rps"



Appendix C � UNIX Commands 537

admindex

Syntax
admindex

Description
admindex is only available if SuperVision is installed. It is used to build an index of the
administration database. The index includes a version number for each file or object, which is
used to determine which files get sent from the administration database to PCs during an
update.

Notes
When SuperVision is installed, it creates an administration group called svision. Any UNIX
user that wants to run admindex from the command line must be a member of this group,
otherwise permission will be denied.
This command is not normally run from the command line, since the Administration
Workbench can be used to initiate an index build. The index cannot be built if
Administration Workbench is running, as it locks the database.

Files
vision.conf - Vision configuration file.

See also
admupdate

Example
admindex
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admls

Syntax
admls  [ -l ]  [ -a ]  [ -R ]  filename

Description
admls is only available if SuperVision is installed. It is used to list the contents of the
administration database. You can use admls in any UNIX directory, but if you use it in an
administration database directory, then it displays Windows long file names (which can be up
to 255 characters long) in parentheses next to the standard 8.3 format names of files in the
database. All the invalid characters are stripped out. For example:
alargefo.bat [a large folder.bat]

All files created in Administration Workbench will have long filename containers, even if the
long filename is the same as the short filename. If a file has an asterisk next to its name, it was
not created in Administration Workbench, and has no container. For example:
BOOTLOG.TXT [BOOTLOG.TXT]
SCANDISK.LOG [SCANDISK.LOG]
*vweventlog

The options are:
-l List in long format, giving file type and size in bytes, short filename and long

filename.
-a List all entries. Usually entries whose name begin with a period (.) are not

listed. Files that are marked for deletion from the file store are renamed to
begin with a period.

-R Recursively list all the subdirectories encountered.
filename List occurrences of the filename. Can use directory names and wildcards. The

wildcard is based on the short filename.

Notes
Duplicate long file names are handled in the same way as in Windows 95. For example, the
long filename geoff a b c becomes short filename geoffabc, whilst long filename geoff a b c d
becomes short filename geoffa~1.

Files
vision.conf - Vision configuration file.

See also
admcopy

Examples
admls -lR

admls -l *.TXT
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admupdate

Syntax
admupdate  [ -p ]  [ -g ]  [ -l ]  [ -a ]  [ -f ]  [ -n ]  [ -s ]  [ -t ]  [ -v ]

Description
admupdate is only available if SuperVision is installed. It is used to download changes in the
administration database to PCs or groups.
The options are:
-p  pc1,pc2,...

The name of the PC(s) on which the update is to be carried out. This is
mutually exclusive with -g.

-g  group1,group2,...
The name of the group(s) on which the update is to be carried out. This is
mutually exclusive with -p.

-l List all the files that need updating.
-a Download everything that is in the index regardless whether they have been

downloaded previously.
-f Force the Administration Server dialog box to the foreground. This

summarizes update information and prompts the users for confirmation.
-n Prevent the Administration Server dialog box from appearing, therefore

bypassing user confirmation.
-s Silent update. This option instructs admupdate not to display any output on

the command line, even if actions fail.
-t Specify the amount of time the Administration Server dialog box waits for a

reply before closing. The default is one minute. If no reply is given, the
update will proceed automatically.

-v List each PC or group and all the files and objects as they are being
downloaded.

Notes
You need to have administrator privileges to be able to download changes to PCs other than
your own.
admupdate relies on the index being built, and will not run if there are no marked changes to
the database. For more information about the index, see admindex. admupdate will also not
run if Administration Workbench is running.
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Files
vision.conf - Vision configuration file.
visionpriv - Authentication database.

See also
admindex

Example
admupdate -pgeoffs,jim,stevel -fw
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authsrv

Syntax
authsrv [ -r ]  [ -e ]  [ -s ]

Description
authsrv is the Authentication Server, which provides the USP vwauth service. It is started at
the beginning of a Local Name Agent session (see lna), and then remains running. When
started authsrv reads a database of user names and permissions called visionpriv. It then
listens for requests from client programs.
The options are:
-r Read the authentication database. This is done by default when the

Authentication Server is started. Using the command again with this switch
specified when the program is already running does not start another
instance of the program, but causes the existing process to read the database
file again.

-e Accept passwords that are valid, but have expired.
-s Check that the user�s account uses one of the shells defined in /etc/shells

before authenticating the user. If the file is not present, the check is not
performed.

Notes
If you edit the visionpriv file while authsrv is running, then you need to use the command
authsrv -r to force it to read the database again. Superuser privilege is required.

Files
vision.conf - Vision configuration file.
visionpriv - authentication database.

See also
�Authentication Overview� in the �Vision Communications Architecture� chapter.

Example
authsrv
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browsesrv

Syntax
browsesrv

Description
browsesrv is the File Access Server, which provides the USP Ftrans service. It is started on
demand by the Local Name Agent (see lna), and then remains running until the end of the
browser session.

See also
�Browsing Overview� in the �Browsing Remote Hosts� chapter.

Example
browsesrv
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dumppath

Syntax
dumppath

Description
dumppath creates a file called .visionpath in the home directory of the current user
containing the current setting of the PATH environment variable for use by the File Access
Server. This ensures that the Paths folder in Host Explorer includes all the folders in the
current PATH.

Notes
If you do not run dumppath to create this file, then the contents of the Paths folder will be
defaults provided by the File Access Server.
You are recommended to include the dumppath command in the .login or .profile startup
file, to ensure that the .visionpath file is up to date.

Files
.visionpath - path data file.

See also
�Browsing Overview� in the �Browsing Remote Hosts� chapter.
browsesrv

Example
dumppath



Vision97 Reference544

licadmin

Syntax
licadmin [ -a ]  [ -A ]  [ -f ]  [ -g ]  [ -i ]  [ -I ]  [ -l ]  [ -p ]  [ -q ]  [ -Q ]  [ -r ]  [ -R ]  [ -u ]

Description
licadmin is a client program that accesses the License Server (see licsrv) to perform license
administration tasks.
The options are:
-a  license_number

Adds a COLA format license number to the license database ln.dat. If you try
to add a duplicate number the operation is ignored. COLA format license
numbers predate Vision97 and are still valid.

-A  license_number
Adds a license number to the license database ln.dat. If you try to add a
duplicate number the operation is ignored.

-f Displays the number of times that license requests were refused.
-g Displays the License Server�s configuration.
-i Displays the licenses in use.
-I Displays the licenses in use on all subnetworks.
-l Lists license numbers currently in ln.dat.
-p  license_number  product_code

Checks whether the specified license number is valid for the specified
product code.

-q  product_code
Checks whether the specified product has a license number installed.

-Q  component_code
Checks whether the specified component has a license number installed.

-r  license_number
Removes a COLA format license number from ln.dat. COLA format license
numbers predate Vision97 and are still valid.

-R  license_number
Removes a license number from ln.dat.

-u Copies a more recent prodinfo.dat file to the master Name Space Manager
(NSM) host.
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Notes
To add or remove licenses, you must have Superuser (root) or license administration
privileges.

Files
vision.conf - Vision configuration file.

See also
�License Management Overview� in the �License Management� chapter.

Example
The first example shows license usage.
[3] % licadmin -i
Component License Domain Total Licenses Licenses Used

VisionFS Server 0 1 0
VisionFS Server (read-only) 0 790 0
Vision Resume 0 1 0
Vision Resume (unrestricted) 0 0 0
Unix Neighborhood 0 635 0
ANSI Emulator 0 431 3
VT420 Emulator 0 431 7
Wyse 60 Emulator 0 431 0
Admin Workbench 0 153 0
Administered PC 0 153 74
ODBC Client 0 204 2
XVision Server 0 278 14
Motif Window Manager 0 278 1
Vision Services 0 788 23

The following example shows information about the License Server�s configuration.
[4] % licadmin -g
When all licenses are in use:
    Send email to: billwe
    Let programs run, with warnings

License Logging:
    Log successful license requests: N
    Log failed license requests: Y
    Log modification details: N
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licsrv

Syntax
licsrv [ -a ]  [ -h ]  [ -k ]

Description
licsrv is the License Server, which provides the USP lcnsesvc service. It is started automatically
by the Local Name Agent (see lna) on the host on which the master Name Space Manager
(see nsmsrv) is running. The server is started when the first request for the service is made by
a client program, and then remains running. Information about current tokens is written to
the licsrv.dat file.
The License Server periodically checks that it should remain active by checking that a lock file
created and removed by the NSM still exists. It also checks that its name is still registered
with the NSM. If these conditions are not met it assumes that another NSM on a different
host has taken over as the master, and so it terminates.
When started, licsrv initializes its license cache by reading the licsrv.dat, ln.dat, prodinfo.dat
and domain.dat files. These files are copied periodically to any hosts running backup NSMs,
so that if a backup NSM takes over as the master and starts a new License Server, existing
license information is preserved.
The options are:
-a  age Set the maximum age in seconds of the licsrv.dat file if it is to be used to

initialize the license cache when the License Server is started (default is
3600).

-h  interval Set the interval in seconds at which the License Server examines its license
cache to determine whether any license tokens have expired (default is 720).
Note that you should not normally need to alter the default interval. Do not
specify an interval that is less than 300.

-k  interval Set the keepalive interval in seconds at which the License Server checks for
the existence of its lock file and also checks that its name is still registered
with the NSM (default is 180).

The file licsrv.rc can be used to configure the behavior of the License Server, although we
recommend that you use License Manager to do this.
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Files
vision.conf - Vision configuration file.
prodinfo.dat - product information database.
domain.dat - license domain database.
ln.dat - license database.
licsrv.dat - license availability and usage file.
licsrv.rc - License Server configuration file.

See also
�License Management Overview� in the �License Management� chapter.

Example
licsrv
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lna

Syntax
lna [ -b ] [ -h  interval ]

Description
lna is the Local Name Agent (LNA) that is responsible for starting server programs. Its
function is similar to a portmapper in a Sun ONC RPC system. Some servers are started
immediately after the LNA has been run, while other servers are started in response to client
requests.
The LNA is normally started at system boot time by an entry in a system startup file. The
entry should specify the -b option, which causes the LNA to read the servers file and start the
programs specified in the boot start section. The LNA registers itself with the Name Space
Manager (NSM), and also supplies the NSM with the names of any server processes it starts.
When these servers start, they register themselves with the NSM. If the NSM is subsequently
asked for a service that is not registered, it will ask the LNA to start the appropriate server.
The options are:
-b Start the boot-time servers.
-h  interval Set the interval in seconds at which the LNA re-sends its token list to the

License Server (default is 300).

Files
vision.conf - Vision configuration file.
servers - servers file.

See also
�Starting Server Programs� in the �Vision Communications Architecture� chapter.

Example
lna -b
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logsrv

Syntax
logsrv

Description
logsrv is the Log Server, which provides debug and event logging facilities. It is started at the
beginning of a Local Name Agent session (see lna), and then remains running.
For debug logging it creates a file called vwdebuglog that contains information useful for
troubleshooting.
For event logging it creates a file called vweventlog that records all important events of
interest to the System Administrator.

Notes
The Log Server creates a FIFO called vwpipe in the directory specified by the
VISION_TMPDIR variable which clients use to add entries to the log files.
logsrv must be started at boot time and cannot be restarted by the LNA. It can be restarted
manually if necessary.

Files
vision.conf - Vision configuration file.
vwdebuglog - debug log file.
vweventlog - events log file.
vwpipe - log pipe.

Example
logsrv
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newterm

Syntax
newterm  command
newterm  -r  utmp-entry

Description
In the first form above, newterm creates an entry in the utmp file for the tty that it is running
on, and then forks command. The newterm command should only be used in a USP terminal
session when the tty that it is running on does not already have an entry in the utmp file.
The -r option is used in exceptional circumstances such as the Task Server tsrv crashing, in
order to remove an entry from the utmp file. The parameter utmp-entry is the tty identifier
(see Examples).

Notes
newterm requires Superuser privilege and is installed with setuid root privilege (mode 4711).
If newterm is not used, the Task Server normally creates a single utmp entry for a user, and
monitors this for messages, which it redirects to Message Pad.
Use the who command to view utmp entries.

See also
�The utmp File� in the �Terminal Emulation� chapter.
�The Terminal Command Line� in the �Terminal Emulation� chapter.

Example
To open a terminal connection with its own utmp entry, use the following as the command in
the Connection dialog box:
newterm csh

To remove a utmp entry:
newterm -r pty/ttyza
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nsmadmin

Syntax
nsmadmin -n -L

Description
nsmadmin lists the currently running Name Space Managers.
The option is:
-n List the Name Space Managers.
-L Display the name and IP address of the License Server host and the port on

which the License Server listens.

Notes
nsmadmin broadcasts a request for all Name Space Managers to respond and waits for five
seconds before exiting.

See also
�Name Space Manager� in the �Vision Communications Architecture� chapter.
nsmsrv

Example
The following example of the output from nsmadmin shows the master NSM and three
backups.
cornflake% nsmadmin -n
poptart.vision.co.uk (MASTER)
cornflake (BACKUP)
salt.vision.co.uk (BACKUP)
poohbear.vision.co.uk (BACKUP)
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nsmrpcsrv

Syntax
nsmrpcsrv

Description
nsmrpcsrv is a server which provides the USP NameSvcRpc service. It is started on demand by
the Local Name Agent (see lna), and then remains running until the end of the client session.
It provides an interface to the Name Space Manager for various clients such as the User
Viewer.

See also
nsmsrv

Example
nsmrpcsrv
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nsmsrv

Syntax
nsmsrv  [ -b ]  [ -g ]  [ -h ]  [ -i ]

Description
nsmsrv is the Name Space Manager (NSM), which provides the USP nsmsrv service. It is
started at the beginning of a Local Name Agent (LNA) session (see lna), and then remains
running. Its main purpose is to resolve clients UNC format requests for services to network
addresses. If a requested server is not running then the NSM will ask the LNA to start it. A
secondary function of the NSM is to maintain a list of PCs and their associated administration
host.
The NSM maintains a register of all Local Name Agents and all USP servers running on the
local network, including those running on UNIX systems and on PCs.
There may be several NSMs running on a subnetwork, in which case one is elected to be the
master NSM and the others are secondary NSMs. The secondary NSMs poll the master for
updates.
The options are:
-b  interval Set the interval in seconds at which a secondary name server requests updates

from the master (default is 600).
-g  interval Set the interval in seconds at which data is sent to remote NSM gateways

(default is 3600).
-h  interval Set the interval in seconds at which the master NSM attempts to connect to

all registered LNAs to make sure they are still alive (default is 120).
-i  ip-address Ignore the specified ip-address when receiving replies from NSMs following a

broadcast. This option is provided for use when the system on which the
master NSM is running has more than one IP address.

Notes
The VISION_NAMESVC setting in vision.conf determines where the preferred master Name
Space Manager is running.

Files
vision.conf - Vision configuration file.

See also
�Name Space Manager� in the �Vision Communications Architecture� chapter.
nsmadmin; nsmrpcsrv; pclist

Example
nsmsrv
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odbc_server

Syntax
odbc_server  [ -f [ filename ] ] [ -i ] [ -l port number ] [ -P ]  [ -r [ filename ] ]
where odbc_server is the server program specific to the database. See the sections on the
specific server modules in the �Vision ODBC Driver� chapter for details.

Description
odbc_server is only available if SQL-Retriever is installed. It is the database-specific server
module of the Vision ODBC driver. It is run at the beginning of a Local Name Agent (LNA)
session (see lna) and then remains running.
The options are:
-f Run session startup SQL file. The file can contain any SQL statement apart

from Select statements.
filename Use specified session startup SQL file. Must be specified directly after the -f

option. The host module of the Vision ODBC driver will look for filename
in the /usr/local/vision/etc directory, where filename is the name of the
specified SQL file. If you include a path, the host module will look for
filename in the directory that you specify. If you don�t specify a file name,
the host module will look for odbc_service.sql in the /usr/local/vision/etc
directory, for example, sqlrora.sql for Oracle.

-i Allow Security Manager to accept native database SQL that it does not
recognize without treating it as a security violation. Applies only if -r is
specified.

-l port number Specify the port on which the server listens. This option should be used in
conjunction with the Port connection string setting.

-P Do not register the server with the RPC portmapper.
-r Enable Security Manager.
filename Use user-defined Security Manager configuration file to grant and revoke

privileges. Must be specified directly after the -r option. The host module of
the Vision ODBC driver will look for filename in the /usr/local/vision/etc
directory, where filename is the name of the specified configuration file. If
you include a path, the host module will look for filename in the directory
that you specify. If you don�t specify a file name, the host module will use
the default configuration file sqlrsec.conf.
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Files
sqlrsec.conf - Security Manager configuration file.
Individual servers have specific configuration files. See the sections on the specific server
modules in the �Vision ODBC Driver� chapter for details.

See also
Sections on the specific server modules in the �Vision ODBC Driver� chapter.

Example
A servers file entry for the Ingres server program:
sqlr.ing40.d m -r -i
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pclist

Syntax
pclist

Description
pclist is only available if SuperVision is installed. It registers all administered PCs with the
Name Space Manager (NSM). It is run at the beginning of a Local Name Agent (LNA) session
(see lna) and then exits.

Notes
If you add or remove PCs using Administration Workbench, the NSMs cache is automatically
updated. There is no need to run pclist except at the start of an LNA session.

See also
nsmsrv

Example
pclist



Appendix C � UNIX Commands 557

pcprtclnt

Syntax
pcprtclnt  -h  pc  -p  printer

Description
The pcprtclnt command is used to pass a UNIX print job to the Print Server on a remote PC.
The options are:
-h  pc The name of the PC to which the print job should be sent.
-p  printer The logical name of a printer configured in Print Server on the remote PC.

Notes
The pcprtclnt command is always called from a shell script such as an lp print interface script
or an lpr output filter.

Files
printers - printers database.

See also
�UNIX to PC Local Printing� in the �Printing� chapter.

Example
pcprtclnt -h stevel -p qms
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printsrv

Syntax
printsrv

Description
printsrv is the Print Server, which provides the USP prtServ service. It is started on demand by
the Local Name Agent (see lna), and then remains running.

See also
�UNIX to PC Local Printing� in the �Printing� chapter.
�PC to UNIX Remote Printing� in the �Printing� chapter.

Example
printsrv
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termdump

Syntax
termdump

Description
termdump creates one or more terminal configuration files which are read by the Task Server
tsrv. A file called either termio or termios is created, and sometimes also a file called winsize,
depending on the version of UNIX.
The file(s) contain the current tty settings as configured by the UNIX stty command. The
termio file overrides defaults provided by the Task Server. A termio file is provided when the
terminal emulator is installed that contains a standard tty configuration similar to that
provided within a standard UNIX terminal session.

Notes
The new termio file will overwrite the currently existing file.
The new settings will not take effect until the USP Task Server is restarted.
Superuser privilege may be required to create the termio file.

Files
vision.conf - Vision configuration file.
termio - terminal configuration file.

See also
tsrv

Example
termdump
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tsrv

Syntax
tsrv  [ -i ] [ -k ] [ -t ] [ -u ]

Description
tsrv is the Task Server, which provides the USP login service. It is started at the beginning of a
Local Name Agent session (see lna), and then remains running. It provides the ability to log in
to a UNIX system and then run a program. The program may remain attached to a terminal
connection, or may run detached in the background.
The Task Server optionally handles messages sent to you by other UNIX users. By default, it
creates a single entry in the utmp file the first time a user logs in, and listens for messages sent
to that username. It sends these messages to Message Pad on the appropriate PC. You can
change this behavior so that a utmp entry is created for each terminal connection, as required
by some applications. Specifying the -u flag indicates that utmp entries should be created in
this way for all users; to specify individual users, edit the tsrv.rc file. Users can specify that a
utmp entry should be created for a specific terminal connection by using the newterm
command when opening the connection.
The options are:
-i  timeout Set the intray timeout to the specified number of seconds (default is 10). The

Task Server watches for messages sent to any of the terminal connections it is
managing, which do not have their own utmp entry. However, it cannot
detect end-of-message conditions, so instead uses a timeout to decide when a
message is complete.

-k  shared-memory
Specify a shared memory area that multiple Task Servers can use to
communicate (default is �tsrv�). You only need to change this if a third-party
program also uses a shared memory area of the same name. The
shared-memory parameter can be any four-byte string.

-t Do not read the termio file. Use internal defaults instead.
-u Always create utmp entries for terminal connections.

Notes
tsrv can handle multiple login sessions from different clients, and can handle multiple
connections.
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Files
vision.conf - Vision configuration file.
termio - terminal configuration file.
tsrv.rc - Task Server configuration file.
utmp - UNIX utmp file.

See also
�USP Task Service Overview� in the �Terminal Emulation� chapter.
�The Terminal Command Line� in the �Terminal Emulation� chapter.

Example
tsrv
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usputppxy

Syntax
usputppxy

Description
usputppxy is the helper process that provides USP services over the UTP protocol. It is
executed by the Vision Communications script when you log in using a UTP transport. It acts
as a proxy for your PC on the TCP/IP network. When a PC client requests a service,
usputppxy asks the Name Space Manager (NSM) to resolve the USP address in the normal
way. It then connects to the server, which may be on any computer on the network, and
packages communications between the client and server for transmission over the serial line.
For servers running on the PC, usputppxy is responsible for registering them with the NSM.

See also
�Universal Transport Protocol� in the �Vision Communications Architecture� chapter.

Example
usputppxy
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visionver

Syntax
visionver  program-file

Description
visionver displays the version number of a Vision program-file.

Example
% visionver lna
lna: Version=2.20.905
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v97

Syntax
v97 remove
v97 start
v97 stop [ -f ]
v97 status
v97 version [ ls | vs | tv | xv | sv | sqlr | all ]
v97 debug [ server ]
v97 debugoff [ server ]

Description
v97 remove removes some or all Vision97 products from your system.
v97 start starts Vision97 services. If Vision97 services are already running, the command
displays an error message.
v97 stop stops Vision97 services.
v97 status displays which Vision97 services are running.
v97 version displays the version of the specified Vision97 service.
v97 debug enables debug infomation to be obtained for the specified server(s). If no server is
specified, debug is enabled for all servers in the servers file. To enable debug, use this
command and then restart Vision97 services. Note that you shouldn�t normally need to use
this command unless asked to do so by Product Support.
v97 debugoff turns off debug.
The options are:
-f Force v97 to stop Vision97 services without prompting the user for

confirmation.
ls License Services.
vs Vision Services.
tv Terminal Services.
xv X Services.
sv Administration Services.
sqlr SQL Services.
all All Vision97 services (the default).
server Server program name as specified in the servers file.
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Notes
v97 requires Superuser privilege.
v97 is located in $VISION_DIR.
The v97 command does not affect VisionFS apart from v97 remove which can be used to
remove all Vision97 products. To control the VisionFS server, use the visionfs command.

Example
v97 stop -f
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workbsrv

Syntax
workbsrv

Description
workbrsv is only available if SuperVision is installed. This program is the Administration
Workbench Server which provides the USP AdmWbSvc service. It is started on demand by the
Local Name Agent (see lna), and then remains running until the end of the Administration
Workbench session. It is responsible for all operations on the database on the administration
host.

Files
vision.conf - Vision configuration file.
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xresume, tpproxy, tpwatch, xresmgr

Syntax
xresume  [ options ]
tpproxy  [ -version ]
tpwatch  [ -version ]
xresmgr  [ -version ]

Description
These programs are only available if Vision Resume is installed. They provide the Vision
Resume proxy service, which can be used with an X server to allow an X session to be
suspended and resumed at a later time with the same X clients running.
The options are:
-license Upgrades an installation from an evaluation to a fully licensed copy. This

option requires suitable licenses to already be installed on your system.
-licstat Display license status. This is normally either �licensed� for a fully licensed

copy, or the number of days remaining for an evaluation copy.
-manage Start the Vision Resume Session Manager program xresmgr to allow a

Resume session to be controlled through a graphical user interface.
-proxydisplay

Display the host name and X display number of the proxy-server.
-relocate  display

Relocate the Resume session to the specified display, where display is an X
server that supports Vision Resume and to which you have access.

-remoterun  host  �command�
Run command on the specified host as part of this Resume session. An error
will occur if there is no current session.

-run  �command�
Run command as part of this Resume session. An error will occur if there is
no current session.

-start  display
Start a Resume session and display clients on the specified display, where
display is an X server that supports Vision Resume and to which you have
access. If you use this command when a Resume session already exists, then
the session will be resumed or relocated to the specified display.

-status Display details of the proxy-server display, the target display, and the license
status. Refer to -proxydisplay, -targetdisplay and -licstat for details of the
information provided.
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-stop Terminate the Resume session.
-suspend Suspend the Resume session.
-targetdisplay

Display the host name and X display number of the X server on which the
proxy-server is currently displaying the clients in the Resume session.

-version Display the version number.
-xremotestart

Start a Resume session over an XRemote serial connection.
-xremotestop

Stop a Resume session when connected using XRemote.
-xremotesuspend

Suspend a Resume session when connected using XRemote.
xresume is used to control a Resume session, and for XVision Eclipse it is normally started by
the Vision X Server. Note that the remote execution mechanism used by XVision Eclipse may
require that the directory containing xresume is included in the user�s PATH environment
variable. The location of the other binaries is deduced from the contents of the
/etc/vision.conf file ($VISION_BINDIR entry) by the xresume binary which is responsible for
launching them.
There is one proxy-server per user per host. Each proxy-server instance implies a
$HOME/.tpinfo file, thus a user may have at most one proxy-server running concurrently if
they have a single network account (as opposed to an account per-host). The intended mode
of use is that a user has a single proxy-server running, and this has been made the most
natural way to control it. For XVision Eclipse, the session is normally controlled using the
Vision Resume Session Control dialog box which is displayed by the Vision X Server. For all
other supported X servers, the Vision Resume Session Manager (xresmgr) must be run on the
UNIX host, and this can be started using xresume -manage. If the proxy-server is already
running when the user attempts to control it then that instance is controlled (it finds out
about that instance from the $HOME/.tpinfo file). If the proxy-server was not already
running then it is started and this new instance is controlled. Starting the proxy-server causes
tpproxy and tpwatch processes to be launched.
It is possible to control which X clients are started up when the proxy-server itself is started,
in much the manner of .xsession files in UNIX based X systems. The session is described in
$HOME/.tpsession, or if that is absent the system-wide definition in
$VISION_ETCDIR/default.tpsession is used instead, and if this is absent then no X clients
are started automatically but the proxy-server is still started correctly. The
$HOME/.tpsession and default.tpsession files both consist of command lines each of which is
terminated by an �&� as they must all be run in the background. The first line should be
�#!/bin/sh� or the like, and the appropriate comment convention may be used (�#� at the
start of the line in this case).
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All X clients automatically started using these session files will be connected to the proxy-
server, and have their DISPLAY environment variable set appropriately. The proxy-server
will take care of ensuring that their output is rendered on the real X-server that is connected
to the proxy-server. The proxy-server is itself a proper X-protocol display, and thus has a
display name and number based on the name of the UNIX host which is unique to that
instance of the proxy-server. For XVision Eclipse, this proxy-server display name is also made
available to the Vision X Server, thus allowing it to start X-clients that are connected to it via
the proxy-server rather than direct to the Vision X Server�s display.
The proxy-server programs tpproxy and tpwatch generate log files called
$HOME/.tpproxylog and $HOME/.tpwatchlog respectively. If the RESUME_DEBUG
environment variable is set ( =1 ) in the environment within which the xresume command is
executing, then a modest amount of information will be written to these log files. If it is unset
( =0 ) then very little information is written to these files. You can set the variable from your
shell startup file (e.g. .profile), or .cshrc, or in vision.conf. Changing the variable will not
affect logging from a proxy-server that is already running, so you need to terminate and
restart the Vision Resume session.
To use Vision Resume when connecting with XRemote over a serial line or modem, place the
following lines at the end of the .xinitremoterc file:
REMOTE_DISPLAY=$DISPLAY
export REMOTE_DISPLAY
xresume -xremotestart

To suspend or stop the resume session, use the -xremotesuspend or -xremotestop options
from within an xterm started by the session.

Notes
Vision Resume can only be used with X servers that contain the Resume extension.
Vision Resume uses the Vision97 license management facility. If you do not enter a Vision
Resume license number when you install your Vision97 UNIX software, then you will get an
evaluation copy. If you later purchase the product, you can upgrade to a full version by
entering the Vision Resume license number using License Manager. You then need to use the
command xresume -license to allow Vision Resume to recognize the new license. Applying
this license will affect all currently running Vision Resume proxy-servers, and they will
become licensed.
If the proxy-server is terminated abnormally, for example during a UNIX system shutdown,
then the user should carry out a Terminate Session operation before attempting to start a new
session. This will remove temporary files whose contents are never valid after a reboot of the
UNIX system.
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Files
/etc/vision.conf Vision configuration file. Used by xresume to find the location of

tpproxy and tpwatch.
$HOME/.tpinfo File containing special state information, including the X display

name of the proxy-server.
$HOME/.tpproxylog Per-user log file for tpproxy.
$HOME/.tpwatchlog Per-user log file for tpwatch.
$HOME/.tpsession Per-user session file.
$VISION_ETCDIR/default.tpsession

Global default session file.

See also
The �Suspending and Resuming a Session� chapter for information about configuring and
using Resume.

Example
% xresume -proxydisplay
jupiter:1



DUNIX File Formats

This appendix covers UNIX file formats.
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UNIX files summary
.visionpath Path data file
domain.dat License domain database
licsrv.dat Current license availability
licsrv.rc License Server configuration file
ln.dat License database
printers Printers database
prodinfo.dat Product database
servers Servers database
sqlrsec.conf Security Manager configuration file
termio Terminal configuration file
tsrv.rc Task Server configuration file
vision.conf Vision configuration file
visionpriv Authentication database
vwdebuglog Debug log file
vweventlog Event log file
winsize Terminal configuration file

Note  When the name of a Vision configuration variable appears preceded by a dollar sign ($) it
means use the value of the variable.



Appendix D � UNIX File Formats 573

.visionpath

Location
$HOME/.visionpath

Description
.visionpath contains details of the user's UNIX path. It is created by the dumppath program,
and is read by Host Explorer.

Notes
You are recommended to include the dumppath command in the .login or .profile startup
file, to ensure that this file is up to date.

See also
dumppath
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domain.dat

Location
$VISION_ETCDIR/domain.dat

Description
domain.dat is the license domain database, which defines licensing domains, and specifies for
each domain the maximum numbers of users licensed to use each product. You only need to
specify domains if you want to allocate licenses to specific groups of users on the subnetwork.
By default, machines not specified in a user-defined domain belong to domain 000, which has
allocated to it all licenses not allocated to another domain. The domain.dat file is an ASCII
text file that can be changed using a text editor providing you have Superuser (root) privilege.
Do not change the access permissions of this file.
The file contains two sections, introduced by section headers. The format of the section
defining licensing domains is as follows:
[DOMAINS]
domain=domain-code  machine-name [ machine-name... ]
The brackets around the section header [DOMAINS] are required and you should enter them.
The domain-code is an arbitary unique three-digit number. Domain 000 is reserved, and
means all machines not specified in any other domain. For each domain you should type a
space-separated list of machine names that define the members of the domain. The brackets
around machine-name indicate an optional item, and the brackets themselves should not be
typed.
The format of the section defining the number of users allowed to use each product in each
domain is as follows:
[LICENSES]
domain=domain-code  product=product-code  users=number
The brackets around the section header [LICENSES] are required and you should enter them.
The domain-code is one of the domains specified in the [DOMAINS] section. The
product-code must be one of the products defined in the products database prodinfo.dat; all
valid product-codes are listed in the comments at the top of domain.dat.
Any invalid product codes will be ignored when the file is processed. The maximum number
of users licensed to use this product in this domain must be specified.
When Vision97 software is installed on a UNIX system, a domain.dat file is installed that
does not contain any entries. If the License Server runs on this host (because the master NSM
runs on this host) then you can edit the file to add domains. If the License Server runs on
another host then the domain.dat file on this host is ignored. If a backup NSM runs on this
host, then the domain.dat file will be overwritten periodically by the domain.dat file copied
from the host on which the master NSM is running.
When allocating the maximum number of users of a product to domains, the total number of
users specified for a product must not exceed the total number of licensed users.
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Notes
If the License Server is already running when you finish changing the file, then you need to
restart the License Server.

See also
�License Management Overview� in the �License Management� chapter.
licsrv
prodinfo.dat
ln.dat
licsrv.dat

Example
The following example defines two domains, with specified users of each. It also shows the
products licensed for use in each domain.
[DOMAINS]
domain=123 jim billw
domain=456 ron
[LICENSES]
domain=123 product=023 users=200
domain=123 product=024 users=200
domain=456 product=023 users=300
domain=456 product=024 users=300
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licsrv.dat

Location
$VISION_ETCDIR/licsrv.dat

Description
licsrv.dat contains information about current license availability and usage. This is a binary
file that cannot be edited.
The licsrv.dat file is created and updated by the License Server, which runs on the same host
as the master NSM. It is copied periodically to any hosts running backup NSMs, so that if a
backup NSM takes over as the master and starts a new License Server, existing license usage
information is preserved. In fact, the license usage information may be slightly out of date,
and there is an option for the License Server that specifies the maximum age of the licsrv.dat
file if it is to be used when the License Server starts (default 1 hour).

See also
�License Management Overview� in the �License Management� chapter.
licsrv
licsrv.rc
domain.dat
prodinfo.dat
ln.dat
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licsrv.rc

Location
$VISION_ETCDIR/licsrv.rc

Description
licsrv.rc is a configuration file for the License Server licsrv. It is an ASCII text file that can be
changed using a text editor providing you have Superuser (root) privilege. We recommend
that you use License Manager to configure the behavior of the License Server.
licsrv.rc has two settings. LSMailAddr specifies the email address of the user who should be
mailed when specified license events take place. LSMode specifies aspects of the License
Server's configuration.
To set LSMode, use a Hex value calculated from the following:
0x2 Log license request failures. This is the License Server's default behavior.
0x4 Log license requests.
0x1000 Operate in hard licensing mode.
0x2000 Operate in soft licensing mode. This is the License Server's default behavior.

See also
�License Management Overview� in the �License Management� chapter.
licsrv

Example
The following example would make the License Server log all license events, use hard
licensing, and email the user fred about license events:
LSMailAddr=fred
LSMode=0x1006
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ln.dat

Location
$VISION_ETCDIR/ln.dat

Description
ln.dat is the license database, which defines the Vision97 software products licensed for use
on this subnetwork, and the maximum number of users. This is a binary file that cannot be
edited.
When Vision97 software is installed on a UNIX system, the licadmin program is used by the
installation script to add the license number for the product into the ln.dat file on the host on
which the License Server is running. The License Server runs on the host on which the master
NSM is running, which may be the host on which the new product has just been installed, or
another host on the subnetwork. The ln.dat file is copied periodically to all hosts running
backup NSMs.

Notes
ln.dat has replaced the file cola.dat used in previous versions of the Vision97 products. Any
cola.dat files are automatically converted to ln.dat files.
COLA format license numbers predate Vision97 and are still valid.

See also
�License Management Overview� in the �License Management� chapter.
licsrv
domain.dat
prodinfo.dat
licsrv.dat
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printers

Location
$VISION_ETCDIR/printers

Description
printers is the printers database, which is used to configure printers, and is read by the RPC
client program pcprtclnt. It is an ASCII text file that can be changed using a text editor
providing you have Superuser (root) privilege. The format of entries in the file is as follows:
local-printer-name:pc-name:remote-printer-name
where local-printer-name is the UNIX name for the printer, pc-name is the name of the PC,
and remote-printer-name is the logical name of the printer as configured in the Local Printer
settings.

See also
�UNIX to PC Local Printing� in the �Printing� chapter.
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prodinfo.dat

Location
$VISION_ETCDIR/prodinfo.dat

Description
prodinfo.dat is the product information database, which defines Vision97 software products
and the components that make up those products. This is a binary file that cannot be edited.
When Vision97 software is installed on a UNIX system, a prodinfo.dat file is installed unless
a more recent file exists that was installed by another Vision97 product. The most recent
prodinfo.dat file must reside on the host on which the License Server runs, which is the host
on which the master NSM runs. This prodinfo.dat file is copied periodically to all hosts
running backup NSMs.

See also
�License Management Overview� in the �License Management� chapter.
licsrv
licadmin
domain.dat
ln.dat
licsrv.dat
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servers

Location
$VISION_ETCDIR/servers

Description
servers contains the list of servers that the Local Name Agent (LNA) is able to start. It is an
ASCII text file that can be changed using a text editor providing you have Superuser (root)
privilege. The format of an entry in the servers file is:
service  server  m|s  [options]  [env:variable=value,...]
where service is the service name, server is the server program name, m means multiple
clients, s means single client, options are command line option switches, and variable is an
environment variable in shell form. Separate multiple environment variables with commas.
For example:
login  tsrv  m  -u  env:LINES=24, COLUMNS=132

If no path is specified for server then the LNA will look for the program in
$VISION_BINDIR. Alternatively, a full path may be specified in the entry.
It is possible for one server program to offer more than one service, in which case there
would be separate entries in the file for each service.
The m option means that one process can handle multiple clients. When this type of server is
started it remains running.
The s option means run a separate process for each client, and terminate the process when the
conversation with that client ends.
The servers file contains a section delineated by BOOT_START and BOOT_END. Service
entries placed between these comments will be started as soon as the LNA has started,
providing the -b flag was specified on the command.
If one of the servers started at boot time fails, it will be restarted by the LNA in the usual way
when the service is requested, with the exception of logsrv and nsmsrv.
The BOOT_DEBUG_OFF and BOOT_DEBUG_ON comments can be used to prevent any
logging, and are typically used to disable logging while the Log Server logsrv is started.
The servers and the services they support are shown in the following table. Note that the
services that are configured in the servers file will depend on which Vision97 products are
installed.
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Service Server s | m Boot start

AdmWbSvc workbsrv s No
FTrans browsesrv s No
lcnsesvc licsrv m No
login tsrv m Yes
logsrv logsrv m Yes
NameSvcRpc nsmrpcsrv s No
nsmsrv nsmsrv m Yes
odbc_service odbc_server m Yes

(database-specific)
pclist pclist m Yes
prtServ printsrv m No

vwauth authsrv m Yes

See also
�Authentication Overview� in the �Vision Communications Architecture� chapter.
lna

Example
# Vision control file for UNIX LNA.
##BOOT_START
#BOOT_DEBUG_OFF
logsrv logsrv m
#BOOT_DEBUG_ON
nsmsrv nsmsrv m
lcnsesvc licsrv m
vwauth authsrv m
login tsrv m
pclist pclist m
#BOOT_END
NameSvcRpc nsmrpcsrv s
FTrans browsesrv s
prtServ printsrv m
AdmWbSvc workbsrv s
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sqlrsec.conf

Location
$VISION_ETCDIR/sqlrsec.conf

Description
sqlrsec.conf is only available if SQL-Retriever is installed. It is the configuration file for
Security Manager. It is an ASCII text file that can be changed using a text editor providing
you have Superuser (root) privilege. Do not change the access permissions of this file. The file
contains entries used to grant and revoke privileges, and definitions of groups of users,
databases, applications, SQL statements and so on that may be used in these entries. The
format of entries used to define groups is:
keyword  groupname = groupmember,...
where keyword is the appropriate keyword for the group to be created, as shown below.

Keyword Groups

USERGROUP UNIX usernames of users or groups of users
DBGROUP Databases or groups of databases
TABLEGROUP Database tables or groups of tables
APPGROUP Applications (see below for conventions on specifying applications)

or groups of applications
SQLGROUP SQL statements or groups of SQL statements

Separate multiple groupmembers with commas. For example:
APPGROUP ALLAPPS = msaccess, excel, msqry32, SALESAPPS

uses APPGROUP to create a group of applications named ALLAPPS containing Microsoft
Access, Excel, Query, and the applications defined in the group SALESAPPS.
Format of entries granting and revoking privileges is:
GRANT | REVOKE user database:reserved:owner:table:application = privilege,...
where user is the UNIX username of the individual user or members of the group of users to
whom privileges are being granted or revoked. database is the UNIX database (note the
database name is not necessarily the same as the ODBC data source name) or group of
databases. owner is the owner of the database tables. table is the table or group of tables.
application is the application as identified by its internal name or group of applications. To
find out an application's internal name, right-click the executable file in Windows Explorer,
and then click Properties in the shortcut menu. In the Properties dialog box, click the Version
tab and then click Internal Name in the Item Name list. For older versions of Windows NT,
click the executable file in File Manager, and then press ALT+ENTER. In the Properties dialog
box, click Internal Name in the Version Information list. If an application doesn't have an
Internal Name then the application's executable file name (minus the extension) can be
specified. This method is considered less secure because it would then be possible for another
application to masquerade as an application specified in this way by changing its file name.
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privilege is the SQL statement or group of SQL statements to be granted or revoked. Separate
multiple privileges with commas. Note that fields in these entries do not have to be groups or
members of groups defined in sqlrsec.conf.
ALL or the asterisk character (*) can be used as a wildcard in any field. If ALL is specified in
the privilege field then the following predefined group of every SQL statement supported by
the Vision ODBC driver will be used:
SELECT CREATE INDEX
INSERT CREATE VIEW
UPDATE DROP TABLE
DELETE DROP VIEW
GRANT DROP INDEX
REVOKE EXECUTE PROCEDURE
CREATE TABLE ALTER TABLE

Note
The sample file sqlrsec.sample provided to illustrate the use of Security Manager with the
demonstration database should be saved as sqlrsec.conf and then modified to your own
requirements. You need Superuser (root) privilege to do this.

See also
�Security Manager� in the �Vision ODBC Driver� chapter.

Example
The following example grants members of the SALES group the ability to perform queries on
all tables in the demonstration database. This privilege is then revoked on certain tables.
GRANT SALES scodemo:ALL:ALL:ALL:gold32 = SELECT
REVOKE lee scodemo:ALL:ALL:sales:gold32 = SELECT
REVOKE SALES scodemo:ALL:ALL:nominal:gold32 = SELECT
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termio

Location
$VISION_ETCDIR/termio
$VISION_ETCDIR/termios

Description
termio, or termios on some UNIX systems, is a binary terminal configuration file that is read
by the Task Server tsrv. The file contains the current tty settings as configured by the UNIX
stty command. The termio file overrides defaults provided by the Task Server. A termio file is
provided when the terminal emulator is installed that contains a standard tty configuration
similar to that provided within a standard UNIX terminal session.
On some UNIX systems, a file called winsize is also created to hold the window size
specification.

See also
tsrv
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tsrv.rc

Location
$VISION_ETCDIR/tsrv.rc

Description
tsrv.rc is a configuration file for the Task Server tsrv. It is an ASCII text file that can be
changed using a text editor providing you have Superuser (root) privilege. Sections in the file
are introduced by #!. Currently, the only section is #!UTMP-USERS, which contains a list of
users for whom the default action is to create an entry in the UNIX utmp file for each
terminal connection. The format is:
#!UTMP-USERS
username

where username is a UNIX username.

See also
tsrv

Example
# Tsrv configuration file.  Sections in this file are introduced by '#!'
# Other lines beginning with # are comments.
# Users whose names appear (one name per line) in the UTMP-USERS section
# will have a utmp entry created for every login session.
#!UTMP-USERS
root
stevel
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vision.conf

Location
/etc/vision.conf

Description
vision.conf is the master Vision configuration file. It is an ASCII text file that can be changed
using a text editor providing you have Superuser (root) privilege. It contains entries of the
form
variable=value
where variable is a variable name, as shown below.

Variable Description

VISION_ADMINDIR Location of SuperVision files
VISION_BINDIR Location of executable files
VISION_DEBUGDIR Location of debug log files
VISION_DEPLOYDIR Location of the vision97 share. This entry is only present if the PC

parts of Vision97 have been made available using VisionFS.
VISION_DIR Base Vision directory
VISION_ETCDIR Location of miscellaneous files
VISION_EVENTDIR Location of event log files
VISION_EVENTLEVEL Level of event logging required
VISION_LOGLIMIT Maximum number of lines in a log file
VISION_MAXSESSIONS Maximum number of USP terminal connections
VISION_NAMESVC Address of master name server
VISION_NSGATEWAY Address of NSMs on other networks
VISION_TCLDIR Location of Tcl files
VISION_TCLSCRIPTDIR Location of Tcl script files
VISION_TCLINTERP Pathname of Tcl interpreter program
VISION_TMPDIR Location of temporary files
VISION_TOOLSDIR Location of the visiontools share. This entry is only present if

VisionFS is installed.



Vision97 Reference588

Example
# Vision master configuration file.
VISION_DIR=/usr/local/vision
VISION_BINDIR=/usr/local/vision/bin
VISION_ETCDIR=/usr/local/vision/etc
VISION_ADMINDIR=/usr/local/vision/admin
VISION_TMPDIR=/usr/local/vision/log
VISION_DEBUGDIR=/usr/local/vision/log
VISION_EVENTDIR=/usr/local/vision/log
VISION_EVENTLEVEL=1
VISION_MAXSESSIONS=8
VISION_LOGLIMIT=5000
VISION_TCLDIR=/usr/local/vision/tcl
VISION_TCLSCRIPTDIR=/usr/local/vision/tcl/admtasks
VISION_TCLINTERP=/usr/local/vision/bin/admsh
VISION_NAMESVC=*.16024
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visionpriv

Location
$VISION_ETCDIR/visionpriv

Description
visionpriv is the authentication database, which contains user names and permissions. It is an
ASCII text file that can be changed using a text editor providing you have Superuser (root)
privilege. Do not change the access permissions of this file. User entries in the authentication
database have the format:
user:username:permissions
where permissions is a decimal number specifying the permissions, as shown below.

Number Meaning

  0 Normal user (default)
  1 SuperVision Administrator
  2 License Administrator

The decimal numbers may be added together. For example, the following entry grants
SuperVision and License administration permissions to user �stevel�.
user:stevel:3

When Vision97 software is first installed on a UNIX system, the authentication database does
not contain any user entries. It does contain server privilege information, which should not be
altered. You only need to add entries for users requiring special permissions; if a user is not
present in the file then the default value (0) will be used.

Notes
If the Authentication Server is already running when you finish changing the file, then you
need to force it to read the information again by entering the following command at the
UNIX system prompt:
authsrv -r

You need Superuser privilege to run this command.

See also
�Authentication Overview� in the �Vision Communications Architecture� chapter.
authsrv
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vwdebuglog

Location
$VISION_DEBUGDIR/vwdebuglog

Description
vwdebuglog is a log file created by the Log Server logsrv to contain information useful for
troubleshooting. It is an ASCII text file that can be viewed using a text editor. The format of
entries is:
date  time  process_id  program_name:  function:  description

Notes
By default the maximum number of entries in a log file is 5000. This limit is specified in the
VISION_LOGLIMIT variable. When this limit is reached, the current log file is renamed,
and a new file is created.

See also
logsrv

Example
An extract from a debug log is shown below.
Aug 22 13:47:54: [12668] nsmsrv: findNS(bcast = 0)
Aug 22 13:47:54: [12668] nsmsrv: presetNS(1073760656, 0)
Aug 22 13:47:54: [12668] nsmsrv: presetNS: calling GetInetAddr(poptart)
Aug 22 13:47:54: [12668] nsmsrv: presetNS: returning 192.86.169.164 (16024)
Aug 22 13:47:54: [27169] nsmsrv: DoLookup: NS_LOOKUP ok '\\jamesw\adminsvc2' 19'
Aug 22 13:47:54: [12668] nsmsrv: usptcp_LookupUspName: (\\jamesw\adminsvc2,192.)
Aug 22 13:47:54: [12668] nsmsrv: ForwardToAgent: notifying client '\\jamesw\admk
Aug 22 13:47:55: [27169] nsmsrv: DoLookup: NS_LOOKUP ok '\\poptart\' 192.86.169
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vweventlog

Location
$VISION_EVENTDIR/vweventlog

Description
vweventlog is a log file created by the Log Server logsrv  that records all important events of
interest to the System Administrator. It is an ASCII text file that can be viewed using a text
editor. The format of entries is:
date  time  process_id  program_name:  function:  description

Notes
By default the maximum number of entries in a log file is 5000. This limit is specified in the
VISION_LOGLIMIT variable. When this limit is reached, the current log file is renamed, and
a new file is created.

See also
logsrv

Example
An extract from an event log is shown below.
Aug 14 12:23:52: [4133] workbsrv: CreateItem: Created PC Rickyd
Aug 14 12:24:05: [4133] workbsrv: SetGroupMembership: Created Group Sales
Aug 14 12:24:05: [4133] workbsrv: SetGroupMembership: Added PC Rickyd to group Sales
Aug 14 12:24:22: [4133] workbsrv: CreateItem: Created PC Sigmundd
Aug 14 12:24:34: [4133] workbsrv: BuildIndex: Indexes built, new version number is
808398979
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winsize

Location
$VISION_ETCDIR/winsize

Description
winsize is a binary terminal configuration file that is read by the Task Server tsrv. It is used on
some UNIX systems to contain the terminal Rows and Columns settings as configured by the
UNIX stty command. (On some UNIX systems, this information can be included in the
termio file and so winsize is not required.)

See also
tsrv
termio
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ComScript overview
In order to establish a link to a remote host system, Vision Communications Architecture needs
to open a physical connection, log in to the host operating system and, possibly, run a remote
program such as usputppxy, the USP proxy process. Some or all of the following parts of this
process are controlled by a Vision Communications script file, written in a language called
�ComScript.�

• Connecting to the host.
• Logging in.
• Command execution.

For USP connections, the script is used for command execution. For non-USP connections, the
script is used for logging in and command execution. For non-TAPI modem connections, the
script is used for connecting to the host, logging in, and command execution. The script file
sends a series of character strings to the remote host or terminal server as necessary. By matching
against specified character strings, the script file monitors the response from the remote
equipment in order to determine if it is appropriate to continue with the next phase of the
connection procedure. If a step fails then an appropriate error message can be issued.

The script file is also responsible for carrying out a disconnect operation when the connection is
closed.

ComScript files
Vision Communications script files are text files and may be created with a PC-based editor such
as Windows Notepad. The files do not require compilation before they may be used.

The script files have file names of the type filename.scr and they are normally stored in
C:\Program Files\Common Files\Vision\Scripts. A number of script files are provided and it may
be useful to use one of these as a starting point when creating your own script files. Alternatively,
you can use Connection Monitor to generate a completely new script (see �Generating a
ComScript File� later in this chapter).

The particular script file that is used to control the connection process depends on how the host,
or the transport used by the host, has been configured.

When configuring a transport, the Default setting means use the appropriate script file for the
protocol used by the transport (see �ComScript Files Supplied� later in this chapter). Refer to the
following table for details on the scripts used by the standard Vision Communications
Architecture transports.
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Transport Script

Local None
Modem Unixsl.scr
Serial-com1 Unixsl.scr
SPX-Unix Unixipx.scr
TCP-Unix Unix.scr
USP-TCP Unixusp.scr
Xtrace None

Note  If you have created a new transport to run USP services via a proxy, then the script
configured for the underlying transport will be used to access the proxy host and Unixusp.scr
will be used for the host on which you want to execute the command.

For a host, Default indicates that the script options specified for the transport should be used.
Any script options specified for a host will override those specified for the transport used by that
host. For example, if you want to use a different script than the one used by the transport, click
the Script tab on the relevant Host properties dialog box, click Script Options and then browse
the folders for the file.

ComScript files supplied
The following ComScript files are placed by Setup in the \Program Files\Common
Files\Vision\Scripts folder.

File Description

Unix.scr Controls the connection process to a remote UNIX host over a
TCP/IP network.

Unixipx.scr Controls the connection process to a remote Unix host over an
IPX/SPX network.

Unixusp.scr Controls the connection process to a remote UNIX host over a
TCP/IP network for a USP connection.

Unixsl.scr Controls the connection process to a remote UNIX host over a
serial line and sets up an X environment for a TCP/IP network.

Unixslsc.scr Controls the connection process to a remote SCO UNIX host over
a serial line and sets up an X environment for a TCP/IP network.
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Scripting language overview
The Vision Communications scripting language consists of a number of system-defined functions
and some simple command constructions. There are no operators available, and so most of the
functions also have a complementary function which is used when testing for failure rather than
for success.

Command structures
This section covers command structures.

IF...THEN...ELSE statement
This construction is used to allow conditional execution. The syntax for using an
IF...THEN...ELSE statement is:

IF...THEN
[ELSE]

ENDIF

The IF statement is followed either by a call to a user-defined function or by a matching
operation. Since ComScript does not support operators, the appropriate system-defined function
must be used to specify the condition depending on whether you are testing for a positive or
negative response. For example, if the THEN operation is to be undertaken when a called user-
defined function has succeeded, the function should be called using CALL. If you wish to
proceed on failure of the function it should be called using NOTCALL. A similar relationship
exists between MATCH and NOMATCH and between REMATCH and NOREMATCH.

LOOP statement
The LOOP construction is used when an action is to be performed repeatedly. The syntax for
using LOOP is:

LOOP
      [EXITLOOP]
ENDLOOP

The inclusion of an EXITLOOP statement is theoretically optional. However, it is important to
include one in order to avoid creating an infinite loop.

The use of both these constructions is illustrated in the following function which is used to
enable the user to enter a new password during the connection process.
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FUNC 'NEWPASSWORD'

TRACE( 'Entering new password' )
PASSWORD( 'Enter new password', 8 )
STATUS( 'Script', 'Entering New Password', SL_CANCEL )
SEND( '\p08\r' )
MATCH( 10, 'New Password', 'ialup', 'erm', '$', '%', '#', 'ncorrect' )

LOOP
    IF REMATCH( 'New Password' ) THEN
        PASSWORD( 'Re-enter new password', 8 )
        SEND( '\p08\r' )
        MATCH( 10, 'New Password', 'ialup', 'erm', '$', '%', '#', 'ncorrect' )
    ELSE
        IF REMATCH( 'ncorrect' ) THEN
            TRACE( 'Failed to enter new password correctly' )
            IF NOTCALL( 'SETPASSWORDERROR' ) THEN
                RETURN( 'FALSE' )
            ENDIF
        ENDIF
        EXITLOOP
    ENDIF
ENDLOOP

ENDFUNC

User-defined functions
Each script consists of a series of user-defined functions. Each function will begin with the
expression FUNC 'function-name', where function-name is the name used to refer to the
function throughout the script, and end with ENDFUNC. Which user-defined functions appear
in a script depends on what tasks the script is called upon to perform. Command execution
requires the presence of functions that must be named DOEXEC and CLOSEEXEC. Logging in
requires DOLOGIN and CLOSELOGIN. Connecting to the host requires DODIAL and
CLOSEDIAL. The former of each pair of functions will be automatically called when execution
of the script to control the particular part of the connection process that the function is
associated with begins. The latter of each pair of functions is called during the disconnect
operation. Other user-defined functions may be used to simplify the structure of a script and to
avoid the need to repeat code.
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Parameters
Up to twenty parameters may be used within a Vision Communications script. These are
identified as p00 through to p19. The value of any parameter may be set during the connection
process by calling a DIALOG or a PASSWORD function to request the necessary information
from the user. However, parameters p00 to p09 are automatically assigned the default values
shown below. Care should be taken not to change the value of one of these parameter
unintentionally.

Parameter Default Value

p00 host name
p01 username from host definition
p02 password from host definition
p03 phone number from host definition
p04 command to be sent to the remote host
p05 terminal type
p06 reset string
p07 PC's network node name
p08 PC's X Display Name
p09 PC's X Display Number

Matching strings
The Vision Communications script operates by sending strings of characters to the modem,
terminal server, or host and by evaluating the returned character strings to determine the
appropriate response.

Four functions are available for evaluating remote output. Each has a list of strings of up to 128
characters as parameters and these are matched against the character strings output remotely.
MATCH and NOMATCH test the output directly it arrives, assuming it is within the specified
timeout period. MATCH returns TRUE if there is a match in the arriving data for one of the
strings specified for the function, whereas NOMATCH returns TRUE if no match is found.

Remote output is also put into a buffer, from where it can be re-evaluated using the REMATCH
and NOREMATCH functions. These functions are used in the same way as MATCH and
NOMATCH in order to be able to test whether or not a match was found and to initiate the
appropriate response.

Note  The buffer will be flushed by a call to the DELAY or SEND function.

The following example illustrates the use of these functions to determine whether a modem
connection has been made and, if the connect has failed, to generate an appropriate error
message depending on the reason for the failure.
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; Dial the phone no
TRACE( 'Dialing the phone number' )
SEND( 'ATDT\p03\r' )
IF MATCH( 30, 'CONNECT', 'BUSY', 'NO CARRIER', 'NO DIALTONE' ) THEN
    IF NOREMATCH( 'CONNECT' ) THEN
        IF REMATCH( 'BUSY' ) THEN
            TRACE( 'BUSY' )
            ERROR( 'Line is busy' )
        ELSE IF REMATCH( 'NO DIALTONE' ) THEN
            TRACE( 'No Dialtone' )
            ERROR( 'No Dialtone' )
        ELSE
            TRACE( 'No Carrier' )
            ERROR( 'No Carrier' )
        ENDIF
        ENDIF
        RETURN( 'FALSE' )
    ENDIF
ENDIF

Comments
Comment lines can be included within a Vision Communications script. Comment text is
indicated by a semi-colon (;) and any text following this character on that line is ignored when
the script is executing.
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ComScript functions summary
The following system-defined functions are available within ComScript. The use of each function
is described in detail in the following pages.

BREAK Send a �break� signal.
CALL Call a function and test if it has succeeded.
DELAY Set a delay.
DIALOG Display a dialog box.
ERROR Set an error message.
EXECUTE Run a Windows or DOS program.
ISSET Determine if a parameter or string has a value assigned to it.
LONGBREAK Send a �long break� signal.
MATCH Match data received against specified strings.
NOMATCH Determine if there is no match of data received against specified strings.
NOREMATCH Determine if there is no match of data in the buffer against specified strings.
NOTCALL Call a function and test if it has failed.
NOTSET Determine if a parameter or string has no value assigned to it.
PASSWORD Display a dialog box. Text appearing in the text box is masked, as is

common with a password.
REMATCH Match data in the buffer against specified strings.
RETURN Return from a function call, setting the appropriate return value.
SAVEPASSWORD Update the password in the host definition.
SEND Send a string.
STATUS Set status icon and message.
TRACE Set trace message.
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BREAK function

Syntax
BREAK( )

Description
BREAK sends a communications �break� signal to the host.

See also
LONGBREAK, to send a �long break� signal.
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CALL function

Syntax
CALL('string')

Description
CALL makes a call to a function defined elsewhere in the script.
String is the name of the function to be called.

Notes
By default a called function will return a value of TRUE, indicating successful completion.

See also
NOTCALL, for how to call a function and test if it has failed.
RETURN, for how to cause an unsuccessful function to return FALSE.

Example
IF NOTCALL( 'LOGIN' ) THEN
    STATUS( 'Script', 'Failed to login, resetting', SL_NOCANCEL )
    CALL( 'HANGUP' )
    CALL( 'RESET' )
    RETURN( 'FALSE' )
ENDIF
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DELAY function

Syntax
DELAY(time)

Description
Delays for the period specified by time.
Time is given in tenths of a second.

Notes
A call to DELAY will cause any data in the buffer to be flushed.

Example
TRACE( 'Send CR to get Login Prompt' )
DELAY( 10 )
SEND( '\r\r' )
TRACE( 'Connected to remote modem' )
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DIALOG function

Syntax
DIALOG('string',parameter)

Description
DIALOG causes a dialog box to appear to prompt the user for information. This is then
assigned as the value of the specified parameter.
String is the text string to appear as the prompt in the dialog box and parameter is the
numeric identifier of the parameter to which the value entered by the user is to be assigned.

Notes
The title of the dialog box which is generated by DIALOG will be the name of the host to
which you are connecting.
String can have a maximum of 128 characters.
If a parameter currently has a value assigned, then this value will automatically appear in the
dialog box. For the parameters p00-p09 the default value will be displayed, assuming an
alternative value has not been assigned.
A dialog box created by the use of the DIALOG function will appear during the connection
process, irrespective of whether or not the Prompts box for the host is checked.

See also
PASSWORD, for how to generate a dialog box in which text entered by the user is masked by
asterisks.

Example
The following command will generate a dialog box which will ask the user for the name or IP
address of his remote host. The string entered is assigned to parameter p08.
DIALOG( 'Enter machine name or IP address', 8 )
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ERROR Function

Syntax
Error('string')

Description
ERROR sets the text of the error message to be displayed if the connection process fails at a
given point.
String is the text of the error message.

Notes
When an error occurs during the connection process a message box is displayed giving the
appropriate system-defined message. If a call to ERROR has been made at the point in the
script which caused the connection to fail, the text given as the value of string will appear in
parentheses after the system message. If ERROR is not called, then only the system message
appears in the message box.
String can have a maximum of 128 characters.

Example
ERROR( 'Login incorrect' )
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EXECUTE function

Syntax
EXECUTE('command','show-parameter')

Description
EXECUTE runs a DOS or Windows program from within the Vision Communications script.
Command is the command to be run and show-parameter is one of the constant values listed
below and is used to determine how the program should appear. When specifying the
command the full path should be given if the program is in a folder which is not in the DOS
PATH. Any backslash characters ( \ ) in the path must be protected by use of an additional \
or they will be treated as the indicator for a special character and the command will fail.

Parameter Value

SL_HIDE The program runs with the window hidden. The focus remains
unchanged.

SL_NORMAL The program runs with its normal size and position. The program
window takes the focus.

SL_MAXIMIZE The program runs as a maximized window. The program window
takes the focus.

SL_MINIMIZE The program runs as an icon. The icon takes the focus.
SL_RESTORE The program runs with its normal size and position. The program

window takes the focus.
SL_SHOW The program runs with its normal size and position. The program

window takes the focus.
SL_SHOWMAXIMIZED The program runs as a maximized window. The program window

takes the focus.
SL_SHOWMINIMIZED The program runs as an icon. The icon takes the focus.
SL_SHOWMINNOACTIVATE The program runs as an icon. The focus remains unchanged.
SL_SHOWNA The program runs with its normal size and position. The focus

remains unchanged.
SL_SHOWNOACTIVATE The program runs with its normal size and position. The focus

remains unchanged.
SL_SHOWNORMAL The program runs with its normal size and position. The program

window takes the focus.
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See also
SEND, to run a command on the remote host.

Example
The following call will run Host Explorer:
EXECUTE ('C:\\PROGRA~1\\VISION\\hostexp.exe','SL_SHOW')
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ISSET function

Syntax
ISSET('string',parameter)

Description
Returns TRUE if a value has been assigned to a specified string or parameter.
String is either of the following text strings DETACH or TTY. DETACH is used by Vision
Communications Architecture to determine whether any output generated from the host
following the execution of the command is required. TTY is used to determine whether the
connection is a terminal or non-terminal connection. Any other values specfied for string will
be ignored.
Parameter is the numeric identifier of the parameter.

See also
NOTSET, to determine if a specified string or parameter does not have a value assigned to it.

Example
The sample below shows how ISSET is used to determine if a value has been assigned to the
string TTY. If it does, then the connection is a terminal connection and any echo generated
as a result of the command being executed needs to be consumed.
IF ISSET( 'TTY' ) THEN
    ; consume the echo
    MATCH( 5, '\n' )
ENDIF
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LONGBREAK function

Syntax
LONGBREAK( )

Description
LONGBREAK sends a communications �long break� signal to the host.

See also
BREAK, to send a �break� signal.
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MATCH function

Syntax
MATCH(timeout,'string'[,'string'])

Description
MATCH will return TRUE if a string which matches one of the values of string is received
from the remote host within the time specified by timeout.
Timeout is given in seconds.

Notes
Up to nine string parameters can be specified, each with a maximum length of 128 characters.
String can include the following special characters:

Character Value

\r Carriage return
\n New line
\t Tab
\nnn nnn is the octal value of a character
\pnn nn is the numeric identifier of a connection parameter. Single digit parameter

numbers should be preceded by a leading zero, for example \p03

Note  A backslash character can be included by the use of \\.

See also
NOMATCH, to determine when a match is not found.
REMATCH, to determine if there is a match against buffered data.
NOREMATCH, to determine when there is no match against buffered data.
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Example
The sample below shows how MATCH is used in evaluating possible data returned when
entering a new password.
FUNC 'NEWPASSWORD'

TRACE( 'Entering new password' )
PASSWORD( 'Enter new password', 8 )
STATUS( 'Script', 'Entering New Password', SL_CANCEL )
SEND( '\p08\r' )
MATCH( 10, 'New Password', 'ialup', 'erm', '$', '%', '#', 'ncorrect' )

LOOP
    IF REMATCH( 'New Password' ) THEN
        PASSWORD( 'Re-enter new password', 8 )
        SEND( '\p08\r' )
        MATCH( 10, 'New Password', 'ialup', 'erm', '$', '%', '#', 'ncorrect' )
    ELSE
        IF REMATCH( 'ncorrect' ) THEN
            TRACE( 'Failed to enter new password correctly' )
            IF NOTCALL( 'SETPASSWORDERROR' ) THEN
                RETURN( 'FALSE' )
            ENDIF
        ENDIF
        EXITLOOP
    ENDIF
ENDLOOP

ENDFUNC
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NOMATCH function

Syntax
NOMATCH(timeout,'string'[,'string'])

Description
NOMATCH will return TRUE if no string matching one of the values of string is received
from the remote host within the time specified by timeout.
Timeout is given in seconds.

Notes
Up to nine string parameters can be specified, each with a maximum length of 128 characters.
String can include the following special characters:

Character Value

\r Carriage return
\n New line
\t Tab
\nnn nnn is the octal value of a character
\pnn nn is the numeric identifier of a connection parameter. Single digit parameter

numbers should be preceded by a leading zero, for example \p03

Note  A backslash character can be included by the use of \\.

See also
MATCH, to determine when a match is found.
REMATCH, to determine if there is a match against buffered data.
NOREMATCH, to determine when there is no match against buffered data.

Example
The sample below shows how NOMATCH is used to check that a modem is not responding.
IF NOMATCH( 5, 'OK' ) THEN
    TRACE( 'No response from modem' )
    ERROR( 'No response from modem' )
    RETURN( 'FALSE' )
ENDIF
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NOREMATCH function

Syntax
NOREMATCH('string'[,'string'])

Description
NOREMATCH will return TRUE if no string which matches one of the values of string is in
the buffer containing data received from the remote host.

Notes
Up to ten string parameters can be specified, each with a maximum length of 128 characters.
String can include the following special characters:

Character Value

\r Carriage return
\n New line
\t Tab
\nnn nnn is the octal value of a character
\pnn nn is the numeric identifier of a connection parameter. Single digit parameter

numbers should be preceded by a leading zero, for example \p03

Note  A backslash character can be included by the use of \\.
A call to DELAY or SEND will cause any data in the buffer to be flushed.

See also
MATCH, to determine when a match is found.
NOMATCH, to determine when a match is not found.
REMATCH, to determine when there is a match against buffered data.
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Example
The sample below shows how NOREMATCH is used in evaluating matched data returned
when initiating the login process.
; Dial the phone no
TRACE( 'Dialing the phone number' )
SEND( 'ATDT\p03\r' )
IF MATCH( 30, 'CONNECT', 'BUSY', 'NO CARRIER', 'NO DIALTONE' ) THEN
    IF NOREMATCH( 'CONNECT' ) THEN
        IF REMATCH( 'BUSY' ) THEN
            TRACE( 'BUSY' )
            ERROR( 'Line is busy' )
        ELSE IF REMATCH( 'NO DIALTONE' ) THEN
            TRACE( 'No Dialtone' )
            ERROR( 'No Dialtone' )
        ELSE
            TRACE( 'No Carrier' )
            ERROR( 'No Carrier' )
        ENDIF
        ENDIF
        RETURN( 'FALSE' )
    ENDIF
ENDIF
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NOTCALL function

Syntax
NOTCALL('string')

Description
NOTCALL returns TRUE if a call to a function defined elsewhere in the script fails.
String is the name of the function called.

Notes
By default a called function will return a value of TRUE. The RETURN function is used to
force a function which fails to return a value of FALSE.

See also
CALL, for how to call a function and test if it has succeeded.
RETURN, for how to cause an unsuccessful function to return FALSE.

Example
The following code tests if the call to the LOGIN function has failed and initiates the
appropriate response.
IF NOTCALL( 'LOGIN' ) THEN
    STATUS( 'Script', 'Failed to log in, resetting', SL_NOCANCEL )
    CALL( 'RESET' )
    RETURN( 'FALSE' )
ENDIF
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NOTSET function

Syntax
NOTSET('string',parameter)

Description
Returns TRUE if a value has not been assigned to a specified string or parameter.
String is either of the following text strings DETACH or TTY. DETACH is used by Vision
Communications Architecture to determine whether any output generated from the host
following the execution of the command is required. TTY is used to determine whether the
connection is a terminal or non-terminal connection. Any other values specfied for string will
be ignored.
Parameter is the numeric identifier of the parameter.

See also
ISSET, to determine if a specified string or parameter has a value assigned to it.

Example
The sample below shows how NOTSET is used to determine if a value has been assigned to
the parameter p02, which by default is the password.
IF NOTSET( 2 ) THEN
    PASSWORD( 'Enter your password:', 2 )
ENDIF
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PASSWORD function

Syntax
PASSWORD('string',parameter)

Description
PASSWORD causes a dialog box to appear to prompt the user for information. This is then
assigned as the value of the specified parameter. Text entered by the user will not be
displayed, each character being replaced by an asterisk.
String is the text string to appear as the prompt in the dialog box and parameter is the
numeric identifier of the parameter to which the value is to be assigned.

Notes
The title of the dialog box which is generated by PASSWORD will be the name of the host to
which you are connecting.
String can have a maximum of 128 characters.
If parameter currently has a value assigned, then this value will automatically appear in the
dialog box. For the parameters p00-p09 the default value will be displayed, assuming an
alternative value has not been assigned.
A dialog box created by the use of the PASSWORD function will appear during the
connection process, irrespective of whether or not the Prompts box for the host is checked.

See also
DIALOG, for how to generate a normal dialog box.

Example
The following command will generate a dialog box which will ask the user for a new
password. The string entered is assigned to parameter p10.
TRACE( 'Entering new password' )
PASSWORD( 'Enter new password', 10 )
STATUS( 'Script', 'Entering New Password', SL_CANCEL )
SEND( '\p10\r' )
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REMATCH function

Syntax
REMATCH('string'[,'string'])

Description
REMATCH will return TRUE if a string which matches one of the values of string is in the
buffer containing data received from the remote host.

Notes
Up to ten string parameters can be specified, each with a maximum length of 128 characters.
String can include the following special characters:

Character Value

\r Carriage return
\n New line
\t Tab
\nnn nnn is the octal value of a character
\pnn nn is the numeric identifier of a connection parameter. Single digit parameter

numbers should be preceded by a leading zero, for example \p03

Note  A backslash character can be included by the use of \\.
A call to DELAY or SEND will cause any data in the buffer to be flushed.

See also
MATCH, to determine when a match is found.
NOMATCH, to determine when a match is not found.
NOREMATCH, to determine when there is no match against buffered data.
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Example
The sample below shows how REMATCH is used to evaluate matched data returned when
initiating the login process.
TRACE( 'Logging in to remote system' )

STATUS( 'Script', 'Logging in to remote system', SL_CANCEL )

IF MATCH( 10, 'ogin', 'assword:', 'Old Password', 'New Password', 'Dialup', 'erm', '$', '%', '#' ) THEN

    ; Send user name to login prompt, then match again on possible prompts.

    IF REMATCH( 'ogin' ) THEN

        TRACE( 'Sending user name to login prompt' )

        SEND( '\p01\r' )

        MATCH( 10, 'assword:', 'Choose', 'expired', 'Dialup', 'erm', '$', '%', '#', 'ogin' )

        ; A login prompt here means login has failed.

        IF REMATCH( 'ogin' ) THEN

            TRACE( 'Login failed' )

            ERROR( 'Login failed' )

            RETURN( 'FALSE' )

        ENDIF

    ENDIF

ENDIF
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RETURN function

Syntax
RETURN('TRUE'|'FALSE')

Description
RETURN is used to return from a function call with the specified return value.

Notes
The default return value for any function is TRUE. RETURN must be used to explicitly set
the return value to FALSE if appropriate.

See also
CALL, for how to call a function and test if it has succeeded.
NOTCALL, for how to call a function and test if it has failed.

Example
The following shows how RETURN is used to set a return value to FALSE.
;
; SEND A DIALUP PASSWORD
;
FUNC 'DIALUPPASSWORD'

TRACE( 'Entering Dialup password' )
PASSWORD( 'Enter Dialup password', 9 )
SEND( '\p09\r' )
MATCH( 10, 'erm', '$', '%', '#', 'ncorrect' )

IF REMATCH( 'ncorrect' ) THEN
    TRACE( 'Failed to enter Dialup password correctly' )
    IF NOTCALL( 'SETPASSWORDERROR' ) THEN
        RETURN( 'FALSE' )
    ENDIF
ENDIF

ENDFUNC



Appendix E � ComScript 621

SAVEPASSWORD function

Syntax
SAVEPASSWORD('string1','string2')

Description
SAVEPASSWORD is used to update the password in the host definition.
String1 is the current password and string2 is the new password.

Notes
SAVEPASSWORD will not work if a host is configured to display the Prompts dialog box
during the connection process, or string1 does not match the password cuurently stored in
the host definition.
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Example
The sample below shows how SAVEPASSWORD is used to update the text string assigned to
parameter p02, the current password, with the string assigned to p09, the new password.
When the user next logs in to his remote host, the string that was entered in response to the
prompt for a new password will be loaded into parameter p02 and become the current
password.
FUNC 'NEWPASSWORD'

TRACE( 'Entering new password' )
PASSWORD( 'Enter new password', 8 )
STATUS( 'Script', 'Entering New Password', SL_CANCEL )
SEND( '\p08\r' )
MATCH( 10, 'New Password', 'ialup', 'erm', '$', '%', 'esktop', 'ncorrect', '\033' )

LOOP
    IF REMATCH( 'New Password' ) THEN
        IF NOTSET( 8 ) THEN
            PASSWORD( 'Re-enter new password', 8 )
            SEND( '\p08\r' )
        ELSE
            PASSWORD( 'Re-enter new password', 9 )
            SEND( '\p09\r' )
        END IF
        MATCH( 10, 'New Password', 'ialup', 'erm', '$', '%', 'esktop', 'ncorrect' )
    ELSE
        IF REMATCH( 'ncorrect' ) THEN
            TRACE( 'Failed to enter new password correctly' )
            IF NOTCALL( 'SETPASSWORDERROR' ) THEN
                RETURN( 'FALSE' )
            ENDIF
        ELSE
            SAVEPASSWORD( '\p02', '\p09' )
        ENDIF
        EXITLOOP
    ENDIF
ENDLOOP

ENDFUNC
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SEND function

Syntax
SEND('string')

Description
SEND is used to send a string to a modem, terminal server, or remote host.

Notes
String can include the following special characters:

Character Value

\r Carriage return
\n New line
\t Tab
\nnn nnn is the octal value of a character
\pnn nn is the numeric identifier of a connection parameter. Single digit parameter

numbers should be preceded by a leading zero, for example \p03

Note  A backslash character can be included by the use of \\.
A call to SEND will cause any data in the buffer to be flushed.

See also
EXECUTE, to run a DOS or Windows program.

Example
The following sends two carriage returns to the remote host to obtain the login prompt.
TRACE( 'Send CR to get Login Prompt' )
DELAY( 10 )
SEND( '\r\r' )
TRACE( 'Connected to remote host' )
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STATUS function

Synopsis
STATUS('icon','string',SL_CANCEL|SL_NOCANCEL)

Description
STATUS is used to specify the icon and text which will appear in the status box whilst
connection is in progress.
Icon is the identifier of one of the icons supplied with Vision Communications Architecture
and string is the text to appear in the status box.
The SL_CANCEL or SL_NOCANCEL parameter determines whether or not the Cancel button is
active or grayed.

Notes
The available icons are:

Icon Identifier

Fax

Go

Modem

Script

String can contain up to 128 characters, which can include the following special characters:

Character Value

\r Carriage return
\n New line
\t Tab
\nnn nnn is the octal value of a character
\pnn nn is the numeric identifier of a connection parameter. Single digit parameter

numbers should be preceded by a leading zero, for example \p03

Note  A backslash character can be included by the use of \\.
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The following settings are available for the cancel parameter:

Parameter Value

SL_CANCEL Cancel button active
SL_NOCANCEL Cancel button grayed

See also
TRACE, to specify additional messages to be displayed when the Trace option is enabled.

Example
STATUS( 'Script', 'Connection Opened', SL_CANCEL )



Vision97 Reference626

TRACE function

Syntax
TRACE('string')

Description
TRACE is used to set the additional messages which are displayed in the Connection Monitor
window during connection when Trace mode is selected in the Script tab.
String is the text to be displayed.

Notes
String can contain up to 128 characters, which can include the following special characters:

Character Value

\r Carriage return
\n New line
\t Tab
\nnn nnn is the octal value of a character
\pnn nn is the numeric identifier of a connection parameter. Single digit parameter

numbers should be preceded by a leading zero, for example \p03

Note  A backslash character can be included by the use of \\.

See also
STATUS, to set the icon and status messages to be displayed in the status box during
connection.

Example
TRACE( 'Opening connection' )
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Example ComScript files
Vision Communications script files are ASCII text files and may be created and modified with a
PC-based editor such as Windows Notepad. When writing your own scripts, you will often find
it useful to modify a copy of an existing script file. The dialback example uses this method.
(Refer to �ComScript Files� earlier in this chapter, to find out which script a host is using.) You
may prefer to generate a completely new script using Connection Monitor. Refer to �Generating
a Script File� later in this chapter for details.

Normally, if you are using a network you would not need to modify a script. The examples
therefore refer to a serial line connection.

Developing a ComScript file
In order to write a script you need first to determine the steps required in the parts of the
connection process that the script will be used to control. You can use the Connection Monitor
window for this purpose.

To open a manual connection

1 Do one of the following:
§ Click the Start button, point to Programs, point to Vision, and then click VT420

Emulator.
§ For older versions of Windows NT, open the Vision group in Program Manager, then

double-click the VT420 Emulator icon.
The emulator window appears on your screen.
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2 On the Session menu, click Connect.
3 In the Host box, type a host name or choose a host from the drop-down list.
4 In the Command Line box, enter the command you want to run on the host system.
5 Hold down the SHIFT key and click OK.

The Connection Monitor window appears and the connection process is halted.
6 On the Script menu, click Manual.

Now enter whatever is necessary to open a link and log in to the remote host.
7 On the Script menu, click Print.

Use this record as the basis for the content of your script.
8 On the Script menu, click Continue.

The Connection Monitor window is now hidden and control is returned to the program from
which the connection was initiated, the VT420 Emulator.

Testing with Connection Monitor
The Connection Monitor window can also be used to watch the conversation between the PC
and host system that is elicited by the execution of the script file. This can help you to determine
the point at which the connection process is failing. The ComScript file can then be modified
accordingly.

To connect automatically

1 Do one of the following:
§ Click the Start button, point to Programs, point to Vision, and then click VT420

Emulator.
§ For older versions of Windows NT, open the Vision group in Program Manager, then

double-click the VT420 Emulator icon.
The emulator window appears on your screen.

2 On the Session menu, click Connect.
3 In the Host box, type a host name or choose a host from the drop-down list.
4 In the Command Line box, enter the command you want to run on the host system.
5 Hold down the SHIFT key and click OK.

The Connection Monitor window appears and the connection process is halted.
6 On the Script menu, click Play.

You can watch the conversation as the output appears in the left side of the Connection Monitor
window. Use this to assist you in determining the point at which your script is failing.
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Generating a ComScript file
You can use Connection Monitor to generate a ComScript file for various types of connection.
For example, to generate a script for a non-TAPI modem connection to a UNIX host, follow the
instructions below. This connection requires a script file to control all parts of the connection
process (connecting, logging in, and command execution), once details relevant to one part of
the connection process have been supplied you use the Continue command to move to the next
part.

To generate a script file for a non-TAPI modem connection

1 In Connection Monitor, click the Script menu, and then click Record.
2 In the Connection Pane, type atz.

The modem should respond �OK� to this command and to the commands entered in
steps 3-5.

3 Type atv1.
4 Type atq0e1s0=0.
5 Type at.
6 Type atdt phone-number where phone-number is supplied by clicking the Send menu, then

clicking Phone Number, and then pressing RETURN.
7 When you see the CONNECT response, press RETURN.
8 On the Script menu, click Continue.
9 Log in manually to the host. Use commands on the Send menu to supply your username,

password, and terminal type as necessary.
10 To execute the shell command interpreter use:

exec command-interpreter

where command-interpreter is the command interpreter (by default the Bourne shell sh) sent
to the host by clicking the Send menu, and then clicking Command.

11 On the Script menu, click Continue.
12 At the system prompt, notify your terminal type to the host if you have not already been

required to supply this information. Use the following command for a Bourne shell:
TERM=terminal type ;export TERM

where terminal type is the terminal type sent to the host by clicking the Send menu, and then
clicking Terminal.

13 To execute the command on the host use:
exec command

where command is the command sent to the host by clicking the Send menu, and then
clicking Command.

14 On the Script menu, click Continue.
15 Click Yes when prompted to save the newly created script file. Save the file with the

extension .scr in the \Program Files\Common Files\Vision\Scripts folder.
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16 In the VT420 Emulator, click the Session menu, and then click Disconnect (if applicable).
The Connection Monitor window appears.

17 On the Script menu, click Continue. You will need to do this three times to generate
functions that perform appropriate disconnect operations for the three parts of the
connection process that this script file will control.

18 Save the changes to the script file when prompted to do so.
19 Click Yes when prompted whether the host should use the new script file.

Dialback
The following example illustrates how Unixsl.scr can be modified for use with a dialback system,
where the remote modem hangs up following a connection, and dials the modem that originated
the call back providing it is an authorized number. The example assumes that the local modem
has not been configured as a TAPI device. You may need to further modify the ComScript file to
work with your particular dialback system. For example, your dialback system may prompt
�dialback:� instead of �login:� so you would have to change the DIALBACK function
accordingly.

The DODIAL function in Unixsl.scr now contains a call to a new user-defined function,
DIALBACK. The NOTCALL function is used to call DIALBACK and test if it failed.

FUNC 'DODIAL'
    TRACE( 'DODIAL' )
    IF NOTCALL( 'MODEM' ) THEN
        RETURN( 'FALSE' )
    ENDIF
    IF NOTCALL( 'DIALBACK' ) THEN
        RETURN( 'FALSE' )
    ENDIF
ENDFUNC

If DIALBACK does fail (returns a value of 'FALSE' at any stage), RETURN is used to set the
return value of the called function (DIALBACK) to FALSE and the connection process is halted.

After the initial connection to the remote modem has been made (accomplished by MODEM), a
series of carriage returns are sent to elicit a login prompt.
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FUNC 'DIALBACK'

; Send some carriage returns to elicit a dialback login prompt. If it is not
; encountered assume that we have failed to get a dialback, and close the
; connection.
STATUS( 'Script', 'Wait for login prompt', SL_CANCEL )
SEND( '\r\r' )
IF NOMATCH( 5, 'ogin:' )
THEN
    SEND( '\r\r' )
    IF NOMATCH( 5, 'ogin:' )
    THEN
        SEND( '\r\r' )
        IF NOMATCH( 5, 'ogin:' )
        THEN
            ERROR( 'No login prompt' )
            RETURN( 'FALSE' )
        ENDIF
    ENDIF
ENDIF

TRACE( 'Dealing with the dialback system' )
STATUS( 'Script', 'Dealing with the dialback system', SL_CANCEL )

If, after the third pair of carriage returns has been sent, there is still no dialback login prompt, an
appropriate error message is generated and a value of FALSE is returned.

The user is prompted for his dialback username and password which are then sent to their
respective prompts.

; Send dialback username to dialback prompt, then match again on
; possible prompts
IF REMATCH( 'ogin' ) THEN
    DIALOG( 'Enter dialback username', 13 )
    TRACE( 'Sending dialback username to login prompt' )
    SEND( '\p13\r' )
    MATCH( 10, 'assword:', 'ogin' )
     ; A login prompt here means login has failed
    IF REMATCH( 'ogin' ) THEN
        TRACE( 'Initial connection failed' )
        ERROR( 'Initial connection failed' )
        RETURN( 'FALSE' )
    ENDIF
ENDIF

; Send dialback password to password prompt
IF REMATCH( 'assword:' ) THEN
    DIALOG( 'Enter dialback password', 14 )
    TRACE( 'Sending password to password prompt' )
    SEND( '\p14\r' )
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If the local modem detects that the remote modem is calling it, a RING response will be echoed
to the PC. If this is the case, the A command (prefixed by AT to indicate to the modem that
subsequent characters are commands not data) is used to answer the incoming call.

        ; Wait for the modem to dial back, and answer it
        MATCH( 30, 'RING' )
        IF REMATCH( 'RING' ) THEN
            SEND( 'ATA' )

Finally, if a data connection is established between the two modems, a CONNECT response is
echoed to the PC. If this result code is not received, the appropriate error message is displayed.

            ; If we don't get a "CONNECT" prompt, the modems have failed to
            ; synchronize on dialback
            MATCH( 10, 'ONNECT' )
            IF NOREMATCH ( 'ONNECT' ) THEN
                TRACE( 'PC failed to answer callback' )
                ERROR ( 'PC failed to answer callback' )
                RETURN( 'FALSE' )
                ENDIF
            ELSE
                TRACE( 'Unix system failed to call PC' )
                ERROR( 'Unix system failed to call PC' )
                RETURN( 'FALSE' )
                ENDIF
            ELSE
                TRACE( 'No password prompt' )
                ERROR( 'No password prompt' )
                RETURN( 'FALSE' )
            ENDIF

            TRACE( 'Dialback succeeded' )

            ENDFUNC
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Miscellany
BackSpace 0xFF08  /* back space, back char */
Tab 0xFF09
Linefeed 0xFF0A  /* Linefeed, LF */
Clear 0xFF0B
Return 0xFF0D  /* Return, enter */
Pause 0xFF13  /* Pause, hold */
Scroll_Lock 0xFF14
Escape 0xFF1B
Delete 0xFFFF  /* Delete, rubout */
Multi_key 0xFF20  /* Multi-key character compose */
Kanji 0xFF21  /* Kanji, Kanji convert */
Muhenkan 0xFF22  /* Cancel Conversion */
Henkan_Mode 0xFF23  /* Start/Stop Conversion */
Henkan 0xFF23  /* Alias for Henkan_Mode */
Romaji 0xFF24  /* to Romaji */
Hiragana 0xFF25  /* to Hiragana */
Katakana 0xFF26  /* to Katakana */
Hiragana_Katakana 0xFF27
Zenkaku 0xFF28  /* to Zenkaku */
Hankaku 0xFF29  /* to Hankaku */
Zenkaku_Hankaku 0xFF2A
Touroku 0xFF2B  /* Add to Dictionary */
Massyo 0xFF2C  /* Delete from Dictionary */
Kana_Lock 0xFF2D  /* Kana Lock */
Kana_Shift 0xFF2E  /* Kana Shift */
Eisu_Shift 0xFF2F  /* Alphanumeric Shift */
Eisu_toggle 0xFF30  /* Alphanumeric toggle */
Home 0xFF50
Left 0xFF51  /* Move left, left arrow */
Up 0xFF52  /* Move up, up arrow */
Right 0xFF53  /* Move right, right arrow */
Down 0xFF54  /* Move down, down arrow */
Prior 0xFF55  /* Prior, previous */
Next 0xFF56  /* Next */
End 0xFF57  /* EOL */
Begin 0xFF58  /* BOL */
Select 0xFF60  /* Select, mark */
Print 0xFF61
Execute 0xFF62  /* Execute, run, do */
Insert 0xFF63  /* Insert, insert here */
Undo 0xFF65  /* Undo, oops */
Redo 0xFF66  /* redo, again */
Menu 0xFF67
Find 0xFF68  /* Find, search */
Cancel 0xFF69  /*Cancel, stop, abort, exit*/
Help 0xFF6A  /* Help, ? */
Break 0xFF6B
Mode_switch 0xFF7E  /* Character set switch */
script_switch 0xFF7E  /* Alias for mode_switch*/
Num_Lock 0xFF7F
KP_Space 0xFF80  /* space */

KP_Tab 0xFF89
KP_Enter 0xFF8D  /* enter */
KP_F1 0xFF91  /* PF1, KP_A, ... */
KP_F2 0xFF92
KP_F3 0xFF93
KP_F4 0xFF94
KP_Equal 0xFFBD  /* equals */
KP_Multiply 0xFFAA
KP_Add 0xFFAB
KP_Separator 0xFFAC  /* separator, often comma */
KP_Subtract 0xFFAD
KP_Decimal 0xFFAE
KP_Divide 0xFFAF
KP_0 0xFFB0
KP_1 0xFFB1
KP_2 0xFFB2
KP_3 0xFFB3
KP_4 0xFFB4
KP_5 0xFFB5
KP_6 0xFFB6
KP_7 0xFFB7
KP_8 0xFFB8
KP_9 0xFFB9
F1 0xFFBE
F2 0xFFBF
F3 0xFFC0
F4 0xFFC1
F5 0xFFC2
F6 0xFFC3
F7 0xFFC4
F8 0xFFC5
F9 0xFFC6
F10 0xFFC7
F11 0xFFC8
L1 0xFFC8
F12 0xFFC9
L2 0xFFC9
F13 0xFFCA
L3 0xFFCA
F14 0xFFCB
L4 0xFFCB
F15 0xFFCC
L5 0xFFCC
F16 0xFFCD
L6 0xFFCD
F17 0xFFCE
L7 0xFFCE
F18 0xFFCF
L8 0xFFCF
F19 0xFFD0
L9 0xFFD0
F20 0xFFD1
L10 0xFFD1
F21 0xFFD2
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R1 0xFFD2
F22 0xFFD3
R2 0xFFD3
F23 0xFFD4
R3 0xFFD4
F24 0xFFD5
R4 0xFFD5
F25 0xFFD6
R5 0xFFD6
F26 0xFFD7
R6 0xFFD7
F27 0xFFD8
R7 0xFFD8
F28 0xFFD9
R8 0xFFD9
F29 0xFFDA
R9 0xFFDA
F30 0xFFDB
R10 0xFFDB
F31 0xFFDC
R11 0xFFDC
F32 0xFFDD
R12 0xFFDD
R13 0xFFDE
F33 0xFFDE
F34 0xFFDF
R14 0xFFDF
F35 0xFFE0
R15 0xFFE0
Shift_L 0xFFE1  /* Left shift */
Shift_R 0xFFE2  /* Right shift */
Control_L 0xFFE3  /* Left control */
Control_R 0xFFE4  /* Right control */
Caps_Lock 0xFFE5  /* Caps lock */
Shift_Lock 0xFFE6  /* Shift lock */
Meta_L 0xFFE7  /* Left meta */
Meta_R 0xFFE8  /* Right meta */
Alt_L 0xFFE9  /* Left alt */
Alt_R 0xFFEA  /* Right alt */
Super_L 0xFFEB  /* Left super */
Super_R 0xFFEC  /* Right super */
Hyper_L 0xFFED  /* Left hyper */
Hyper_R 0xFFEE  /* Right hyper */

Latin1
space 0x020
exclam 0x021
quotedbl 0x022
numbersign 0x023
dollar 0x024
percent 0x025

ampersand 0x026
apostrophe 0x027
quoteright 0x027    /* deprecated */
parenleft 0x028
parenright 0x029
asterisk 0x02a
plus 0x02b
comma 0x02c
minus 0x02d
period 0x02e
slash 0x02f
0 0x030
1 0x031
2 0x032
3 0x033
4 0x034
5 0x035
6 0x036
7 0x037
8 0x038
9 0x039
colon 0x03a
semicolon 0x03b
less 0x03c
equal 0x03d
greater 0x03e
question 0x03f
at 0x040
A 0x041
B 0x042
C 0x043
D 0x044
E 0x045
F 0x046
G 0x047
H 0x048
I 0x049
J 0x04a
K 0x04b
L 0x04c
M 0x04d
N 0x04e
O 0x04f
P 0x050
Q 0x051
R 0x052
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S 0x053
T 0x054
U 0x055
V 0x056
W 0x057
X 0x058
Y 0x059
Z 0x05a
bracketleft 0x05b
backslash 0x05c
bracketright 0x05d
asciicircum 0x05e
underscore 0x05f
grave 0x060
quoteleft 0x060    /* deprecated */
a 0x061
b 0x062
c 0x063
d 0x064
e 0x065
f 0x066
g 0x067
h 0x068
i 0x069
j 0x06a
k 0x06b
l 0x06c
m 0x06d
n 0x06e
o 0x06f
p 0x070
q 0x071
r 0x072
s 0x073
t 0x074
u 0x075
v 0x076
w 0x077
x 0x078
y 0x079
z 0x07a
braceleft 0x07b
bar 0x07c
braceright 0x07d
asciitilde 0x07e
nobreakspace 0x0a0

exclamdown 0x0a1
cent 0x0a2
sterling 0x0a3
currency 0x0a4
yen 0x0a5
brokenbar 0x0a6
section 0x0a7
diaeresis 0x0a8
copyright 0x0a9
ordfeminine 0x0aa
guillemotleft 0x0ab  /* left angle quotation mark*/
notsign 0x0ac
hyphen 0x0ad
registered 0x0ae
macron 0x0af
degree 0x0b0
plusminus 0x0b1
twosuperior 0x0b2
threesuperior 0x0b3
acute 0x0b4
mu 0x0b5
paragraph 0x0b6
periodcentered 0x0b7
cedilla 0x0b8
onesuperior 0x0b9
masculine 0x0ba
guillemotright 0x0bc
onehalf 0x0bd
threequarters 0x0be
questiondown 0x0bf
Agrave 0x0c0
Aacute 0x0c1
Acircumflex 0x0c2
Atilde 0x0c3
Adiaeresis 0x0c4
Aring 0x0c5
AE 0x0c6
Ccedilla 0x0c7
Egrave 0x0c8
Eacute 0x0c9
Ecircumflex 0x0ca
Ediaeresis 0x0cb
Igrave 0x0cc
Iacute 0x0cd
Icircumflex 0x0ce
Idiaeresis 0x0cf
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ETH 0x0d0
Eth 0x0d0    /* deprecated */
Ntilde 0x0d1
Ograve 0x0d2
Oacute 0x0d3
Ocircumflex 0x0d4
Otilde 0x0d5
Odiaeresis 0x0d6
multiply 0x0d7
Ooblique 0x0d8
Ugrave 0x0d9
Uacute 0x0da
Ucircumflex 0x0db
Udiaeresis 0x0dc
Yacute 0x0dd
THORN 0x0de
Thorn 0x0de    /* deprecated */
ssharp 0x0df
agrave 0x0e0
aacute 0x0e1
acircumflex 0x0e2
atilde 0x0e3
adiaeresis 0x0e4
aring 0x0e5
ae 0x0e6
ccedilla 0x0e7
egrave 0x0e8
eacute 0x0e9
ecircumflex 0x0ea
ediaeresis 0x0eb
igrave 0x0ec
iacute 0x0ed
icircumflex 0x0ee
idiaeresis 0x0ef
eth 0x0f0
ntilde 0x0f1
ograve 0x0f2
oacute 0x0f3
ocircumflex 0x0f4
otilde 0x0f5
odiaeresis 0x0f6
division 0x0f7
oslash 0x0f8
ugrave 0x0f9
uacute 0x0fa
ucircumflex 0x0fb

udiaeresis 0x0fc
yacute 0x0fd
thorn 0x0fe
ydiaeresis 0x0ff

Latin2
Aogonek 0x1a1
breve 0x1a2
Lstroke 0x1a3
Lcaron 0x1a5
Sacute 0x1a6
Scaron 0x1a9
Scedilla 0x1aa
Tcaron 0x1ab
Zacute 0x1ac
Zcaron 0x1ae
Zabovedot 0x1af
aogonek 0x1b1
ogonek 0x1b2
lstroke 0x1b3
lcaron 0x1b5
sacute 0x1b6
caron 0x1b7
scaron 0x1b9
scedilla 0x1ba
tcaron 0x1bb
zacute 0x1bc
doubleacute 0x1bd
zcaron 0x1be
zabovedot 0x1bf
Racute 0x1c0
Abreve 0x1c3
Lacute 0x1c5
Cacute 0x1c6
Ccaron 0x1c8
Eogonek 0x1ca
Ecaron 0x1cc
Dcaron 0x1cf
Dstroke 0x1d0
Nacute 0x1d1
Ncaron 0x1d2
Odoubleacute 0x1d5
Rcaron 0x1d8
Uring 0x1d9
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Udoubleacute 0x1db
Tcedilla 0x1de
racute 0x1e0
abreve 0x1e3
lacute 0x1e5
cacute 0x1e6
ccaron 0x1e8
eogonek 0x1ea
ecaron 0x1ec
dcaron 0x1ef
dstroke 0x1f0
nacute 0x1f1
ncaron 0x1f2
odoubleacute 0x1f5
udoubleacute 0x1fb
rcaron 0x1f8
uring 0x1f9
tcedilla 0x1fe
abovedot 0x1ff

Latin3
Hstroke 0x2a1
Hcircumflex 0x2a6
Iabovedot 0x2a9
Gbreve 0x2ab
Jcircumflex 0x2ac
hstroke 0x2b1
hcircumflex 0x2b6
idotless 0x2b9
gbreve 0x2bb
jcircumflex 0x2bc
Cabovedot 0x2c5
Ccircumflex 0x2c6
Gabovedot 0x2d5
Gcircumflex 0x2d8
Ubreve 0x2dd
Scircumflex 0x2de
cabovedot 0x2e5
ccircumflex 0x2e6
gabovedot 0x2f5
gcircumflex 0x2f8
ubreve 0x2fd
scircumflex 0x2fe

Latin4
kra 0x3a2
kappa 0x3a2    /* deprecated */
Rcedilla 0x3a3
Itilde 0x3a5
Lcedilla 0x3a6
Emacron 0x3aa
Gcedilla 0x3ab
Tslash 0x3ac
rcedilla 0x3b3
itilde 0x3b5
lcedilla 0x3b6
emacron 0x3ba
gcedilla 0x3bb
tslash 0x3bc
ENG 0x3bd
eng 0x3bf
Amacron 0x3c0
Iogonek 0x3c7
Eabovedot 0x3cc
Imacron 0x3cf
Ncedilla 0x3d1
Omacron 0x3d2
Kcedilla 0x3d3
Uogonek 0x3d9
Utilde 0x3dd
Umacron 0x3de
amacron 0x3e0
iogonek 0x3e7
eabovedot 0x3ec
imacron 0x3ef
ncedilla 0x3f1
omacron 0x3f2
kcedilla 0x3f3
uogonek 0x3f9
utilde 0x3fd
umacron 0x3fe

Katakana
overline 0x47e
kana_fullstop 0x4a1
kana_openingbracket 0x4a2
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kana_closingbracket 0x4a3
kana_comma 0x4a4
kana_conjunctive 0x4a5
kana_middledot 0x4a5 /* deprecated */
kana_WO 0x4a6
kana_a 0x4a7
kana_i 0x4a8
kana_u 0x4a9
kana_e 0x4aa
kana_o 0x4ab
kana_ya 0x4ac
kana_yu 0x4ad
kana_yo 0x4ae
kana_tsu 0x4af
kana_tu 0x4af  /* deprecated */
prolongedsound 0x4b0
kana_A 0x4b1
kana_I 0x4b2
kana_U 0x4b3
kana_E 0x4b4
kana_O 0x4b5
kana_KA 0x4b6
kana_KI 0x4b7
kana_KU 0x4b8
kana_KE 0x4b9
kana_KO 0x4ba
kana_SA 0x4bb
kana_SHI 0x4bc
kana_SU 0x4bd
kana_SE 0x4be
kana_SO 0x4bf
kana_TA 0x4c0
kana_CHI 0x4c1
kana_TI 0x4c1  /* deprecated */
kana_TSU 0x4c2
kana_TU 0x4c2  /* deprecated */
kana_TE 0x4c3
kana_TO 0x4c4
kana_NA 0x4c5
kana_NI 0x4c6
kana_NU 0x4c7
kana_NE 0x4c8
kana_NO 0x4c9
kana_HA 0x4ca
kana_HI 0x4cb
kana_FU 0x4cc
kana_HU 0x4cc  /* deprecated */
kana_HE 0x4cd
kana_HO 0x4ce
kana_MA 0x4cf

kana_MI 0x4d0
kana_MU 0x4d1
kana_ME 0x4d2
kana_MO 0x4d3
kana_YA 0x4d4
kana_YU 0x4d5
kana_YO 0x4d6
kana_RA 0x4d7
kana_RI 0x4d8
kana_RU 0x4d9
kana_RE 0x4da
kana_RO 0x4db
kana_WA 0x4dc
kana_N 0x4dd
voicedsound 0x4de
semivoicedsound 0x4df
kana_switch 0xFF7E  /* Alias for

mode_switch */

Arabic
Arabic_comma 0x5ac
Arabic_semicolon 0x5bb
Arabic_question_mark 0x5bf
Arabic_hamza 0x5c1
Arabic_maddaonalef 0x5c2
Arabic_hamzaonalef 0x5c3
Arabic_hamzaonwaw 0x5c4
Arabic_hamzaunderalef 0x5c5
Arabic_hamzaonyeh 0x5c6
Arabic_alef 0x5c7
Arabic_beh 0x5c8
Arabic_tehmarbuta 0x5c9
Arabic_teh 0x5ca
Arabic_theh 0x5cb
Arabic_jeem 0x5cc
Arabic_hah 0x5cd
Arabic_khah 0x5ce
Arabic_dal 0x5cf
Arabic_thal 0x5d0
Arabic_ra 0x5d1
Arabic_zain 0x5d2
Arabic_seen 0x5d3
Arabic_sheen 0x5d4
Arabic_sad 0x5d5
Arabic_dad 0x5d6
Arabic_tah 0x5d7
Arabic_zah 0x5d8
Arabic_ain 0x5d9
Arabic_ghain 0x5da
Arabic_tatweel 0x5e0
Arabic_feh 0x5e1
Arabic_qaf 0x5e2
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Arabic_kaf 0x5e3
Arabic_lam 0x5e4
Arabic_meem 0x5e5
Arabic_noon 0x5e6
Arabic_ha 0x5e7
Arabic_heh 0x5e7  /* deprecated */
Arabic_waw 0x5e8
Arabic_alefmaksura 0x5e9
Arabic_yeh 0x5ea
Arabic_fathatan 0x5eb
Arabic_dammatan 0x5ec
Arabic_kasratan 0x5ed
Arabic_fatha 0x5ee
Arabic_damma 0x5ef
Arabic_kasra 0x5f0
Arabic_shadda 0x5f1
Arabic_sukun 0x5f2
Arabic_switch 0xFF7E  /* Alias for

mode_switch */

Cyrillic
Serbian_dje 0x6a1
Macedonia_gje 0x6a2
Cyrillic_io 0x6a3
Ukrainian_ie 0x6a4
Ukranian_je 0x6a4  /* deprecated */
Macedonia_dse 0x6a5
Ukrainian_i 0x6a6
Ukranian_i 0x6a6  /* deprecated */
Ukrainian_yi 0x6a7
Ukranian_yi 0x6a7  /* deprecated */
Cyrillic_je 0x6a8
Serbian_je 0x6a8  /* deprecated */
Cyrillic_lje 0x6a9
Serbian_lje 0x6a9  /* deprecated */
Cyrillic_nje 0x6aa
Serbian_nje 0x6aa  /* deprecated */
Serbian_tshe 0x6ab
Macedonia_kje 0x6ac
Byelorussian_shortu 0x6ae
Cyrillic_dzhe 0x6af
Serbian_dze 0x6af  /* deprecated */
numerosign 0x6b0
Serbian_DJE 0x6b1
Macedonia_GJE 0x6b2
Cyrillic_IO 0x6b3
Ukrainian_IE 0x6b4
Ukranian_JE 0x6b4  /* deprecated */
Macedonia_DSE 0x6b5
Ukrainian_I 0x6b6
Ukranian_I 0x6b6  /* deprecated */
Ukrainian_YI 0x6b7

Ukranian_YI 0x6b7  /* deprecated */
Cyrillic_JE 0x6b8
Serbian_JE 0x6b8  /* deprecated */
Cyrillic_LJE 0x6b9
Serbian_LJE 0x6b9  /* deprecated */
Cyrillic_NJE 0x6ba
Serbian_NJE 0x6ba  /* deprecated */
Serbian_TSHE 0x6bb
Macedonia_KJE 0x6bc
Byelorussian_SHORTU 0x6be
Cyrillic_DZHE 0x6bf
Serbian_DZE 0x6bf  /* deprecated */
Cyrillic_yu 0x6c0
Cyrillic_a 0x6c1
Cyrillic_be 0x6c2
Cyrillic_tse 0x6c3
Cyrillic_de 0x6c4
Cyrillic_ie 0x6c5
Cyrillic_ef 0x6c6
Cyrillic_ghe 0x6c7
Cyrillic_ha 0x6c8
Cyrillic_i 0x6c9
Cyrillic_shorti 0x6ca
Cyrillic_ka 0x6cb
Cyrillic_el 0x6cc
Cyrillic_em 0x6cd
Cyrillic_en 0x6ce
Cyrillic_o 0x6cf
Cyrillic_pe 0x6d0
Cyrillic_ya 0x6d1
Cyrillic_er 0x6d2
Cyrillic_es 0x6d3
Cyrillic_te 0x6d4
Cyrillic_u 0x6d5
Cyrillic_zhe 0x6d6
Cyrillic_ve 0x6d7
Cyrillic_softsign 0x6d8
Cyrillic_yeru 0x6d9
Cyrillic_ze 0x6da
Cyrillic_sha 0x6db
Cyrillic_e 0x6dc
Cyrillic_shcha 0x6dd
Cyrillic_che 0x6de
Cyrillic_hardsign 0x6df
Cyrillic_YU 0x6e0
Cyrillic_A 0x6e1
Cyrillic_BE 0x6e2
Cyrillic_TSE 0x6e3
Cyrillic_DE 0x6e4
Cyrillic_IE 0x6e5
Cyrillic_EF 0x6e6
Cyrillic_GHE 0x6e7
Cyrillic_HA 0x6e8
Cyrillic_I 0x6e9
Cyrillic_SHORTI 0x6ea
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Cyrillic_KA 0x6eb
Cyrillic_EL 0x6ec
Cyrillic_EM 0x6ed
Cyrillic_EN 0x6ee
Cyrillic_O 0x6ef
Cyrillic_PE 0x6f0
Cyrillic_YA 0x6f1
Cyrillic_ER 0x6f2
Cyrillic_ES 0x6f3
Cyrillic_TE 0x6f4
Cyrillic_U 0x6f5
Cyrillic_ZHE 0x6f6
Cyrillic_VE 0x6f7
Cyrillic_SOFTSIGN 0x6f8
Cyrillic_YERU 0x6f9
Cyrillic_ZE 0x6fa
Cyrillic_SHA 0x6fb
Cyrillic_E 0x6fc
Cyrillic_SHCHA 0x6fd
Cyrillic_CHE 0x6fe
Cyrillic_HARDSIGN 0x6ff

Greek
Greek_ALPHAaccent 0x7a1
Greek_EPSILONaccent 0x7a2
Greek_ETAaccent 0x7a3
Greek_IOTAaccent 0x7a4
Greek_IOTAdiaeresis 0x7a5
Greek_OMICRONaccent 0x7a7
Greek_UPSILONaccent 0x7a8
Greek_UPSILONdieresis 0x7a9
Greek_OMEGAaccent 0x7ab
Greek_accentdieresis 0x7ae
Greek_horizbar 0x7af
Greek_alphaaccent 0x7b1
Greek_epsilonaccent 0x7b2
Greek_etaaccent 0x7b3
Greek_iotaaccent 0x7b4
Greek_iotadieresis 0x7b5
Greek_iotaaccentdieresis 0x7b6
Greek_omicronaccent 0x7b7
Greek_upsilonaccent 0x7b8
Greek_upsilondieresis 0x7b9
Greek_upsilonaccentdieresis 0x7ba
Greek_omegaaccent 0x7bb
Greek_ALPHA 0x7c1
Greek_BETA 0x7c2
Greek_GAMMA 0x7c3
Greek_DELTA 0x7c4
Greek_EPSILON 0x7c5
Greek_ZETA 0x7c6
Greek_ETA 0x7c7

Greek_THETA 0x7c8
Greek_IOTA 0x7c9
Greek_KAPPA 0x7ca
Greek_LAMDA 0x7cb
Greek_LAMBDA 0x7cb
Greek_MU 0x7cc
Greek_NU 0x7cd
Greek_XI 0x7ce
Greek_OMICRON 0x7cf
Greek_PI 0x7d0
Greek_RHO 0x7d1
Greek_SIGMA 0x7d2
Greek_TAU 0x7d4
Greek_UPSILON 0x7d5
Greek_PHI 0x7d6
Greek_CHI 0x7d7
Greek_PSI 0x7d8
Greek_OMEGA 0x7d9
Greek_alpha 0x7e1
Greek_beta 0x7e2
Greek_gamma 0x7e3
Greek_delta 0x7e4
Greek_epsilon 0x7e5
Greek_zeta 0x7e6
Greek_eta 0x7e7
Greek_theta 0x7e8
Greek_iota 0x7e9
Greek_kappa 0x7ea
Greek_lamda 0x7eb
Greek_lambda 0x7eb
Greek_mu 0x7ec
Greek_nu 0x7ed
Greek_xi 0x7ee
Greek_omicron 0x7ef
Greek_pi 0x7f0
Greek_rho 0x7f1
Greek_sigma 0x7f2
Greek_finalsmallsigma 0x7f3
Greek_tau 0x7f4
Greek_upsilon 0x7f5
Greek_phi 0x7f6
Greek_chi 0x7f7
Greek_psi 0x7f8
Greek_omega 0x7f9
Greek_switch 0xFF7E  /* Alias for

mode_switch */

Technical
leftradical 0x8a1
topleftradical 0x8a2
horizconnector 0x8a3
topintegral 0x8a4
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botintegral 0x8a5
vertconnector 0x8a6
topleftsqbracket 0x8a7
botleftsqbracket 0x8a8
toprightsqbracket 0x8a9
botrightsqbracket 0x8aa
topleftparens 0x8ab
botleftparens 0x8ac
toprightparens 0x8ad
botrightparens 0x8ae
leftmiddlecurlybrace 0x8af
rightmiddlecurlybrace 0x8b0
topleftsummation 0x8b1
botleftsummation 0x8b2
topvertsummationconnector 0x8b3
botvertsummationconnector 0x8b4
toprightsummation 0x8b5
botrightsummation 0x8b6
rightmiddlesummation 0x8b7
lessthanequal 0x8bc
notequal 0x8bd
greaterthanequal 0x8be
integral 0x8bf
therefore 0x8c0
variation 0x8c1
infinity 0x8c2
nabla 0x8c5
approximate 0x8c8
similarequal 0x8c9
ifonlyif 0x8cd
implies 0x8ce
identical 0x8cf
radical 0x8d6
includedin 0x8da
includes 0x8db
intersection 0x8dc
union 0x8dd
logicaland 0x8de
logicalor 0x8df
partialderivative 0x8ef
function 0x8f6
leftarrow 0x8fb
uparrow 0x8fc
rightarrow 0x8fd
downarrow 0x8fe

Special
blank 0x9df
soliddiamond 0x9e0
checkerboard 0x9e1
ht 0x9e2
ff 0x9e3

cr 0x9e4
lf 0x9e5
nl 0x9e8
vt 0x9e9
lowrightcorner 0x9ea
uprightcorner 0x9eb
upleftcorner 0x9ec
lowleftcorner 0x9ed
crossinglines 0x9ee
horizlinescan1 0x9ef
horizlinescan3 0x9f0
horizlinescan5 0x9f1
horizlinescan7 0x9f2
horizlinescan9 0x9f3
leftt 0x9f4
rightt 0x9f5
bott 0x9f6
topt 0x9f7
vertbar 0x9f8

Publishing
emspace 0xaa1
enspace 0xaa2
em3space 0xaa3
em4space 0xaa4
digitspace 0xaa5
punctspace 0xaa6
thinspace 0xaa7
hairspace 0xaa8
emdash 0xaa9
endash 0xaaa
signifblank 0xaac
ellipsis 0xaae
doubbaselinedot 0xaaf
onethird 0xab0
twothirds 0xab1
onefifth 0xab2
twofifths 0xab3
threefifths 0xab4
fourfifths 0xab5
onesixth 0xab6
fivesixths 0xab7
careof 0xab8
figdash 0xabb
leftanglebracket 0xabc
decimalpoint 0xabd
rightanglebracket 0xabe
marker 0xabf
oneeighth 0xac3
threeeighths 0xac4
fiveeighths 0xac5
seveneighths 0xac6
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trademark 0xac9
signaturemark 0xaca
trademarkincircle 0xacb
leftopentriangle 0xacc
rightopentriangle 0xacd
emopencircle 0xace
emopenrectangle 0xacf
leftsinglequotemark 0xad0
rightsinglequotemark 0xad1
leftdoublequotemark 0xad2
rightdoublequotemark 0xad3
prescription 0xad4
minutes 0xad6
seconds 0xad7
latincross 0xad9
hexagram 0xada
filledrectbullet 0xadb
filledlefttribullet 0xadc
filledrighttribullet 0xadd
emfilledcircle 0xade
emfilledrect 0xadf
enopencircbullet 0xae0
enopensquarebullet 0xae1
openrectbullet 0xae2
opentribulletup 0xae3
opentribulletdown 0xae4
openstar 0xae5
enfilledcircbullet 0xae6
enfilledsqbullet 0xae7
filledtribulletup 0xae8
filledtribulletdown 0xae9
leftpointer 0xaea
rightpointer 0xaeb
club 0xaec
diamond 0xaed
heart 0xaee
maltesecross 0xaf0
dagger 0xaf1
doubledagger 0xaf2
checkmark 0xaf3
ballotcross 0xaf4
musicalsharp 0xaf5
musicalflat 0xaf6
malesymbol 0xaf7
femalesymbol 0xaf8
telephone 0xaf9
telephonerecorder 0xafa
phonographcopyright 0xafb
caret 0xafc
singlelowquotemark 0xafd
doublelowquotemark 0xafe
cursor 0xaff

APL
leftcaret 0xba3
rightcaret 0xba6
downcaret 0xba8
upcaret 0xba9
overbar 0xbc0
downtack 0xbc2
upshoe 0xbc3
downstile 0xbc4
underbar 0xbc6
jot 0xbca
quad 0xbcc
uptack 0xbce
circle 0xbcf
upstile 0xbd3
downshoe 0xbd6
rightshoe 0xbd8
leftshoe 0xbda
lefttack 0xbdc
righttack 0xbfc

Hebrew
hebrew_doublelowline 0xcdf
hebrew_aleph 0xce0
hebrew_bet 0xce1
hebrew_beth 0xce1  /* deprecated */
hebrew_gimel 0xce2
hebrew_gimmel 0xce2  /* deprecated */
hebrew_dalet 0xce3
hebrew_daleth 0xce3  /* deprecated */
hebrew_he 0xce4
hebrew_waw 0xce5
hebrew_zain 0xce6
hebrew_zayin 0xce6  /* deprecated */
hebrew_chet 0xce7
hebrew_het 0xce7  /* deprecated */
hebrew_tet 0xce8
hebrew_teth 0xce8  /* deprecated */
hebrew_yod 0xce9
hebrew_finalkaph 0xcea
hebrew_kaph 0xceb
hebrew_lamed 0xcec
hebrew_finalmem 0xced
hebrew_mem 0xcee
hebrew_finalnun 0xcef
hebrew_nun 0xcf0
hebrew_samech 0xcf1
hebrew_samekh 0xcf1 /* deprecated */
hebrew_ayin 0xcf2
hebrew_finalpe 0xcf3
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hebrew_pe 0xcf4
hebrew_finalzade 0xcf5
hebrew_finalzadi 0xcf5 /* deprecated */
hebrew_zade 0xcf6
hebrew_zadi 0xcf6  /* deprecated */
hebrew_qoph 0xcf7
hebrew_kuf 0xcf7  /* deprecated */
hebrew_resh 0xcf8
hebrew_shin 0xcf9
hebrew_taw 0xcfa
hebrew_taf 0xcfa  /* deprecated */
Hebrew_switch 0xFF7E  /* Alias for

mode_switch */

XKeysymDB
hpmute_grave 0x100000A9
hpmute_asciicircum 0x100000AA
hpmute_diaeresis 0x100000AB
hpmute_asciitilde 0x100000AC
hplira 0x100000AF
hpguilder 0x100000BE
hpYdiaeresis 0x100000EE
hpIO 0x100000EE
hplongminus 0x100000F6
hpblock 0x100000FC
apLineDel 0x1000FF00
apCharDel 0x1000FF01
apCopy 0x1000FF02
apCut 0x1000FF03
apPaste 0x1000FF04
apMove 0x1000FF05
apGrow 0x1000FF06
apCmd 0x1000FF07
apShell 0x1000FF08
apLeftBar 0x1000FF09
apRightBar 0x1000FF0A
apLeftBox 0x1000FF0B
apRightBox 0x1000FF0C
apUpBox 0x1000FF0D
apDownBox 0x1000FF0E
apPop 0x1000FF0F
apRead 0x1000FF10
apEdit 0x1000FF11
apSave 0x1000FF12
apExit 0x1000FF13
apRepeat 0x1000FF14
hpModelock1 0x1000FF48
hpModelock2 0x1000FF49
hpReset 0x1000FF6C
hpSystem 0x1000FF6D
hpUser 0x1000FF6E
hpClearLine 0x1000FF6F

hpInsertLine 0x1000FF70
hpDeleteLine 0x1000FF71
hpInsertChar 0x1000FF72
hpDeleteChar 0x1000FF73
hpBackTab 0x1000FF74
hpKP_BackTab 0x1000FF75
apKP_parenleft 0x1000FFA8
apKP_parenright 0x1000FFA9
I2ND_FUNC_L 0x10004001
I2ND_FUNC_R 0x10004002
IREMOVE 0x10004003
IREPEAT 0x10004004
IA1 0x10004101
IA2 0x10004102
IA3 0x10004103
IA4 0x10004104
IA5 0x10004105
IA6 0x10004106
IA7 0x10004107
IA8 0x10004108
IA9 0x10004109
IA10 0x1000410A
IA11 0x1000410B
IA12 0x1000410C
IA13 0x1000410D
IA14 0x1000410E
IA15 0x1000410F
IB1 0x10004201
IB2 0x10004202
IB3 0x10004203
IB4 0x10004204
IB5 0x10004205
IB6 0x10004206
IB7 0x10004207
IB8 0x10004208
IB9 0x10004209
IB10 0x1000420B
IB11 0x1000420B
IB12 0x1000420C
IB13 0x1000420D
IB14 0x1000420E
IB15 0x1000420F
IB16 0x10004210
DRemove 0x1000FF00
Dring_accent 0x1000FEB0
Dcircumflex_accent 0x1000FE5E
Dcedilla_accent 0x1000FE2C
Dacute_accent 0x1000FE27
Dgrave_accent 0x1000FE60
Dtilde 0x1000FE7E
Ddiaeresis 0x1000FE22
osfCopy 0x1004FF02
osfCut 0x1004FF03
osfPaste 0x1004FF04
osfBackTab 0x1004FF07
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osfBackSpace 0x1004FF08
osfClear 0x1004FF0B
osfEscape 0x1004FF1B
osfAddMode 0x1004FF31
osfPrimaryPaste 0x1004FF32
osfQuickPaste 0x1004FF33
osfPageLeft 0x1004FF40
osfPageUp 0x1004FF41
osfPageDown 0x1004FF42
osfPageRight 0x1004FF43
osfActivate 0x1004FF44
osfMenuBar 0x1004FF45
osfLeft 0x1004FF51
osfUp 0x1004FF52
osfRight 0x1004FF53
osfDown 0x1004FF54
osfEndLine 0x1004FF57
osfBeginLine 0x1004FF58
osfEndData 0x1004FF59
osfBeginData 0x1004FF5A
osfPrevMenu 0x1004FF5B
osfNextMenu 0x1004FF5C
osfPrevField 0x1004FF5D
osfNextField 0x1004FF5E
osfSelect 0x1004FF60
osfInsert 0x1004FF63
osfUndo 0x1004FF65
osfMenu 0x1004FF67
osfCancel 0x1004FF69
osfHelp 0x1004FF6A
osfSelectAll 0x1004FF71
osfDeselectAll 0x1004FF72
osfReselect 0x1004FF73
osfExtend 0x1004FF74
osfRestore 0x1004FF78
osfDelete 0x1004FFFF
SunFA_Grave 0x1005FF00
SunFA_Circum 0x1005FF01
SunFA_Tilde 0x1005FF02
SunF36 0x1005FF10
SunF37 0x1005FF11
SunSys_Req 0x1005FF60
SunProps 0x1005FF70
SunFront 0x1005FF71
SunCopy 0x1005FF72
SunOpen 0x1005FF73
SunPaste 0x1005FF74
SunCut 0x1005FF75
SunCompose 0xFF20
SunPageUp 0xFF55
SunPageDown 0xFF56
SunPrint_Screen 0xFF61
SunUndo 0xFF65
SunAgain 0xFF66
SunFind 0xFF68

SunStop 0xFF69
SunAltGraph 0xFF7E
WYSetup 0x1006FF00
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General UNIX
By setting the DISPLAY environment variable you ensure that all clients will display on your PC.
Use one of the following methods, depending on your shell:

csh/tcsh
setenv DISPLAY pcname:0

sh/bash
DISPLAY=pcname:0
export DISPLAY

ksh
DISPLAY=pcname:0.0
export DISPLAY

AIX
This section covers AIX.

AIX fonts
If the application uses fonts that are not available on your PC, copy the fonts from your AIX
system to the PC and use the XVision Font Compiler to generate fonts that are accessible to the
X Server. The Font Compiler can compile X fonts in PCF or BDF format, and creates Microsoft
Windows .fon format files.

For further information on fonts, refer to �Using Fonts� in the �Using the X Server� chapter.

Keypad keys
If the keypad keys do not produce the correct output in an aixterm, try running aixterm -v.

Using the Print service with AIX
The Print service provided by Vision97 software can act as a network printer server for AIX.
Configure a printer on the UNIX system as follows:

1 Log in as root.
2 Enter the command smit (System Management Interface Tool).
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If you are running the X version of smit from a PC, the X Server must be running. A
character-terminal version of smit is also available, but these notes assume the X version is
being used.

3 Choose Devices.
4 Choose Printer/Plotter.
5 Choose Manage Remote Printer Subsystems.
6 Choose Client Services.
7 Choose Remote Printer Queues.
8 Choose Add a Remote Queue.
9 Fill in the dialog box as follows:

Name of queue to add pcprinter
Activate the queue? yes
Will this become the default queue? no
Queueing discipline first come first served
Accounting file pathname /tmp/account_pcprinter
Destination host for remote jobs your_pcname (e.g. stevel)
Pathname of the short form filter for /usr/lpd/aixshort
  queue status output
Pathname of the long form filter for /usr/lpd/aixlong
  queue status output
Name of queue on remote printer pc_port (e.g. lpt1)
Name of device to add lp1
Backend program pathname /usr/lpd/rembak
Each queue must be unique, so if several PC users want to set up queues associated with their
PCs then they must use different queue names. You may choose to make a queue the default
for the AIX system if you wish.

10 Choose Do or press ENTER.
Wait while the request is processed, then when the OK message is seen, exit from smit.

11 At the root system prompt, ensure that lpd is running on the AIX machine by typing:
lpd

12 Enable the new printer by typing:
enable pcprinter

The UNIX printer is now ready. To print a file use the following command:

lpr  -Ppcprinter  file_name

The Print Server will be started automatically if it is not already running on the PC. The file
should appear on the Windows default printer. (Note that you can set the default printer to be a
file for testing purposes.)

Note that the Print Server does not use the Windows printer driver, so the print file must be in
the format needed for the printer. For example, if you have a PostScript printer, you must use a
UNIX filter to process a text file before submitting it to the printer.
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DEC OSF/1
DECwindows clients do not follow the same naming convention as on other versions of UNIX.
The names of common clients are prefixed by �d�, for example the client known as xterm on a
UNIX System V computer is called dxterm on a DEC Ultrix system.

To check the names of the DECwindows clients, type the following commands at the Ultrix
system prompt:

cd /usr/bin/X11
ls

If the client you are looking for is not in the directory listing, look for the same name prefixed by
�d�.

DEC Ultrix
DECwindows clients do not follow the same naming convention as on other versions of UNIX.
The names of common clients are prefixed by �d�, for example the client known as xterm on a
UNIX System V computer is called dxterm on a DEC Ultrix system.

To check the names of the DECwindows clients, type the following commands at the Ultrix
system prompt:

cd /usr/bin/X11
ls

If the client you are looking for is not in the directory listing, look for the same name prefixed by
�d�.

HP-UX
This section covers HP-UX.

Using XDMCP with HP-UX
If the X Server is in multiple-windows mode then you may have difficulty starting an X session
using XDMCP. Because the Vision Window Manager (VWM) is active, there is a conflict with
the program used to log in and start the session. If HINTS are enabled then you will see the
message:

�The application that has just terminated generated the following error: BadAccess
This error occurred while processing the following request: ChangeWindowAttributes�

To overcome this problem, configure the X Server to use single-window mode.
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Fonts for HP VUE
HP fonts distributed with the X Server should allow you to use most HP applications. However,
these fonts are not installed if you use Express Installation. Use Custom Installation and select
the fonts before installing the X Server, or add the fonts to an existing installation by running
Maintenance Setup from the Start menu folder or Program Manager group.

Not all fonts used by HP VUE are included with the X Server. To access any missing fonts, run
the HP Font Server on the UNIX system, and configure the X Server to use this font server.

VUE File Manager will not start
You may find that attempting to start VUE File Manager from within VUE causes the error:

VUE-WM:Message server refused connection due to inetd.sec

This symptom means that although more than five TCP connections are configured in the
TCP/IP stack on the PC, only five X windows can be opened at one time. VUE File Manager
needs more than this number of connections to run correctly.

There is a bug in the network software message server, which the vuefile application uses. A
patch to the message server will be available in the future: contact HP Technical Support for the
latest information.

The work-around, which allows the X Server to work with unpatched HP-UX 9.04 on
HP 9000/847 hosts, is to disable the security features for the message server. To do this, add the
following line to the /usr/adm/inetd.sec file:

mesgd allow

Using the Print service with HP-UX
The Print service provided by Vision97 software can act as a network printer server for HP-UX.
Configure a printer on the UNIX system as follows:

1 Log in as root.
2 Enter the command sam (System Administration Manager).
3 Select �Printers and Plotters� and choose Open.
4 Select �Printers/Plotters� and choose Open.
5 From the Actions menu, choose Add Remote Printer/Plotter.
6 In the Printer Name box, enter a name for the remote printer. You could use the name of the

PC to which the printer is attached. In the Remote System Name box, enter the network node
name of the PC to which the printer is attached. In the Remote Printer Name box, enter
Default which means the Windows default printer. Be sure to use this exact spelling and
capitalization.
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You may also choose the Make This The System Default Printer option and/or the Allow
Anyone to Cancel a Request option. Do NOT choose the Remote Printer is on a BSD System
option.
After you have chosen OK to create the printer in the UNIX system then a file will be created
in the /usr/spool/lp/interface directory and will be named the same as the Printer Name you
specified.

7 Open the file in a text editor, and search for the following line:
shift;shift;shift;shift;shift

After this line, add the following three lines:
/usr/bin/ux2dos $1 > /tmp/tmp$$
mv /tmp/tmp$$ $1
echo '^L' >> $1

The ux2dos command is a HP-UX standard which resides in the /usr/bin directory and which
handles the addition of carriage return characters to line terminators. (Because UNIX uses LF
and DOS uses CR LF).
The echo command adds a Form Feed character at the end of the file and is necessary to send
the file to the printer. The line contains control codes, so cannot be added as ordinary text.
Type the line as:
echo 'ctrl-Vctrl-L' >> $1

The UNIX printer is now ready. To print a file use the following command:

lp  -d  printer_name  file_name

The Print Server will be started automatically if it is not already running on the PC. The file
should appear on the Windows default printer. (Note that you can set the default printer to be a
file for testing purposes.)

Note that Print Server does not use the Windows printer driver, so the print file must be in the
format needed for the printer. For example, if you have a PostScript printer, you must use a
UNIX filter to process a text file before submitting it to the printer.

SCO OpenServer
This section covers SCO OpenServer.

Connecting to SCO OpenServer
Because SCO OpenServer handles the login procedure slightly differently to other UNIX
systems, you may encounter problems when using the standard ComScript files. For a serial
connection, use Unixslsc.scr instead.



Appendix G � Tips and Tricks for Using XVision 653

Using XDMCP
If the X Server is in multiple-windows mode then you may have difficulty starting an X session
using XDMCP. Because the Vision Window Manager (VWM) is active, there is a conflict with
the program used to log in and start the session. If HINTS are enabled then you will see the
message:

�The application that has just terminated generated the following error: BadAccess
This error occured while processing the following request: ChangeWindowAttributes.�

There are two ways to overcome this problem:

• Configure the X Server to run in single-window mode.
- or -

• Create a file called .startxrc in your home directory containing the following line:
exec scoterm 2> /dev/null

Using the Print service with SCO OpenServer
By default, the SCO OpenServer operating system uses the UNIX System V Release 3 printing
system rather than the BSD system. However, SCO provide a mechanism to install limited BSD
lpd services, so it is therefore possible to use this mechanism to access the Print server on an
attached PC. Configure a printer on the UNIX system as follows:

1 Log in as root.
2 Enter the command mkdev rlp.
3 You will now be prompted whether you want to install or remove remote printing. Type �i�

to install. Two directories, /usr/lpd/remote and /usr/spool/lpd, and the /etc/printcap file are
now created. In addition, the lp, cancel, and lpstat commands are installed.

4 Next, you are asked �Do you wish to to change the printer description file /etc/printcap?�
Type �y� to enable remote printing configuration.

5 To configure a remote printer, respond to the following as shown:
Please enter the printer name (q to quit): your_printername (e.g. Tims_Printer)
Is Tims_Printer a remote printer or a local printer (r/l)? r
Please enter the name of the remote host
that Tims_Printer is attached to: your_pcname (e.g. timp)
You will be asked to confirm whether the printer you specified is connected to the host you
specified. Type �y� to confirm or �n� to re-enter the name of the remote host.

6 Now choose whether to make the printer you have just configured the default for the system.
Again, type �y� or �n� as appropriate. The printer information you supplied is added to the
/etc/printcap file, and the spooling directory for the printer is created.
Either repeat step 5 to configure additional printers or type �q� to exit.

7 Type �y� in response to �Do you want to start remote daemon now?�
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8 Open the /etc/printcap file in a text editor. This file contains entries for each printer you have
configured using the rlpconf command. Each of the entries needs to be changed so that the rp
capability specifies the remote printer as Default (meaning the Windows default printer). For
example, if you had configured two remote line printers, Tims_Printer and Steves_Printer,
and these printers were connected to two PCs named respectively, timp and stevel, the
contents of your /etc/printcap file would be:
# Remote Line Printer (BSD format)
Tims_Printer:\
        :lp=:rm=timp:rp=Tims_Printer:sd=/usr/spool/lpd/Tims_Printer:
Steves_Printer:\
        :lp=:rm=stevel:rp=Steves_Printer:sd=/usr/spool/lpd/Steves_Printer:

You would need to modify the entries so that they looked like this:
# Remote Line Printer (BSD format)
Tims_Printer:\
        :lp=:rm=timp:rp=Default:sd=/usr/spool/lpd/Tims_Printer:
Steves_Printer:\
        :lp=:rm=stevel:rp=Default:sd=/usr/spool/lpd/Steves_Printer:

Be sure to use this exact spelling and capitalization when typing �Default�. You must make
this change to a printer entry before you send a print request to that printer. If you forget,
open the /etc/printcap file, amend the relevant entry, then type the following at the root
prompt:
lpd stop
lpd start

Assuming the LPD Server is running on your PC, your file should now print out.
9 If you want to configure additional remote printers at a later date, log in as root and type:

/etc/rlpconf

Refer to steps 5, 6, and 8 for what to do next.

The UNIX printer is now ready. To print a file use the following command:

lp -d printer_name file_name

The Print Server will be started automatically if it is not already running on the PC. The file
should appear on the Windows default printer. (Note that you can set the default printer to be a
file for testing purposes.)

Note that Print Server does not use the Windows printer driver, so the print file must be in the
format needed for the printer. For example, if you have a PostScript printer, you must use a
UNIX filter to process a text file before submitting it to the printer.
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Solaris
These notes discuss using AnswerBook. AnswerBook provides online access to Sun
documentation. It uses a navigator window to show the books available and to list their contents,
and a viewer window to actually display the selected pages. When you run AnswerBook on a Sun
workstation, the viewer program used is docviewer, which uses Display PostScript to draw the
image of the page on the screen. Because the PC does not have Display PostScript, you need to
use a different method to view the PostScript document pages.

Two methods are described below. Both of these require GhostScript to be installed on the
UNIX system. If you do not have GhostScript, it can be downloaded from the Internet using
anonymous FTP:

FTP server: src.doc.ic.ac.uk
Location: /gnu
Filename: ghostscript-2.6.2.tar.gz

The .gz file extension indicates that the file is compressed using GNU zip. You need to have gzip
or gunzip available on your UNIX system. After decompressing the file, you need to unpack the
tar file, and read the README file.

Both methods require that the DISPLAY environment variable should be set to point to your PC,
and that the BOOKINFO variable should be set to the location of the AnswerBook bookinfo
file. For example:

setenv DISPLAY mypc:0
setenv BOOKINFO answerbook_directory/SysSoft1_4/bookinfo

Method 1: xnav
This method provides hypertext linking, although not between separate PostScript files. It does
not provide Search facilities (which are available using Method 2). It uses a program called xnav
that can be downloaded from:

FTP server: src.doc.ic.ac.uk
Location: /computing/systems/sun/sun-faq/Source
Filename: ab.tar.gz

Read the README file when you have decompressed and unpacked the files.

You need to compile the programs after making changes to three Imakefile files, as follows:

srcdir/Imakefile

Add the line:
INCLUDES = -I/usr/openwin/include

srcdir/gscanvas/Imakefile
scrdir/dc/Imakefile
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Change the line INCLUDES to show the following:
INCLUDES = -I/usr/openwin/include

To compile the programs, type:

xmkmf; make Makefiles;make

This will issue one warning, in ps.c on line 786, which can be ignored.

To start xnav type the following command:

xnav SUNWab_1_4

The navigator window should appear, allowing you to browse the contents of the AnswerBooks.
When you double-click on an entry in Contents, the viewer window appears to display the
relevant page (you may need to give the viewer window the focus). You can then use the Next
Page and Previous Page buttons in the viewer window. Hypertext links are indicated where the
text is surrounded by a rectangle. Double-click on a link to jump to a new topic.

Method 2: xdocviewer
This method provides Search facilities, but not hypertext linking. It uses a script called
xdocviewer that can be downloaded from:

FTP server: src.doc.ic.ac.uk
Location: /computing/graphics/systems/X11/R5contrib
Filename: xdocviewer-2.0.1.README
Filename: xdocviewer-2.0.1.z

Read the README file, and note the restrictions on the versions of the operating system that the
script will work with.

The .z extension on the script file name indicates that the file is compressed using the standard
UNIX compress program. To decompress, just type compress followed by the file name.

The xdocviewer script is written in Perl, and you need Perl installed on your UNIX system to
interpret the script. If you do not have Perl, it can be downloaded from:

FTP server: src.doc.ic.ac.uk
Location: /gnu
Filename: perl5.002.tar.gz

You may need to edit the xdocviewer script to point a variable to the location of Perl (/usr/local/
bin/perl by default). By default, the xdocviewer script runs the GhostScript viewer ghostview as
the document viewer. It can also use gspreview, and you can change either by modifying the
script or by setting the GSVIEWER environment variable.

Make the Perl script executable, rename it docviewer, and move it to a location in your path
ahead of the original docviewer program.



Appendix G � Tips and Tricks for Using XVision 657

Next, you need to make a copy of the answerbook script, calling the copy xanswerbook. Edit
the new script to prevent the undesirable modification to your path, as described in comments in
the Perl script. Read the xdocviewer-2.0.1.README file for full details of these modifications.

To run, type the following command:

xanswerbook

The navigator window should appear, allowing you to browse the contents of the AnswerBooks.
When you double-click on an entry in Contents, the GhostScript viewer appears to display the
relevant page. You can search by choosing the appropriate button in the navigator window.

SunOS
This section covers SunOS.

OPEN LOOK buttons not visible
When using the OPEN LOOK Window Manager OLWM, you may find that button fonts don't
appear on the screen, in particular the thumb tack and the ovals around options in menus. If this
happens when using a 16-color VGA display adapter it probably indicates that the window
manager has not been able to allocate colors. The window manager uses the available colors,
drawing the button fonts and the menu background in the same color. This means that the
objects cannot be seen even though they have been drawn.

The solution is to disable the Windows System Colors option in the Colors Properties dialog
box. When this option is enabled, there are no free colors in the colormap.

Interrupted System Call error
If you are running OpenWindows 3, and see the �Interrupted System Call� error when running
shelltool or cmdtool, it could be that you have an stty statement in your .cshrc file. This should
be moved to your .login file.

If you are running OpenWindows 2, then you may see the �Interrupted System Call� error when
running shelltool or cmdtool, but not when running xterm. The solution is to run setsid when
running the shelltool or cmdtool. For example:

/usr/etc/setsid  /usr/openwin/bin/cmdtool -display pcname:0

The reason is to do with controlling terminals (see man setsid for details).
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XRemote
This section covers XRemote.

Using XRemote via a terminal server
If you wish to use XRemote via a terminal server, contact Technical Support for a special
ComScript file.

Using XRemote with Series 800 HP-UX 9.0
The default Series 800 X server is not supported on HP-UX 9.0. In order for XRemote to
function on HP 9000 Series 800 machines running HP-UX 9.0 create the directory:

/usr/spool/sockets/X11

There are no necessary contents for the directory, it just must exist.

Configuring an 8-bit data path on BSD UNIX
XRemote requires an 8-bit data path between PC and remote host and it is possible to configure
the host port manually to facilitate this. You need to create a new entry in the /etc/gettytab file
and reference this in the /etc/ttytab file:

1 Log in as root.
2 Open the /etc/ttytab file in a text editor. The ttytab file determines what ttys, or terminal

devices, are available to the UNIX system. A standard line from /etc/ttytabmight look
something like this:
ttya  "/usr/etc/getty std.9600"    unknown    on local secure

This means that on ttya (serial port A) the /usr/etc/getty program (responsible for opening and
initializing the terminal line, reading the login name, and invoking login) is being executed
with the argument �std.9600�. This argument (the name of the baud rate code to be used) is
found in the /etc/gettytab file. For example:
2|std.9600|9600-baud:\
        :sp#9600:

This entry uses the sp field to set the line speed to 9600 baud.
Copy the line in the /etc/ttytab file that pertains to the serial port you want to use, then type
the number sign (#) immediately before the line to comment it out.

3 Now paste the copied text immediately below the original. You need to alter the second field
in the line so that the getty program runs with a new argument named �8bit.9600�. For
example, if you want to connect to a remote host on serial port A, change the following line
in the ttytab file to look like this:
ttya  "/usr/etc/getty 8bit.9600"    unknown    on local secure
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Having created a new argument, you now need to create an entry for it in the /etc/gettytab
file.

4 Open the /etc/gettytab file in a text editor. Locate and copy the original entry for the
argument you have just changed, then paste the copied text underneath the original. You
need to change the name of the copy to �8bit.9600�. (The first field in each entry is the
argument name; if an argument has more than one name, they will be separated by pipe (|)
characters.)

5 To enable an 8-bit connection, add the p8 field, followed immediately by a colon (:), to the
new entry. For example:
8bit.9600:\
        :sp#9600:p8:

6 At the root prompt type:
kill -1 1

This notifies init that the /etc/ttytab file has been changed, causing it to read the new
information in the file. Init will then execute the /usr/etc/getty command along with your new
argument.

For a modem connection, you could also use the following example gettytab file entry:

Modem.9600:\
        :sp#9600:p8:hc:to#30:

Again, the sp and p8 fields are used to enable an 8-bit connection at 9600 baud. In addition, the
hc and to fields are combined so that the dial in line will be hung up unless a new user name is
supplied within thirty seconds of the last exit.

Note  Some BSD UNIX systems use the /etc/ttys file rather than the /etc/ttytab.
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Wyse 60 terminal keys on the IBM
Enhanced 101 keyboard
Hardware keys are not mapped.

To access function keys F13 to F16, you must use the Function Keys toolbar within the Wyse 60
emulator.
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The Function Keys toolbar
To access the Function Keys toolbar, start a Wyse 60 emulator, and use the right mouse button
to click the standard toolbar. Click Function Keys on the shortcut menu, so that a check mark
appears next to the item.

F13 to F16 from the keyboard, you should create the necessary mappings in the Keymap Editor.
Combinations of these keys and modifiers are not available at all, unless you create them in the
Keymap Editor.
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Wyse 60 terminal keys on the IBM
Enhanced 102 keyboard
Hardware keys are not mapped.

To access function keys F13 to F16, you must use the Function Keys toolbar within the Wyse 60
emulator.
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The Function Keys toolbar
To access the Function Keys toolbar, start a Wyse 60 emulator, and use the right mouse button
to click the standard toolbar. Click Function Keys on the shortcut menu, so that a check mark
appears next to the item.

Note  If you wish to access keys F13 to F16 from the keyboard, you should create the necessary
mappings in the Keymap Editor. Combinations of these keys and modifiers are not available at
all, unless you create them in the Keymap Editor.
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VT420 terminal keys on the IBM
Enhanced 101 keyboard
Hardware keys are not mapped.

To access function keys F13 to F20, you must use the Function Keys toolbar within the VT420
emulator.
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The Function Keys toolbar
To access the Function Keys toolbar, start a VT420 emulator, and use the right mouse button to
click the standard toolbar. Click Function Keys on the shortcut menu, so that a check mark
appears next to the item.

Note  If you wish to access keys F13 to F20 from the keyboard, you should create the necessary
mappings in the Keymap Editor. Combinations of these keys and modifiers are not available at
all, unless you create them in the Keymap Editor.
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VT420 terminal keys on the IBM
Enhanced 102 keyboard
Hardware keys are not mapped.

To access function keys F13 to F20, you must use the Function Keys toolbar within the VT420
emulator.
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The Function Keys toolbar
To access the Function Keys toolbar, start a VT420 emulator, and use the right mouse button to
click the standard toolbar. Click Function Keys on the shortcut menu, so that a check mark
appears next to the item.

Note  If you wish to access keys F13 to F20 from the keyboard, you should create the necessary
mappings in the Keymap Editor. Combinations of these keys and modifiers are not available at
all, unless you create them in the Keymap Editor.
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Where is TermVision different from
PC-Connect?
This section describes some of the principal differences between TermVision and PC-Connect.

What platforms does TermVision run on?
PC-Connect was designed at the time of Windows 2, and its iconic desktop-centric design
existed before the Program Manager of Windows 3. However, today there exist new
technologies and platforms which PC-Connect simply cannot take advantage of because of its
aging design.

TermVision is a 32-bit terminal emulator that functions on Windows 95 and Windows NT.

Where is the desktop?
Many PC-Connect users chose to use the Program Manager to launch Windows applications,
and the PC-Connect Desktop to launch UNIX applications. The Vision97 approach is for the
products to fit in with the normal way of working for the user, rather than insist that the user
changes his work pattern. This is especially important with newer environments such as
Windows 95.

Where PC-Connect was desktop-centric, TermVision is document-centric. All of the information
that describes an application session is held in an emulator document rather than on the
PC-Connect desktop in an icon. These documents can then be placed on the users desktop,
whether this is the Windows 95 desktop or the Windows NT 3.51 Program Manager. By simply
double clicking on the application document the emulator starts up and configures itself in
accordance with the document settings.

The advantages of the document-centric approach are that UNIX applications can be treated in
the same way as Windows applications, and documents can be distributed more easily than
desktops throughout the community of users.

How do I configure different application sessions?
Different application sessions are simply different documents. How you create a document can
vary depending on your version of Windows.

On Windows 95 or NT 4.0
On Windows 95 or NT 4.0, an emulator document is created using the Unix Application
Wizard. If you want the application to appear on the Start menu, click the Start button, and then
click New Unix Program. If you want the application to appear on the desktop or in a folder,
click with the right mouse button where you want the item to appear, click New, and then click
Unix Program.
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On Windows NT 3.51
An emulator of the required type is executed from the Program Manager group. From the
Properties menu an application session can be configured and then saved to as a document. This
document can then be placed on the Program Manager and executed from there. For users
wanting a separate grouping of UNIX applications, these documents could be placed in a new
Program Manager group of their own.

Where is the File Transfer program?
Transferring files between a PC and a UNIX system is just one aspect of file management. Other
tasks include: navigation around directories, creating and deleting, copying and moving,
renaming and configuring attributes. Users are able to handle UNIX files in the same way as they
manage Windows files on their own PC, by drag-and-drop and point-and-click methods.
TermVision has a major browsing component that delivers this functionality, which has two
guises depending on platform.

In Windows 95 or NT 4.0, files are managed using My Computer, Network Neighborhood, and
Windows Explorer. TermVision provides Unix Neighborhood and Host Explorer to allow UNIX
file systems to be managed in a similar way. To transfer files between the PC and UNIX systems,
icons are simply dragged between My Computer and Unix Neighborhood.

On Windows NT 3.51 file management is accomplished using the File Manager. TermVision
supplies a tool called Host Manager that provides a similar interface for managing UNIX files.
Files are transferred by simple drag and drop between File Manager and Host Manager.

Can I restrict which hosts my users can see?
PC-Connect gave the System Administrator the ability to control what UNIX machines their
users could see, by simply configuring, on the desktop, those hosts that the user needed to run
his applications. By default, TermVision shows all those hosts that are running the Vision
Services for UNIX software. This is a real-time feature which gives feedback about whether the
host is running or not. However, TermVision can be �hard-wired� so that a given user can only
see those hosts that his System Administrator wants him to see. This is done by turning off the
Host Finder feature from the Vision Services item in the Windows Control Panel, and then by
the System Administrator distributing host description files (.hst), using SuperVision, the system
management component of Vision97.
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Can I restrict which applications my users can
use?
All of the TermVision components can be configured, remotely if desired, so that they cannot be
re-configured or changed. Therefore, application documents that the System Administrator
distributes, can be the only UNIX tools the user can access. Using SuperVision, a greater degree
of control can be accomplished by tailoring the exact restrictions that apply to each component.
Global settings are also possible for managing large communities of PCs. For example, you may
not want the user to be able to produce a hard-copy of the emulator screen through the print
screen function.

Can TermVision do DDE �hot-links�?
TermVision now uses OLE to provide hot links. OLE is understood by most major software
products and delivers a more powerful data sharing environment. For example, if you update a
hot-link in Excel that is pointing to an emulator, the emulator will automatically be started by
Excel and the data refreshed.

How do I use serial connections?
PC-Connect required that users be aware of the transport used to connect to a host. For instance,
when configuring a new host the user had to specify whether it was a TCP/IP host, a DECnet
host, and so on. A consequence of this approach was that if a mobile user wanted to use host
applications whilst on the LAN and, later, on the road, he would have to use two different PC-
Connect hosts, one configured for a connection over a LAN and another over a modem.

TermVision uses an advanced protocol layering scheme which means that hosts are protocol
independent. The user can leave TermVision to decide on the best way to reach a host. This is
accomplished by means of primary and fallback protocols. When a user tries to open an emulator
connection to a host, the primary transport is used; if this fails, the secondary transport is used,
and so on until a connection is established. From the users� perspective, he can use his
applications in the same way when in the office or on the road.

In addition, where PC-Connect provided Host access, TermVision provides LAN access. That is,
PC-Connect connects to a single host machine and all the user can use is applications on that
machine. TermVision uses a Proxy mechanism to make the remote PC appear as though it is
directly connected to the network. This means that all hosts on the network are available, as well
as other resources such as printers.
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Does TermVision have the �in-tray� function?
The in-tray facility in PC-Connect captured output destined for a user and presented it in a
special Window called the in-tray. TermVision has a similar feature called Message Pad which
looks like a sticky yellow paper note on the screen. Furthermore, Message Pad has an associated
utility called User Viewer, which displays a visual representation of other PC users and allows
you to send them text or even multimedia messages.

Where is UNIXExec?
UNIXExec in PC-Connect allowed the user to navigate the UNIX file system and allowed
management of files. The browsing facilities of TermVision perform the same function but are
truly graphical and not simply a list of names.

What about UNIX Notepad?
TermVision does not currently have a UNIX Notepad component.

What additional features does
TermVision offer me?
This section describes some of the new features of TermVision.

Powerful terminal emulation
The emulation components of PC-Connect were designed using older design techniques. The
emulators of TermVision are object-oriented and are even OLE objects themselves.

Visual configuration
TermVision benefits from all the new interface characteristics of Windows 95. For example,
when configuring the emulators the user receives a preview of the effect of the changes he is
making.

Recordings
To help the user become more effective in the work-environment, the emulator incorporates a
powerful Record and Playback feature, which lets the user record a common sequence of actions.
This recording can then be played back when the user hits a particular key or presses a button.
For example, the user may often navigate through several screens of a stock control application.
This process can now be automated and executed by pressing one button.
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Styles
The emulator also supports the idea of styles. A particular configuration can be modified and
saved as a style. The user can quickly change to this new style whenever needed. For example,
the UNIX application being used may present lots of information on the screen during its
execution. At this point the user may wish to switch to 132 column mode style, to display the
data more effectively. Styles can be switched at any time.

Toolbars
TermVision emulators allow full customization of toolbars, including the ability to dock them in
any location within the window. Buttons can be used as a quick way to simulate keystrokes, send
strings of characters, play recordings, change styles or execute built-in commands such as File
Print. Existing toolbars can be customized or new ones created.

Graphical keyboard mapping
Keyboard handling is extremely powerful in TermVision. Not only can one key or key sequence
be mapped to another key or key sequence, but keys can be programmed to send strings, start
recordings, change styles or execute built-in commands.

Event handling
Event handling allows emulators to react automatically when an event occurs. For example,
when new data arrives in the emulator, it could send a key sequence. The TermVision event
handling mechanism allows more task automation.

TrueType fonts
PC-Connect used its own bitmap fonts, which meant that the emulator window size had to be a
multiple of the font size. TermVision uses Windows TrueType scaleable fonts, which means that
the user can have an infinite number of font and window sizes. The user can also choose a
typeface to suit their tastes.

Attribute mapping
The Bold, Flashing and Underline attributes of dumb terminals can now be mapped to different
colors, which themselves can flash, be bold or be underlined. TermVision�s attribute mapping is
comprehensive and easy to use.

Downloadable fonts
The precision emulation that TermVision provides means that even the most complex features of
dumb terminals are supported. For example, the VT420 emulator supports downloadable fonts.

Wyse 60
The Wyse 60 emulation that was requested by many PC-Connect users is now available under
TermVision.
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Systems management using SuperVision
More and more organizations are choosing to use PC�s instead of dumb terminals in order to
give their workforce the best tools for their jobs. However, the management of ever increasing
numbers of PC�s may present problems for many System Administrators, whose skills lie more in
the UNIX world. TermVision is �administration-ready.� It can be managed efficiently and simply
by Vision97�s system management component, SuperVision

Groupings
SuperVision uses the concept of PC groups in order to simplify the job of administrating them.
An administrator can create arbitrary groups, such as �Salespeople� or �Windows 95 PCs�, with
a PC being able to belong to any number of groups. In addition, PCs can be treated individually
or as a whole through the use of a special group called �system� which contains all PCs.

File distribution
One of the most common tasks for a System Administrator is to distribute files to groups of
users. The files may be data files, such as a new phone-list, executables or DLL�s, or
configuration files. For example, if your organization decides to use a new style for its corporate
fax template, SuperVision can put the new .dot file in the right place on every users� PC in the
organization.

Desktop management
SuperVision makes desktop management easy. For example, the System Administrator may need
to allow sales people to use a new UNIX character-based application as a lead-tracking system.
He can configure a TermVision emulator document to work solely with this application,
incorporating special toolbars and styles, which he can then drag and drop onto the group
�Salespeople� so that it will appear on their Windows 95 desktop or Program Manager group
automatically.

Restrictions
Vision97 applications can be remotely configured with SuperVision. Restrictions can be applied
that withdraw certain functionality from specific programs. For example, you may not want your
users to be able to reconfigure their emulator, or print the screen. Restrictions can be applied
specifically to a given PC, to a group, or to everyone.

Remote configuration
Configuration information for applications is held in the Registry or .ini files. SuperVision
permits the merger of new information with existing information in these places so that the
System Administrator can control the behavior of applications.
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Task Automation
SuperVision is supplied with a UNIX scripting language called Tool Command Language (Tcl).
Tcl has been extended so that the System Administrator can write scripts which issue RPC calls
to PCs. For example, the System Administrator could write a script to interrogate a PC for a file
called Excel.exe. By applying this script to a group or all PCs, the System Administrator has
written a simple software inventory application.

Furthermore the System Administrator can write a script which is executed when a PC first
connects to a server. This script may calculate the free space that the PC has. Using Tcl scripts,
the System Administrator may be able to prevent system problems before they occur.

Remote administration
SuperVision allows the System Administrator to browse a users PC (even if they are connected to
the LAN via a modem) and examine their installation. He can also see what tasks are currently
running and even get a snap-shot of the screen. These abilities are especially useful for remote
diagnosis of users problems.

Security
Most terminal emulation packages use standard UNIX terminal services such as rlogind or
telnetd. TermVision can use these services too, but more usually it talks to the Task Server, a
component of Vision Services for UNIX. When talking to standard services, user names and
passwords must be transmitted �in the clear� and are therefore susceptible to security breaches.
Using Vision Services for UNIX, passwords can be encrypted securely.

Licensing
With ever increasing numbers of PCs, purchasers are seeking the optimal way to buy and license
PC software. Many people are finding that although they have purchased many licenses of PC
products at any one time, only a fraction of the licensed community use the product. Yet many
PC software vendors insist upon install-based licensing, where every possible PC that runs the
software must have a license pertaining to it.

With Vision97 from SCO, a new approach has been taken called concurrent licensing. This
means that you can install the software on all potential users PCs�, but only buy the number of
licenses that you know will be using the product concurrently. If you don�t know what that
number will be, Vision97 has a tool to help manage licenses for you and inform you if you need
more.
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Log Server
All the TermVision components log events and errors to the Log Server for the network. The
Log Server is a Vision Services for UNIX component that stores messages in a central place. This
enables the System Administrator to look in one place for information rather than examine log
files on numerous PCs and hosts.

Setup
The Vision97 CD is Autoplay-enabled for Windows 95 and NT 4.0, which means that the user
simply inserts the CD and it is run automatically without user interaction.

For System Administrators who want to create standard installations, there is the Server-based
Setup wizard. This wizard creates a Response file which can be used to supply answers to
questions that the Setup program would normally ask. Response files ensure that each PC is
installed identically with no intervention required by the user. This is also called a silent install.

To ensure that TermVision is ready for use immediately after installation, the Setup program
performs some checks upon the underlying network layer using a utility called Network
Checkout. Faults that are detected are corrected by the user being led through a Windows 95
style Troubleshooting Help.

Part of SCO Vision97
SCO Vision97 does not just offer you a set of products for today. Each product starts from
where you are today and helps you migrate your computing infrastructure into the direction you
want to go. For example, as a Windows desktop user with a UNIX server, you may eventually
want full client-server applications. But you cannot afford to throw away that important
character-based corporate application running on UNIX. Today TermVision will help introduce
your corporate application users to the techniques of Windows, making that application more
useful through the utilization of toolbars and session recordings. Or maybe you buy the graphical
version of that application that uses X Windows and need a PC X server on your PC, like
XVision. Tomorrow, you can produce that full client-server solution using great middleware
members of the family such as SQL-Retriever or Wintif.

The benefits of employing members of the same family go beyond a consistent look and feel to
sharing a common communications infrastructure and a single system management paradigm.
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Tables overview
The ODBC demonstrator examples described in this manual require a number of demonstration
tables with which to operate. Normally, these are created using the SQLGold program, as
described in the �Vision ODBC Driver� chapter. This appendix lists the contents of these tables.

The tables are based on the requirements of a fictitious supplier of sporting goods, the west-coast
based Ocean Paradise, Inc. This is a wholesale company supplying small retail outlets in northern
California.

Table Name Purpose

customer Customer names and addresses.
orders Order details.
items Details of individual order items.
stock Products stocked.
manufact Manufacturers of stock.
sales Sales-person details.
nominal General ledger for accounts.
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customer Tablecustomer Tablecustomer Tablecustomer Tablecustomer Table

custom_num

fname lname company address1 address2 city state zipcode phone

101 Ludwig Pauli All Sports Supplies 213 Erstwild Court Sunnyvale CA 94086 408-789-8075

102 Carole Sadler Sports Spot 785 Geary St San Francisco CA 94117 415-822-1289

103 Philip Currie Phils Sports 654 Poplar P. O. Box 3498 Palo Alto CA 94303 415-328-4543

104 Anthony Higgins Play Ball! East Shopping Cntr. 422 Bay Road Redwood City CA 94026 415-368-1100

105 Raymond Vector Los Altos Sports 1899 La Loma Drive Los Altos CA 94022 415-776-3249

106 George Watson Watson & Son 1143 Carver Place Mountain View CA 94063 415-389-8789

107 Charles Ream Athletic Supplies 41 Jordan Avenue Palo Alto CA 94304 415-356-9876

108 Donald Quinn Quinns Sports 587 Alvarado Redwood City CA 94063 415-544-8729

109 Jane Miller Sport Stuff Mayfair Mart 7345 Ross Blvd. Sunnyvale CA 94086 408-723-8789

110 Roy Jaeger AA Athletics 520 Topaz Way Redwood City CA 94062 415-743-3611

111 Frances Keyes Sports Center 3199 Sterling Court Sunnyvale CA 94085 408-277-7245

112 Margaret Lawson Runners & Others 234 Wyandotte Way Los Altos CA 94022 415-887-7235

113 Lana Beatty Sportstown 654 Oak Grove Menlo Park CA 94025 415-356-9982

114 Frank Albertson Sporting Place 947 Waverly Place Redwood City CA 94062 415-886-6677

115 Alfred Grant Gold Medal Sports 776 Gary Avenue Menlo Park CA 94025 415-356-1123

116 Jean Parmelee Olympic City 1104 Spinosa Drive Mountain View CA 94040 415-534-8822

117 Arnold Sipes Kids Korner 850 Lytton Court Redwood City CA 94063 415-245-4578

118 Dick Baxter Blue Ribbon Sports 5427 College Oakland CA 94609 415-655-0011
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orders Table

order_num custom_num instruct backlog po_num

1001 104 ups n B77836

1002 101 po on box deliver back door only n 9270

1003 104 via ups n B77890

1004 106 ring bell twice y 8006

1005 116 call before delivering n 2865

1006 112 after 10 am y Q13557

1007 117 n 278693

1008 110 closed Monday y LZ230

1009 111 door next to supersaver n 4745

1010 115 deliver 776 Gary if no answer n 429Q

1011 104 ups n B77897

1012 117 n 278701

1013 104 via ups n B77930

1014 106 ring bell, kick door loudly n 8052

1015 110 closed Mon n MA003
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items Table

item_num order_num stock_num manu_code quantity total

1 1001 1 HRO 1 250

1 1002 4 HSK 1 960

2 1002 3 HSK 1 240

1 1003 9 ANZ 1 20

2 1003 8 ANZ 1 840

3 1003 5 ANZ 5 99

1 1004 1 HRO 1 960

2 1004 2 HRO 1 126

3 1004 3 HSK 1 240

4 1004 1 HSK 1 800

1 1005 5 NRG 10 280

2 1005 5 ANZ 10 198

3 1005 6 SMT 1 36

4 1005 6 ANZ 1 48

1 1006 5 SMT 5 125

2 1006 5 NRG 5 190

3 1006 5 ANZ 5 99

4 1006 6 SMT 1 36

5 1006 6 ANZ 1 48

1 1007 1 HRO 1 250

2 1007 2 HRO 1 126

3 1007 3 HSK 1 240

4 1007 4 HRO 1 480

5 1007 7 HRO 1 600



Vision97 Reference686

items Table (continued)

item_num order_num stock_num manu_code quantity total

1 1008 8 ANZ 1 840

2 1008 9 ANZ 5 100

1 1009 1 SMT 1 450

1 1010 6 SMT 1 36

2 1010 6 ANZ 1 48

1 1011  5 ANZ 5 99

1 1012 8 ANZ 1 840

2 1012 9 ANZ 10 200

1 1013 5 ANZ 1 19

2 1013 6 SMT 1 36

3 1013 6 ANZ 1 48

4 1013 9 ANZ 2 40

1 1014 4 HSK 1 960

2 1014 4 HRO 1 480

1 1015 1 SMT 1 450
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stock Table

stock_num manu_code descript unit_price unit unit_descr

1 HRO baseball gloves 250 case 10 gloves/case

1 HSK baseball gloves 800 case 10 gloves/case

1 SMT baseball gloves 450 case 10 gloves/case

2 HRO baseball 126 case 24/case

3 HSK baseball bat 240 case 12/case

4 HSK football 960 case 24/case

4 HRO football 480 case 24/case

5 NRG tennis racquet 28 each each

5 SMT tennis racquet 25 each each

5 ANZ tennis racquet 19 each each

6 SMT tennis ball 36 case 24 cans/case

6 ANZ tennis ball 48 case 24 cans/case

7 HRO basketball 600 case 24/case

8 ANZ volleyball 840 case 24/case

9 ANZ volleyball net 20 each each

manufact Table

manu_code manu_name

SMT Smith

ANZ Anza

NRG Norge

HSK Husky

HRO Hero
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sales Table

lname fname region target actual

Adams Chuck East 100000 121000

Atkins Lee West 160000 146000

Ellis Nancy West 150000 212000

Conners Paul Midwest 190000 196000

Geary Jerry South 180000 204000

Mallory Betty South 170000 185000

Harris Ken East 120000 113000

Parker Greg Midwest 200000 238000

nominal Table

nom_code nom_name nom_value

20001001 Sales 65536

20001020 Cost Sales 23417

20010001 Accommodation 4723

20010002 Motor Expenses 2809

20010003 Depreciation 850

20010004 Advertising 590

20010005 Bank Charges 243

20010006 Administration 1024
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LOOP statement 596
MATCH function 598, 610
NOMATCH function 598, 612
NOREMATCH function 598, 613
NOTCALL function 615
NOTSET function 616
parameters 598
PASSWORD function 617
REMATCH function 598, 618
repeated execution 596
RETURN function 620
SAVEPASSWORD function 621
SEND function 623
STATUS function 624
string matching 598
testing ComScript files 628
TRACE function 626
user-defined functions 597

concepts 426
configuration

remote 431

configuration files
distributing 430

configuring
Audio Server 110
BSD UNIX printer to use LPD 390
BSD UNIX printer to use RPC 390
Database Server 47
emulator documents from a Program Manager

group 174
emulator documents from the Windows desktop 174
hosts 27
hosts for modem connection 41
hosts for OPEN LOOK 127
hosts for serial connection 41
modem connections 35
Modem transport 39
modem transports 36
modems 35
Motif Window Manager 125
ODBC data sources in PowerBuilder 353
Print Server 392
printing 392
remote printer in Vision Services 397
serial connections 35
serial transports 36
Serial-Com1 transport 37
server for X Display Manager 138
server programs 55
transports 20
UNIX System V printer to use LPD 391
UNIX System V printer to use RPC 391
Vision Resume on PC 155
Vision Resume on UNIX 156
X Display Manager 139
X Server 77
X Server for OLWM 127
XRemote on the PC 145
XRemote on UNIX 147

Connect function 200
connecting to a remote host 169
connecting to data sources 262

connection string 266
in PowerBuilder 350
in PowerBuilder using a database profile 351

Connection Manager 44, 508
Connection Monitor 508

generating ComScript files 629
opening a serial connection 45
testing ComScript files 628
XRemote and 151

connection string 266
connections

testing 530, 531
constants

creation from array ranges in Excel 318
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control
Delphi 336
PowerBuilder 348
Visual Basic 326

Control panel
configuring hosts 28

Control-menu icon 508
controlling and monitoring PCs 432, 462

browsing 462
viewing programs 464

conventions viii
Copy Area command 108
Copy With Substitution 448
copying 107, 179, 377, 380

between Windows and X 107
file names 377
graphics 108
in X 107
in X Server 107
text into another application 186
translation of line terminators 377
X fonts to the PC 95

CreateHotSpot function 201
CreatePattern function 202
creating

administration tasks 452
alias items 446
database hierarchy 437, 441
drive items 441
emulator documents in Windows NT 3.51 174
emulator documents on Windows 95 or NT 4.0 173
folders 442
group items 438
PC items 437
Program Manager items 451
Setup script file 9
User-defined aliases 445

cross-subnetwork licensing 68
cursor library 272
custom control

Visual Basic 326
cut-buffers 107, 508

D
data access component

Delphi 336
data control

defined 327
using in Visual Basic 329

data control component
Delphi 336

data sources 509
adding 256

advanced configuration options 261
connecting to 262
connection string 266
deleting 261
distributing with SuperVision 262
in ODBC model 256
modifying 260
saving as Registry files 262

data type mapping
Informix 277
Ingres 282
InterBase 287
Oracle 290
Progress 295
Sybase 299

database
Vision Communications 46

Database fields 324
example 325
Word 324

Database Form Expert
Delphi 340

database object
Visual Basic 327

database options
Oracle 292
Progress 296

database profiles
PowerBuilder 351

Database Server 509
configuring 47

database window 509
dataset

Delphi 337
DataWindow control

PowerBuilder 348
DataWindow object

PowerBuilder 348
datetime data type

Informix 279
DBauth setting 266
DblClick event handler 234
DBMS 509
DBname setting 266
DBoptions setting 266
DBuser setting 266
DDE

and Excel 311
and Word 320

debug
enabling 61
logging messages 62

debug mode
Vision ODBC Driver 273
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DebugHostAppend setting 268
DebugHostFile setting 268

using debug mode 273
DebugOptions setting 268

using debug mode 274
DebugPCAppend setting 268
DebugPCFile setting 268

using debug mode 273
DEC OSF/1 650
DEC Ultrix 650
decimal numbers

Informix 281
DECnet 509
decryption 85
DECwindows 509
default 509
default colormap 103
default.tpsession file 156
definitions 506
DELAY function

ComScript 603
deleting

database items 453
Delphi 336

Bd2 Demo project 343
Database Form Expert 340
files supplied 338
ODBC connection aliases 338
refreshing data 338
terms 336
using the Bd2 Demo project 343

demonstration database 682
creating tables 264
deleting tables 265
Informix 279
Ingres 284
InterBase 288
Oracle 292
Progress 295
Sybase 300

desktop 379, 509
configuring emulator documents from 174
creating emulator documents on 173

desktops
managing 431

DestroyHotSpot function 203
DestroyPattern function 204
Dialback

example ComScript file 630
DIALOG function

ComScript 604
Direct query

XDMCP 141
DirectColor visual 103

directories in UNIX path
accessing from Host Explorer 366

directory structure
administration host 459

Disconnect function 205
Display Id

for XDM-AUTHORIZATION-1 security 86, 139
display manager

configuring X Server for 138
log file 141
ping interval 141
starting 141
xdm 137, 139, 141, 143, 144

display modes 509
choosing 79

DISPLAY variable 136
in Vision Resume session 160

displaying
emulator History view 175
Message Pad 403

distributing files 430
distributing items to PCs 458
docking bar 509
documentation vi

conventions viii
online Help vii
related sources viii

documents 510
adding types 373
Remote Program Starter 386
terminal emulator 173

DoDefaultCommand function 206
Domain Name System 510
domain.dat file 65, 66, 574
downloading

files from administration database 449
drag 510
dragging files to the Administration Workbench 449
drive items

creating 441
driver

in ODBC model 256
log files 274

Driver Manager
connection string 261

DSN setting 266
dumppath 366, 369, 543
dynamic-link library 510

E
EGA display 104
email 510
embedding emulator objects in a document 183
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emulator documents
configuring from a Program Manager group 174
configuring from the Windows desktop 174
copying text into another application 186
creating in Windows NT 3.51 174
creating on Windows 95 or NT 4.0 173
embedding as objects 183
hot links 186
linking and embedding 183, 188
opening in a browser 189
programming with 187
summary information 174
Unix Application Wizard and 130

emulator scripting 196
ApplicationEvent event handler 228
ButtonDown event handler 229
ButtonUp event handler 230
Command event handler 231
Connect function 200
CreateHotSpot function 201
CreatePattern function 202
DblClick event handler 234
DestroyHotSpot function 203
DestroyPattern function 204
Disconnect function 205
DoDefaultCommand function 206
emulator objects 197
Event event handler 235
event handlers summary 227
examples 241, 244, 247, 248, 249
functions summary 199
GetApplicationBuffer function 207
GetApplicationDataLength function 208
GetDelimitedString function 209
GetRectAttributes function 210
HotSpotHit event handler 236
KeyDown event handler 237
KeyUp event handler 238
LastError function 211
Load function 212
Message function 213
MsgBoxShow function 214
NewObject function 215
PatternHit event handler 239
PlayRecording function 216
RecvdData event handler 240
Save function 217
Scrape function 218
SendKey function 219
SendString function 220
SetRectAttributes function 221
SetStyle function 224
ShowToolbar function 225
ShowWindow function 226
type libraries 198

encryption
for XDM-AUTHORIZATION-1 security 85

ENDFUNC statement
ComScript 597

EnvironmentFile setting 268
ERROR function

ComScript 605
error messages

Vision ODBC Driver 270
evaluation 4
event

PowerBuilder 349
event alerters

InterBase 288
Event event handler 235
event handler

Delphi 337
event procedure

Visual Basic 327
events 180

logging 62
non-printable characters 180

example Tcl scripts
checkxv.tcl 497
msgbox.tcl 497

examples of ComScript files 627
Dialback 630

Excel 311
and Microsoft Query 311
clearing array ranges 318
converting array ranges to constants 318
loading Profit model 318
Profit model 318
quitting Profit model 319
refreshing external data 317
selecting array ranges 317
SQLRequest function 314
SQLRequest function example 314
tips on using arrays 317

Excel ODBC Add-in
installing 314

EXECUTE function
ComScript 606

executing remote programs 382
Expand Aliases 449
external tables

changing links in Access 308
editing in Access 307
importing to Access 304
linking to Access 304
opening in Access 306
performance in Access 310
renaming in Access 307
setting properties in Access 307
using in Access 306
viewing links in Access 308
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F
FetchCache setting 266
fields

tips on using in Word 325
file access

FTP 369
USP 369

File Access Server 542
File Access service 368, 369, 510

choosing method 368
file data sources

adding 259
distributing with SuperVision 262

File Manager
OPEN LOOK 126

file names 460
copying 377

File Transfer Protocol 510
file types 370

actions 375
associations 376
local 371
pattern matching 374
properties 375
remote 372

files
browsing 364
ComScript 594, 595
developing ComScript files 627
generating ComScript files 629
testing ComScript files 628
UNIX 572

files supplied
Delphi 338
PowerBuilder 350
Visual Basic 328

focus policy
Vision Window Manager 117

folder paths
inheriting 447

folders
creating 442

font path 93, 510
adding folder to 96
changing the order 94
Global Aliases 101

font server 511
font substitution 100

automatic 101
enabling 101
interactive 101
searching available fonts 102
selecting replacement font 101

fonts 176, 510
AIX 648
aliases 92, 96, 100
copying X fonts to PC 95
folders 96
HP-UX 651
in X 91
in X Server 92
Matrix XLFD Enhancement 91
server 98
substitution 100
supported formats 92
TrueType and X applications 100
Windows and X clients 99
X fonts and Windows applications 100
X Window System 93

Fonts.ali file 92, 98, 100
creating aliases 96

Fonts.dir file 95, 98, 100
creating 95

forcing an update 458
form

Delphi 337
Visual Basic 327

FTP file access 369
FUNC statement

ComScript 597
function

Delphi 337
PowerBuilder 349
Visual Basic 327

Function Keys toolbar 177
Function Wizard

Excel 314
functions

ComScript 600
ODBC 271
Vision Window Manager 122

further information on Tcl 469

G
Get External Data command

Excel 311
GetApplicationBuffer function 207
GetApplicationDataLength function 208
GetDelimitedString function 209
GetRectAttributes function 210
Global Aliases 93, 101
global restrictions 454
glossary 506
graphics

clipboard format for 108
copying 108
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graphics cache 83
Graphics Speed Optimizer 81

benchmarking display 83
running from Properties dialog 82

GrayScale visual 103
group items

creating 438
group ordering

administration database 439
GSO. See Graphics Speed Optimizer

H
hardware colormaps 103

colormap management 105
Helpful Interactive Suport 110
HINTS 511. See also Helpful Interactive Support
hints

Motif 116, 117
history of screen output 175
hold cursors

Informix 281
host 511
Host Access Control 84

enabling 84
Host Explorer 511

browsing with 364
paths 366

Host Finder 511
configuring hosts 27

Host Manager 380, 511
batch files 378
browsing with 367
configuring hosts 30
hostmgr command 378

Host options
hosts 31

hostmgr command 378
Hostname setting 266
hosts

browsing 364
configuring 27
configuring for modem connection 41
configuring for OPEN LOOK 127
configuring for serial connection 41
specifying Host options 31
specifying Script options 32
specifying Security options 32

hot links 186
HotSpotHit event handler 236
HP fonts 93
HP VUE fonts 651
HP-UX

fonts 651

using Print service with 651
using XDMCP with 650
using XRemote with 658

I
ICCCM 511. See also Inter-Client Communications

Conventions Manual
ICL fonts 93
icons

Vision Window Manager 117
IF...THEN...ELSE statement

ComScript 596
II_SYSTEM 282
implementation issues

ODBC 272
importing tables to Access 304
in-place activation 184
inactive and active PCs 440
index 427

building 450
Indirect query

choosing a display manager 142
XDMCP 141

information
about X Server 111

Information Server 411, 511
Informix server module 277

creating demonstration database 279
datetime data type 279
decimal numbers 281
files installed on UNIX 277
hold cursors 281
owner names 280
scalar functions 280
SQLGetInfo function 280
SQLProcedureColumns function 280

infosrv service 411
Ingres server module 281

creating demonstration database 284
data type mapping 282
files installed on UNIX 282
keyed storage structures 286
locking mode 285
multiple column indexes 285
owner names 285
scalar functions 284
SQLProcedureColumns function 284
text data type 283
varchar data type 283

inheriting
alias paths 447
restrictions 457
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initial window state
Vision Window Manager 117

initialization
Vision Window Manager 115

installing
Microsoft TCP/IP on Windows 95 528
Microsoft TCP/IP on Windows NT 528, 529
Vision97 from VisionFS share 6
Vision97 on a network file server 7
Vision97 on a PC 6
Vision97 on a UNIX host 5
Vision97 overview 4
XRemote host software 6, 146

Inter-Client Communications Conventions Manual 114
interactive font substitution 101
InterBase server module 286

creating demonstration database 288
data type mapping 287
event alerters 288
files installed on UNIX 286
owner names 289
procedures 289
SQLGetInfo function 288
SQLProcedureColumns function 289
SQLProcedures function 289
SQLSpecialColumns function 288

Internet 512
interpretative shell for Tcl 468
introduction v
IP address 512
IPX 512
IPX/SPX 4
ISO 512
ISSET function

ComScript 608
items

administration database 436

J
JDBC Driver Manager

in ODBC model 255
JDBC-aware applets

in ODBC model 255
JDBC-aware applications

in ODBC model 255
JDBC/ODBC bridge

in ODBC model 255
Jet Database Engine 326

K
Kanji font 93
key

for XDM-AUTHORIZATION-1 security 86, 139
keyboard input

in X 87
in X Server 87
modifier keys 89
Num Lock management 90
shortcut keys 89

keyboard maps 87, 177, 512
modifying with xmodmap 89
supplied with X Server 87
vendor-specific 87
VT420 666, 668
Wyse 60 662, 664
X 87

keycodes 87, 512
KeyDown event handler 237
keyed storage structures

Ingres 286
Keymap Editor 178, 512
keymaps 512

in an emulator 178
keypad keys

AIX 648
keysyms 87, 512

APL 643
Arabic 639
Cyrillic 640
Greek 641
Hebrew 643
Katakana 638
Latin1 635
Latin2 637
Latin3 638
Latin4 638
miscellany 634
Publishing 642
Special 642
Technical 641
XKeysymDB 644

KeyUp event handler 238

L
LAN 512
LastError function 211
library

PowerBuilder 349
licadmin 65, 544
License Administrator 512
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license management 4, 64, 432
across subnetworks 68
client authorization 67
licadmin 65
license events 68
License Manager 65
License Numbers 66
License Server 66
organizing users into domains 65
products and components 66
soft licensing 68
warning messages 68

License Manager 65
License Numbers 66
License Server 66, 513, 546
license_event script 68
licsrv 66, 546
licsrv.dat file 66, 576
licsrv.rc file 67, 577
limitations

OpenWindows 126
line terminators 377
linger 513
Linked Table Manager 308
linking tables to Access 304
linking to other documents 183, 188
listing updates 459
ln.dat file 66, 578
LNA. See Local Name Agent
lna 548
Load function 212
local authorization file 86

enabling 86
local file types 371
local Motif Window Manager 124

starting 125
Local Name Agent 54, 513, 548

client authorization 67
configuring servers 55
starting 54
starting workbsrv 427

local printer
adding in Vision Services 389

local printing 388, 513
locating resources 51
locating resources on another network

Name Space Manager 57
locking mode

Ingres 285
log file

xdm 141
XRemote on UNIX 149

log files
Vision Communications 274

Vision ODBC Driver 274
Vision Resume 157
X Server 111

log in
manual 135

Log Server 513, 549
logging 61

debug information 62
events 62
on a PC 61
on UNIX 62

logging in with xdm 143
logical font description 91

for Windows fonts 99
logsrv 62, 549
long file names 460
LONGBREAK function

ComScript 609
LOOP statement

ComScript 596
Lower command (Control menu)

X Server and Motif compatibility 119
LPD protocol 388, 393, 513

M
macro language 513
macros 513
magic cookie 85
main program

closing 77
Maintenance Setup 11
managing desktops 431
managing PCs remotely 426
mapping windows

Vision Window Manager 116
marking an item for deletion 453
MATCH function

ComScript 598, 610
Matrix XLFD Enhancement 91

character subsetting 92
maximum window size 116
menu bar 513
menus

Motif 117
Message function 213
message handling 402

Message Pad 402
sending multimedia messages 405
sending text messages 404
UNIX messages 407

Message Pad 513
displaying 403
handling messages 402
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messaging 433
method

Delphi 337
Visual Basic 327

methods
file access 368
remote execution 384
terminal connection 171

Microsoft Access. See Access
Microsoft Excel. See Excel
Microsoft Query

and Excel 311
and Word 320

Microsoft Query and Excel
example 311

Microsoft Query and Word
example 320

Microsoft TCP/IP
installing on Windows 95 528
installing on Windows NT 528, 529

Microsoft Visual Basic. See Visual Basic
Microsoft Word. See Word
middle mouse button

combinations with 91
dragging 90
emulation of 90

minimum window size 116
MISC fonts 93
MIT-MAGIC-COOKIE-1 85, 139
Mode Switch 87, 90
modem connections 33

configuration 35
configuring hosts 41
configuring modem as a TAPI device 35
configuring Modem transport 39
configuring transports 36
configuring USP-Modem transport 40
opening using a terminal emulator 43
phone number 37

modems 514
configuring 35
selecting 531

modifier keys 87, 89, 514
module

Visual Basic 327
monochrome display 104
Motif 123

compatibility with Vision Window Manager 118
hints 116, 117
mapping windows 116
menus 117
quitting 125
Window Manager functions 122
X Server and 124

Motif Window Manager 80, 123, 124
configuring 125
local 124
starting 125

mouse
middle button emulation of 90

moving 377
translation of line terminators 377

MsgBoxShow function 214
multimedia messages 405
multiple column indexes

Ingres 285
multiple-tier driver 256
multiple-windows mode 74, 79
multiplexed protocol 514
MWM. See Motif Window Manager
Mwmrc.txt file 126

N
Name Space Environment 51, 514
Name Space Manager 52, 514

locating resources on another network 57
registering administered PCs 53

NCP 514
NDIS 514
NetBEUI 514
NetBIOS 514
NetWare 4
network

types supported 4
XDMCP support 138

Network Checkout 515
network connections 33
network file server

installing Vision97 on 7
network workstations

setting up Vision97 on 8
NewObject function 215
newterm 550
NOMATCH function

ComScript 598, 612
non-changeable color display 104
non-printable characters

events 180
keymaps 179
SendString function 220
toolbars 180

NOREMATCH function
ComScript 598, 613

Normal style 181
NOTCALL function

ComScript 615
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NOTSET function
ComScript 616

NSE. See Name Space Environment
NSM. See Name Space Manager
nsmadmin 551
nsmrpcsrv 52, 552
nsmsrv 52, 553
Num Lock management 90
NUMBER data type

Oracle 294

O
object

PowerBuilder 349
Visual Basic 327

Object Linking and Embedding. See OLE
objects

in administration database 450
Program Manager item 450
Registry files 451

ODBC 254, 515
API function limitations 272
API functions 271
components in Vision model 254
implementation issues 272

ODBC Add-in
installing in Excel 314

ODBC API function
limitations 272

ODBC applications overview 304
ODBC connection aliases

Delphi 338
ODBC Data Sources key 255
ODBC driver 515. See also Vision ODBC Driver
ODBC Driver Manager

in ODBC model 255
odbc_server 554
OLE 183, 515

embedding emulator objects 183
in-place activation 184
Paste Link 186

OLE Automation 515
Connect function 200
CreateHotSpot function 201
CreatePattern function 202
DestroyHotSpot function 203
DestroyPattern function 204
Disconnect function 205
DoDefaultCommand function 206
emulator objects 197
functions summary 199
GetApplicationBuffer function 207
GetApplicationDataLength function 208

GetDelimitedString function 209
GetRectAttributes function 210
LastError function 211
Load function 212
Message function 213
MsgBoxShow function 214
NewObject function 215
PlayRecording function 216
programming with emulator documents 187
Save function 217
Scrape function 218
SendKey function 219
SendString function 220
SetRectAttributes function 221
SetStyle function 224
ShowToolbar function 225
ShowWindow function 226
type libraries 198

OLWM. See OPEN LOOK Window Manager
Open Database Connectivity. See ODBC
OPEN LOOK 126, 515

buttons not visible 657
OPEN LOOK Window Manager 127

configuring X Server for 127
File Manager 126
host configuration for 127
starting 127
X Server and 126

opening
modem connection from a terminal emulator 43

opening a serial connection
using Connection Monitor 45

opening a terminal connection
using a terminal emulator 169

OpenRecordset method
Visual Basic 334

OpenWindows 126
limitations 126

optimizing
server performance 81

Oracle server module 289
creating demonstration database 292
data type mapping 290
database options 292
NUMBER data type 294
scalar functions 293
SQLProcedureColumns function 293

ORACLE_HOME 290
ORACLE_SID 290
organizing PCs into groups 426
organizing the desktop 416, 418
organizing users into domains

license management 65
Oriental fonts 93
OSF/Motif 515
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output
previous 175

override_redirect attribute 121
window decoration 116

owner names
Informix 280
Ingres 285
InterBase 289

P
painter

PowerBuilder 349
Palette Manager 104
panning 516
parameters

ComScript 598
PASSWORD function

ComScript 617
password storage 24, 60
Paste Link 186
pasting 107, 179

in X 107
in X Server 107

PATH
XRemote host software 147

paths
Host Explorer 366

pattern matching 374, 516
PatternHit event handler 239
patterns

adding 375
Pb5 Demo

how it works 356
PowerBuilder 354
using 354

PC client authentication 59
PC items

creating 437
PC-Connect users

upgrading to TermVision 671
PCF font 516
pcinvent.tcl 472
pclist 53, 410, 556
pcprtclnt 388, 557
PCs

browsing directly 462
controlling and monitoring remotely 462
inactive and active 440
logging 61
performing tasks using Tcl scripts 431
removing Vision97 from 12
requirements 4
updating 458
viewing programs 464

performance optimization 81
performing tasks on PCs using Tcl scripts 431
phone numbers 37
ping interval 141
planes

video 102
PlayRecording function 216
Port setting 268
port settings 38
Portable Compiled Format font 92
position

terminal emulator 175
PostScript 388, 516
PowerBuilder 348

configuring ODBC data sources 353
connecting to data sources 350
connecting to data sources using a database
profile 351
database profiles 351
files supplied 350
how the Pb5 Demo project works 356
Pb5 Demo project 354
terms 348
using the Pb5 Demo project 354

Powersoft PowerBuilder. See PowerBuilder
PPP 516
previous output 175
primary group 439
PRIMARY selection atom 107
Print Server 516, 558

configuring 392
showing window 393

Print service
with AIX 648
with HP-UX 651
with SCO-ODT 653

Print style 181
printers

adding local in Vision Services 389
adding remote 394
configuring on BSD UNIX to use LPD 390
configuring on BSD UNIX to use RPC 390
configuring on UNIX System V to use LPD 391
configuring on UNIX System V to use RPC 391
configuring remote in Vision Services 397

printers file 388, 579
printing 388

configuring 392
emulator screen 182
emulator slave printing 183
from a PC to UNIX 393
from an emulator 182
from UNIX to a PC 388
local 388
remote 393
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printsrv 393, 558
privilege

System Administrator 436
privileges

granting and revoking with Security Manager 275
probe of communications transport 20
procedure

Delphi 337
procedures

InterBase 289
prodinfo.dat file 66, 580
profiles

X Server 74, 78
Profit model

Excel 318
loading in Excel 318
quitting in Excel 319

program functionality
restricting 454

Program Manager item 450
creating 451

Program Manger group
configuring emulator documents from 174

programming
Visual Basic 331

programming with emulator documents 187
object types 197

programs
adding types 372

Progress server module 294, 295
creating demonstration database 295
database options 296
files installed on UNIX 294
scalar functions 297
security 298
SQLProcedureColumns function 298
SQLSpecialColumns function 296
system tables 297
updating data sources 297

project
Delphi 337
Visual Basic 328

project file
Delphi 337
Visual Basic 328

properties
of a file type 375

property 516
Delphi 337
Visual Basic 328

protocols 516
proxy hosts 23
proxy process 34, 35, 517, 562

proxy-server
tpproxy 154
tpwatch 154
Vision Resume 154
Xremote 144

PseudoColor visual 103
PWD setting 266

Q
Query Add-in

for Excel 311
QueryTimeout setting 268
quitting

Motif 125
Profit model in Excel 319
Vision Resume session 162
xdm 144
XRemote 151

QWERTY keyboard 517

R
read-ahead facility 254
ReadOnly setting 266
recordings 181
recordset object

Visual Basic 328
RecvdData event handler 240
Refresh method 347
refreshing data

Delphi 338
registering administered PCs

Name Space Manager 53
Registry file 451
related documents viii
relocating a Vision Resume session 161
REMATCH function

ComScript 598, 618
remote command processor 517
remote configuration 431
remote execution

choosing method 384
rexec 385
rsh 385
USP 385

Remote Execution service 384, 517
choosing method 384

remote file types 372
remote hosts

connecting to 169
remote printers

adding 394
configuring in Vision Services 397
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remote printers (continued)
configuring on BSD UNIX to use LPD 390
configuring on BSD UNIX to use RPC 390
configuring on UNIX System V to use LPD 391
configuring on UNIX System V to use RPC 391

remote printing 393, 517
Remote Procedure Call service 49, 517
Remote Program Starter 382, 517

documents 386
executing remote programs 382
starting X applications with 133
Unix Application Wizard and 130

remote programs
executing 382

removing
administration tasks 453
Vision97 from PC 12
Vision97 from UNIX 11

repository
PowerBuilder 349

requesting an update 458
requirements for Vision97 4
resolving aliases to pathnames during an update 448
resource location 51
resources

graphics cache 83
restarting

X Server 78
restrictions 431, 454

application 455
global 454
inheriting 457
setting 456
X Server 75

Resume 154
resuming a Vision Resume session 159
Retrieve function

PowerBuilder 358
RETURN function

ComScript 620
reuseaddr 517
rexec 171, 385
RGB model 102
RGB values 102

color name database 106
Rgb.txt file 106
rlogin 171
root window 518
RowFocusChanged event

PowerBuilder 358
RPC. See Remote Procedure Call
RPC protocol 388, 393
RS232C 518
RS232C protocol 34

rsh 385
running

commands from Tcl command line 469
tasks using Tcl scripts 470
Tcl scripts from Tcl command line 469
Tcl scripts from UNIX command line 469

S
Save function 217
SAVEPASSWORD function

ComScript 621
scalar functions

Informix 280
Ingres 284
Oracle 293
Progress 297
Sybase 301

scaleable fonts in X 91
scan codes

ANSI Emulator 191
SCO Vision Language Translator 273
SCO Vision ODBC Setup dialog box

enabling fields in 261
SCO-ODT

connecting to 652
using Print service with 653
using XDMCP with 653

Scodemo database
creating tables 264
deleting tables 265

Scrape function 218
screen shot 465

increasing size of picture 465
script 518

PowerBuilder 349
script file

for automated installations 8
Script options

hosts 32
transports 24

scripting
examples 241, 244, 247, 248, 249

scripting language 596
comments 599
IF...THEN...ELSE statement 596
LOOP statement 596
parameters 598
string matching 598
user-defined functions 597

scripts 182
scroll bars 518
search path

XRemote host software 147
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security 58, 84
Authentication Server 59
authentication types 58
client authentication 59
Host Access Control 84
local authorization file 86
Progress 298
User Access Control 85
XDMCP 85

Security Manager 275
granting and revoking privileges 275

Security options
hosts 32
transports 23

selection atoms 107
CLIPBOARD 107
PRIMARY 107

selection mechanism 107
SEND function

ComScript 623
SendKey function 219
SendString function 220
serial connections 33

choosing a modem 531
configuration 35
configuring hosts 41
configuring Serial-Com1 transport 37
configuring transports 36
creating USP-Serial transport 40
opening using Connection Monitor 45
phone number 37
protocols 34
setting up 530
testing 531

server modules
in ODBC model 256

Server-based Setup 7
ServerID setting 266
ServerOptions setting 267
servers

configuring 55
enabling the XRemote protocol 149
starting 48, 56
X Window System 74
XDMCP 138

servers file 581
session manager

XRemote 144
sessions

starting xdm 143
SetRectAttributes function 221
SetStyle function 224
setting restrictions 456
setting up a serial connection 530

SetTransObject function
PowerBuilder 357

Setup
creating a script file 9
starting on PC 6
starting on UNIX 5

Setup.exe 6
shortcut keys 89
shortcuts 379, 518
ShowToolbar function 225
ShowWindow function 226
Simple style 181
single-window mode 74, 80
SITE_FORWARD property 122
size

terminal emulator 175
slave printing 183, 518
SLIP 518
Sockets service 50, 518
soft licensing 68
Solaris 655
specifications

ANSI Emulator 190
VT420 Emulator 191
Wyse 60 Emulator 193

SPX 518
SQL Communications Area

PowerBuilder 349
SQL Services for Informix

files installed 277
SQL Services for Ingres

files installed 282
SQL Services for InterBase

files installed 286
SQL Services for Oracle

files installed 289
SQL Services for Progress

files installed 294
SQL Services for Sybase

files installed 298
SQL statements

viewing or modifying in Access 309
SQL-Exchange

in ODBC model 255
SQL-Retriever 519
SQL_TIMESTAMP data type

Informix 279
SQLExtendedFetch 272
SQLGetData function 272
SQLGetInfo function

Informix 280
InterBase 288

SQLGold 519
SQLProcedureColumns function

Informix 280
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SQLProcedureColumns function (continued)
Ingres 284
InterBase 289
Oracle 293
Progress 298

SQLProcedures function
InterBase 289

SQLRequest function 314
example 314

sqlrsec.conf file 583
SQLSetConnectOption function 272
SQLSpecialColumns function

InterBase 288
Progress 296

SQLSTATE 270
SQLSyntax setting 269
Standard toolbar 177
Start menu

creating emulator documents on 173
starting

Audio Server 109
clients in Vision Resume session 160
clients with terminal emulators 135
clients with UNIX commands 136
local Motif Window Manager 125
Local Name Agent 54
Motif Window Manager 125
OPEN LOOK Window Manager 127
programs automatically 420
server programs 48, 56
Vision Resume session 159
X applications 130
X applications with Remote Program Starter 133
X applications with terminal emulators 135
X applications with UNIX commands 136
X applications with xdm 143
X Server 76
xdm 141

StaticColor visual 103
StaticGray visual 103
status bar 519
STATUS function

ComScript 624
string matching

ComScript 598
styles 180

predefined 181
subroutine

Visual Basic 328
substitute fonts

selecting 101
substitution

fonts 100
summary information

emulator documents 174

SunOS 657
Interrupted System Call error 657

SuperVision 519
components 427, 428

SuperVision for UNIX 427
SuperVision for Windows 428
supported networks 4
suspending a Vision Resume session 161
Sybase server module 298

creating demonstration database 300
data type mapping 299
scalar functions 301

System Administrator 519
System Administrator privilege 436
system data sources

adding 258
system requirements 4
system settings 19
system tables

Progress 297
system-defined functions

ComScript 600

T
TAPI 35, 519
task list 464
Task Server 560
Task service 171, 385, 519

terminal command line 172
utmp file 172

taskbar 519
tasks 452

in administration database 452
Tcl 431, 468

admsh 468
further information on 469
interpreter 468
online Help 469
package libraries 468
UNIX components 468

Tcl commands 475
adm_checkprocess 476
adm_connect 477
adm_copy 478
adm_db 479
adm_delete 480
adm_disconnect 481
adm_drives 482
adm_eventlog 484
adm_execute 485
adm_fileinfo 486
adm_getdirlist 487
adm_getwinver 488
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Tcl commands (continued)
adm_group 489
adm_ini 490
adm_messagebox 491
adm_pc 492
adm_reboot 493
adm_registry 494
adm_task 495
adm_vwgetenv 496
running from Tcl command line 469

Tcl scripts 468
checkxv.tcl 471
examples 497
pcinvent.tcl 472
running from Administration Workbench 452, 470
running from Tcl command line 469
running from UNIX command line 469
supplied with SuperVision 470
who.tcl 473
wingroups.tcl 474

TCP 519
TCP/IP 4, 520

installing Microsoft TCP/IP on Windows 95 528
installing Microsoft TCP/IP on Windows

NT 528, 529
testing the connection on 530
XDMCP support 138

TCPOptions setting 269
termdump 559
terminal command line 172
Terminal Connection service

choosing method 171
terminal connections

opening using a terminal emulator 169
USP 171

terminal emulation 168
terminal emulators 520

ANSI specification 190
ANSI terminal settings 191
ANSI unsupported features 190
changing size and postion 175
colors 177
connecting to a remote host 169
copying and pasting 179
creating hot links 186
displaying the History view 175
documents 173
embedding emulator objects 183
event handlers summary 227
events 180
fonts 176
functions summary 199
keyboard input 177
object types 197
OLE 183, 188

opening a modem connection 43
opening a terminal connection 169
printing 182
printing the screen 182
programming with emulator documents 187
recording and playback 181
scripts 182
slave printing 183
starting X applications with 135
styles 180
toolbars 177
type libraries 198
UNIX messages 407
virtual screen 175
VT420 character sets 192
VT420 specification 191
VT420 terminal settings 192
VT420 unsupported features 192
Wyse 60 specification 193
Wyse 60 terminal settings 194
Wyse 60 unsupported features 193

Terminal Options toolbar 177
terminal server

using XRemote with 658
Terminal service 170, 520
terminal settings

ANSI Emulator 191
VT420 Emulator 192
Wyse 60 Emulator 194

terminals 520
termio file 585
termios file 585
terms 506

Delphi 336
PowerBuilder 348
Visual Basic 326

TermVision 520
upgrading from PC-Connect 671

testing
network connections 530
serial connections 531

text data type
Ingres 283

text messages 404
Timeout setting 268
title bar 520
Tool Command Language 520. See also Tcl
toolbars 177, 520

non-printable characters 177
tpproxy 154, 567
tpwatch 154, 567
TRACE function

ComScript 626
transaction object

PowerBuilder 349
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translating data 272
translation DLL 272, 521
TranslationDLL setting 270
TranslationName setting 270
TranslationOption setting 270
transports 521

adding 20
configuring 20
configuring Modem 39
configuring Serial-Com1 37
configuring USP-Modem 40
configuring USP-Serial 40
order 21
specifying Advanced options 25
specifying Communications options 22
specifying Script options 24
specifying Security options 23
used by X Server 81

troubleshooting 432
true color display 105
TrueColor visual 103
TrueType fonts 176

using with X applications 100
tsrv 172, 385, 560
tsrv.rc file 173, 586
TWO_TASK 290

U
UID setting 266
undeleting database items 454
Uniform Naming Convention 521
uninstalling Vision97 12
unit

Delphi 337
Universal Session Protocol 34, 521

services 48
Uniform Naming Convention 51

Universal Transport Protocol 34, 521
UNIX

client authentication 60
components for Tcl 468
configuring XRemote 147
directory structure 459
logging 62
messages 407
removing Vision97 from 11
requirements for installing on 4
tips and tricks 648
upgrading software 6
xdm configuration 139
XRemote installation 146

Unix Application Wizard 130

UNIX commands 534
admcopy 535
admexec 536
admindex 537
admls 538
admupdate 539
authsrv 541
browsesrv 542
dumppath 543
for starting X applications 136
licadmin 544
licsrv 546
lna 548
logsrv 549
newterm 550
nsmadmin 551
nsmrpcsrv 552
nsmsrv 553
odbc_server 554
pclist 556
pcprtclnt 557
printsrv 558
termdump 559
tpproxy 567
tpwatch 567
tsrv 560
usputppxy 562
v97 debug 564
v97 debugoff 564
v97 remove 564
v97 start 564
v97 status 564
v97 stop 564
v97 version 564
visionver 563
workbsrv 566
xresmgr 567
xresume 567

UNIX files 572
.visionpath 573
cola.dat 578
domain.dat 574
licsrv.dat 576
licsrv.rc 577
ln.dat 578
printers 579
prodinfo.dat 580
servers 581
sqlrsec.conf 583
termio 585
termios 585
tsrv.rc 586
vision.conf 587
visionpriv 589
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UNIX files (continued)
vwdebuglog 590
vweventlog 591
winsize 592

Unix Neighborhood 521
browsing with 364
configuring hosts 29

Unixslsc.scr file 652
unsupported features

ANSI Emulator 190
VT420 Emulator 192
Wyse 60 Emulator 193

update
forcing 458
listing 459
requesting 458
resolving aliases back to pathnames during 448
running 458

updating data sources
Progress 297

updating PCs 428
updating tables

Visual Basic 328
upgrading

to TermVision from PC-Connect 671
UNIX software 6

user access
restricting 456

User Access Control 85
local authorization file 86
MIT-MAGIC-COOKIE-1 85
XDM-AUTHORIZATION-1 85

user data sources
adding 256

User Datagram Protocol 522
User Viewer 432, 522

sending multimedia messages 405
sending text messages 404
viewing current users 410
viewing user properties 411

User-defined alias 445
expanding aliases to pathnames 448
folder paths 447
inheriting paths 447

User-defined aliases
creating 445

user-defined functions
ComScript 597

USP Services 522
USP services 48

File Access service 369
Remote Procedure Call service 49
Sockets service 50
Task service 171, 385

usputppxy 35, 50, 562
utmp file 172
UTP. See Universal Transport Protocol

V
v97

debug option 564
debugoff option 564
remove option 11, 564
start option 564
status option 564
stop option 564
version option 564

varchar data type
Ingres 283

Vb4 Demo 331
how it works 333
using 332

Vb4demo.exe 332
Vb4demo.frm 333
version number

XRemote 149
VGA display 104
video planes 102
viewing

current users 410
user properties 411

viewing programs running on a PC 464
VirtualServer setting 267
Visdata application 331
Vision Communications

log files 274
XRemote and 145

Vision Communications Architecture 16, 522
adding transports 20
ComScript 594
configuring hosts 27
configuring transports 20
File Access service 368
locating resources 51
model 17
Name Space Environment 51
password storage 60
Remote Execution service 384
scripting language 596
security 58
Terminal service 170
Universal Transport Protocol 34
USP services 48

Vision Communications Database 522
Vision Communications database 46
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Vision ODBC Driver
254, 277, 282, 286, 289, 294, 295, 298

data type mapping 282, 287, 290, 299
database options 292, 296
datetime data type 279
debug 273
decimal numbers 281
event alerters 288
hold cursors 281
Informix 277
Ingres 281
InterBase 286
keyed storage structures 286
locking mode 285
log files 274
multiple column indexes 285
NUMBER data type 294
Oracle 289
owner names 280, 285, 289
procedures 289
Progress 294
scalar functions 280, 284, 293, 297, 301
security 298
SQLGetInfo function 280, 288
SQLProcedureColumns
function 280, 284, 289, 293, 298
SQLProcedures function 289
SQLSpecialColumns function 288, 296
Sybase 298
system tables 297
text data type 283
updating data sources 297
varchar data type 283

Vision ODBC driver
granting and revoking privileges 275
Security Manager 275

Vision Resume 154, 522
abnormal termination 162
configuring on PC 155
configuring on UNIX 156
how it works 154
log files 157
quitting a session 162
relocating a session 161
resuming a session 159
starting a session 159
starting clients 160
suspending a session 161
window management 161

Vision Resume Session Control 158
Vision Resume Session Manager 159
Vision RPC mechanism 254
Vision Services 48, 522

shutting down 49
starting 48

Vision Window Manager 80, 114, 523
closing X clients 118
colormap management 117
colormaps 105
compatibility with Motif 118
focus policy 117
functions 122
icons 117
initial window state 117
initialization 115
Lower command (Control menu) 119
mapping windows 116
position of window 116
size of window 116
title of window 117
window decoration 116
window properties set by 122

vision.conf file 52, 57, 69, 468, 470, 587
VISION_ADMINDIR 587
VISION_BINDIR 587
VISION_DEBUGDIR 587
VISION_DEPLOYDIR 587
VISION_DIR 587
VISION_ETCDIR 587
VISION_EVENTDIR 587
VISION_EVENTLEVEL 587
VISION_LOGLIMIT 587
VISION_MAXSESSIONS 587
VISION_NAMESVC 587
VISION_NSGATEWAY 6, 57, 69, 587
VISION_TCLDIR 587
VISION_TCLINTERP 587
VISION_TCLSCRIPTDIR 587
VISION_TMPDIR 587
VISION_TOOLSDIR 587
Vision97

adding more options after Setup 11
automated installations 8
installation overview 4
installing on a network file server 7
Maintenance installation 11
removing from PC 12
removing from UNIX 11
setting up on a network workstation 8
setting up on a PC 6
setting up on a UNIX host 5

VisionFS 523
visionpriv file 436, 589
visionver 563
Visual Basic 326

data access objects 326
data control 329
files supplied 328
how the Vb4 Demo project works 333
programming for data access 331
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Visual Basic (continued)
terms 326
updating tables 328
using the Vb4 Demo project 332
Vb4 Demo project 331

visuals 103, 523
class 103

VMS 523
VT420 Emulator 523

character sets 192
specification 191
terminal settings 192
unsupported features 192

VUE File Manager 651
vwdebuglog file 62, 590
vweventlog file 62, 591
VWM. See Vision Window Manager
Vwodbc.dll 254
vwodbc.log 273
Vwodbc.txt 273

W
WAN 523
warning messages

licensing 68
Well-known alias 443
what you need to install Vision97 4
who.tcl 473
wildcards

in X logical font description 91
window

decoration 116
initial state 117
mapping in Motif 116
override_redirect attribute 116
position 116
PowerBuilder 350
properties 119
properties set by Vision Window Manager 122
properties set by X clients 119
size 116
titles 117
WM_TRANSIENT_FOR property 116

window management 80, 114
in Vision Resume session 161
Motif 124
OPEN LOOK 126
Vision Window Manager 114
X Display Manager 143

window manager 523
Windows

aliases for fonts 100
Clipboard 107

fonts and X clients 99
resources 83
using X fonts 100

Windows > Display 116
Windows Open Services Architecture 254
Windows Registry 55, 517
wingroups.tcl 474
winsize file 592
WM_COLORMAP_WINDOWS property 117, 122
WM_DELETE_WINDOW protocol 118, 121
WM_HINTS property 120
WM_ICON_NAME property 119
WM_ICON_SIZE property 122
WM_NAME property 119
WM_NORMAL_HINTS property 119
WM_PROTOCOLS property 121
WM_SAVE_YOURSELF protocol 118, 121
WM_STATE property 122
WM_TAKE_FOCUS protocol 121
WM_TRANSIENT_FOR property 121

window decoration 116
Word 320

and Microsoft Query 320
Database fields 324
Database fields example 325
tips on using fields 325

Workbench Server 429, 462, 524
Workbnch.exe 428
workbsrv 566
Workbsrv.exe 429
World Wide Web 523
WOSA. See Windows Open Services Architecture
Wyse 60 Emulator 524

specification 193
terminal settings 194
unsupported features 193

X
X

closing applications 118
colors 102
copying 107
fonts 91
fonts copying to PC 95
fonts used with Windows applications 100
keyboard input 87
keyboard maps 87
pasting 107
security 84
window properties set by 119

X applications
starting 130, 143
starting with Remote Program Starter 133
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X applications (continued)
starting with terminal emulators 135
UNIX commands for starting 136

X clients 524
X display 524
X display device 136
X Display Management Control Protocol. See XDMCP
X Display Manager

chooser 141, 142
choosing a willing 141
configuring on UNIX 139
configuring X Server for 138
log file 141
logging in 143
ping interval 141
quitting 144
starting 141
starting a session 143
User Access Control 141
window management 143
xdm 137

X Keymap Editor 88, 524
X logical font description 91

for Windows fonts 99
X logical fonts 524
X Server 74

closing manually 76
colors 103
configuring 77
configuring for OLWM 127
configuring for X Display Manager 138
copying 107
copying graphics 108
diagnostics 111
display modes 79
enabling the XRemote protocol 149
font path order 94
fonts 92
getting information about 111
graphics cache 83
keyboard input 87
log files 111
Motif and 124
OPEN LOOK and 126
pasting 107
performance optimization 81
profiles 78
restarting 78
restrictions 75
security 84
starting 76
transports 81
XDMCP 138
XRemote and 145

X server 524
X Window System

colors 102
fonts in X 91
keyboard input 87
standard X fonts 93

Xaccess file 141
xauth 86
Xdef-lcl.txt file 126
Xdefault.txt file 126
xdm 137, 524

chooser 141, 142
choosing a willing 141
closing 77
configuring on UNIX 139
configuring X Server for 138
log file 141
logging in 143
ping interval 141
quitting 144
starting 141
starting sessions 143
User Access Control 141
using session file for XRemote 140

XDM-AUTHORIZATION-1 85, 139
xdm-config 139
xdm-errors file 141
xdm-keys file 85
XDMCP 85, 137, 524

Broadcast query 141
Direct query 141
enabling 85, 138
Indirect query 141, 142
security 141
starting xdm 141
supported networks 138
using 85
using with HP-UX 650
using with SCO-ODT 653
X11R3 clients and 85

Xhosts.txt file 84
xinitremote 144

XRemote host software 147
XLFD 91
Xlodbc.xla file

Excel 314
Xlog.txt file 111
xmodmap 89
xprop 119
XRemote 144, 525

configuring on the PC 145
configuring on UNIX 147
Connection Monitor and 151
host software 6, 146
host software search path 147
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XRemote (continued)
log file on UNIX 149
protocol 34
quitting 151
running over USP connection 40
session manager 144
using session file for xdm 148
using with BSD UNIX 658
using with Series 800 HP-UX 9.0 658
version number 149
via a terminal server 658
Vision Communications and 145
X Server and 145

Xremote
helper process 150

Xremote proxy-server 144
XREMOTETMPDIR 149
xresmgr 567
xresume 154, 567

search path 156
Xsession 143
xterm 525
Xtrace protocol 23
XVision 525
XVision Font Compiler 525

Z
Zone Control 418
Zone Police 417
zonebar 416
Zones

organizing the desktop 416
organizing zones 416
quitting 417
starting programs automatically 420
using Zone Control 418
viewing zone properties 419
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